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Situs Pelatihan untuk Surveyor dan Manajer Proyek

Selamat datang di situs pelatihan untuk surveyor dan manajer proyek. Situs ini dikembangkan melalui
kerjasama antara Humanitarian OpenStreetMap Team (HOT) dengan Pasific Disaster Center (PDC)
dalam rangka pengembangan kapasitas di bidang pengumpulan data melalui OpenStreetMap untuk
mendukung InAWARE, sebuah platform yang dibuat oleh Pacific Disaster Center (PDC).

Supported by:

“Partners”
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 — title: Integrasi Data OpenStreetMap di InAWARE weight: 1 —

Tujuan Pembelajaran:

• Mengetahui Cara Membuat Membuat Akun di InAWARE
• Memasukkan Data OpenStreetMap ke dalam InAWARE

Salah satu tujuan dari kegiatan pemetaan yang dilakukan dalam Proyek HOT - PDC InAWARE adalah
untuk melengkapi data diOpenStreetMap sekaligus untuk membantu pemerintah khususnya Badan Na-
sional Penanggulangan Bencana (BNPB) dan Badan Penanggulangan Bencana Daerah (BPBD) dalam
melengkapi data mereka di InAWARE, platform yang dibuat oleh Pacific Disaster Center (PDC), sebuah
lembaga dari University of Hawaii, untuk melakukan manajemen penanggulangan bencana. Materi ten-
tang pemanfaatan InAWARE yang lengkap dapat anda lihat pada modul-modul yang telah dibuat oleh
PDC. Dalam modul ini pembahasan InAWARE akan fokus tentang bagaimana data dariOpenStreetMap
dapat dimasukkan dan diintegrasikan ke dalam InAWARE.

I. Membuat dan Mengakses Akun InAWARE

InAWARE membatasi akses platform mereka hanya untuk kalangan praktisi/tenaga ahli pengelolaan
bencana dan pekerja kemanusiaan seperti BNPB, BPBD, dan lembaga yang bekerjasama dengan
BNPB/BPBD. Hal ini diperuntukkan untuk menjaga dan menjamin kelancaran akses prioritas dan tanpa
gangguan menuju informasi kritis dan konten terlindungi selama masa-masa darurat dan bencana. Anda
dapat mengajukan permohonan akun InAWARE, sebagai berikut:

• Silakan akses: inaware.bnpb.go.id/
• Klik tautan Meminta Akses InAWARE dalam halaman login.

Saat disetujui, prosesnya kemungkinan memakan waktu hingga 24 jam, tergantung dari BNPB untuk
membuatkan akun tersebut. Saat proses pembuatan akun selesai, akan akan dikirimkan kepada pemo-
hon melalui surat elektronik (e-mail).

• Silakan login ke sistem

II. Memasukkan Data OpenStreetMap ke InAWARE

Setelah Anda mengetahui apa itu InAWARE serta langkah-langkah untuk mendapatkan akun, sekarang
Anda akan mempelajari tentang bagaimana cara memasukkan hasil pemetaan dan pengumpulan data
Anda di lapangan yang telah dimasukkan ke dalam _OpenStreetMap _ke dalam InAWARE. Format data
yang dapat kita masukkan ke dalam InAWARE adalah GeoJSON. Untuk mendapatkan data _Open-
StreetMap _dalam format tersebut, Anda dapat melihat Modul Konversi Data Shapefile ke GeoJSON.
Berikut adalah langkah-langkah dalam memasukkan data OpenStreetMap ke dalam InAWARE:

• Silahkan klik menu Layers di InAWARE
• Pilih Edit kemudian pilih Add Layer
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Memasukkan layer untuk data OpenStreetMap

• Kemudian pilih File dan klik Please Choose the File
• Cari dan pilih data OpenStreetMap yang telah dikonversi menjadi GeoJSON
• Layer data OSM Anda akan tampil di InAWARE dan berada di Folder KML & External Layers

dengan nama GeoJSON Feature

Tampilan layer OpenStreetMap di InAWARE

• Anda dapat melihat informasi untuk setiap fitur / objek dari data OpenStreetMap yang telah dima-
sukkan. Anda klik pada fitur yang mau Anda lihat informasinya kemudian pilih info
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Tampilan Informasi Fitur Data OpenStreetMap di InAWARE

RINGKASAN

Selamat Anda telah memahami tentang InAWARE dan bagaimana memasukkan hasil kegiatan
pemetaan Anda ke dalamnya. Untuk analisa kebencanaan yang lebih mendalam Anda dapat
menambahkan layer-layer lain yang terdapat di InAWARE dengan data OpenStreetMap Anda. Untuk
pemahaman InAWARE yang lebih lanjut Anda dapat melihat modul-modul yang disediakan oleh pihak
Pacific Disaster Center (PDC).
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Konsep Penjaminan Kualitas

Tujuan Pembelajaran:

• Memahami pengertian penjaminan kualitas
• Memahami pengertian penjaminan kualitas data di OpenStreetMap

OpenStreetMap (OSM) merupakan peta dunia yang bersifat bebas dan terbuka. OSM memiliki banyak
data dan informasi mengenai berbagai macam objek yang ada di permukaan bumi. Data tersebut
dikumpulkan dan dimasukkan oleh pengguna OSM yang tersebar di seluruh dunia. Beragamnya data
yang dimasukkan dan dikumpulkan oleh pengguna OSM seringkali mengakibatkan kualitas data yang
dimiliki menjadi berbeda satu dengan yang lain dan kurangnya pemahaman pengguna OSM mengenai
kualitas data juga mempengaruhi hasil data yang ada di di OSM. Oleh karena itu, setiap pengguna
OpenStreetMap sebaiknya tidak hanya menambahkan data saja, namun juga turut serta dalam men-
jaga kualitas data. Pada pembahasan kali ini, Anda akan mempelajari apa itu penjaminan kualitas dan
mekanisme pendekatan yang digunakan untuk menunjukkan cara menjaga dan memperbaiki kualitas
data OpenStreetMap.

I. Pengertian Penjaminan Kualitas Data

Ketika Anda berbicara tentang data yang terlintas dalam pikiran Anda mungkin suatu rangkaian infor-
masi yang terkait tentang suatu kejadian, objek atau fenomena yang terkumpul dari sumber tertentu. Se-
makin banyak jumlah data yang tersedia, maka pengecekan mengenai kualitas data tersebut sebelum
bisa diolah semakin diperlukan. Pengecekan tersebut bertujuan agar data yang akan diolah bebas dari
noise atau data kotor. Data kotor yang dimaksud adalah data yang nilainya menunjukkan nilai yang
tidak wajar dibandingkan data yang lainnya.

Penjaminan kualitas data adalah suatu kegiatan untuk mengecek kondisi data dari segi akurasi, kon-
sistensi, kelengkapan, kejelasan, dan anomali. Dengan memperhatikan aspek-aspek tersebut, sebuah
data bisa dikatakan bagus/baik apabila semua aspek yang ada terpenuhi.

II. Mekanisme Penjaminan Kualitas

Sejak diluncurkan tahun 2004 oleh Steve Coast, OSM telah menjadi alternatif bahkan pilihan utama bagi
masyarakat untuk melengkapi data spasial di wilayah yang mereka inginkan. Kemudahan, kelengkapan,
serta fleksibilitas dari OSM memungkinkan data yang ada di OSM seringkali digunakan kembali untuk
berbagai macam keperluan seperti bisnis, teknologi, sosial, bahkan untuk kegiatan kemanusiaan dan
kebencanaan. Hal tersebut menyebabkan meningkatnya jumlah data yang ada di OSM dan pastinya
akan mempengaruhi kualitas data itu sendiri. Dengan sifatnya yang gratis dan terbuka, menjaga kualitas
data OSM merupakan hal yang sangat penting agar nantinya pemanfaatan data OSM untuk berbagai ke-
butuhan khususnya yang menyangkut kepentingan masyarakat seperti kemanusiaan dan kebencanaan
dapat dilakukan secara berkualitas.

Menurut buku “Assuring the quality of volunteered geographic information” yang ditulis oleh Goodchild
dan Li (2012), penjaminan kualitas data dalam kegiatan pemetaan partisipatif secara garis besar dapat
dilakukan dengan 3 mekanisme, yaitu :

1. Penjaminan Partisipatif

Ditambahkan oleh Surowiecki dalam bukunya yang berjudul “The Wisdom of Crowds” (2004)
mekanisme penjaminan kualitas data secara partisipatif memiliki beberapa ciri dan kelebihan
seperti:

• Beberapa pengguna dapat menghasilkan suatu kesepakatan bersama atas suatu kesalahan
data yang ditemukan. Hal ini biasanya terjadi seperti kesalahan informasi ataupun jenis-jenis
dari objek yang dipetakan di suatu wilayah. Para pengguna yang memetakan wilayah terse-
but dapat menghasilkan kesepakatan bersama sehingga tidak ada lagi kesalahan informasi
terhadap objek-objek yang akan dipetakan.
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• Beberapa pengamatan dan pengalaman dari suatu individu dapat memperkuat validitas
pengamatan dan pengalaman individu yang lain sehingga dapat mengurangi risiko kesalahan
pemahaman terhadap suatu objek tertentu.

• Secara bersama-sama dapat melakukan validasi dan pengecekan kualitas data dan ke-
salahan di wilayah tertentu sehingga dapat menghemat waktu, tenaga dan biaya dalam
melakukan kegiatan penjaminan kualitas data.

Contoh penjaminan kualitas secara partisipatif ini pernah dilakukan oleh Humanitarian Open-
StreetMap Team bekerja sama dengan Resilience Network Initiative (RNI) memetakan Kelurahan
Purwodinatan, Kecamatan Semarang Tengah, Kota Semarang. Kegiatan ini melibatkan elemen
masyarakat dan dibantu oleh mahasiswa lokal serta panitia sekitar dalam melakukan pemetaan
hingga menginput data-data yang dipetakan ke dalam OpenStreetMap.

2. Penjaminan Sosial

Sedikit berbeda namun tetap berkaitan dengan mekanisme penjaminan kualitas secara partisipatif,
penjaminan kualitas secara sosial lebih mengedepankan kualitas individu untuk melakukannya.
Semakin sering seseorang melakukan validasi dan memperbaiki kesalahan-kesalahan yang ada
pada data, maka dia akan semakin dipercaya untuk bisa melakukan penjaminan kualitas data.
Dengan demikian, seseorang yang memiliki reputasi yang baik akan dipercaya untuk memimpin
yang lain untuk melakukan kegiatan penjaminan kualitas di dalam suatu kegiatan atau proyek.
Selain itu, penjaminan kualitas sosial dapat dilakukan dengan membentuk suatu working group
yang menjadi sebuah media untuk memberitahukan serta memperbaharui kegiatan-kegiatan yang
terkait penjaminan kualitas data. Hal ini dapat mempercepat kegiatan penjaminan kualitas data
dan mengefektifkan komunikasi sesama anggota.

Salah satu contoh kegiatan penjaminan kualitas sosial ini seperti yang telah dilakukan oleh Open-
StreetMap Foundation dimana mereka membuat beberapa kelompok diskusi (working group) yang
tiap kelompok memiliki tema diskusi yang berbeda-beda. Untuk kualitas data OpenStreetMap
dibahas dalam kelompok diskusi data (Data Working Group) dimana dalam kelompok tersebut
dibahas berbagai hal terkait data yang ada di OpenStreetMap seperti lisensi data, vandalisme
data, perselisihan tentang data, serta membantu dalam menentukan kebijakan pemakaian ter-
hadap data OpenStreetMap. Kelompok diskusi data ini terdiri dari anggota OpenStreetMap foun-
dation yang merupakan donor OpenStreetMap dan juga beberapa pengguna yang direkomen-
dasikan oleh anggota yang berada di OpenStreetMap foundation itu sendiri. Untuk melihat tu-
gas dan kegiatan Data Working Group silahkan mengunjungi halaman wiki untuk Data Working
Group1 dan jika Anda ingin bergabung untuk berdiskusi dapat menghubungi anggota mereka di
data@osmfoundation.org.

3. Penjaminan Geografi

Mekanisme penjaminan kualitas data yang terakhir adalah secara geografi. Mekanisme
ini menggunakan pendekatan teori geografi. Tidak semua pengguna dapat dan boleh untuk
melakukan penjaminan kualitas menggunakan mekanisme geografi. Hanya mereka yang sudah
benar-benar memahami teori geografi yang terkait dengan analisa data spasial seperti Spatial
neighbors and auto-correlation (Moran Statistics), Inferential Statistics and Analysis of Variance
(ANOVA), dan lain-lain. Oleh karena itu mekanisme ini masih jarang digunakan dalam kegiatan
pemetaan partisipatif khususnya di OpenStreetMap. Untuk contoh dokumentasi kualitas data
OpenStreetMap berdasarkan pendekatan geografi di Indonesia telah dibuat oleh Departemen
Teknik Geodesi dan Geomatik, Fakultas Teknik, Universitas Gadjah Mada pada tahun 2012,
Dokumentasi ini mengambil sampel data OpenStreetMap di beberapa kota seperti Jakarta,
Surabaya, Bandung, Yogyakarta, Padang, dan Dompu. Kota-kota tersebut pernah diseleng-
garakan kegiatan pemetaan _OpenStreetMap _dari tahun 2011 hingga 2012 mulai dari kegiatan
pemetaan sosial di Provinsi Nusa Tenggara Barat khususnya Dompu yang diselenggarakan
oleh ACCESS dan Humanitarian OpenStreetMap Team (HOT) hingga Scenario Develop-
ment for Contingency Planning(SD4CP) yang dilakukan oleh Humanitarian OpenStreetMap
Team (HOT) dengan Australia Indonesia for Disaster Reduction (AIFDR) dan Badan Nasional
Penanggulangan Bencana (BNPB). Dokumentasi kualitas data tersebut dapat Anda unduh di:
http://openstreetmap.id/docs/Final_Report-OSM_Evaluation_in_Indonesia_2012.pdf.

1https://www.markdownguide.org/basic-syntax

7

mailto:data@osmfoundation.org
http://openstreetmap.id/docs/Final_Report-OSM_Evaluation_in_Indonesia_2012.pdf


III. Penjaminan Kualitas Data di OpenStreetMap

Mekanisme penjaminan kualitas data yang telah dijelaskan dapat diaplikasikan ke dalam penjaminan
kualitas data OpenStreetMap. Perlu diketahui bahwa kegiatan penjaminan kualitas di OpenStreetMap
menjadi tanggung jawab seluruh pengguna. Oleh karena itu, OpenStreetMap telah memiliki beber-
apa petunjuk teknis dalam melakukan kegiatan tersebut dengan menggunakan ketiga mekanisme yang
telah dijelaskan. Terdapat 2 jenis alat yang digunakan dalam melakukan penjaminan kualitas data di
OpenStreetMap, yaitu:

• Alat Pemantau Data OpenStreetMap
• Alat Pendeteksi Kesalahan OpenStreetMap

Alat pemantau data adalah alat yang dapat digunakan untuk melihat kualitas data OpenStreetMap
yang telah Anda buat ataupun data OpenStreetMap yang ada di sekitar wilayah kegiatan pemetaan
yang Anda lakukan. Alat pendeteksi kesalahan akan membantu dalammenunjukkan kesalahan yang
terdapat pada data OpenStreetMap,sehingga akan mempermudah dalam menemukan kesalahan data
dibandingkan harus mencari satu persatu secara manual. Beberapa alat tersebut dibuat oleh para
pengguna yang mengembangkan OpenStreetMap sesuai dengan kebutuhan mereka. Anda juga akan
mempelajari beberapa kesalahan pada data OpenStreetMap dan alat-alat terkait dengan penjaminan
kualitas data di OpenStreetMap.

RINGKASAN

Saat ini Anda tentunya sudah memahami apa itu penjaminan kualitas data, mekanisme penjaminan
kualitas data, dan penjaminan kualitas data di OpenStreetMap. Dengan adanya penjaminan kualitas
data di OpenStreetMap, kualitas data di OpenStreetMap dapat terus terjaga dan tentunya hasil data
OpenStreetMap dapat digunakan oleh semua orang.
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Membuat dan Mengelola Map Campaigner untuk Pemetaan

Tujuan pembelajaran:

• Mengetahui dan memahami cara kerja Map Campaigner
• Mengoperasikan Map Campaigner untuk membuat kegiatan pemetaan
• Mengoperasikan Map Campaigner untuk memantau kegiatan pemetaan

Dalam melaksanakan proyek pemetaan seringkali Anda membutuhkan sebuah laporan terkait progres
kegiatan tersebut dalam sebuah data statistik mengenai seberapa banyak objek yang telah terpetakan
dalam kegiatan tersebut. Terdapat beberapa alat yang bisa digunakan untuk mendapatkan data statistik
tersebut. Salah satu alat yang akan kita pelajari saat ini adalah Map Campaigner.

I. Apa itu Map Campaigner?

Map Campaigner merupakan sebuah alat yang ditujukan untuk mengumpulkan semua manajer proyek
dan juga surveyor ke dalam satu platform. Manajer proyek bisa mengatur kegiatan dengan tipe yang
spesifik sesuai dengan kebutuhan mereka. Setiap kegiatan pemetaan yang dibuat oleh manajer proyek
bisa diatur secara spesifik terkait data dan objek yang dikumpulkan kemudian akan disajikan dalam
setiap proyek pemetaan.

II. Manfaat dan contoh penggunaan Map Campaigner

Map Campaigner bertujuan memudahkan para manajer proyek dalam memantau proyek pemetaan
mereka. Sebagai contoh disini adalah kegiatan pemetaan yang dilakukan oleh tim HOT untuk
memetakan semua tempat ibadah, sekolah, universitas dan sekolah tinggi yang ada di Jakarta Pusat.
Dengan menggunakan Map Campaigner, Anda bisa melihat berapa banyak total objek yang sudah
terpetakan dalam kegiatan proyek ini, kemudian berapa banyak pengguna OpenStreetMap yang
membantu untuk turut serta dalam proyek pemetaan ini, baik secara sukarela maupun yang tergabung
ke dalam tim proyek pemetaan.

Contoh penggunaan Map Campaigner untuk Jakarta Pusat
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Dengan menggunakan Map Campaigner, Anda juga bisa mengetahui berapa banyak objek yang sudah
lengkap secara definisi tags atau atribut yang dibutuhkan. Misalkan pada gambar di atas, terlihat bahwa
dari kegiatan proyek pemetaan ini berhasil memperoleh 1.705 objek dengan menjangkau pengguna
sebanyak 157 pengguna (baik yang secara sukarela maupun termasuk tim surveyor). Map Campaigner
juga memberikan informasi mengenai kelengkapan semua data yang dikumpulkan, misalnya dari 486
objek sekolah yang terpetakan, hanya 36,2% dari objek sekolah tersebut yang lengkap terpetakan dari
segi atribut informasi yang dibutuhkan untuk proyek pemetaan ini.

Map Campaigner juga menyajikan fitur penjaminan kualitas dari segi kelengkapan atribut suatu objek
di OSM. Dengan Map Campaigner Anda bisa melihat berapa banyak objek yang masih belum lengkap
dari segi atribut data yang sudah ditentukan sebelumnya. Anda bisa mengunduh semua objek tersebut
dan kita perbaiki dengan menggunakan JOSM.

Contoh pengecekan atribut oleh Map Campaigner

III. Membuat Proyek Pemetaan Baru di Map Campaigner

Sampai saat ini Anda telah mengetahui apa ituMap Campaigner dan apa saja manfaat dan contohMap
Campaigner. Anda mungkin akan menggunakanMapCampaigner untuk proyek pemetaan Anda sendiri.
Agar dapat membuat project baru, Anda harus login terlebih dahulu dengan akun OpenStreetMap Anda.
Setelah Anda berhasil login dengan akun Anda, selanjutnya Anda perlu mengklik tombol Create Cam-
paign. Berikutnya terdapat beberapa tahapan setelah Anda berhasil login dengan akunOpenStreetMap
Anda. Setelah mengklik tombolCreate Campaign, Anda akan diarahkan ke halaman pembuatan proyek
campaign baru. Pada halaman ini terdapat dua tahapan: mengatur informasi dasar danmengatur area
kerja.

a. Mengatur Informasi Dasar untuk Proyek Campaign Anda

Pada bagian ini, Anda akan mengisi informasi dasar untuk proyek Anda. Anda harus mengisi beberapa
informasi pada halaman ini:
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• Nama proyek. Pada bagian ini, Anda cukup mengisikan nama proyek yang sedang Anda lakukan.
• Durasi proyek berlangsung. Pada bagian ini, Anda akan mengatur durasi proyek berlangsung.

Anda bisa memberikan tanggal yang telah lampau apabila proyek pemetaan yang Anda lakukan
adalah proyek pemetaan yang sudah selesai.

• Deskripsi proyek. Pada bagian ini, Anda akan mengisikan mengenai deskripsi kegiatan proyek.
• Atribut/tags yang dibutuhkan. Pada bagian ini Anda akan memberikan atribut OpenStreetMap

yang dibutuhkan selama proyek pemetaan berlangsung. Untuk atribut OpenStreetMap yang
dibutuhkan, Anda bisa mengacu pada halaman Wikipedia2 atau pada modul Model Data Open-
StreetMap. Format pengisian pada halaman ini Anda bisa memilih menggunakan struktur data
YAML (yang sudah Anda pelajari pada modul Penggunaan YAML pada HOT Export) atau
dengan versi mudah yang sudah disediakan pada situs ini.

Tampilan saat memasukkan atribut OSM untuk Map Campaigner

Catatan:

Saat memasukkan tag/atribut dalam format YAML. Ada beberapa hal yang harus diperhatikan:

- Penggunaan spasi sangat sensitif disini.

- Satu elemen terdiri dari elemen utama dan elemen pendukung

- Semua elemen dibawah elemen utama (elemen pendukung) harus berada beberapa spasi dibandingkan elemen utama

- Isi elemen pendukung = feature, tags, & element_type

- feature merupakan kategori yang ada di OSM. Untuk lebih jelasnya bisa melihat wikipedia OSM

- Agar lebih spesifik, Anda bisa menggunakan set key & value seperti misalnya building=school atau amenity=hospital

2https://www.markdownguide.org/basic-syntax
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- tags merupakan kumpulan atribut (key & value) OSM yang akan diperiksa oleh sistem. Harap cek wikipedia atau modul Model Data OpenStreetMap

- element_type merupakan jenis objek OSM yang akan diperiksa. Apakah titik (point), garis (line), atau area (polygon)

• Menambahkan manajer proyek lainnya (opsional). Pada bagian ini Anda bisa menambahkan
akunOSM lainnya sebagai manajer proyek campaign apabila proyek yang Anda kerjakan terdapat
lebih dari satu orang manajer proyek. Peran dari manajer proyek ini adalah mereka bisa menam-
bahkan atribut baru untuk dihitung atau mengubah informasi yang ada pada proyek campaign
mereka.

Tampilan pada halaman informasi dasar

b. Mengatur Area Kerja untuk Project Campaign Anda

Setelah Anda berhasil mengatur informasi dasar, langkah berikutnya adalah Anda harus mengatur area
kerja proyek Anda. Pada bagian ini, terdapat dua cara untuk mengatur area kerja proyek Anda.

Cara pertama adalah dengan menggunakan alat yang ada pada bagian sebelah kiri peta. Anda bisa
menggambar kotak ataupun menggambar secara bebas dengan menggunakan alat tersebut. Hal yang
perlu diingat adalah luas area proyek campaign tidak boleh lebih dari 315 km2. Apabila proyek
pemetaan Anda memiliki luas lebih dari yang telah disebutkan, disarankan untuk membagi wilayah
proyek pemetaan tersebut kedalam beberapa bagian agar dapat dibuat di Map Campaigner.

Cara kedua adalah dengan menggunakan data batas administrasi dalam format GeoJSON. Dengan
menggunakan data tersebut, Anda dapat langsung melihat area kerja proyek Anda yang sudah terbagi
menjadi beberapa bagian.

Setelah mengatur area kerja proyek, Anda dapat menetapkan tim mana saja yang bertugas untuk area
proyek yang sudah ditentukan sebelumnya. Pengaturan tim ini sifatnya opsional dan bertujuan untuk
memudahkan memantau perkembangan tim Anda.
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Tampilan pada halaman pengaturan area kerja

IV. Tampilan Halaman Proyek Map Campaigner Anda

Setelah berhasil membuat proyek campaign, Anda bisa langsung menuju halaman utama untuk melihat
proyek. Ketika membuka proyek pemetaan, Anda akan disajikan beberapa informasi mulai dari data
statistik, daftar kesalahan/error, dan grafik pengguna yang turut serta dalam pemetaan.

Tampilan halaman Map Campaigner

1. Feature collected. Bagian ini menjelaskan tentang berapa banyak total objek yang dikumpulkan
pada area kerja.

2. User engaged. Menjelaskan tentang berapa banyak pengguna OSM yang turut serta membantu
memetakan baik secara sukarela maupun tidak.
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3. Area covered. Menjelaskan tentang berapa persen area yang telah lengkap terpetakan.
4. Feature selection. Untuk memilih fitur OSM yang telah ditentukan sebelumnya.
5. Selected attribute. Menjelaskan beberapa atribut OSM yang harus dicek oleh sistem untuk

mengetahui kelengkapan atributnya.
6. Attribute completeness. Menjelaskan tentang berapa persen objek OSM yang telah lengkap

memiliki atribut seperti yang sudah ditentukan pada bagian selected attribute.
7. Feature checked. Menjelaskan tentang jumlah objek OSM yang telah dikumpulkan, spesifik hanya

pada satu fitur saja sesuai dengan bagian feature selection.
8. Graph. Menjelaskan tentang grafik jumlah objek secara rinci

Selain beberapa tampilan di atas, terdapat pula bagian Errors yang menjelaskan tentang daftar objek
yang belum dilengkapi dari segi atribut OSM. Selain itu Anda juga bisa melihat pada bagian User Eng-
gagement mengenai daftar pengguna OSM yang turut serta membantu memetakan daerah tersebut
beserta jumlah kontribusi dari masing-masing pengguna OSM.

V. Memperbaiki Objek OSM yang Belum Lengkap

Dengan menggunakan Map Campaigner, Anda bisa langsung memperbaiki objek OSM yang belum
lengkap dari segi atribut datanya. Untuk memperbaikinya terdapat dua cara.

• Cara yang pertama adalah dengan memperbaiki satu-persatu objek OSM tersebut dengan
memilih id objek pada kolom Name. Dengan cara ini Anda akan diarahkan ke halaman situs
OpenStreetMap dan kemudian Anda bisa langsung mengubahnya dengan menggunakan JOSM
ataupun iD.

• Cara kedua adalah dengan mengklik tombol Download yang ada pada bagian bawah dari daftar
errors. Dengan menggunakan ini, Anda akan mengunduh file .osm untuk dapat dibuka dengan
menggunakan JOSM. Setelah berkas berhasil anda unduh, Anda dapat langsung membukanya
di JOSM untuk langsung melengkapi atributnya.

RINGKASAN

Selamat! Saat ini Anda telah berhasil mempelajari cara menggunakan Map Campaigner untuk keper-
luan proyek pemetaan Anda. Dengan menggunakan Map Campaigner Anda akan lebih mudah menge-
tahui berapa banyak objek yang berhasil terpetakan secara mudah dan melihat mana saja objek OSM
yang belum memiliki kelengkapan atribut yang sesuai dengan proyek Anda.
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Membuat dan Mengelola Tasking Manager

Tujuan Pembelajaran:

• Menjelaskan fungsi dari Tasking Manager dalam Konteks Pemetaan Partisipatif
• Mengoperasikan cara membuat Tasking Manager
• Mengoperasikan cara mengatur Tasking manager yang sudah ada

Anda tentunya sudah mengetahui bagaimana cara menggunakan tasking manager untuk melakukan
kegiatan pemetaan secara bersama-sama. Ketika Anda menggunakan tasking manager yang tidak
sesuai dengan wilayah yang Anda inginkan, maka Anda ingin membuat tasking manager untuk wilayah
Anda sendiri. Pada modul ini, Anda akan mempelajari bagaimana cara membuat tasking manager.
Pembuatan tasking manager membutuhkan orang yang bertanggung jawab atas tasking tersebut, agar
data OSM yang dihasilkan memiliki kualitas data yang baik. Juga hal ini dikarenakan awal dibuatnya
tasking manager untuk keperluan pemetaan sebagai respon kebencanaan di suatu wilayah.

I. Apa itu Tasking Manager

a. Definisi Tasking Manager

Tasking Manager merupakan sebuah alat yang dibuat secara khusus untuk melakukan pemetaan se-
cara kolaboratif dan partisipatif. Tasking Manager memungkinkan Anda untuk melakukan pemetaan
di suatu wilayah secara bersama-sama dengan pengguna OSM yang lain dengan membagi-bagi area
pemetaan di wilayah tersebut. Tujuan Tasking Manager adalah untuk membagi pekerjaan pemetaan ke
dalam beberapa grid /kotak yang berbeda sehingga setiap orang dapat memilih grid/kotak untuk diker-
jakan. Selain itu, Tasking Manager juga dapat memudahkan Anda dalam memantau progres pemetaan
sehingga Anda dapat mengetahui wilayah mana yang masih butuh dipetakan dan wilayah mana yang
sudah selesai dipetakan.

Bayangkan jika Anda ingin melakukan pemetaan pada suatu wilayah tertentu dimana Anda harus
memetakan secara bersama-sama dengan 20 orang lainnya. Jika tidak ada pembagian tugas dan
wilayah, maka akan ada kemungkinan beberapa orang memetakan di wilayah yang sama. Den-
gan adanya Tasking Manager, hal seperti ini dapat dihindari dan pekerjaan pemetaan akan dapat
diselesaikan secara lebih cepat dan efektif.

b. Contoh Penggunaan Tasking Manager

Tasking Manager pernah digunakan sebagai bentuk respon ketika bencana Topan Haiyan terjadi di Fil-
ipina pada 8 November 2013. Pemetaan menggunakan Tasking Manager dilakukan di Kota Tacloban,
salah satu kota yang terdampak sangat parah ketika bencana terjadi. Dalam kurun waktu 24 jam sete-
lah dibuatnya proyek Tasking Manager, sebanyak 10.000 bangunan telah terpetakan atau sekitar 25%
dari total jumlah bangunan yang ada di Kota Tacloban. Seluruh pemetaan ini dilakukan oleh 33 orang
relawan.

“Kondisi bangunan sebelum dan setelah dipetakan dengan Tasking
Manager”

Kondisi bangunan sebelum dan setelah dipetakan dengan Tasking Manager

Di Indonesia, penggunaan Tasking Manager juga digunakan untuk respon ketika bencana terjadi. Salah
satu contohnya adalah ketika bencana gempa dan tsunami terjadi di Selat Sunda pada Desember 2018.
Dalam kurun waktu 1 bulan, seluruh daerah terdampak sudah selesai dipetakan oleh sekitar 60 orang.
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“Tasking Manager yang dibuat sebagai respon ben-
cana di Selat Sunda”

Tasking Manager yang dibuat sebagai respon bencana di Selat Sunda

II. Membuat Proyek Tasking Baru

Untuk dapat membuat tasking baru di tasking manager, Anda harus terlebih dahulu mempunyai akses
sebagai project manager. Apabila Anda belum memiliki akses maka anda harus diatur sebagai manager
proyek agar dapat membuat tasking, Anda bisa mengajukan akses tersebut dengan mengirim e-mail ke
team.id@hotosm.org untuk tasking manager khusus di Indonesia. Setelah Anda berhasil mendapatkan
akses untuk membuat tasking, Anda dapat melihat pada bagian kanan atas dari halaman depan tasking
dan mengklik tombol Create New Project.

“Memulai membuat proyek baru di tasking manager”

Memulai membuat proyek baru di tasking manager

Ada beberapa tahapan yang harus dilakukan dalam membuat tasking:

a. Penentuan Wilayah Kerja

• Step 1: Define Area = mengatur area kerja

Setelah Anda menekan tombol Create New Project, Anda akan diarahkan pada halaman pengat-
uran pertama, yaitu mengatur area proyek pemetaan Anda. Terdapat dua cara dalam mengatur
area proyek pemetaan:

– Draw= dengan menggambar secara bebas area yang Anda inginkan
– Import= dengan menggunakan data spasial yang berformatGeoJSON, KML, OSM atau SHP

yang terkompresi dalam bentuk zip.

Klik Next apabila Anda sudah selesai mengatur area kerja Anda.
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“Pilihan mengatur area kerja”

Pilihan mengatur area kerja

• Step 2: Choose Tasks Step = mengatur tipe pembagian area kerja

Setelah Anda sudah mengatur area kerja, tahapan berikutnya adalah Anda diminta untuk men-
gatur bentuk pembagian area kerja. Terdapat dua tipe pembagian area kerja: kotak (Square Grid)
dan bebas (Arbitary Tasks). Jika memilih bentuk kotak, area kerja Anda akan dibagi menjadi be-
berapa kotak persegi dengan ukuran yang sama. Sementara itu apabila Anda memilih bentuk
bebas. Area kerja Anda akan dibagi menjadi beberapa ukuran acak. Klik Next untuk menuju
tahapan berikutnya.

“Pilihan mengatur tipe pembagian area kerja”

Pilihan mengatur tipe pembagian area kerja

• Step 3: Set Task Sizes = Mengatur besar luasan kotak kerja

Pada tahapan ini, Anda akan mengatur besar luasan kotak kerja. Diasumsikan bahwa pada taha-
pan sebelumnya Anda memilih pembagian area kerja dalam bentuk kotak dan pada tahapan ini
Anda akan menentukan jumlah kotak yang ada di dalam area yang Anda tentukan. Semakin besar
ukuran kotak kerja, maka jumlah pembagi kotak kerja akan lebih sedikit. Namun hal tersebut juga
berarti para relawan pemetaan yang ikut memetakan area Anda bisa jadi mendapatkan pembagian
luas wilayah yang sangat besar dan begitu juga sebaliknya.
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“Deskripsi alat-alat pada tahapan pengaturan kotak kerja”

Deskripsi alat-alat pada tahapan pengaturan kotak kerja

Catatan: Sedikit tips dalam menentukan luasan kotak kerja, Anda tentunya menginginkan
membuat kotak kerja yang tidak terlalu besar dan tidak terlalu kecil. Untuk menentukannya
Anda bisa melihatnya melalui kepadatan jaringan jalan yang terlihat pada area pemetaan
Anda, dengan menggunakan citra satelit Bing atau Mapbox. Apabila Anda melihat kotak
yang berisikan daerah padat, Anda bisa membagi kotak tersebut ke dalam beberapa kotak
kecil dengan menggunakan tombol Split (Polygon) atau Split (Point).

• Step 4: Trim Project= Memotong kotak kerja yang tidak dibutuhkan

Setelah Anda mengatur besaran kotak kerja, pada tahapan selanjutnya Anda akan diarahkan
untuk memotong kotak kerja hanya spesifik ke area proyek Anda saja. Dengan menggunakan
fitur ini, Anda bisa menghapus kotak kerja yang berada di luar area kotak kerja dan menyisakan
kotak kerja yang sesuai dengan area batas proyek kerja Anda. Lama tidaknya proses memotong
kotak ini tergantung dari besar luasan proyek kerja Anda.

“Menggunakan trim untuk memotong area kerja”

Menggunakan trim untuk memotong area kerja

• Step 5: Review=Memberikan nama proyek

Tahapan selanjutnya adalah Anda memberikan nama untuk proyek pemetaan Anda. Pada taha-
pan ini sebaiknya Anda memberikan nama yang mudah untuk dicari oleh para pengguna lainnya.
Pada bagian ini juga terdapat keterangan jumlah grid/kotak yang akan Anda kerjakan, seperti gam-
bar di bawah ini ada 56 grid/kotak. Klik Create untuk membuat proyek tasking manager Anda.
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“Tahapan akhir sebelum proyek dibuat”

Tahapan akhir sebelum proyek dibuat

b. Pengaturan Deskripsi Proyek

Setelah selesai membuat proyek, Anda akan diarahkan ke pengaturan tambahan dimana Anda akan
memasukkan deskripsi proyek, instruksi, area prioritas, dsb. Anda harus memasukkan deskripsi proyek
dan instruksi data yang dipetakan, sementara yang lainnya adalah opsional.

• Description= Memberikan deskripsi proyek

Ada beberapa hal yang Anda lakukan pada bagian ini.

1. Anda akan mengatur status proyek tasking Anda (Draft, Published, Archived). Status Draft
merupakan pengaturan bawaan saat pertama kali proyek berhasil dibuat. Apabila sebuah
proyek taskingmasih berstatus draft, para relawan pemetaan tidak akan dapat ikut membantu
memetakan proyek tasking Anda. Status Published berarti proyek tasking Anda sudah dipub-
likasikan sehingga orang lain dapat melihat dan ikut membantu memetakan tasking Anda.
Status Archived berarti proyek tasking Anda sudah diarsipkan karena sudah selesai atau
ada proyek tasking baru dengan area yang sama. Pilih Published agar para sukarelawan
dan tim Anda bisa melihat tasking Anda.

2. Anda akan mengatur prioritas tasking Anda. Pada tasking manager, Anda akan diberikan
tiga pilihan prioritas yaitu mendesak, tinggi, sedang, dan rendah dimana masing-masing
tingkat memiliki arti yang berbeda-beda. Anda bisa mengatur tasking Anda ke dalam tingkat
mendesak/urgent apabila proyek tasking yang dibuat oleh Anda bertujuan untuk segera
dipetakan seperti pemetaan respon saat bencana terjadi sehingga proyek tasking Anda akan
ditampilkan pada urutan teratas di daftar tasking. Atur prioritas ke tingkat tinggi/high apabila
kegiatan pemetaan Anda merupakan kegiatan pemetaan untuk respon kebencanaan namun
bencana tersebut telah melewati fase tanggap darurat. Atur prioritas ke sedang/medium apa-
bila proyek pemetaan Anda tidak terlalu mendesak untuk dipetakan namun termasuk kedalam
lingkup pemetaan untuk kebencanaan. Atur prioritas ke rendah/low apabila kegiatan proyek
tasking Anda tidak mendesak dan bukan merupakan kegiatan untuk pemetaan kebencanaan.

3. Anda akan mengatur ringkasan (Short description) dan deskripsi dari tasking manager Anda.
Dalam memberikan ringkasan (short description) dan deskripsi untuk tasking Anda, terdapat
pilihan bahasa dari bahasa Inggris (EN) dan Indonesia (ID). Pilihan bahasa tersebut akan
muncul saat pengguna mengubah bahasa situs tasking manager ke bahasa yang mereka
inginkan. Apabila Anda ingin memasukkan bahasa Indonesia saja, pilih ID sebagai pilihan
bahasa dan kemudian isi deskripsi singkat dan deskripsinya dalam format markdown. Mark-
down merupakan format yang sama dengan format html dengan penulisan yang lebih seder-
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hana. Untuk panduan penulisan dengan format markdown, Anda bisa melihatnya di situs
Markdown Guide3.

“Penjelasan untuk Bagian Deskripsi Proyek Pemetaan Anda”

Penjelasan untuk Bagian Deskripsi Proyek Pemetaan Anda

• Instructions= Memberikan instruksi pemetaan

Pada bagian ini Anda akan memberikan informasi mengenai objek apa saja yang harus dipetakan
pada Tasking Manager yang telah Anda buat.

1. Pada bagian Entitles to map Anda bisa menjabarkan obyek apa saja yang Anda butuhkan
dari proyek tasking ini. Misalnya Anda membutuhkan data jaringan jalan, bangunan dan
sungai. Maka pada bagian ini, Anda bisa menjabarkan tentang obyek-obyek tersebut.

2. Pada bagian Changeset comment Anda bisa mengatur komen changeset bawaan yang
akan muncul otomatis pada saat pengguna akan mengunggah penambahan data mereka
ke OpenStreetMap.

3. Pada bagian Detailed Instruction Anda bisa memasukkan instruksi pemetaan secara de-
tail. Penjelasan ini sangat membantu relawan yang ingin berkontribusi dalam proyek tasking
Anda tetapi belum memiliki pengalaman pemetaan baik di Tasking Manager maupun di Open-

3https://www.markdownguide.org/basic-syntax
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StreetMap. Anda bisa memberikan instruksi yang sedetail mungkin pada bagian ini.

“Tampilan pada bagian instruksi”

Tampilan pada bagian instruksi

• Metadata= Mengeset metadata proyek (opsional)
1. Mapper Level. Pada bagian ini, Anda bisa mengatur tingkat kesulitan proyek pemetaan

dan mengaturnya berdasarkan persepsi Anda sendiri. Sebagai contoh apabila daerah yang
dipetakan merupakan daerah pemukiman padat penduduk dengan kondisi citra satelit yang
tidak terlalu baik dan kebutuhan data yang dipetakan adalah data bangunan umum, Anda bisa
mengatur tingkat kesulitan untuk memetakan daerah tersebut termasuk tinggi atau sedang.

2. Type(s) of Mapping. Anda bisa mengidentifikasi obyek yang akan dipetakan pada proyek
tasking Anda dengan memberikan centang pada daftar obyek yang ada di bagian Type(s) of
Mapping.

3. Organization Tag. Pada bagian ini Anda bisa memberikan tag organisasi Anda untuk memu-
dahkan pencarian proyek tasking pada kolom pencarian.

4. Campaign Tag. Sama seperti organization tag pada bagian ini Anda bisa menambahkan tag
yang sesuai dengan proyek pemetaan Anda agar memudahkan pencarian.
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“Tampilan halaman metadata”

Tampilan halaman metadata

• Priority Areas = Mengatur area prioritas (opsional) Pada menu ini Anda bisa menggambar area
prioritas untuk proyek _tasking _Anda dengan beberapa cara:

1. Menggambar area dengan menggunakan tombol DRAW POLYGON
2. Menggambar area berbentuk kotak dengan menggunakan tombol DRAW RECTANGLE
3. Menggambar lingkaran dengan menggunakan tombol DRAW CIRCLE
4. Mengubah area prioritas yang sudah digambar dengan menggunakan tombol EDIT
5. Menghapus area prioritas dengan menggunakan tombol DELETE, dan
6. Menghapus semua area prioritas dengan menggunakan tombol CLEAR ALL

“Tampilan halaman Priority Areas”

Tampilan halaman Priority Areas
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• Imagery = Memberikan citra satelit tambahan (opsional) Apabila Anda mempunyai citra satelit tam-
bahan dalam format TMS (Tile Map Service). Anda bisa memasukkan url nya di bagian ini. Selain
itu Anda juga perlu mengatur lisensi dari citra satelit yang anda gunakan. Anda harus memas-
tikan citra satelit yang Anda gunakan mempunyai lisensi yang dapat digunakan untuk pemetaan
di OpenStreetMap.

“Tampilan halaman Imagery”

Tampilan halaman Imagery

• Permissions = Mengatur tingkat izin proyek (opsional) Pada bagian ini Anda bisa mengatur task-
ing proyek Anda hanya dapat diakses oleh pengguna dengan tingkat skill mulai dari tingkat pemula
sampai mahir. Dengan mengaktifkan fitur Mapper Level, proyek tasking Anda hanya bisa diker-
jakan oleh pengguna dengan tingkat yang telah Anda tentukan.

Apabila Anda mengaktifkan Validator Level maka pengguna yang bisa mengakses tasking Anda
untuk melakukan validasi data adalah pengguna dengan tingkat level validator.

Apabila Anda mengaktifkan Private Project maka tasking Anda hanya akan bisa diakses oleh
pengguna yang namanya (user OSM) sudah Anda tentukan sebelumnya. Orang lain diluar nama
yang telah diatur tidak dapat melihat tasking yang dibuat oleh Anda.

“Tampilan halaman Permissions”

Tampilan halaman Permissions
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Setelah selesai dengan pengaturan tambahan. Anda bisa menyimpan proyek tasking Anda dengan
mengklik tombol SAVE CHANGES yang ada pada bagian bawah.

“Klik tombol untuk
menyimpan proyek tasking yang sudah diubah”

Klik tombol untuk menyimpan proyek tasking yang sudah diubah

III. Pengelolaan Proyek Tasking

a. Mengubah Instruksi dan Deskripsi

Jika Anda ingin menambahkan beberapa kalimat instruksi baru atau ingin mengubah deskripsi proyek
Anda seiring dengan berjalannya waktu pemetaan di tasking Anda, Anda bisa memilih tombol Edit
Project pada halaman tasking tersebut . Setelah itu Anda bisa langsung merubah deskripsi dan in-
struksi untuk tasking Anda.

“Klik tombol EDIT PROJECT untuk mengubah deskripsi proyek tasking Anda”

Klik tombol EDIT PROJECT untuk mengubah deskripsi proyek tasking Anda

b. Validasi Hasil Kerja

Seiring dengan berjalannya proyek tasking Anda dan bertambahnya data di daerah yang sedang Anda
kerjakan, beberapa relawan mungkin ada yang belum mahir melakukan digitasi dengan OSM sehingga
Anda membutuhkan kegiatan validasi untuk memperbaiki data. Untuk lebih jelasnya, Anda bisa mem-
baca modul Penjaminan Kualitas Data dengan Tasking Manager. Silahkan klik tombol Validate untuk
beralih ke halaman validasi untuk proyek tasking Anda.
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“Halaman validasi pada tasking manager”

Halaman validasi pada tasking manager

Terdapat 5 opsi pada halaman validasi hasil di tasking manager:

• Memilih sendiri kotak pada peta. Dengan cara ini Anda tinggal memilih kotak yang tersedia pada
peta untuk memulai validasi.

• Memilih kotak secara acak. Dengan cara ini Anda akan dibantu untuk memilih kotak oleh tasking
manager.

• Memilih kotak dengan menggambar polygon. Dengan menggunakan fitur ini. Anda bisa memilih
beberapa kotak untuk divalidasi dengan menggambar sebuah polygon atau area.

• Memilih kotak yang sudah terkunci sebelumnya. Apabila Anda sudah mendapatkan kotak untuk
divalidasi tetapi tidak ingat telah memilih kotak tersebut, Anda bisa menggunakan fitur ini. Dengan
mengklik tombol ini, Anda akan diarahkan ke kotak yang telah dipilih sebelumnya.

• Memilih sesuai dengan nama pengguna. Anda juga dapat melakukan validasi pada sebuah kotak
dengan memilih berdasarkan nama pengguna yang ikut serta untuk memetakan di proyek tasking
Anda.

c. Mengubah Area Prioritas

Anda bisa menentukan area prioritas untuk dipetakan terlebih dahulu. Caranya adalah dengan mengk-
lik Edit Project terlebih dahulu dan setelah itu Anda menuju ke menu Priority areas. Silahkan ubah
dan tambahkan area prioritas Anda dengan menggunakan cara yang sudah dijelaskan pada bagian
sebelumnya.
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d. Beberapa Fitur Aksi di Tasking Manager

Pada menu pengelolaan tasking manager Anda, terdapat beberapa tombol aksi:

• Mengirim pesan ke para kontributor proyek tasking Anda. Dengan menggunakan tombolMessage
All Contributors Anda bisa mengirim pesan yang akan terbaca oleh semua kontributor proyek
tasking Anda. Hal ini tentunya sangat berguna apabila terdapat perubahan pada obyek yang
dipetakan atau perubahan area prioritas.

• Mengatur semua tasking secara serentak. Terdapat alat yang bisa Anda gunakan untuk mengatur
semua tasking secara serentak.
– Map All Tasks digunakan untuk menandakan bahwa semua kotak pada tasking Anda sudah

terpetakan semua.
– Invalidate All Tasks digunakan untuk membatalkan semua kotak yang sudah tervalidasi
– Validate All Tasks digunakan untuk mengesahkan semua kotak yang sudah terpetakan
– Reset All Bad Imagery Tasks digunakan untuk mengatur ulang semua kotak yang memiliki

keterangan bahwa citra satelit pada kotak tersebut tidak bisa digunakan.
• Menghapus proyek tasking. Dengan menggunakan tombol Delete Project Anda bisa langsung

menghapus proyek tasking Anda dengan catatan bahwa belum ada kontributor yang berpartisipasi
dalam tasking Anda

• Mengatur ulang proyek tasking. Dengan tombol Reset Tasks Anda akan mengatur ulang tasking
Anda tetapi masih dapat menyimpan histori kontributor yang ikut turut serta memetakan proyek
tasking Anda.

• Menduplikasi tasking. Dengan tombol Clone Project Anda bisa menduplikasi tasking Anda dan
membuat tasking baru dengan deskripsi dan area kerja yang sama seperti tasking sebelumnya.
Hal yang berbeda adalah proyek tasking hasil duplikasi Anda akan dalam status Draft dan untuk
bagian area yang ingin dipetakan, jumlah kotak dan area prioritas tidak akan terduplikasi sehingga
Anda harus melakukan pengaturan lebih lanjut.
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“Tampilan fitur-fitur yang terdapat pada halaman Action”

Tampilan fitur-fitur yang terdapat pada halaman Action

e. Mengarsip Proyek Tasking

Apabila proyek tasking sudah selesai, Anda disarankan untuk mengarsipkan proyek tasking yang telah
Anda buat. Hal ini bertujuan untuk menghindari kontributor untuk melakukan pemetaan pada proyek
tasking tersebut. Untuk mengarsip proyek tasking , klik Edit Project dan pilih menu Description. Pada
menu status, ubah dari Published ke Archived. Klik Save Changes untuk menyimpan perubahannya.
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“Mengubah status proyek dari Published ke Archived”

Mengubah status proyek dari Published ke Archived

RINGKASAN

Selamat! Saat ini Anda telah berhasil mempelajari cara membuat dan mengelola proyek pada tasking
manager. Dengan menggunakan tasking manager, proyek pemetaan Anda akan menjadi lebih teratur.
Hal yang harus diperhatikan, ketika Anda membuat taskingmanager, proyek tersebut harus diselesaikan
dan diperhatikan tidak hanya kuantitas data tetapi juga kualitas data.
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 — title: Download Data OSM dengan Menggunakan Export Tool weight: 1 —

Tujuan Pembelajaran

• Memahami pengertian Export Tool
• Mempraktikkan cara mendapatkan data OSM dengan Export Tool

Setelah Anda belajar bagaimana menambahkan dan mengedit data pada OpenStreetMap (OSM),
sekarang Anda akan mempelajari tentang bagaimana cara mendapatkan data OpenStreetMap yang
telah di-upload ke server OSM. Data tersebut dapat digunakan untuk analisis data, kustomisasi
simbologi data, membuat peta, dan lainnya sesuai kebutuhan Anda.

I. Pengertian Export Tool

Export tool adalah sebuah layanan terbuka yang digunakan untuk men-download data OSM terbaru
yang memberikan kebebasan bagi pengguna untuk memilih data yang akan mereka download di area
tertentu. Export tool juga menyediakan pilihan format data spasial, seperti ESRI shapefiles (.shapefile),
google KML (.kml), GeoPackage (.gpkg) dan MBTiles (.mbtiles). Anda dapat memilih wilayah yang
diinginkan dan kategori data yang akan di-download dengan menggunakan Export Tool. Cara men-
download data pada situs ini sangat mudah dan tidak ada persyaratan, hanya Anda diwajibkan untuk
mendaftar dengan menggunakan akun OpenStreetMap Anda dan mencantumkan sumber data untuk
lisensi kredit pada produk yang Anda buat seperti © OpenStreetMap contributors.

II. Cara Menggunakan Export Tool

• Buka halaman situs Anda, dan ketikkan link berikut ini https://export.hotosm.org

Halaman muka Export Tool

• Anda harus masuk menggunakan akun OSM dengan klik Login di sudut kanan atas. Apabila
muncul ‘Authorize access to your account’ klik Grant Access. Jika belum memiliki akun OSM,
Anda dapat membuka pada modul Memulai Menggunakan OSM.

• Sekarang Anda sudah berhasil masuk dengan menggunakan akun OSM, kemudian klik Start
Exporting untuk memulai proses download data OSM.

• Akan muncul formulir isian dan peta seperti gambar di bawah ini, formulir isian harus diisi dan
Anda dapat memilih area yang diinginkan pada peta di sebelah kanan.
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Lembar kerja Export Tool

• Ada beberapa cara untuk menggambarkan area yang akan dipilih

Box = Menggambar area dengan menggunakan kotak. Jika Anda ingin mengulang untuk pembuatan
kotak klik tanda X pada kolom Box.

Penentuan area dengan kotak

Draw = Menggambar area yang dipilih secara manual
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Penentuan Area dengan Bentuk Manual

Import = Menggunakan poligon dalam format .geojson untuk memilih area yang akan di-download. Cara
mendapatkan file .geojson dapat Anda lihat pada modul Menggunakan GeoJSON.

Penentuan area dengan berdasarkan admin
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• Jika sudah menyelesaikan formulir isian dan menentukan area yang akan di download, pilih menu
Format. Pilih data spasial yang Anda inginkan, misalnya shapefile

Format data spasial

• Selanjutnya klik Menu Data, pada bagian ini halaman yang akan muncul akan menyesuaikan
pemilihan tipe data spasial yang Anda pilih sebelumnya pada Menu Format. Pada bagian Tag
Tree, menunjukkan informasi objek yang sesuai dengan presets OSM secara global. Anda harus
memberikan tanda centang untuk data OSM yang akan di-download sesuai dengan kebutuhan
data yang diinginkan. Sebagai contoh, jika kita akan men-download data bangunan dan jalan,
berikan tanda centang pada Buildings dan Transportation > Roads
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Pilihan Objek di Export Tool

• Klik MenuSummary, Anda harus memilih apakah file ekspor ini akan dipublikasikan kepada umum
atau hanya ada pada akun Anda. Kemudian klik Create Export untuk memulai proses export data
OSM.

Menu Summary

• Tunggu beberapa saat sampai proses selesai. Jika file export Anda telah selesai, Export Tool akan
memberikan pemberitahuan melalui email, atau Anda dapat melihat hasilnya di Menu Exports
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Menu Exports

• Jika proses sudah selesai akan muncul kotak dialog seperti di bawah ini, klik nama file.shp.zip
untuk menyimpan hasil ekspor data OSM di direktori laptop/komputer Anda.

Proses Export Tool Selesai

RINGKASAN

Anda telah mengetahui bagaimana cara men-download data OSM dengan menggunakan Export Tool.
Data yang telah Anda download dapat diolah dengan perangkat lunak sistem informasi geografis yang
salah satu contohnya perangkat lunak yang Open Source yaitu QGIS (www.qgis.org). Anda dapat me-
manfaatkan data tersebut untuk perhitungan kuantitas data OSM hasil dari pemetaan untuk membuat
analisis data OSM.
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 — title: Metodologi Perencanaan Proyek Pemetaan dengan OpenStreetMap weight: 1 —

Tujuan Pembelajaran:

• Memahami cara membuat kerangka kegiatan pemetaan
• Memahami cara pembagian arsip untuk masing-masing kelompok survei
• Memahami cara pembagian area survei berdasarkan batas administrasi
• Mengetahui cara pembagian kelompok yang efektif

Perencanaan proyek pemetaan memerlukan metodologi survei yang tepat dan efisien untuk mencapai
target dan tujuan pemetaan. Indikator-indikator yang perlu diperhatikan dalam pembuatan metodologi
survei meliputi: luas wilayah survei, jumlah tim pemetaan, jumlah objek yang dikumpulkan, dan pen-
danaan proyek. Jika luas wilayah semakin besar dan jumlah objek yang dikumpulkan semakin banyak,
maka pendanaan proyek juga semakin besar.

Pada proyek pemetaan survei lapang akan dilaksanakan oleh tim pemetaan yang dibagi menjadi 3 (tiga)
peran, yaitu :

• Mapping Supervisor = mengatur dan mengawasi jalannya proyek pemetaan, mempersiapkan
keperluan pemetaan, membuat laporan hasil pemetaan dan memeriksa kualitas dan kuantitas
data yang telah divalidasi oleh Quality Assurance.

• Quality Assurance= menjamin kuantitas dan kualitas data yang dihasilkan oleh data entry dan
mengawasi data entry dalam melakukan survei lapangan.

• Data Entry = melaksanakan survei lapangan dan memasukkan data lapangan ke dalam OSM
beserta digitasi bangunan dan jalan.

I. Pembuatan Kerangka Kerja

Perencanaan pemetaan memerlukan suatu kerangka kerja yang disesuaikan dengan indikator-indikator
pemetaan yang telah disebutkan sebelumnya. Kerangka kerja tersebut dapat dijadikan acuan dalam
pelaksanaan proyek pemetaan yang akan dimonitor oleh Mapping Supervisor dan Quality Assurance.
Kerangka kerja secara garis besar terdiri dari:

• Persiapan proyek pemetaan
• Penentuan jumlah tim data entry dan tim quality assurance
• Pelaksanaan pelatihan OSM untuk tim pemetaan
• Proses pemetaan dan kegiatan mapathon
• Pelaksanaan pelatihan QGIS untuk tim pemetaan
• Pembuatan peta akhir

Sebagai contoh, dibawah ini merupakan kerangka kerja yang disusun untuk pemetaan di Kota Se-
marang tahun 2018 yang memiliki luas wilayah 373,8 km2 dengan jumlah data entry 16 orang dan
jumlah quality assurance 4 orang. Infrastruktur yang dikumpulkan berjumlah 58 kategori objek meliputi
jaringan jalan, sungai, tanggul dan fasilitas umum. Semua tahapan-tahapan pemetaan dilakukan se-
lama 6 bulan.

Kerangka kerja pemetaan

35



a. Pelatihan OpenStreetMap dan QGIS untuk tim Pemetaan Pelatihan ini dilakukan untuk mem-
berikan pemahaman terhadap metode pemetaan, penggunaan alat-alat survei lapangan, dan pem-
buatan peta cetak hasil survei lapang. Berikut ini pelatihan yang dapat Anda persiapkan sebelum
pemetaan berlangsung :

• Pelatihan OpenStreetMap untuk Data Entry dan Quality Assurance

Pelatihan dilakukan selama 3 hari, bertujuan untuk menggunakan alat-alat survei lapangan dan mema-
sukkan hasil data survei ke dalam OpenStreetMap. Materi pelatihan yang diberikan, sebagai berikut:

1. Memulai OpenStreetMap
2. Pengoperasian JOSM
3. Penggunaan Alat-Alat Survei (OpenMapKit, ODK Collect, OSMTracker, dan GPS)
4. Praktik Survei Lapang
5. Penggunaan Tasking Manager
6. Memasukkan Hasil Survei ke dalam OSM dengan menggunakan JOSM
7. Download Data OSM dengan Export Tool

• Pelatihan Validasi Data untuk Quality Assurance

Pelatihan dilakukan selama 2 hari, bertujuan untuk melakukan validasi data yang sudah dimasukkan
oleh data entry ke dalam OpenStreetMap. Materi pelatihan yang diberikan, sebagai berikut:

1. Validasi Data OSM menggunakan JOSM
2. Validasi Data OSM menggunakan Tasking Manager
3. Membuat Batas Administrasi dengan Relasi

• Pelatihan QGIS untuk Data Entry dan Quality Assurance

Pelatihan dilakukan selama 1 hari, bertujuan untuk membuat peta hasil survei lapang yang telah divali-
dasi oleh Quality Assurance dan Mapping Supervisor. Materi pelatihan yang diberikan, sebagai berikut:

1. Download dan Install QGIS
2. Persiapan data
3. Analisis Vektor
4. Pembuatan peta dengan Map Composer

b. Persiapan Mapathon Mapathon adalah pemetaan yang dilakukan secara bersama-sama secara
partisipatif dengan menggunakan tasking manager. Anda dapat bekerja sama dengan pihak universitas
untuk membantu memetakan bangunan dan jalan di wilayah pemetaan Anda. Hal ini sangat efektif untuk
membantu pemetaan sehingga data entry dapat berfokus pada survei lapangan dan mempersingkat
durasi pemetaan. Juga dapat menjalin kerjasama guna keberlanjutan data OpenStreetMap di wilayah
tersebut. Kegiatan mapathon dapat dilakukan selama 3 hari, dengan kegiatan di hari pertama diisi
dengan pelatihan, kemudian hari kedua dan ketiga diisi dengan kegiatan pemetaan.

II. Pembuatan Timeline Survei Pemetaan

Timeline survei pemetaan berbeda dengan kerangka kerja yang sebelumnya telah dibahas, pada bagian
ini akan ditekankan bagaimana Anda dapat mengatur dan mengawasi pelaksanaan survei lapangan.
Secara garis besar timeline pemetaan terbagi menjadi tiga bagian, yaitu :

1. Sebelum Survei Pemetaan Pada tahapan ini, kegiatan yang dilakukan akan berfokus pada per-
siapan peralatan survei. Peralatan survei lapangan terdiri dari GPS, smartphone dan peta cetak. Se-
mua peralatan itu harus dipersiapkan sebelum survei pemetaan dilaksanakan oleh data entry. Pada
smartphone akan dipasang aplikasi ODK Collect, OpenMapKit (OMK), dan OSMTracker, dimana ap-
likasi OMK membutuhkan dua jenis data yang harus dipersiapkan yaitu batas administrasi dalam for-
mat .osm dan citra satelit dalam format .mbtiles. Peran mapping supervisor sangat dominan di dalam
bagian sebelum survei pemetaan, dimana mereka harus mempersiapkan peralatan yang diperlukan
dalam pemetaan. Persiapan survei pemetaan terdiri dari:
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• Membuat MBTiles untuk citra satelit
• Membuat peta survei berdasarkan batas administrasi
• Membuat panduan survei pemetaan

Contoh Tabel Timeline Pemetaan Tahap Sebelum Survei

No Timeline

Tim
Sur-
veyor Kec

Jumlah
Kel Kel

Jumlah
RW MBTiles

Peta
Kel
(satelit)

Peta
Kel
(OSM)

1 Feb -
Mar

A Candisari 3 Candi 11 v v v

100%
Dipetakan

Jatingaleh10 v v v

100%
Divalidasi

Jomblang10 v v v

2 Feb -
Mar

B Banyumanik3 Sumurboto5 v v v

100%
Dipetakan

Ngesrep 11 v v v

100%
Divalidasi

Gedawang10 v v v

_*Pengisian dilakukan oleh Mapping Supervisor_

b. Survei Pemetaan

Pada saat proses survei pemetaan, masing-masing tim memiliki peran agar survei pemetaan dapat
terlaksana dengan baik, yaitu:

• Data Entry = mempersiapkan peralatan survei pada smartphone, melaksanakan survei, mema-
sukkan data survei dan meng-upload ke dalam OSM, digitasi bangunan dan jalan dengan meng-
gunakan JOSM.

• Quality Assurance = memastikan dan mengawasi kualitas data yang telah di-upload oleh data
entry, memastikan dan mengawasi pelaksanaan survei yang dilakukan oleh data entry di lapangan,
serta mengatur strategi kegiatan survei lapangan bersama data entry.

• Mapping Supervisor = memastikan kualitas dan kuantitas data serta memantau pelaksanaan
survei yang disesuaikan dengan timeline yang telah ditetapkan.

Contoh Tabel Timeline Pemetaan Tahap Survei Pemetaan

input
mbtiles

clear
file
man-
ager

Tgl
Survei

Tgl
Sur-
vey
Batas
RW InfrastrukturPosko

Jalur
Evakuasi

Upload
track

Kirim
form
ke
OMK
Server InfrastrukturRW

Jalur
Evakuasi
dan
Posko

Tgl
Vali-
dasi
Data

v v 1,5-6
Mar
2018

1
Mar
2018

v Ada Tidak
Ada

v v v v v 26
Mar
2018

v v 12
Feb
2018

12
Feb
2018

v Ada Tidak
Ada

v v v v v 14,
19
Feb
2018

v v 8,12-
14
Mar
2018

12
Mar
2018

v Ada Tidak
Ada

v v v v v 27-
28
Mar
2018
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c. Setelah Survei Pemetaan Jika seluruh proses pemetaan sudah selesai, maka mapping supervisor
dan quality assurance harus memastikan keseluruhan data yang dimasukkan ke dalam OSM memiliki
kualitas yang baik dan bebas dari kesalahan. Langkah selanjutnya adalah pembuatan peta akhir yang
diberikan untuk pemerintah lokal yang terlibat dalam proses survei lapangan.

Contoh Tabel Timeline Pemetaan Tahap Setelah Survei

Validasi Batas
Administrasi

Perhitungan
Kuantitas Data

Perhitungan Kualitas
Data

Peta Cetak dan
Distribusi

v v v v
v v v v
v v v v

Contoh kelengkapan timeline pemetaan dapat diunduh di tautan berikut https://tinyurl.com/timeline-
pemetaan

III. Pembuatan dan Pengaturan Folder Kerangka Kerja Pemetaan

Dalam mengatur dan memantau kerangka kerja pemetaan, Anda memerlukan suatu tempat peny-
impanan data yang terorganisasi dan mempermudah pendistribusian ke semua pihak yang terlibat
dalam proyek pemetaan. Hasil pemetaan terdiri dari data spasial yang akan di-upload ke dalam
OpenStreetMap. Data tersebut akan di download kembali dan disimpan dalam beberapa format data
spasial yang disesuaikan dengan output pemetaan.

Database dapat disimpan dalam bentuk file digital yang bersifat online, agar mudah pendistribusian
kepada data entry dan quality assurance. Nantinya data tersebut akan dipantau juga oleh mapping
supervisor, sebagai pengecekan dan perhitungan untuk kalkulasi data.

Tempat penyimpanan yang mudah dari segi penggunaan dan pengaplikasian yaitu google drive. Google
drive dapat menyimpan berbagai jenis data dan dapat dibagikan kepada semua orang. Mapping super-
visor dapat membuat suatu folder didalam google drive yang terdiri dari:

Contoh Tabel Folder Proyek Pemetaan

Nama Folder Deskripsi

Timeline Kerangka kerja dan timeline survei pemetaan
Training Agenda pelatihan dan materi pelatihan
Tim Pemetaan Daftar nama tim pemetaan (data entry, quality

assurance, dan mapping supervisor)
Data Survei Hasil pemetaan OpenMapKit (OMK) dan ODK

Collect, batas administrasi, tempat
pengungsian, jalur evakuasi, dll.

Dokumentasi Survei Foto dan video selama kegiatan survei
Peta Peta survei, fieldpapers, dan peta hasil
Laporan Laporan perbulan yang dibuat oleh quality

assurance dan mapping supervisor
Kualitas Data Perhitungan kualitas data yang dihasilkan

sebelum dan sesudah pemetaaan
Kuantitas Data Perhitungan kuantitas data yang dihasilkan

sebelum dan sesudah pemetaaan
OMK Equipment Peralatan survei yang dibutuhkan oleh OMK

seperti MBTiles

Data-data digital harus di-upload ke dalam folder tersebut seiring dengan berjalannya proyek pemetaan,
agar data tersebut dapat di-backup dengan baik dan tidak ada data yang hilang atau rusak.
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Contoh folder di dalam Google Drive

IV. Pembagian Wilayah Survei Berdasarkan Batas Administrasi

Luas wilayah, topografi, dan penggunaan lahan suatu wilayah sangat menentukan pembagian wilayah
dan durasi pemetaan dalam survei. Pembagian wilayah dapat dibagi berdasarkan unit terkecil dari
wilayah administrasi misalnya tingkat kelurahan. Jika Anda telah memiliki batas-batas kelurahan yang
ada di dalam wilayah tersebut, maka Anda dapat memperhatikan aspek selanjutnya yaitu topografi dan
penggunaan lahan.

Misalnya pemetaan yang dilakukan di Kota Semarang memiliki luas wilayah 373,8 km2 yang terdiri dari
16 kecamatan dan 177 kelurahan. Topografi yang dimiliki Kota Semarang mempengaruhi karakteristik
wilayahnya yang terbagi menjadi dua bagian yaitu wilayah pesisir (Semarang Bawah) dan wilayah per-
bukitan (Semarang Atas). Wilayah semarang bawah merupakan pusat aktivitas perekonomian, pemerin-
tahan, dan permukiman. Sedangkan wilayah Semarang Atas merupakan perkembangan permukiman,
fasilitas pendidikan, dan perkebunan. Oleh karena itu, Semarang bawah memiliki infrastruktur yang
lebih padat dibandingkan dengan Semarang atas.

Analisis ketinggian wilayah dapat mempengaruhi dalam hal rute perjalanan saat data entry melak-
sanakan survei lapangan karena masing-masing wilayah padat pemukiman dan wilayah perbukitan
memiliki hambatan tersendiri. Faktor lainnya yang harus diperhatikan yaitu kondisi cuaca saat
pemetaan dilakukan, musim hujan dapat menjadi penghambat survei lapangan, terutama di wilayah
yang rawan banjir. Jika curah hujan tinggi, Anda dapat mengarahkan data entry ke lokasi yang tidak
rawan banjir terlebih dahulu.

Setelah Anda mengetahui faktor-faktor yang menentukan durasi pemetaan, Anda dapat membagi
wilayah survei berdasarkan batas administrasi kecamatan atau kelurahan. Misalnya satu kecamatan
dapat diselesaikan dalam waktu satu bulan dan dikerjakan oleh satu tim kelompok survei yang terdiri
dari beberapa orang data entry. Berdasarkan analisis tersebut, pemetaan di Kota Semarang dapat
diselesaikan dalam waktu 4 bulan dengan melibatkan 16 orang data entry.

Tahapan pembagian wilayah untuk bulan pertama dapat dilakukan dengan area yang dekat dengan
basecamp/kantor agar memudahkan dalam hal koordinasi penggunaan alat yang dilakukan oleh data
entry. Jika data entry menemukan masalah di lapangan, maka mereka dapat kembali ke kantor dengan
jarak yang tidak terlalu jauh dari lokasi survei.
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Peta timeline pemetaan Kota Semarang

Pada peta perencanaan pemetaan Kota Semarang dibawah ini, dibagi menjadi dua bagian berdasarkan
karakteristik wilayah, sehingga diperlukan dua orang mapping supervisor untuk mengatur dan meman-
tau kegiatan pemetaan.

Peta pembagian wilayah Kota Semarang

Contoh Tabel Timeline Pembagian Wilayah
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Timeline Wilayah Kecamatan

Mapping Supervisor
Utara - Semarang
Bawah

Mapping Supervisor
Selatan - Semarang
Atas

Tahap 1 (1,5 Bulan) Kecamatan yang
dekat dengan
kantor/basecamp.
Misalnya berjarak
kurang dari 20 km dari
kantor

Kec Semarang Barat Kec Candisari

Kec Semarang
Tengah

Kec Semarang
Selatan

Kec Semarang Timur Kec Gayamsari
Kec Semarang Utara Kec Gajah Mungkur

Tahap 2 (2,5 Bulan) Kecamatan lebih dari
20 km

Kec Ngaliyan Kec Banyumanik

Kec Pedurungan Kec Tembalang
Kec Tugu Kec Mijen
Kec Genuk Kec Gunung Pati

V. Pembagian Kelompok Tim Pemetaan

Aspek pembagian wilayah sangat menentukan dalam pembagian kelompok survei, terutama untuk
pendistribusian data entry. Anda dapat memilih berdasarkan orang-orang yang sudah mengenal wilayah
tersebut. Untuk mendapatkan informasi tersebut, Anda dapat mencantumkan pertanyaan wilayah mana
saja yang mereka pahami pada saat tahap penerimaan data entry yang baru. Berdasarkan pembagian
wilayah yang sudah dijelaskan sebelumnya, maka tim pemetaan memiliki bagan sebagai berikut:
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Bagan pembagian kelompok

Tabel Pembagian Kelompok Berdasarkan Wilayah Survei

Mapping
Supervisor

Quality
Assurance data entry Kecamatan

Jml
Kelurahan

Total
Kelurahan

Mapping
Supervisor 1

QA1 DE1 Candisari 7 21

DE2 Mijen 14
DE3 Semarang

Selatan
10

DE4 Banyumanik 11
QA2 DE5 Gayamsari 7 23

DE6 Gunung Pati 16
DE7 Gajah

Mungkur
8 20

DE8 Tembalang 12
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Mapping
Supervisor

Quality
Assurance data entry Kecamatan

Jml
Kelurahan

Total
Kelurahan

Mapping
Supervisor 2

QA3 DE9 Semarang
Barat

16 23

DE10 Tugu 7
DE11 Semarang

Tengah
15 25

DE12 Ngaliyan 10
QA4 DE13 Semarang

Timur
10 23

DE14 Genuk 13
DE15 Semarang

Utara
9 21

DE16 Pedurungan 12

RINGKASAN

Jika Anda dapat mengikuti dan memperhatikan seluruh tahapan dalam bab ini, maka Anda telah berhasil
membuat perencanaan proyek pemetaan yang nantinya dapat diaplikasikan ketika survei pemetaan
berlangsung. Perencanaan proyek yang tepat akan menghasilkan kualitas dan kuantitas data yang
maksimal.
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 — title: Metodologi Pengumpulan Data weight: 1 —

Tujuan Pembelajaran:

• Memahami persiapan pengumpulan data
• Mengetahui alur kerja dalam pengumpulan data
• Mengetahui peralatan yang digunakan dalam pengumpulan data
• Mengetahui cara mengambil data di lapangan

Melakukan pengumpulan data atau yang disebut survei lapangan merupakan sesuatu penting khusus-
nya dalam kegiatan pemetaan. Dalam melakukan pemetaan khususnya dalam konteks kebencanaan
pengumpulan informasi adalah hal yang tidak dapat diabaikan. Meskipun saat ini perkembangan
teknologi sudah dapat membantu Anda dalam melakukan pemetaan jarak jauh akan tetapi tidak semua
informasi dapat dikumpulkan hanya dengan mengandalkan citra satelit atau foto udara. Oleh karena
itu, survei lapangan di area pemetaan menjadi satu-satunya pilihan yang dapat Anda lakukan.

Dalam melakukan kegiatan pengumpulan data di lapangan, Anda perlu mengetahui cara serta
metodologi yang tepat untuk melakukannya. Hal ini menjadi penting agar nantinya kegiatan pengumpu-
lan data dapat dilaksanakan secara efisien, efektif dan tepat sasaran. Selain itu, pengumpulan data
yang baik akan menghasilkan hasil pemetaan yang baik dari sisi kuantitas dan kualitas. Dalam
modul ini Anda akan mempelajari metodologi serta tahapan-tahapan yang dilakukan dalam melakukan
pemetaan khususnya di kegiatan HOT-PDC InAWARE.

I. Persiapan Pengumpulan Data

Dalam melaksanakan kegiatan pemetaan HOT-PDC InAWARE, Humanitarian OpenStreetMap Team
(HOT) Indonesia membuat perencanaan yang terorganisir. Hal ini dimaksudkan agar kegiatan
pemetaan yang dilaksanakan di masing-masing kota dapat dilaksanakan secara efektif dan efisien
serta tetap menjaga kualitas dari data yang dikumpulkan. Terdapat beberapa kegiatan persiapan yang
perlu dilakukan sebelum melakukan pengumpulan data di lapangan seperti:

• Pembagian Wilayah Survei dan Tim Survei

Pembagian wilayah pemetaan ini bertujuan untuk memfokuskan area kegiatan pemetaan dimana
masing-masing team akan bertanggung jawab untuk wilayahnya tertentu seperti yang nanti akan
dijelaskan lebih lanjut di Modul Metodologi Survei untuk OpenStreetMap bahwa terdapat 2 (dua)
Mapping Supervisor sehingga dengan dibaginya wilayah pemetaan maka tim survei akan dapat fokus
dan bertanggung jawab untuk wilayahnya masing-masing. Kemudian untuk pembagian tim survei
harus melihat aspek kemampuan teknis maupun pengetahuan lokal dari wilayah yang akan disurvei.

Pentingnya kemampuan teknis dalam mengoperasikan peralatan survei akan membantu dalam
pengambilan data di lapangan. Pengetahuan lokal seperti pemahaman akan lokasi yang akan menjadi
tujuan survei dan kemampuan berbahasa daerah (lokal) menjadi nilai tambah yang dapat membantu
mendapatkan informasi dari masyarakat dan komunitas di area survei.
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“Pembagian wilayah pemetaan di masing-masing Kota”

Pembagian wilayah pemetaan di masing-masing Kota

• Mengurus Surat Izin Survei

Dalam kegiatan yang melibatkan berbagai pihak dan memiliki area pemetaan yang luas dan dilak-
sanakan dalam waktu yang relatif lama, surat izin survei merupakan hal yang sangat penting untuk
dimiliki sebelum memulai melakukan pemetaan. Dengan memiliki surat izin survei yang dikeluarkan
oleh pemerintah lokal atau dalam hal ini Badan Penanggulangan Bencana Daerah (BPBD) di masing-
masing kota, kegiatan survei akan relatif lebih dipercaya oleh masyarakat di area survei. Selain itu, Anda
juga akan lebih mudah untuk mendapatkan informasi dari kelurahan dan masyarakat setempat karena
sudah memiliki tujuan yang jelas dalam melakukan kegiatan survei pemetaan di wilayah mereka. Surat
izin survei sebaiknya dikeluarkan oleh instansi / organisasi lokal yang bekerja sama dengan tim survei
dalam melakukan kegiatan pemetaan.

• Mengetahui Prioritas Objek Pemetaan

Sebelum memulai kegiatan survei ada baiknya Anda melakukan komunikasi dengan pemerintah lokal
atau BPBD untuk membahas objek-objek yang menjadi prioritas dalam kegiatan pemetaan ini. Masing-
masing kota dapat berbeda satu dengan yang lain dalam aspek keragaman bentuk wilayah, jenis ben-
cana, dan aspek sosial. Aspek-aspek tersebut dapat menjadi pertimbangan dalam menentukan objek-
objek yang menjadi prioritas dalam kegiatan pengumpulan data di lapangan. Sebagai contoh objek pri-
oritas fasilitas tempat ibadah umat muslim di DKI Jakarta hanya masjid, tetapi di Kota Semarang musala
juga menjadi objek prioritas untuk dikumpulkan. Menurut BPBD DKI Jakarta, jika terjadi bencana seperti
banjir maka potensi tempat pengungsian hanya dapat dilaksanakan di masjid karena kapasitas tampun-
gan mereka yang relatif besar, sedangkan di Semarang menurut BPBD Kota Semarang lebih sering
terjadi bencana skala kecil/lokal seperti longsor sehingga tidak memerlukan tempat pengungsian dan
musala dapat dijadikan tempat mengungsi. Oleh karena itu, jumlah pengungsi tidak banyak sehingga
diarahkan ke musala-musala terdekat dari wilayah terdampak.

Tujuan mengetahui prioritas objek pemetaan yang sesuai dengan kebutuhan pemerintah lokal adalah
agar hasil dari kegiatan pemetaan dapat digunakan oleh pemerintah, komunitas, dan masyarakat lokal,
tidak hanya HOT. Dimana hasil kegiatan pemetaan dapat disesuaikan dengan kebutuhan mereka.

• Melakukan Pelatihan Tim Pemetaan dan Mapathon

Hal ini merupakan persiapan untuk internal tim dimana paraQuality Assurance dan Data Entry diajarkan
hal-hal teknis yang akan mereka lakukan sepanjang kegiatan pemetaan berlangsung seperti menggu-
nakan aplikasi di smartphone yang akan digunakan saat survei, menggunakan peta survei, mengirim
data-data hasil survei ke server, melakukan input hasil pengumpulan data dengan JOSM, melakukan
validasi hasil input data, dan lain-lain. Kegiatan ini sangat penting karena dapat membantu kegiatan
pemetaan supaya tidak terhambat dan lebih maksimal. Selain itu, persiapan dalam pelaksanaan map-
athon sebagai kegiatan pemetaan jarak jauh (mapathon) bersama dengan universitas lokal dapat mem-
bantu untuk melengkapi data bangunan dan jalan di area pemetaan sebelum melakukan pengumpulan
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data di lapangan.

II. Alur Pengumpulan Data

Kegiatan pengumpulan data dimulai tidak hanya ketika berada di wilayah survei atau lapangan, akan
tetapi dimulai dari basecamp hingga kembali ke basecamp sebelum melakukan input data hasil survei.
Berikut alur kegiatan dalam melakukan pengumpulan data di lapangan:

“Alur pengumpulan data di lapangan”

Alur pengumpulan data di lapangan

• Tahap 1

Masing-masing tim survei yang terdiri dari 2 (dua) Data Entry mengendarai sepeda motor dan mem-
bawa Surat Izin Survei yang dibuat oleh organisasi lokal atau instansi seperti Badan Penanggulangan
Bencana Daerah (BPBD) dan Peta Survei. Tujuan pertama adalah menuju kantor kelurahan di area
survei mereka.

• Tahap 2

Pemberhentian pertama adalah kantor kelurahan di area survei masing-masing tim survei. Kemudian
mereka bertemu dengan perwakilan kelurahan untukmeminta izinmelakukan survei dengan berkeliling
di wilayah kelurahan tersebut selama beberapa hari dan untuk berdiskusi dalam rangkamembarui batas
administrasi di kelurahan tersebut hingga batas rukun warga (RW).

• Tahap 3

Setelah membarui batas administrasi di kelurahan tersebut, tim data entry (DE) melanjutkan kegiatan un-
tuk melakukan survei terhadap semua fasilitas umum dan objek prioritas di kelurahan tersebut. Mereka
menggunakan aplikasi smartphone untuk mengumpulkan seluruh informasi objek-objek yang ada di
kelurahan tersebut. Kegiatan tahap 3 ini dapat berlangsung selama 2-4 hari untuk satu kelurahan.

• Tahap 4

Setelah survey, tim survei meng-upload hasil pengumpulan data mereka ke server (ona.io) kemudian
kembali ke kantor untuk melakukan input semua hasil pengumpulan data di lapangan menggunakan
JOSM dan upload seluruh hasil survei ke OpenStreetMap.

Tahap selanjutnya adalah Quality Assurance (QA) men-download data-data tersebut dan memeriksa
kualitas bentuk objek dan informasinya (tag). Setelah itu, tim Mapping Supervisor akan memeriksa
kembali data yang sudah divalidasi oleh tim Quality Assurance, sehingga kualitas data yang dihasilkan
semakin baik sebelum di-upload ke OpenStreetMap. Materi terkait penjaminan kualitas data Open-
StreetMap akan dibahas pada modul-modul yang berbeda.
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III. Perlengkapan Pengumpulan Data

Dalam melakukan pengumpulan data di lapangan, tim survei perlu mengetahui perlengkapan apa saja
yang dibutuhkan untuk dibawa ke wilayah pemetaan mereka. Hal ini menjadi penting karena keterse-
diaan dan kelengkapan peralatan menjadi salah satu faktor yang mendukung performa dari tim survei
di lapangan. Berikut adalah beberapa perlengkapan yang dibutuhkan dalam melakukan pengumpulan
data di lapangan:

• Smartphone

Ini merupakan alat yang paling penting dalam melakukan pengumpulan data di lapangan. Dalam
memilih smartphone yang akan digunakan perlu diperhatikan spesifikasi tertentu dari smartphone
tersebut seperti kapasitas memori penyimpanan, RAM yang dimiliki serta ketersediaan fitur GPS/lokasi
di GPS tersebut dan sistem operasi yang digunakan harus menggunakan sistem operasi Android
karena aplikasi yang akan diinstal dan digunakan hanya tersedia di Android. Adapun aplikasi yang
dibutuhkan dalam melakukan pengumpulan lapangan adalah OpenMapKit, ODK Collect , dan OSM
Tracker.

• Power Bank

Alat ini juga menjadi penting untuk dibawa ketika melakukan pengumpulan data di lapangan. Ketika
melakukan pengumpulan data, tim survei akan selalu mengaktifkan fitur lokasi GPS serta koneksi inter-
net diSmartphonemereka dalam melakukan pengumpulan data sehingga daya baterai dariSmartphone
dapat berkurang secara cepat. Oleh karena itu, power bank menjadi alat bantu yang dapat memastikan
smartphone dari Data Entry tetap bisa digunakan selama kegiatan pengumpulan data berlangsung.

• Alat Tulis

Alat tulis menjadi perlengkapan yang penting dalam mencatat informasi yang didapatkan di lapangan.
Selain itu, alat tulis digunakan untuk menggambarkan batas-batas administrasi di peta survei yang
dibawa oleh Data Entry ke kantor kelurahan. Beberapa contoh alat tulis yang dapat dibawa adalah
spidol warna, penggaris dan buku catatan.

• Peta Survei

Peta survei dibawa untuk mempermudah mengidentifikasi wilayah area yang akan disurvei. Selain itu,
peta survei akan dijadikan sebagai alat bantu dalam membarui batas-batas administrasi kelurahan yang
disurvei. Pembuatan peta survei lebih lengkapnya akan dibahas dalam Modul Pembuatan Peta Survei
dengan QGIS.

• Surat Izin Survei

Seperti yang sudah dijelaskan sebelumnya bahwa surat izin survei merupakan hal yang harus dibawa
oleh Data Entry saat melakukan pengumpulan data di lapangan. Surat izin survei biasanya dikeluarkan
oleh organisasi lokal atau instansi lokal seperti BPBD sehingga akan memudahkan komunikasi oleh
masyarakat setempat dalam mendapatkan informasi terkait objek-objek yang akan dipetakan.

• GPS

GPS adalah alat yang dapat dijadikan alternatif jika smartphone yang digunakan sedang mengalami
masalah. Selain itu, GPS juga digunakan sebagai alat bantu validasi untuk melakukan pengecekan
kembali hasil pengumpulan data di lapangan.

IV. Pengumpulan Data di Lapangan

a. Pengumpulan Data Infrastruktur

Dalam melakukan pengumpulan data infrastruktur data entry harus menggunakan smartphone android
yang telah memiliki beberapa aplikasi yang telah diinstal yaitu:

• ODK Collect

Ini merupakan aplikasi yang berfungsi untuk mengumpulkan informasi-informasi terkait objek yang Anda
petakan. Dengan menggunakan aplikasi ini Anda tidak perlu untuk mencetak puluhan hingga ratusan
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formulir survei. Selain itu aplikasi ini memungkinkan Anda untuk mengambil foto serta koordinat lokasi
dari objek yang Anda petakan.

• OpenMapKit (OMK)

OMK merupakan aplikasi tambahan untuk ODK Collect dimana Anda dapat langsungmemberikan in-
formasi yang Anda kumpulkan di lapangan sesuai dengan tag yang ada di OpenStreetMap. Selain
itu, dengan OpenMapKit kita bisa menambahkan informasi yang sesuai dengan atribut (tag) OSM pada
data OSM yang sebelumnya telah Anda download. Tidak hanya itu, OMK juga memberikan kemudahan
untuk menambahkan data berupa titik sesuai dengan lokasi yang disajikan pada peta yang ada di OMK.
Semua informasi yang Anda masukkan melalui OMK akan disimpan kembali pada ODK Collect, yang
kemudian akan dikirim ke server ona.io atau server lain yang digunakan.

• OSMTracker

Aplikasi ini membantu Data Entry dalam mencatat cakupan survei di kelurahan target pemetaan mereka.
OSM Tracker memiliki fungsi yang sama seperti GPS dimana Anda bisa merekam jejak perjalanan
survei kemudian menampilkannya dalam dengan latar belakang peta OpenStreetMap. OSM Tracker
juga bisa menambahkan titik untuk menandai objek survei, mengambil gambar, catatan ataupun video
singkat.

Secara umum kegiatan pengumpulan data infrastruktur dilakukan dengan berkeliling di kelurahan target
pemetaan kemudian mencari objek-objek prioritas pemetaan dan mengumpulkan informasi-informasi
yang dibutuhkan untuk masing-masing objek dengan pengamatan secara langsung terhadap objek
ataupun bertanya kepada masyarakat sekitar. Setelah itu data hasil pemetaan akan di-upload ke google
drive yang telah dibuat oleh masing-masingQuality Assurance dan ke server ona.io sebagai backup atau
cadangan data jika data hilang atau terhapus secara tidak sengaja. Langkah terakhir adalah melakukan
input hasil pengumpulan data di lapangan dengan menggunakan JOSM. Berikut adalah alur singkat
dalam melakukan pengumpulan data infrastruktur:

“Alur pengambilan data infrastruktur”

Alur pengambilan data infrastruktur

Catatan : Kegiatan pengambilan data infrastruktur bisa dilaksanakan sekitar 2-4 hari untuk
1 kelurahan. Durasi pengambilan data tergantung oleh luas wilayah dan kepadatan data
yang dikumpulkan. Hasil pengumpulan data HARUS dihapus berkala setiap hari di smart-
phone setelah melakukan upload ke google drive dan server ona.io. Hal ini dilakukan untuk
mengantisipasi kapasitas memori yang tidak cukup dan sebagai laporan survei kepada Qual-
ity Assurance yang nanti akan melakukan pengecekan terhadap kualitas data yang diambil.
Jika terdapat penolakan/pengusiran dari masyarakat setempat, Data Entry dapat meminta
bantuan tim BPBD untuk menemani dalam melakukan pengumpulan data di lapangan.
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“Kegiatan pengumpu-
lan data infrastruktur di lapangan”

Kegiatan pengumpulan data infrastruktur di lapangan

b. Pengumpulan Data Batas Administrasi

Mengumpulkan data batas administrasi sedikit berbeda dengan mengumpulkan data infrastruktur. Jika
dalam mengumpulkan infrastruktur Data Entry menggunakan aplikasi ODK Collect dan OMK di smart-
phone, maka dalam mengumpulkan atau memperbaharui batas administrasi di kelurahan pemetaan
menggunakan peta survei yang telah dibuat oleh Mapping Supervisor.

Pengumpulan data batas administrasi menggunakan pendekatan komunikasi dan melibatkan perwak-
ilan kelurahan dan masyarakat setempat. Secara umum cara pengambilan batas administrasi adalah
dengan datang ke kantor kelurahan yang menjadi area target pemetaan dengan membawa peta survei
kemudian berdiskusi dengan pihak kelurahan tentang batas-batas kelurahan dan rukun warga (RW).
Pihak kelurahan kemudian akan melihat peta survei dan setelah itu menggambar garis batas-batas
kelurahan dengan alat tulis seperti pensil ataupun spidol di atas peta survei tersebut.

“Kegiatan pengumpulan batas administrasi di kantor kelurahan”

Kegiatan pengumpulan batas administrasi di kantor kelurahan

Setelah selesai, data entry dapat memberikan hasil pengumpulan batas administrasi tersebut kepada
Quality Assurance untuk di-input ke dalam OpenStreetMap dengan menggunakan JOSM. Untuk pen-
jelasan tentang bagaimana cara input batas-batas administrasi dapat dilihat di Modul Membuat Batas
Administrasi di JOSM.

Berikut adalah alur dalam melakukan pengumpulan batas administrasi:
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“Alur pengambilan data batas administrasi”

Alur pengambilan data batas administrasi

Catatan : Pengambilan data batas-batas administrasi dapat melibatkan perwakilan kelura-
han ataupun ketua RW setempat jika perwakilan kelurahan tidak memahami dengan baik
batas-batas RW yang ada di kelurahan tersebut. Jika ketua RW tidak dapat hadir ke kantor
kelurahan maka Data Entry WAJIB datang ke rumah setiap ketua RW dengan membawa
peta survei untuk berdiskusi tentang batas-batas wilayah mereka. Jika terdapat penolakan
dari ketua RW setempat, Data Entry dapat meminta bantuan tim BPBD untuk menemani
dalam melakukan pengumpulan batas administrasi di kelurahan tersebut.

RINGKASAN

Anda telah mempelajari tahapan dan metodologi dalam melakukan pengumpulan data di lapangan. Den-
gan mengetahui langkah-langkah tersebut diharapkan Anda dapat melaksanakan kegiatan pemetaan
dengan lebih efektif dan efisien sehingga hasil yang didapatkan tidak hanya bagus dari sisi kuantitas
tetapi juga dari sisi kualitas data yang dihasilkan di OpenStreetMap.
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 — title: Pengenalan OpenStreetMap weight: 1 —

Tujuan Pembelajaran:

• Mampu menjelaskan pengertian OpenStreetMap
• Mampu menjelaskan sejarah terbentuknya OpenStreetMap
• Mampu menjelaskan keuntungan menggunakan OpenStreetMap
• Mampu menjelaskan pemanfaatan OpenStreetMap
• Mampu menjelaskan konsep dasar peta dan OpenStreetMap

Sekarang ini banyak orang yang menggunakan peta digital, namun masih sedikit yang menggunakan
peta digital terbuka. Peta digital terbuka memiliki sifat yang gratis dan dapat diedit oleh siapa saja.
Salah satu peta digital terbuka adalah OpenStreetMap. Pada modul ini, Anda akan mempelajari segala
sesuatu mengenai OpenStreetMap.

I. Pengertian OpenStreetMap

OpenStreetMap adalah peta digital seluruh dunia yang bersifat bebas, terbuka dan dapat diubah oleh
siapapun. Dengan sifatnya yang digital, siapapun dapat mengaksesOpenStreetMap dimanapun secara
gratis. DataOpenStreetMapmemiliki lisensi ODbL, sedangkan kartografi/tampilan petaOpenStreetMap
memiliki lisensi CC-BY-SA yang memungkinkan para penggunanya untuk dapat membagikan, mencipta
dan mengadaptasi data OpenStreetMap selama mencantumkan sumber dengan cara menuliskan “©
OpenStreetMap contributors” serta memiliki lisensi yang sama dan bersifat terbuka. Konsep berbagi
data sangat berguna untuk masyarakat apalagi untuk data yang sulit diperoleh ataupun diakses. Den-
gan menggunakan OpenStreetMap, Anda dapat berbagi data spasial dimana data tersebut dibuat dan
berasal dari pengguna lain dan sebaliknya pengguna lain pun dapat menggunakan data yang Anda buat.
OpenStreetMap juga memungkinkan Anda untuk menciptakan suatu produk dari data OpenStreetMap
hingga memodifikasi data tersebut.

Logo OpenStreetMap

II. Sejarah OpenStreetMap

OpenStreetMap pertama kali digagas oleh Steve Coast pada tahun 2004. Pada saat itu, Steve merasa
data dari Ordnance Survey (Badan Survei dan Pemetaan di Inggris) sangat mahal dan sulit untuk diper-
oleh. Kemudian Steve dan beberapa orang lainnya mendirikan OpenStreetMap agar orang-orang di
seluruh dunia dapat membuat peta digital untuk komunitas atau masyarakat dan menyimpannya di se-
buah database bersama. Tahun 2006, OpenStreetMap diregistrasikan menjadi organisasi nonprofit di
Inggris. Pada tahun 2007, pertama kalinya diselenggarakan konferensi tahunan oleh OpenStreetMap
bertajuk “State of the Map” di Manchester, yang hingga sekarang diselenggarakan rutin setiap tahun di
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kota-kota berbeda di dunia. Tahun 2008, 20 juta garis yang merepresentasikan objek garis dari jalan,
sungai, hingga pagar, sudah berhasil terpetakan di OpenStreetMap.

Tahun 2009, para sukarelawan berhasil memetakan Kibera diOpenStreetMap, sebuah kawasan kumuh
kedua terbesar di Afrika. Tahun 2010, citra satelit Bing mulai dapat digunakan sebagai acuan pemetaan
di OpenStreetMap. Tahun 2011, satu milyar titik/nodes dari persimpangan jalan hingga pohon, berhasil
terpetakan diOpenStreetMap. Tahun 2011 juga merupakan tahun dimanaOpenStreetMapmulai masuk
ke Indonesia. Tahun 2012, ODbL mulai diaplikasikan ke OpenStreetMap yang memungkinkan penggu-
nanya untuk bebas berbagi, bebas mencipta dan bebas mengadaptasi data OSM. Tahun 2013, peng-
guna OpenStreetMap sudah mencapai satu juta orang. Hingga saat ini, OpenStreetMap sudah memiliki
lebih dari lima juta pengguna dari seluruh dunia.

Alur sejarah terbentuknya OpenStreetMap

III. Mengapa Memilih OpenStreetMap

Beberapa alasan mengapa sebaiknya Anda memilih OpenStreetMap adalah:

• OpenStreetMap bersifat terbuka dan gratis sehingga OpenStreetMap tidak akan meminta Anda
membayar untuk menggunakannya. Banyak dari penyedia data spasial yang meminta Anda mem-
bayar untuk mendapatkan data spasial. OpenStreetMap dapat menjadi alternatif sumber data
spasial yang bebas biaya. Dengan adanya OpenStreetMap, pengguna tidak perlu bergantung
lagi dengan badan/instansi pemerintah atau penyedia data spasial lainnya untuk mendapatkan
data spasial.

• Data OpenStreetMap juga lebih kaya dan lebih baru. Hal ini disebabkan karena setiap pengguna
dapat menambahkan, mengubah dan menghapus data kapanpun dan dimanapun. Misalnya ada
sebuah restoran yang sudah tidak ada di suatu tempat namun masih terpetakan diOpenStreetMap,
Anda dapat dengan mudah menghapus restoran tersebut dari OpenStreetMap. Di beberapa tem-
pat seperti di kota-kota besar data OSM nya akan cenderung lebih kaya, karena biasanya di daerah
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pedesaan belum ada pengguna yang memetakan daerah tersebut. Jadi, ketersediaan data dan
pembaruan data akan sangat bergantung pada pengguna.

• Menggunakan OpenStreetMap relatif lebih mudah. OpenStreetMap menyediakan banyak sekali
panduan untuk para pengguna yang baru memulai menggunakan OpenStreetMap. Selain itu,
tampilan OSM yang user friendly memudahkan pengguna dalam menggunakan OpenStreetMap
bahkan jika pengguna tidak memiliki latar belakang di bidang pemetaan.

• Peta OpenStreetMap dapat dimodifikasi sesuai keinginan. Semua data di dalam OpenStreetMap
dapat Anda gunakan sesuai dengan kebutuhan. Misalnya Anda ingin membuat data lokasi pari-
wisata di tempat Anda, Anda bisa mengambil data OpenStreetMap dan hanya memunculkan des-
tinasi pariwisata di tempat Anda tanpa harus memasukkan data OpenStreetMap yang lain.

IV. Pemanfaatan OpenStreetMap

Banyak sekali contoh penggunaan OpenStreetMap dalam berbagai bidang. Dengan OpenStreetMap,
Anda dapat melengkapi data peta dan membuat peta di lokasi yang sudah familier dengan Anda mis-
alnya dalam skala desa. Anda dapat memetakan secara detail karena setiap pengguna dimungkinkan
untuk melakukan survei secara mandiri pada wilayah yang akan dipetakan. Berikut ini adalah contoh
peta Dusun Bodeh di D.I. Yogyakarta yang dibuat oleh salah satu pengguna OpenStreetMap yang ting-
gal di dusun tersebut.
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Contoh peta yang dibuat menggunakan OpenStreetMap

Data OpenStreetMap juga digunakan oleh salah satu Android Developer untuk membuat aplikasi an-
droid peta offline dunia yang bernama Maps Me. Aplikasi ini menggunakan data OpenStreetMap yang
harus di-download terlebih dahulu kemudian Anda dapat menggunakan data tersebut secara offline
untuk navigasi.
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Tampilan aplikasi android Maps Me

OpenStreetMap juga dapat digunakan untuk membuat peta dampak suatu bencana. OpenStreetMap
sudah sering digunakan sebagai alat memetakan daerah bencana yang kemudian datanya digunakan
untuk menaksir dampak dari bencana tersebut. OpenStreetMap juga sering digunakan sebagai platform
pemetaan untuk respon bencana karena sifat OpenStreetMap mendukung pemetaan partisipatif. Data
OpenStreetMap juga dapat digunakan untuk membuat rute evakuasi serta titik-titik pengungsian, namun
data OSM harus diolah terlebih dahulu menggunakan software SIG.
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V. Konsep Dasar Peta dan OpenStreetMap

a. Konsep Peta Kertas

Peta adalah salah satu sarana penyampaian informasi yang efektif. Peta dapat merepresentasikan infor-
masi lebih baik daripada kata-kata khususnya informasi mengenai objek di permukaan bumi. Untuk men-
jawab beberapa pertanyaan pun menjadi lebih efektif jika divisualisasikan dengan peta, seperti “Dimana
letak SDN 01?” atau “Dimana letak rumah sakit terdekat?”. Biasanya jika ada pertanyaan seperti ini,
jawabannya digambarkan menggunakan alat tulis dan kertas berupa peta kertas. Jalan biasanya digam-
barkan menjadi garis dan bangunan-bangunan biasanya digambarkan menjadi kotak. Tetapi penggam-
baran peta akan tergantung dari siapa yang menggambarkannya, karena gaya penggambaran objek
setiap orang berbeda-beda.

b. Mengapa Beralih Ke Peta Digital

Penggunaan peta kertas, selain sulit untuk meyampaikannya ke orang lain karena mungkin peta tersebut
hanya ada satu salinan, cara penggambaran petanya juga belum tentu dapat dipahami oleh orang lain.
Peta kertas juga rawan rusak jika terkena air dan perlu tempat penyimpanan yang baik juga agar tidak
rusak dan hilang. Inilah mengapa sebaiknya peta dibuat menjadi digital agar semua orang mudah
mengaksesnya. Dengan menggunakan kemampuan komputer, data peta lebih mudah dipahami dan
dibagikan. Peta digital juga memungkinkan Anda untuk menyesuaikan simbol peta sesuai kebutuhan.
Selain itu, peta digital memungkinkan Anda untuk dapat menambahkan informasi yang tak terbatas
pada objek yang dipetakan. Berbeda dengan peta kertas, Anda hanya dapat menuliskan informasi
yang terbatas untuk objek tersebut karena tempat menuliskan informasinya juga terbatas. Dan yang
lebih penting, ketika menambahkan objek, objek tersebut lokasinya tepat (lintang dan bujurnya) di bumi
ini.

c. Komponen Peta Digital

Ketika menggambar objek-objek yang ada di permukaan bumi, objek-objek tersebut akan disimbolkan
dengan titik, garis ataupun poligon tergantung dari objek yang digambarkan. Titik-titik penting (point
of interest) seperti restoran, fire hydrant dan bank biasanya disimbolkan dengan titik. Simbol garis
biasanya diberikan pada objek seperti jalan, sungai dan rel kereta. Garis merupakan kumpulan dari
beberapa titik yang saling menyambung. Poligon biasanya digunakan untuk menggambarkan objek
area seperti bangunan, danau dan penggunaan lahan. Poligon merupakan garis yang tertutup, jadi jika
Anda menggambar poligon, titik awal garis harus menyatu dengan titik akhir garis.

Simbologi titik dari objek yang dipetakan di OpenStreetMap
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Simbologi garis dari objek yang dipetakan di OpenStreetMap

Simbologi poligon dari objek yang dipetakan di OpenStreetMap

RINGKASAN

Jika Anda dapat memahami dan memperhatikan seluruh tahapan dalam bab ini, maka Anda dapat
menjelaskan pengertianOpenStreetMap, menjelaskan sejarah terbentuknyaOpenStreetMap serta men-
jelaskan keuntungan menggunakan OpenStreetMap. Selain itu, Anda juga dapat menjelaskan pe-
manfaatan OpenStreetMap dan menjelaskan konsep dasar peta dan OpenStreetMap. Pada modul-
modul selanjutnya, Anda akan mempelajari bagaimana cara mengoperasikan OpenStreetMap untuk
melakukan kegiatan pemetaan.
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 — title: Memulai menggunakan OpenStreetMap weight: 2 —

Tujuan Pembelajaran:

• Mampu mengoperasikan dan melakukan navigasi situs OpenStreetMap
• Mampu melihat informasi objek di OpenStreetMap
• Mampu menerapkan pembuatan tautan OpenStreetMap
• Mampu menyimpan gambar dari peta OSM
• Mampu menerapkan pembuatan akun di OpenStreetMap
• Mampu memahami konsep dasar atribut OpenStreetMap
• Mampu memahami riwayat yang terdapat peta OSM di situs OSM

Setelah Anda memahami pengertian OpenStreetMap pada modul sebelumnya, Anda dapat langsung
memulai untuk menggunakan OpenStreetMap. Pada modul ini Anda akan memulai untuk mengenal
situs OpenStreetMap, membuat akun OSM, dan mengetahui tombol-tombol menu serta cara penggu-
naannya.

I. Mengunjungi situs OpenStreetMap

Untuk dapat mengunjungi situs OpenStreetMap (OSM), pastikan komputer Anda telah terkoneksi den-
gan jaringan internet. Tahap untuk mengunjungi situs OpenStreetMap adalah sebagai berikut:

• Buka web browser pada komputer Anda seperti Mozilla Firefox, Google Chrome, Internet Ex-
plorer, Safari, dan lain-lain.

• Pada bar alamat (address bar) di bagian atas browser Anda, ketikkanwww.openstreetmap.org dan
tekan Enter.

• Ketika halaman situs sudah muncul, maka Anda akan melihat tampilan sebagai berikut:

Tampilan awal situs OpenStreetMap

II. Menavigasikan Peta

Pada tampilan utama halaman situs OpenStreetMap, Anda akan melihat tampilan satu peta besar di
dalamnya. Anda harus dapat menavigasikan peta tersebut agar Anda bisa pergi ke suatu lokasi yang
Anda inginkan. Berikut adalah cara-cara untuk menavigasikan peta pada OpenStreetMap:

• Menggeser tampilan peta. Anda dapat menggunakan perangkat mouse Anda. Klik kiri pada
perangkat mouse Anda, kemudian tahan dan geser peta ke tempat yang Anda inginkan. Apa-
bila Anda tidak mempunyai mouse, Anda dapat tekan dan tahan touchpad kanan pada peta lalu
geser kursor ke lokasi yang Anda inginkan.
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Cara menggeser tampilan peta

• Memperkecil dan memperbesar tampilan peta. Anda dapat menggunakan tombol (+) dan (-) yang
ada pada panel di sebelah kanan layar Anda. Apabila perangkat mouse Anda memiliki scroll-
wheel atau roda gulir, Anda dapat menggunakannya untuk dapat memperbesar dan memperkecil
peta. Gulirkan scroll-wheel atau roda gulir mouse Anda ke atas untuk memperbesar, sedangkan
gulirkan ke bawah untuk memperkecil.

Cara memperbesar dan memperkecil tampilan peta

• Mencari lokasi yang Anda inginkan. Anda dapat menggunakan kotak pencarian Search yang
berada di sebelah kiri layar. Anda dapat mengetikkan lokasi yang ingin Anda cari pada kolom
pencarian ini, kemudian tekan Enter atau klik Go. Setelah itu akan muncul kotak Search Results
di bawah kolom pencarian. Anda dapat memilih dan mengklik pada hasil pencarian untuk dapat
langsung menuju ke titik lokasi yang Anda inginkan tersebut.
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Langkah pencarian lokasi dengan kotak Search

• Menampilkan titik lokasi Anda saat ini. Anda dapat menuju panel peta di sebelah kanan peta
dan klik tombol Show My Location. Lalu, secara otomatis peta akan menampilkan titik lokasi
Anda saat ini (titik berwarna biru). Pastikan GPS pada laptop/komputer Anda telah aktif dan Anda
mengizinkan OSM untuk mendapatkan lokasi Anda.

Tampilan Show My Location pada peta OpenStreetMap

III. Melihat peta dengan tampilan yang berbeda

PetaOpenStreetMap berisi data geografis dari seluruh dunia. Walaupun disimpan dalam satu database,
data tersebut dapat ditampilkan dalam beberapa tampilan layer yang berbeda. Langkah-langkah untuk
mengganti layer peta pada OSM adalah sebagai berikut:

• Silakan klik pada tombol Layers di sebelah kanan pada peta Anda.
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Tombol untuk mengganti layer di situs OpenStreetMap

OSM memiliki empat macam layer dengan fungsi yang berbeda-beda, yaitu: * Standard: Layer yang
menampilkan semua objek pada peta OSM.

Tampilan Standard Layer

• Cycle Map: Layer yang hanya menampilkan jalur sepeda dan jalan untuk pejalan kaki.
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Tampilan Cycle Layer

• Transport Map: Layer yang menampilkan rute transportasi yang ada pada peta seperti jalan raya
ataupun halte bis.

Tampilan Transport Map Layer

• Humanitarian: Layer yang menampilkan bangunan objek penting atau fasilitas umum yang ada
pada peta seperti sekolah, rumah sakit, dan lain-lain.

Tampilan Humanitarian Layer

IV. Melihat informasi objek di OpenStreetMap

Pada halaman utama situs OpenStreetMap, selain melihat lokasi dan menavigasikan peta, Anda juga
dapat mengetahui informasi objek yang ada pada peta dengan menggunakan Query Features. Adapun
langkah-langkah menggunakannya adalah sebagai berikut:

• Klik pada tombol Query Features di sebelah kanan layar. Setelah diklik maka akan muncul ikon
tanda tanya pada sebelah kanan kursor Anda. Hal ini menandakan bahwa query features telah
aktif.
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Tombol untuk Mengaktifkan Query Features

• Pilih objek atau lokasi yang ingin diidentifikasi. Misalnya pada contoh ini akan dipilih objek bangu-
nan Dinas Kesehatan di Jakarta.

• Akan muncul kotak di sebelah kiri layar yang menampilkan Nearby Features dan Enclosing Fea-
tures. Nearby features atau fitur terdekat menunjukan keterangan objek apa saja yang berada
paling dekat dengan lokasi titik yang Anda pilih, sedangkan Enclosing features atau fitur sekitar
menunjukan keterangan objek apa saja yang berada di sekitar lokasi titik yang Anda pilih. Pilih
keterangan Governmental office Dinas Kesehatan.

Tampilan pilihan Nearby features dan Enclosing features

• Setelah dipilih, akan muncul informasi detail mengenai bangunan Dinas Kesehatan pada kotak
sebelah kiri. Informasi yang ditampilkan tersebut merupakan tag atau atribut mengenai informasi
umum objek seperti nama objek, alamat, tingkat bangunan, dan lain-lain.
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Hasil Identifikasi Objek menggunakan Query Features pada OpenStreetMap

V. Membagikan tautan OpenStreetMap

Anda dapat membagikan tautan peta OpenStreetMap kepada orang lain untuk berbagai keperluan,
seperti membagikan lokasi posisi Anda saat ini kepada rekan Anda dan lain sebagainya. Untuk da-
pat membagikan peta OpenStreetMap, langkah-langkahnya adalah sebagai berikut :

• Klik tombol Share pada bagian kanan layar Anda. Lalu akan muncul kolom Share di sebelah
kanan layar Anda.

• Beri tanda centang pada Include marker untuk menambahkan titik penanda lokasi. Titik penanda
lokasi ini dapat Anda pindahkan atau geser sesuai dengan lokasi yang diinginkan. Caranya, klik
dan tahan penanda lokasi tersebut kemudian Anda geser ke titik lokasi yang diinginkan. Cara
lainnya ialah dengan menggeser peta sehingga titik penanda lokasi berada pada posisi yang Anda
inginkan.

Menambahkan penanda lokasi

• Setelah sesuai, Anda dapat menyalin tautan yang ada pada kotak Link dan bagikan tautan ini
sesuai dengan keperluan Anda. Anda juga dapat menyalin versi lebih pendek dari tautan pada
kotak Short Link atau menyalin kode HTML pada kotak HTML.
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Membagikan Tautan Peta OpenStreetMap

VI. Mengekspor peta menjadi sebuah gambar

Selain bisa mengganti layer di peta OpenStreetMap, Anda juga bisa mengambil peta tersebut dalam
bentuk gambar dengan format yang diinginkan seperti .png, .jpg, .svg, dan .pdf. Langkah mengekspor
peta menjadi gambar adalah sebagai berikut:

• Silakan klik pada label Share pada ikon sebelah kanan dari peta Anda. Lalu akan muncul kolom
Share di sebelah kanan layar Anda.

Tombol untuk mengekspor Peta OpenStreetMap

• Setelah itu tentukan area pada peta yang ingin Anda ekspor sebagai gambar. Caranya dengan
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centang pada kotak Set custom dimensions pada bagian Image kemudian atur perbesaran ko-
taknya sesuai dengan yang diinginkan atau Anda juga mengatur skalanya pada bagian Scale.

Catatan : Anda hanya dapat mengekspor peta dalam bentuk gambar dengan menggunakan
tampilan peta Standard. Apabila tampilan peta Anda tidak menggunakan Standard Layer,
Anda dapat merubahnya terlebih dahulu pada menu Layers.

• Anda dapat memilih format hasil ekspor gambar pada menu dropdown Format. Setelah itu klik
Download untuk men-download gambar dan simpan gambar pada folder yang diinginkan.

Tampilan Opsi untuk mengekspor peta OpenStreetMap dalam bentuk gambar

VII. Cara melihat riwayat perubahan pada OpenStreetMap

Ketika Anda mengedit objek atau membuat perubahan pada OpenStreetMap, Anda dapat melihat ri-
wayat pengeditan objek yang berada pada wilayah tersebut. Langkah-langkah untuk melihat riwayat
pengeditan adalah sebagai berikut:

• Anda dapat melihat informasi tersebut dengan mengklik tombol menu History di bagian kiri atas
peta.

• Setelah itu, akan muncul kolom Changesets di bagian bawah kotak Search dan akan muncul
kotak-kotak berwarna oranye pada peta yang menandakan area mana saja yang baru saja di-
lakukan pengeditan. Changeset merupakan versi setiap perubahan yang di-upload oleh setiap
pengguna OSM. Keterangan yang dapat kita lihat pada kolom Changesets adalah sebagai berikut:

1. Komentar changeset. Anda dianjurkan untuk mengisi kolom komentar singkat ketika meng-upload
perubahan/changeset. Komentar dapat berisikan keterangan perubahan apa saja yang dilakukan
atau hashtag tertentu.

2. Keterangan waktu upload.
3. Username OSM yang mengedit changeset.
4. Nomor changeset. Nomor ini merupakan nomor unik sebagai identitas changeset.
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Tampilan untuk melihat History pada OpenStreetMap

• Anda dapat klik salah satu changeset pada daftar changeset atau Anda dapat langsung memilih
kotak berwarna oranye pada peta. Setelah Anda memilih salah satu changeset, Anda akan men-
dapatkan detail informasi mengenai changeset tersebut.

Tampilan detail informasi pada changeset

VIII. Cara membuat akun OpenStreetMap

Anda telah melihat tampilan serta menu-menu utama dari situs OpenStreetMap, sekarang Anda akan
mempelajari bagaimana membuat akun di OpenStreetMap dan membuat kontribusi pertama di Open-
StreetMap. Berikut adalah langkah-langkahnya:

• Pada sebelah kanan atas dari situs OpenStreetMap, klik Sign Up. Anda akan melihat tampilan
seperti berikut:
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Tampilan awal membuat akun di OpenStreetMap

• Akan ada lima kotak yang harus Anda isi untuk mendaftarkan akun Anda di OSM. Pertama, ma-
sukkan alamat email Anda pada kotak pertama dan kotak kedua. Anda harus memasukkan ala-
mat email yang sama di kedua kotak tersebut. Fungsinya adalah untuk melakukan konfirmasi
akun Anda yang pesannya akan dikirim pada email yang telah Anda daftarkan.

• Pada kotak ketiga, masukkan tampilan nama yang akan Anda gunakan. Jika Anda mencoba
menggunakan nama Anda sebagai nama pengguna kemungkinan sudah ada yang menggunakan-
nya dan Anda tidak dapat menggunakan nama pengguna yang telah digunakan oleh pengguna
lain sebelumnya, jadi silahkan cari nama pengguna yang masih tersedia.

• Masukkan juga password yang Anda inginkan pada kotak keempat dan kelima. Anda harus
memasukkan kata sandi yang sama di kedua kotak dan kata kunci tersebut tidak harus sama
dengan kata kunci email Anda. Jika Anda sudah selesai mengisi kotak-kotak tersebut, klik Sign
Up di bagian bawah pada situs Anda.

Pada tahap ini, Anda telah berhasil mendaftarkan diri Anda pada situs OpenStreetMap, namun Anda
belum bisa mengaktifkan akun Anda. Untuk mengaktifkannya, langkah yang harus dilakukan adalah
sebagai berikut :

• Buka tab baru pada browser Anda dan silahkan buka email Anda.
• Masukkan alamat email dan kata kunci Anda.
• Jika berhasil, Anda seharusnya melihat email dari OpenStreetMap di kotak masuk email Anda.
• Buka email tersebut. Klik tautan seperti gambar di bawah ini.

Notifikasi Pendaftaran akun OSM yang muncul di email

• Sebuah tab baru akan otomatis muncul di browser Anda. Jika semuanya lancar, selamat Anda
sudah memiliki akun OSM!
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Catatan : Jika terjadi suatu masalah, akan ada sebuah pesan yang muncul. Pastikan bahwa
email yang Anda masukkan sama di dua kotak awal tadi begitu juga dengan kata sandi
Anda. Jika kotak untuk nama pengguna berwarna merah maka sudah ada orang lain yang
menggunakan nama tersebut dan Anda harus mencari nama lain.

• Pada halaman OpenStreetMap, klik Log In di pojok kanan atas. Masukkan nama pengguna Open-
StreetMap dan kata kunci Anda kemudian tekan Enter. Anda seharusnya bisa masuk dan Anda
akan melihat nama pengguna Anda di sebelah kanan atas dari situs OpenStreetMap.

Selamat! Jika semua tahapan dari bagian ini sudah Anda lakukan dengan baik maka Anda telah memiliki
akun OpenStreetMap serta sudah mengetahui dan bisa menavigasi situs OpenStreetMap.

VIII. Konsep dasar atribut OpenStreetMap

a. Konsep atribut pada objek

Ketika Anda menggambarkan objek berupa titik, garis, atau poligon pada OSM, Anda perlu menam-
bahkan informasi mengenai objek tersebut seperti, nama objek, alamat, ataupun informasi pendukung
lainnya. Informasi pada objek inilah yang akan membantu pengguna lain ketika menggunakan data
OSM untuk berbagai keperluan. Informasi yang diberikan pengguna pada objek OSM disebut dengan
atribut/tag.

Sebuah atribut/tag adalah seperti sebuah label yang Anda dapat letakkan ke suatu objek. Misalnya, jika
Anda menggambar sebuah persegi, ini hanya sebuah persegi tanpa ada informasi objek apa. Tetapi
Anda dapat menambahkan atribut untuk mendeskripsikannya, misalnya persegi ini adalah sebuah ban-
gunan; nama bangunan adalah “Rumah Sakit Tebet”; bangunan 10 tingkat.

b. Komponen pada data atribut OpenStreetMap

Anda dapat menambahkan sebanyak mungkin atribut/tag yang Anda inginkan ke sebuah objek. Atribut
disimpan sebagai sepasang teks, bernamaKey danValues. Keymerupakan informasi umum yang men-
jelaskan mengenai fungsi dari suatu objek. Dalam satu key, bisa terdiri atas banyak value. Misalnya
sekolah, masjid, dan rumah sakit memiliki key=amenity (amenitas/fasilitas penting). Walaupun ketiga
objek tersebut memiliki jenis fungsi yang berbeda, tapi ketiga objek memiliki key yang sama. Sedan-
gkan Values adalah informasi yang lebih spesifik menjelaskan jenis dari suatu objek. Karena value ini
menjelaskan informasi yang spesifik mengenai suatu objek, maka dalam 1 jenis value tersebut hanya
menjelaskan jenis objek itu sendiri. Tidak sama seperti key yang dapat menjelaskan beberapa informasi
mengenai objek tersebut. Pada OpenStreetMap, atribut ditambahkan dengan format sepasang key =
value dan berdasarkan keadaan objek sesungguhnya, contohnya seperti berikut:

Contoh atribut objek

Pada contoh diatas terdapat 4 macam atribut key & value, diantaranya key amenitas objek berupa
rumah sakit (amenity = hospital), objek bangunan (building = yes), bangunan tingkat 10 (building:levels
= 10) dan nama objek Rumah Sakit Tebet (name = Rumah Sakit Tebet).

c. Panduan referensi atribut OpenStreetMap di dunia dan Indonesia
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Dalam memberikan informasi terhadap objek yang dipetakan Anda perlu memastikan bahwa informasi
tersebut sudah benar dan sesuai dengan ketentuan dari OpenStreetMap. Untuk itu, Anda perlu memas-
tikan acuan yang benar apabila ingin memberikan atribut pada objek tertentu. OpenStreetMap telah
menyediakan halaman Wikipedia khusus yang dapat Anda jadikan acuan secara umum. Halaman
tersebut dapat Anda lihat pada halaman Wiki Map Features di https://wiki.openstreetmap.org/wiki/Map_
Features.

Tampilan awal halaman Wiki Map Features dan daftar tabel fitur

Halaman dariMap Features yang berisikan informasi terhadap objek-objek diOpenStreetMap dianggap
tidak cukup untuk membantu terutama untuk objek spesifik yang biasanya hanya terdapat di suatu ne-
gara termasuk di Indonesia. Seringkali para pengguna tidak mendapatkan informasi tag terhadap objek
yang mereka cari di Map Features ataupun melewatkan objek tersebut karena berbeda nama.

Biasanya objek di Indonesia memiliki nama lokal sendiri seperti posyandu, pesantren, dan lain-lain.
Anda tidak perlu kebingungan dalam mencari dan menghafal daftar atribut karena Anda dapat melihat
daftar atribut objek yang dapat Anda lihat di halaman Wikipedia https://wiki.openstreetmap.org/wiki/Id:
Indonesian_Tagging_Guidelines.

70

https://wiki.openstreetmap.org/wiki/Map_Features
https://wiki.openstreetmap.org/wiki/Map_Features
https://wiki.openstreetmap.org/wiki/Id:Indonesian_Tagging_Guidelines
https://wiki.openstreetmap.org/wiki/Id:Indonesian_Tagging_Guidelines


Tampilan awal halaman Wiki panduan referensi atribut objek Indonesia

Halaman Wikipedia tersebut dibuat khusus untuk memberikan referensi atribut objek-objek OSM yang
ada di Indonesia. Dalam halaman tersebut objek-objek yang ada akan dibagi ke dalam beberapa kate-
gori dimana akan disesuaikan dengan objek-objek yang ada di Indonesia.

Tampilan daftar tabel atribut objek Indonesia

RINGKASAN

Jika Anda dapat mengikuti dan mempraktekkan seluruh tahapan dalam bab ini, maka Anda telah berhasil
membuat akun OSM dan mengoperasikan dan menavigasikan situs OpenStreetMap. Selain itu, Anda
juga telah berhasil membagikan gambar peta OSM dan membagikan tautan ke orang lain. Pada bab
selanjutnya Anda akan mempelajari bagaimana cara menggunakan Java OpenStreetMap (JOSM).
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 — title: Menggunakan Aplikasi ODK Collect weight: 2 —

Tujuan Pembelajaran:

• Mampu menjelaskan ODK Collect sebagai salah satu alat mengambil data infrastruktur
• Mampu mengoperasikan cara pengaturan awal untuk aplikasi ODK Collect
• Mampu menerapkan cara penggunaan ODK Collect untuk pengumpulan data survei

I. Apa itu ODK Collect

Open Data Kit Collect (ODK Collect) merupakan aplikasi pengumpulan data di lapangan berbasis an-
droid. ODK Collect dapat menggantikan formulir survei dalam bentuk kertas menjadi bentuk digital.
Oleh karena itu, aplikasi ini dapat membantu kegiatan pemetaan dan pengumpulan data di lapangan
yang juga memungkinkan menyimpan informasi lokasi dan foto sekaligus.

II. Pengaturan awal untuk ODK Collect

a. Mengatur URL Server

Untuk mengambil formulir survei dari server untuk pertama kalinya, pengguna perlu mengatur URL
server. Langkah-langkah mengatur URL server adalah sebagai berikut:

• Buka aplikasi ODK Collect dan tekan tombol titik tiga di pojok kanan atas, pilih General Settings
→ Server

“server”

Menu pilihan untuk memasukkan alamat URL pada ODK Collect

• Ketikkan alamat Server URL pada pilihan isian URL→ OK

72



“Langkah untuk memasukkan alamat URL pada ODK Collect”

Langkah untuk memasukkan alamat URL pada ODK Collect

b. Mengatur ukuran gambar

Selain titik lokasi, Anda juga dapat mengambil foto sebagai keterangan tambahan. Anda dapat men-
gatur resolusi gambar sesuai keinginan. Namun, resolusi gambar juga akan mempengaruhi jumlah
kapasitas memori atau file yang akan di-upload ke server nantinya. Disarankan agar Anda memilih
resolusi gambar terkecil saat pengaturan awal. Langkah-langkahnya adalah sebagai berikut:

• Tekan tombol titik tiga di pojok kanan atas dan pergi ke General Settings → Form Management.

“Menu pilihan untuk mengatur resolusi gambar”
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Menu pilihan untuk mengatur resolusi gambar

• Pilih Image Size lalu pilih pilihan Very Small (640px).

“Menu pilihan Image Size untuk menentukan besar resolusi gambar”

Menu pilihan Image Size untuk menentukan besar resolusi gambar

III. Pengoperasian dasar ODK Collect

a. Cara mengambil formulir survei kosong dari server

Sebelum Anda mengisi formulir survei yang telah dibuat sebelumnya, Anda perlu mengambil atau men-
download formulir survei kosong dari server yang telah ditentukan. Untuk penjelasan lebih lanjut ten-
tang pembuatan formulir survei di ODK, Anda dapat mempelajari modul Membuat Form Survei untuk
aplikasi ODK & OMK. Langkah-langkah untuk mengambil survei kosong dari server adalah sebagai
berikut:

• Tekan Get Blank Form dan tunggu formulir ter-download dari server dan pastikan internet Anda
telah aktif.
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“Pilihan Get Blank Form untuk mengambil formulir pada
server”

Pilihan Get Blank Form untuk mengambil formulir pada server

• Pilih formulir yang telah tersedia dengan tekan tanda centang di samping formulir atau jika memilih
semua formulir pilih Select All. Jika formulir Anda tidak muncul, Anda dapat tekan Refresh untuk
memuat ulang halaman.
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“Tampilan halaman pada menu Get Blank Form”

Tampilan halaman pada menu Get Blank Form

• Setelah Anda memilih formulir yang diinginkan, Anda dapat tekan Get Selected untuk men-
download formulir yang sudah terpilih.
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“Tampilan halaman pada pilihan Get Blank Form untuk
mengambil formulir survei”

Tampilan halaman pada pilihan Get Blank Form untuk mengambil formulir survei

b. Mengisi formulir survei * Untuk mengisi formulir, kembali ke halaman awal dan pilih menu Fill Blank
Form. Lalu pilih salah satu formulir kosong yang ingin Anda isi pada daftar formulir survei.
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“Pilihan Fill Blank Form untuk mengisi formulir survei dan daftar formulir survei kosong”

Pilihan Fill Blank Form untuk mengisi formulir survei dan daftar formulir survei kosong

• Geser layar ke kanan atau ke kiri untuk berpindah halaman pengisian formulir dan untuk berpindah
ke isian formulir selanjutnya. Pertanyaan yang mempunyai tanda bintang merah di sisi kiri atas
merupakan pertanyaan yang wajib diisi dan tidak dapat dilewati apabila jawaban kosong.
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“Contoh pertanyaan yang wajib diisi tanda
bintang merah”

Contoh pertanyaan yang wajib diisi (tanda bintang merah)

• Anda dapat mengambil foto langsung dengan tekan pilihan Take Picture atau pilih foto dari galeri
foto Anda dengan memilih pilihan Choose Image.
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“Tampilan halaman pertanyaan pada for-
mulir untuk mengambil foto”

Tampilan halaman pertanyaan pada formulir untuk mengambil foto

• Untuk menambahkan titik lokasi objek sekaligus tag OSM pada objek, Anda dapat menggunakan
aplikasi tambahan yaitu OpenMapKit (OMK). Anda dapat langsung beralih ke aplikasi OMK den-
gan cara menekan tombol Launch OpenMapKit pada formulir. Anda dapat mempelajari penggu-
naan aplikasi OMK lebih lanjut pada modul Menggunakan Aplikasi OpenMapKit.
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“Tombol Launch OpenMapKit pada for-
mulir survei”

Tombol Launch OpenMapKit pada formulir survei

• Di akhir formulir Anda dapat memberi nama pada formulir, beri centang Mark form as finalized
dan di akhir tekan Save Form and Exit untuk finalisasi akhir formulir survei.
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“Tampilan halaman finalisasi akhir pada
formulir survei”

Tampilan halaman finalisasi akhir pada formulir survei

c. Mengubah formulir survei yang sudah diisi

Formulir yang telah disimpan akan otomatis tersimpan pada aplikasi ODK Collect. Apabila Anda ingin
mengedit kembali formulir yang telah diisi Anda dapat melakukan langkah sebagai berikut:

• Anda dapat kembali ke halaman awal dan tekan pilihan Edit Saved Form.
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“Pilihan Edit Saved Form untuk mengubah formulir
survei”

Pilihan Edit Saved Form untuk mengubah formulir survei

• Pilih formulir dengan cara tekan pada formulir yang akan Anda ubah dan lakukan perubahan pada
formulir tersebut.
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“Tampilan halaman Edit Saved Form un-
tuk memilih formulir yang akan diubah”

Tampilan halaman Edit Saved Form untuk memilih formulir yang akan diubah

• Setelah itu, simpan formulir dengan cara tekan ikon disket untuk simpan perubahan pada formulir
survei.
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“Tampilan formulir survei yang sudah diisi dan ikon untuk simpan perubahan formulir”

Tampilan formulir survei yang sudah diisi dan ikon untuk simpan perubahan formulir

d. Mengupload formulir survei ke server

Setelah Anda mengisi dan menyimpan formulir, langkah selanjutnya ialah meng-upload atau upload
formulir tersimpan ke server. Langkah-langkah untuk meng-upload formulir ke server adalah sebagai
berikut:

• Untuk meng-upload formulir survei kembali ke server, Anda dapat memilih pilihan Send Finalized
Form pada halaman awal.
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“Pilihan Send Finalized Form untuk mengupload for-
mulir survei ke server”

Pilihan Send Finalized Form untuk mengupload formulir survei ke server

• Pada halaman tersebut tersimpan formulir survei yang telah disimpan dan siap dikirim. Anda dapat
memilih Select All untuk memilih semua formulir terlebih dahulu.

• Pastikan Anda telah terhubung di internet. Lalu tekan Send Selected dan tunggu sampai proses
upload formulir selesai.
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“Tampilan formulir survei yang siap dikirim pada pilihan
Send Finalized Form”

Tampilan formulir survei yang siap dikirim pada pilihan Send Finalized Form

• Semua formulir yang telah berhasil ter-upload akan tersimpan di menu pilihan View Sent Form
dan ikon formulir sudah berubah warna menjadi hijau.
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“Pilihan View Sent Form dan formulir survei yang telah berhasil di-upload ke server”

Pilihan View Sent Form dan formulir survei yang telah berhasil di-upload ke server

• Setelah Anda selesai meng-upload formulir ke server, Anda dapat menghapus formulir pada menu
pilihan Delete Saved Form.
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“Pilihan Delete Saved Form untuk menghapus for-
mulir”

Pilihan Delete Saved Form untuk menghapus formulir

• Anda dapat menghapus formulir yang sudah diisi pada pilihan Saved Forms dan menghapus
formulir yang kosong pada pilihan Blank Forms. Anda perlu memilih formulir yang akan dihapus
atau pilih Select All untuk memilih semua formulir lalu tekan Delete Selected untuk menghapus
formulir yang sudah terpilih.
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“Tampilan pilihan Delete Saved Form”

Tampilan pilihan Delete Saved Form

• Selanjutnya Anda perlu mengkonfirmasi untuk menghapus formulir survei dengan tekan Delete
Forms.
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“Kotak dialog untuk konfirmasi hapus for-
mulir”

Kotak dialog untuk konfirmasi hapus formulir

e. Meng-upload formulir survei ke Google Drive

Setelah Anda meng-upload semua formulir survei kembali ke server, Anda perlu menyimpan dan meng-
upload file hasil survei dalam format .zip ke dalam folder diGoogle Drive yang telah dibuat olehMapping
Supervisor. Langkah-langkahnya adalah sebagai berikut:

• Pergi ke File Manager atau File Explorer pada smartphone Anda dan buka penyimpanan internal
Anda. Kemudian buka folder dengan nama odk yaitu folder yang berisikan semua file hasil survei
yang tersimpan pada aplikasi ODK Collect. Lalu tekan folder instances yang berisi folder yang
didalamnya terdapat file *.osm objek hasil survei.
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“Folder instances di dalam folder odk dan isi folder instances hasil survei”

Folder instances di dalam folder odk dan isi folder instances hasil survei

• Sebelum memindahkan folder instances ke dalam folder komputer Anda, Anda perlu mengubah
folder instances tersebut menjadi format .zip dengan cara tekan pada folder instances dan tekan
Compress dan Anda dapat ubah nama file .zip tersebut.

92



“Langkah untuk kompresi file menjadi format zip”

Langkah untuk kompresi file menjadi format *.zip

• Setelah itu Anda dapat memindahkan file .zip ke dalam komputer dan Anda dapat meng-upload
file tersebut ke folder Google Drive yang telah disediakan oleh Mapping Supervisor.
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“File zip yang siap untuk dipindahkan ke
komputer”

File .zip yang siap untuk dipindahkan ke komputer

• Anda dapat meng-upload file ke folder Hasil survei dengan cara klik kanan pada mouse lalu pilih
Upload Files dan pilih file yang ingin Anda upload.
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“Tampilan folder pada Google Drive untuk upload file zip”

Tampilan folder pada Google Drive untuk upload file .zip

RINGKASAN

Jika Anda dapat mengikuti dan memperhatikan seluruh tahapan dalam bab ini, maka Anda telah berhasil
memahami penggunaan aplikasiODK Collect sebagai salah satu alat untuk pengumpulan data di lapan-
gan. Selain itu, Anda juga telah berhasil menerapkan pengoperasian cara pengaturan awalODKCollect
dan cara penggunaan ODK Collect untuk mengambil data lapangan. Nantinya, Anda akan mempelajari
alat pengumpulan data di lapangan yang lain yaitu aplikasi OpenMapKit (OMK).
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 — title: Model Data OpenStreetMap weight: 2 —

Tujuan Pembelajaran:

• Memahami konsep tag, key, dan value di OpenStreetMap
• Mengenal halaman Wikipedia OpenStreetMap untuk melihat key dan value
• Memahami objek yang dapat dipetakan di dalam OpenStreetMap
• Mengetahui dan memahami model data sebagai rencana persiapan pemetaan
• Mengecek penggunaan key dan value tertentu di Situs TagInfo

Dalam modul ini, Anda akan mempelajari tentang konsep key dan value yang ada di OpenStreetMap
(OSM) kemudian anda juga akan mengetahui tentang model data yang ada di OSM. Pemahaman ter-
hadap pembuatan model data akan memudahkan Anda dalam melakukan kegiatan pemetaan, mulai
dari kegiatan perencanaan, survei lapangan, hingga pengambilan data hasil pemetaan. Anda juga akan
mempelajari beberapa situs yang dapat memudahkan Anda dalam menemukan informasi yang Anda
butuhkan sesuai dengan key dan value yang ada di OpenStreetMap.

I. Pengenalan Konsep Tag, Key, dan Value

Di OpenStreetMap setiap objek digambarkan dalam tipe data dan informasi tertentu. Tipe data di Open-
StreetMap ada 3 yaitu: titik (Nodes), garis (Ways), dan area (Polygon/Relation). Setiap tipe data OSM
terdiri dari beberapa informasi objek yang disebut dengan Tag yang dimana terdiri dari key dan value.

Terdapat objek yang merupakan sebuah sekolah oleh karena itu objek tersebut harus diberikan Tag
sebagai sebuah sekolah. Dalam tag tersebut terdapat beberapa informasi lebih rinci yang membuat
sekolah itu memiliki informasi khusus yang akan membedakannya dengan sekolah-sekolah yang lain
seperti nama, alamat, jumlah tingkat, jenis sekolah, dll. Informasi-informasi tersebut disebut dengan
Key sedangkan untuk nilai masing-masing informasi disebut dengan Value.

Sebagai contoh Tag Sekolah:

nama=SDN Kebon Manggis 11 Pagi
alamat= Jalan Slamet Riyadi II.

Dalam contoh di atas “nama dan alamat” adalah Key sedangkan “SDN Kebon Manggis 11 Pagi dan
Jalan Slamet Riyadi II” merupakan Value. Untuk penjelasan lebih lanjut silahkan lihat gambar di bawah
ini:
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Contoh key dan value di data OpenStreetMap

Seperti yang dapat Anda lihat pada gambar di atas, key dan value yang digunakan adalah Bahasa
Inggris karena itu merupakan aturan baku yang telah ditetapkan untuk semua data yang ada di Open-
StreetMap. Anda tidak diharuskan untuk mengingat semua key dan value yang ada. Anda dapat men-
emukan key dan value yang disesuaikan dengan kebutuhan pemetaan di halaman wikipedia Open-
StreetMap yang akan dibahas di sub-bab selanjutnya.

II. Wikipedia OpenStreetMap untuk Melihat Key and Value

Sebagai salah satu platform peta partisipatif yang ada di dunia, OpenStreetMap memiliki jutaan peng-
guna di seluruh dunia. Oleh karena itu, untuk menghasilkan data serta informasi yang akurat di Open-
StreetMap, kontributor OpenStreetMap membuat berbagai macam aturan serta standar yang telah dis-
epakati bersama-sama oleh para pengguna OpenStreetMap. Aturan dan standar tersebut dituangkan
ke dalam platform berupa halaman wikipedia yang merupakan ensiklopedia yang bersifat bebas dan
terbuka.

a. Wikipedia OpenStreetMap Global

Penjelasan tentang objek serta daftar key dan value yang ada di data OSM telah dibuat di dalam
satu halaman khusus pada OSM Wikipedia yang disebut Map Feature. Di halaman ini Anda dapat
melihat berbagai macam daftar objek yang dapat dipetakan di dalam OSM serta informasi key dan
value yang menggambarkan objek di seluruh dunia. Untuk mengaksesnya silahkan buka di https:
//wiki.openstreetmap.org/wiki/Map_Features
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Tampilan situs wikipedia OpenStreetMap map feature

Setiap key dan value yang ada di halamanMap Features adalah hal yang tidak dapat Anda ubah ataupun
edit sesuai keinginan Anda. Jadi, halaman ini merupakan panduan untuk para pengguna OSM di selu-
ruh dunia. Anda dapat menelusuri seluruh halaman Map Features ini untuk mencari segala macam
informasi objek yang Anda ingin ketahui.

b. Wikipedia OpenStreetMap Indonesia

Jumlah pengguna OSM di Indonesia terus mengalami peningkatan dalam beberapa tahun terakhir. Se-
bagai salah satu pengguna OSM terbesar di dunia, Indonesia tentu akan membutuhkan informasi key
dan value khususnya yang informasinya sesuai dengan kondisi di Indonesia. Akan tetapi, pada keny-
ataannya dalam pemetaan biasanya mereka mengalami kesulitan untuk memberikan Tag yang sesuai
dengan objek yang hanya ada di Indonesia. Informasi yang ditampilkan di Map Features sangat be-
ragam dan banyak jumlahnya sehingga seringkali untuk pengguna OSM di Indonesia sulit untuk meli-
hat serta menemukan informasi terkait objek yang ada di area pemetaan mereka. Selain itu, banyak
nama-nama objek yang sifatnya global sehingga tidak dapat dipahami dengan baik oleh para pengguna
OpenStreetMap di Indonesia. Oleh karena itu Humanitarian OpenStreetMap Team (HOT) Indonesia
membuat halaman wikipedia khusus untuk objek-objek yang ada di Indonesia sebagai panduan untuk
para pengguna OSM di Indonesia.

Perbedaan mendasar antara halaman Map Features dan wikipedia Panduan Objek OSM di Indone-
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sia adalah daftar objek-objek yang ditampilkan di halaman wikipedia Panduan Objek OSM semuanya
hanya objek-objek yang ada di Indonesia tetapi tidak ada di halaman Map Features. Sebagai contoh,
informasi terhadap sekolah SD, SMP dan SMA yang merupakan informasi umum dan penting di Indone-
sia serta fasilitas kesehatan yang beragam mulai dari rumah sakit, puskesmas, posyandu serta klinik.
Oleh karena itu, objek-objek serta informasi tersebut dimasukkan ke dalam halaman wikipedia Pand-
uan Objek OSM di Indonesia. Contoh lainnya adalah jika Anda menemukan informasi nama objek yang
berbeda misalnya di dalam panduan Map Features “toko kelontong” dinamakan kios maka di Panduan
Objek OSM Indonesia akan dinamakan “warung”. Hal ini dikarenakan nama “warung” lebih dikenal dan
mudah dipahami untuk orang Indonesia dibandingkan dengan kios.

Anda dapat melihat daftar objek-objek panduan OSM di Indonesia dengan mengakses tautan sebagai
berikut: https://wiki.openstreetmap.org/wiki/Id:Indonesian_Tagging_Guidelines

Halaman wiki panduan objek titik (atas) dan garis (bawah) di OSM Indonesia

III. Objek-Objek Pemetaan di OpenStreetMap

a. Tipe Data di OpenStreetMap

Pada modul ini telah dijelaskan sebelumnya mengenai tipe data OpenStreetMap, yang terdiri dari titik
(Nodes), garis (Ways) dan area (Polygon/Relation). Berikut akan diberikan penjelasan lebih rinci men-
genai tipe data tersebut. * Titik (Nodes)

Titik biasanya digunakan untuk menggambarkan posisi atau lokasi dari suatu objek tertentu. Sebagai
contoh objek yang dapat digambarkan berbentuk titik di OpenStreetMap yaitu lampu merah, Saluran
Pengisian Bahan Bakar Umum (SPBU), ataupun rumah makan yang berada di dalam suatu mall atau
pusat perbelanjaan.
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Contoh objek titik (nodes) di OSM

• Garis (Ways)

Garis adalah bentuk yang terdiri dari beberapa titik (nodes) yang saling terhubung satu sama lain. Be-
berapa contoh objek garis di OpenStreetMap yaitu jalan, sungai, rel kereta, dan batas administrasi.

Contoh objek garis (ways) di OSM

• Area (Polygon)
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Area merupakan bentuk dari beberapa garis (ways) yang saling terhubung dan tertutup. Beberapa
contoh objek area di OpenStreetMap yaitu bangunan, taman, penggunaan lahan dan danau/waduk.

Contoh objek area (polygon) di OSM

b. Objek Pemetaan di Kegiatan Pemetaan HOT-PDC InAWARE
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Dalam pemetaan di OpenStreetMap Anda dapat memetakan segala macam objek yang ada di per-
mukaan bumi yang bersifat nyata (real) dan tetap / permanen. Objek yang bersifat nyata artinya objek
tersebut memiliki wujud dan dapat dilihat bentuknya oleh mata manusia seperti bangunan atau jalan
sedangkan objek yang tidak nyata adalah objek yang tidak memiliki bentuk fisik dan tidak dapat dilihat
oleh mata manusia seperti ketinggian ataupun kepadatan penduduk. Kemudian objek bersifat permanen
artinya objek yang dipetakan tidak berpindah-pindah tempat dan memiliki lokasi yang tetap sedangkan
objek tidak permanen merupakan objek yang hanya ada sementara atau pada waktu tertentu seperti
warung kaki lima di pinggir jalan.

Memilih objek yang akan dipetakan di dalamOpenStreetMap tergantung dari tujuan pemetaan itu sendiri.
Tujuan pemetaan di dalam kegiatan HOT-PDC InAWARE adalah untuk melengkapi infrastruktur publik
yang memiliki peran penting dalam kegiatan manajemen kebencanaan. Berikut adalah objek-objek yang
dipetakan ke dalam OpenStreetMap dalam pemetaan HOT-PDC InAWARE:

1.Fasilitas Ekonomi

• Pasar
• Supermarket
• Bank

2. Fasilitas Pendidikan

• Universitas
• Sekolah Tinggi
• Sekolah (SD, SMP, SMA)
• Taman Kanak-Kanak

3. Fasilitas Kesehatan

• Rumah Sakit
• Klinik

4. Infrastruktur Komunikasi

• Tower Komunikasi

5. Layanan Kedaruratan

• Kantor Polisi
• Kantor Pemadam Kebakaran
• Tempat Evakuasi
• Hidran Air

6. Kantor Pemerintahan

• Kantor Pemerintah (Kantor Gubernur, Kantor Walikota, Kantor Kantor Kecamatan, Kantor Kelura-
han, dan Kantor RW)

• Kedutaan Besar
• Instansi Pemerintah (Kementrian dan Lembaga)

7. Infrastruktur Kelistrikan

• Tower Listrik
• Gardu Listrik
• Pembangkit Listrik

8. Sarana Transportasi

• Bandar Udara
• Terminal Bis
• Stasiun Kereta
• Pelabuhan/Dermaga

9. Fasilitas Publik

• Tempat Ibadah (Masjid, Musala, Gereja, Capel, Pura, Vihara)
• Fasilitas Olahraga (GOR, Stadium, Lapangan Olahraga, Ruang Terbuka Hijau)
• Ruang Publik Terpadu Ramah Anak (RPTRA)
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10. Sarana Perairan

• Menara Air
• Pintu Air
• Rumah Pompa
• Tanggul
• Sungai
• Waduk / Danau

11. Stasiun Pengisian Bahan Bakar Umum (SPBU)

12. Batas Wilayah Administrasi

• Batas Kota
• Batas Kecamatan
• Batas Kelurahan
• Batas RW

13. Jaringan Jalan

IV. Model Data Pemetaan di OpenStreetMap

Model data adalah beberapa informasi yang terdapat dalam sebuah objek dimana merupakan gabun-
gan dari beberapa key dan value yang telah disepakati sebelum kegiatan pemetaan dilakukan. Sebuah
model data tidak memiliki bentuk baku karena informasi yang ingin diambil akan disesuaikan sesuai
dengan kebutuhan kegiatan pemetaan. Sebagai contoh dalam melakukan pemetaan sekolah, jika Anda
ingin mengumpulkan informasi nama sekolah, alamat sekolah, jenis sekolah, pengelola sekolah, jum-
lah tingkat sekolah maka model data yang akan Anda buat adalah seperti berikut:

Tabel Tag Informasi Sekolah

key (possible) values

amenity school
building school
school:type_idn sd [SD/MI (Elementary School)], smp [SMP/MTs

(Junior High School)], sma [SMA/SMK/MA
(Senior High School)]

name (nama bangunan)
addr:full (alamat)
operator:type government (Pemerintah), private (Swasta),

community (Komunitas/Masyarakat)
building:levels (jumlah lantai)

amenity=school merupakan informasi yang wajib ada untuk informasi sekolah. Key dan value ini meru-
pakan informasi utama yang menandakan bahwa objek tersebut merupakan sebuah sekolah.

building=school merupakan informasi yang menunjukkan bahwa sekolah tersebut merupakan sebuah
bangunan yang berdiri sendiri dan tidak menumpang di bangunan yang lain. Jika sekolah tersebut
menumpang di bangunan lain yang fungsinya bukan sekolah maka key dan value ini tidak perlu dima-
sukkan.

a. Model Data di Kegiatan Pemetaan HOT-PDC InAWARE

Pemetaan HOT-PDC InAWARE memiliki tujuan untuk mengumpulkan beberapa informasi terhadap
masing-masing objek yang akan dipetakan. Oleh karena itu, Anda membutuhkan model data yang
dapat membantu tim surveyor untuk melakukan pemetaan di lapangan dan input data ke dalam Open-
StreetMap. Berikut adalah contoh model data untuk masing-masing objek dalam kegiatan Pemetaan
HOT-PDC InAWARE:

Keterangan Warna:
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• Warna biru artinya key dan value tersebut wajib dimiliki oleh objek tersebut.
• Warna merah artinya key dan value merupakan informasi khusus untuk bangunan. Jika ob-

jek tersebut memiliki bangunan sendiri maka informasi tersebut perlu dimasukkan, jika objek
menumpang di bangunan lain dengan fungsi yang berbeda maka informasi tersebut tidak perlu
dimasukkan.

• Warna hitam artinya key dan value tersebut sebaiknya dimasukkan ke dalam objek pemetaan baik
objek tersebut memiliki bangunan sendiri ataupun menumpang di bangunan yang lain.

1.Fasilitas Ekonomi

• Tabel Model Data Pasar

key possible values

amenity marketplace
building marketplace
name (nama pasar)
addr:full (alamat)
addr:city (kota pemetaan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

• Tabel Model Data Supermarket

key possible values

amenity supermarket
building supermarket
name (nama supermarket)
addr:full (alamat)
addr:city (kota pemetaan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)
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key possible values

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

• Tabel Model Data Bank

key possible values

amenity bank
building bank
name (nama bank)
addr:full (alamat)
addr:city (kota pemetaan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

2. Fasilitas Pendidikan

• Tabel Model Data Universitas

key possible values

amenity university
building university
name (nama universitas)
addr:full (alamat)
addr:city (kota pemetaan)
operator:type government (Pemerintah), private (Swasta),

community (Komunitas/Masyarakat)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)
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key possible values

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
water_source water_works (PDAM), manual_pump (Pompa

Tangan), powered_pump (Mesin Pompa)
kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

• Tabel Model Data Sekolah Tinggi

key possible values

amenity college
building college
name (nama sekolah tinggi)
addr:full (alamat)
addr:city (kota pemetaan)
operator:type government (Pemerintah), private (Swasta),

community (Komunitas/Masyarakat)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
water_source water_works (PDAM), manual_pump (Pompa

Tangan), powered_pump (Mesin Pompa)
kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

• Tabel Model Data Sekolah (SD, SMP, SMA)
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key possible values

school:type_idn sd [SD/MI (Elementary School)], smp [SMP/MTs
(Junior High School)], sma [SMA/SMK/MA
(Senior High School)]

amenity school
building school
name (nama sekolah)
addr:full (alamat)
addr:city (kota pemetaan)
operator:type government (Pemerintah), private (Swasta),

community (Komunitas/Masyarakat)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height tinggi bangunan dari jalan dalam satuan meter
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
water_source water_works (PDAM), manual_pump (Pompa

Tangan), powered_pump (Mesin Pompa)
kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

• Tabel Model Data Taman Kanak-Kanak

key possible values

amenity kindergarten [PAUD/ Play Group / TK (Early
education / Play group / Kindergarten)]

building kindergarten
name (nama taman kanak-kanak)
addr:full (alamat)
addr:city (kota pemetaan)
operator:type government (Pemerintah), private (Swasta),

community (Komunitas/Masyarakat)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)
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key possible values

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

3. Fasilitas Kesehatan

• Tabel Model Data Rumah Sakit

key possible values

amenity hospital
name (nama rumah sakit)
addr:full (alamat)
addr:city (kota pemetaan)
operator:type government (Pemerintah), private (Swasta),

community (Komunitas/Masyarakat)
building hospital
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
water_source water_works (PDAM), manual_pump (Pompa

Tangan), powered_pump (Mesin Pompa)
kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

• Tabel Model Data Klinik, Puskesmas, Posyandu

key possible values

amenity clinic (Klinik / Puskemas / Posyandu)
name (nama klinik)
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key possible values

addr:full (alamat)
addr:city (kota pemetaan)
operator:type government (Pemerintah), private (Swasta),

community (Komunitas/Masyarakat)
building clinic
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
water_source water_works (PDAM), manual_pump (Pompa

Tangan), powered_pump (Mesin Pompa)
kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

4. Infrastruktur Komunikasi

• Tabel Model Data Tower Komunikasi

key possible values

man_made tower
tower:type communication
name (nama tower)
height (tinggi tower dalam meter)
operator Telkomsel, Indosat, XL, Tri, Smartfren
communication:mobile yes (Ada), no (Tidak ada)
communication:radio yes (Ada), no (Tidak ada)
addr:city (kota pemetaan)
source HOT_InAWARESurvey_2018

5. Layanan Kedaruratan

• Tabel Model Data Kantor Polisi

key possible values

amenity police
building police
name (nama kantor polisi)
addr:full (alamat)
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key possible values

addr:city (kota pemetaan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

• Tabel Model Data Kantor Pemadam Kebakaran

key possible values

amenity fire_station
building fire_station
name (nama kantor pemadam kebakaran)
addr:full (alamat)
addr:city (kota pemetaan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

• Tabel Model Data Hidran Air

key possible values

emergency fire_hydrant
fire_hydrant:type underground (bawah tanah), pillar (pilar), wall

(dinding), pond (kolam)
name (nama hidran)
operator (nama operator)
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key possible values

addr:city (kota pemetaan)
source HOT_InAWARESurvey_2018

6. Kantor Pemerintahan

• Tabel Model Data Kantor Pemerintah (Kantor Gubernur, Kantor Walikota, Kantor Camat, Kantor
Lurah, Kantor RW)

key possible values

office government
building governor_office (Kantor Gubernur), townhall

(Kantor Bupati / Walikota), subdistrict_office
(Kantor Camat), village_office (Kantor Desa /
Lurah), community_group_office (Balai Warga /
Kantor RW)

admin_level 4 (Kantor Gubernur), 5 (Kantor Bupati /
Walikota), 6 (Kantor Kecamatan), 7 (Kantor
Desa / Keluruhan), 9 (Kantor RW)

name (nama kantor pemerintahan)
addr:full (alamat)
addr:city (kota pemetaan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
water_source water_works (PDAM), manual_pump (Pompa

Tangan), powered_pump (Mesin Pompa)
kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

• Tabel Model Data Instansi Pemerintah (Kementrian dan Lembaga)

key possible values

office government
building government_office
name (nama instansi pemerintahan)
addr:full (alamat)
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key possible values

addr:city (kota pemetaan)
admin_level 4 (Provinsi), 5 (Kabupaten/Kota), 6

(Kecamatan), 7 ( Desa / Keluruhan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

7. Infrastruktur Kelistrikan

• Tabel Model Data Tower Listrik

key possible values

power tower
name (nama tower)
addr:city (kota pemetaan)
operator PT Perusahaan Listrik Negara
source HOT_InAWARESurvey_2018

• Tabel Model Data Gardu Listrik

key possible values

power substation
substation transmission (Gardu Induk), distribution (Gardu Distribusi)
building power_substation
name (nama gardu listrik)
addr:city (kota pemetaan)
rating (ditentukan pengguna)
operator PT Perusahaan Listrik Negara
source HOT_InAWARESurvey_2018

• Tabel Model Data Pembangkit Listrik

key possible values

power plant
building power_plant
name (nama pembangkit listrik)
operator (nama operator)
addr:city (kota pemetaan)
addr:full (alamat)
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key possible values

source HOT_InAWARESurvey_2018

8. Sarana Transportasi

• Tabel Model Data Bandar Udara

key possible values

amenity aerodrome
building aerodrome
name (nama bandar udara)
addr:full (alamat)
addr:city (kota pemetaan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

• Tabel Model Data Terminal Bis

key possible values

amenity bus_station
name (nama terminal bis)
addr:full (alamat)
addr:city (kota pemetaan)
source HOT_InAWARESurvey_2018

• Tabel Model Data Stasiun Kereta

key possible values

amenity station
name (nama stasiun kereta)
ele (ketinggian di atas permukaan laut)
operator PT Kereta Api Indonesia
addr:full (alamat)
addr:city (kota pemetaan)
source HOT_InAWARESurvey_2018

• Tabel Model Data Pelabuhan/Dermaga
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key possible values

amenity ferry_terminal
building ferry_terminal
name (nama dermaga)
addr:full (alamat)
addr:city (kota pemetaan)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

9. Fasilitas Publik

• Tabel Model Data Tempat Ibadah (Masjid, Musala, Gereja, Capel, Pura, Vihara)

key possible values

amenity place_of_worship
religion muslim, christian, hindu, buddhist, confucian
name (nama tempat ibadah)
addr:full (alamat)
addr:city (kota pemetaan)
building mosque (Masjid), church (Gereja), temple

(Pura), temple (Vihara), temple (Klenteng)
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
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key possible values

water_source water_works (PDAM), manual_pump (Pompa
Tangan), powered_pump (Mesin Pompa)

kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

• Tabel Model Data Fasilitas Olahraga (GOR,Lapangan Olahraga, Stadium)

key possible values

leisure stadium (Stadion), sports_centre (Pusat
Kegiatan Olahraga / GOR), pitch (Lapangan
Olahraga)

building stadium, sports_centre, yes (futsal field)
name (nama fasilitas olahraga)
addr:full (alamat)
addr:city (kota pemetaan)
sport soccer,futsal,basketball,badminton,tennis,volleyball,swimming,athletics,

baseball,cycling, multi
capacity:persons <50, 50-100, 100-250, 250-500, >500
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
water_source water_works (PDAM), manual_pump (Pompa

Tangan), powered_pump (Mesin Pompa)
kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

• Tabel Model Data Taman

key possible values

leisure park
name (nama taman)
addr:full (alamat)
addr:city (kota pemetaan)
source HOT_InAWARESurvey_2018
evacuation_center yes (Ya), no (Bukan)
shelter_type tent (Tenda), building (Bangunan)
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key possible values

water_source water_works (PDAM), manual_pump (Pompa
Tangan), powered_pump (Mesin Pompa)

kitchen:facilities yes (Ada), no (Tidak ada)
toilet:facilities yes (Ada), no (Tidak ada)
toilets:number (jumlah toilet)

10. Sarana Perairan

• Tabel Model Data Menara Air

key possible values

man_made water_tower
name (nama tower)
operator (nama operator)
addr:city (kota pemetaan)
source HOT_InAWARESurvey_2018

• Tabel Model Data Pintu Air

key possible values

waterway floodgate
name (nama pintu air)
operator (nama operator)
floodgate:unit (jumlah pintu air)
elevation (ketinggian di atas permukaan laut)
condition good (baik), poor (buruk)
addr:city (kota pemetaan)
source HOT_InAWARESurvey_2018

• Tabel Model Data Rumah Pompa

key possible values

man_made pumping_station
building pumping_station
name (nama rumah pompa)
addr:full (alamat)
addr:city (kota pemetaan)
operator (nama operator)
pump:unit (jumlah pompa)
elevation (ketinggian di atas permukaan laut)
capacity:persons (kapasitas pompa (l/s))
building:levels (jumlah lantai)
building:structure confined_masonry (Rangka beton bertulang),

steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:material brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)
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key possible values

access:roof yes (Ada), no (Tidak ada)
building: condition poor (Buruk), good (Baik)
ground_floor:height (tinggi bangunan dari jalan dalam satuan meter)
backup_generator yes (Ada), no (Tidak ada)
source HOT_InAWARESurvey_2018

• Tabel Model Data Tanggul

key possible values

man_made embankment
name (nama tanggul)
material concrete (Benton), stone (Batu), soil (Tanah), sand (Pasir)
source HOT_InAWARESurvey_2018

• Tabel Model Data Sungai

key possible values

waterway river (Sungai), riverbank (Badan sungai), canal (Kanal)
name (nama sungai)
width (lebar sungai)
source HOT_InAWARESurvey_2018

• Tabel Model Data Waduk / Danau

key possible values

landuse reservoir
name (nama waduk/danau)
operator (nama operator)
addr:city (kota pemetaan)
source HOT_InAWARESurvey_2018

11. Stasiun Pengisian Bahan Bakar Umum (SPBU)

• Tabel Model Data SPBU

key possible values

amenity fuel
name (nama SPBU)
addr:full (alamat)
addr:city (kota pemetaan)
operator (PT Pertamina, Shell, etc)
source HOT_InAWARESurvey_2018

12. Batas Wilayah Administrasi

key possible values

type boundary
boundary administrative
name (nama batas admin)
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key possible values

admin_level 4 (Provinsi), 5 (Kota / Kotamadya / Kabupaten),
6 (Kecamatan), 7 (Kelurahan / Desa), 8
(Dusun), 9 (RW), 10 (RT)

is_in:province (nama provinsi)
is_in:city (Kota) / is_in:town (Kabupaten) (nama kota/kabupaten)
is_in:municipality (nama kecamatan)
is_in:village (nama kelurahan)
is_in:RW (nama rw)
flood_prone *khusus untuk relasi RW yes (Iya), no (Tidak)
landslide_prone *khusus untuk relasi RW yes (Iya), no (Tidak)
source HOT_InAWARESurvey_2018

13. Jaringan Jalan

key possible values

highway motorway (Jalan Tol), trunk (Jalan Arteri Primer),
primary (Jalan Arteri Sekunder), secondary
(Jalan Kolektor Primer), , tertiary (Jalan Lokal),
service (Jalan Layanan), residential (Jalan
Permukiman), pedestrian (Jalan Khusus
Pejalan Kaki), path (Jalan Setapak),
living_street (Gang), track (Jalan Pematang).

name (nama jalan)
layer 5,4,3,2,1,-1,-2,-3,-4,-5
width (lebar jalan)
lanes (jumlah lajur)
surface asphalt (Aspal), concrete (Beton), metal

(Besi/Baja), wood (Kayu), grass (Rumput),
ground (Tanah), gravel (Batu Kerikil), mud
(Lumpur), sand (Pasir), paving_stones (Paving
blok)

smoothness good (Baik), intermediate (Cukup Baik), bad
(Buruk), impassable (Tidak dapat dilewati)

motorcycle yes (Iya), no (Tidak)
oneway yes (Iya), no (Tidak)
ref (referensi)
source HOT_InAWARESurvey_2018

b. Tipe Data OpenStreetMap Berdasarkan Objek

Setelah Anda mengetahui model data berdasarkan tag yang diperlukan untuk masing-masing objek
khususnya dalam kegiatan pemetaan kebencanaan, Anda juga perlu mengetahui pemetaan objek
berdasarkan tipe data diOpenStreetMap. Berikut adalah tabel pembagian jenis-jenis objek berdasarkan
tipe data yang dapat dipetakan:

Keterangan Warna:

• Warna hijau artinya objek bisa dipetakan dalam tipe data tersebut.
• Warna merah artinya objek tidak bisa dan tidak boleh dipetakan dalam tipe data tersebut

Tabel Jenis Infrastruktur dan Tipe Data di OpenStreetMap
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“Tabel Infrastruktur”

V. Mengecek key dan value di Tag Info

Pada bab sebelumnya sudah dijelaskan mengenai panduan untuk melihat key dan value pada objek di
OpenStreetMap dengan menggunakan halaman wikipedia Map Features dan Referensi objek OSM In-
donesia. Namun, ada beberapa key dan value yang tidak dijelaskan pada halaman tersebut khususnya
informasi yang lebih rinci dan spesifik misalnya untuk kapasitas orang pada sebuah bangunan atau
jenis lantai bangunan. Untuk melihat informasi (tag) tersebut Anda dapat melihat di halaman berikut:
https://taginfo.openstreetmap.org/

Tampilan halaman utama Tag Info

Pada gambar di atas, menunjukkan kolom KEYS dimana menunjukkan beberapa key yang sering di-
cari oleh pengguna OpenStreetMap seperti building, highway, name, source, dan lain-lain. Selain itu
Anda juga dapat memilih kombinasi key dan value (tag) yang populer seperti building=yes dan high-
way=residential di kolom TAGS dan Anda juga dapat mencari secara manual di kotak pencarian pada
pojok kanan atas pada halaman utama Tag Info.
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Sebagai contoh, jika Anda ingin melihat informasi khusus terkait sumber kegiatan pemetaan dan jum-
lah tingkat dari sebuah bangunan maka silakan klik building di bagian Keys. Anda kemudian akan
melihat halaman berikut:

Contoh kombinasi tag and value di Tag Info

Pilih menu tab Combinations kemudian Anda akan melihat beberapa kombinasi key building khusus
yang sering digunakan oleh pengguna OpenStreetMap. Misalnya, jika Anda ingin mencari sumber
pemetaan bangunan dan tinggi bangunan maka Anda bisa menggunakan source untuk sumber
pemetaan bangunan dan building:levels untuk tinggi bangunan. Selain itu, Anda dapat melihat key
yang terkait informasi bangunan yang lain. Anda dapat memilih key dengan jumlah terbanyak yang
terdapat pada kolom Count. Hal ini menunjukkan seberapa sering key tersebut digunakan untuk objek
bangunan oleh pengguna OSM di seluruh dunia.

Catatan : 1. Penulisan key dan value di OpenStreetMap harus menggunakan Bahasa Inggris
2. Penulisan key dan value di OpenStreetMap harus menggunakan huruf kecil 3. Tampilan
Informasi untuk objek bisa diatur dalam tampilan sebagai Bahasa Indonesia di JOSM dengan
mengedit / membuat presets khusus. 4. Materi pembuatan presets akan dibahas di modul
yang berbeda dengan judul Membuat Presets OpenStreetMap

RINGKASAN

Selamat Anda telah mempelajari tentang model data yang ada di OpenStreetMap. Materi yang ada di
modul ini perlu dan penting untuk Anda pahami agar dalam melaksanakan kegiatan pemetaan Anda su-
dah mengetahui acuan standar yang harus digunakan. Selain itu, Anda juga telah mengetahui situs-situs
yang dapat membantu Anda dalam mencari standar tag terhadap informasi yang Anda butuh kumpulkan
di lapangan seperti halaman OSM wikiMap Feature dan Referensi Objek OSM Indonesia serta Tag Info.
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Penggunaan JOSM untuk Validasi Data Survei

Tujuan Pembelajaran:

• Menerapkan cara pengecekkan awal data hasil survei lapangan di JOSM
• Menerapkan cara penjaminan kualitas data hasil survei dengan JOSM
• Memahami jenis-jenis kesalahan dan peringatan yang harus diperbaiki di JOSM

JOSM merupakan software yang paling sering digunakan untuk melakukan pemetaan dan menam-
bahkan data OpenStreetMap. JOSM lebih banyak digunakan karena dapat digunakan secara offline
dan memiliki banyak fitur pendukung untuk memudahkan dalam melakukan pemetaan. Salah satu fitur
unggulan yang dimiliki oleh JOSM adalah melakukan validasi data. Validasi data merupakan hal yang
penting dilakukan untuk menjaga kualitas data OpenStreetMap.

I. Tahapan yang Dibutuhkan untuk Memeriksa Raw Data Hasil Survei

Dalam survei lapangan, data entry mengumpulkan dua jenis data yaitu data objek infrastruktur dan data
batas administrasi. Sebelum dimasukkan ke dalam JOSM, kedua jenis data tersebut harus diperiksa
oleh tim Quality Assurance. Hal ini dilakukan untuk memeriksa kelengkapan atribut yang dikumpulkan
yang telah disesuaikan dengan Pembuatan Model Data OSM dan objek-objek yang berada didalam
suatu area survei apakah sudah semua di ambil datanya.

1. Memeriksa Hasil Survei menggunakan Batas Administrasi

Hasil survei yang telah dikumpulkan harus dicek menggunakan batas administrasi yang ada. Tu-
juannya untuk melihat apakah seluruh objek yang ada dalam batas administrasi tersebut telah
selesai disurvei atau belum. Anda dapat menggunakan batas administrasi yang diperoleh dari
BPS atau dengan menggunakan batas administrasi yang telah digambar oleh Quality Assurance.

• Silakan Anda buka hasil survei yang telah dikumpulkan. Sebagai contoh, dalam modul ini
akan digunakan data hasil survei di daerah Yogyakarta.

Figure 1: contoh_hasil_survei

Contoh data hasil survei di Desa Wedomartani, Sleman, Yogyakarta

• Setelah itu, silakan Anda buka file batas administrasi yang Anda miliki. Dalam contoh ini akan
digunakan data batas desa yang didapatkan dari BPS. Data dari BPS masih dalam format
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.shp. Untuk dapat dibuka di dalam JOSM, Anda perlu mengubah format data ini menjadi ben-
tuk GeoJSON. Anda dapat membuka materi Menggunakan GeoJSON untuk mempelajari
bagaimana cara mengubah format data ini.

Untuk membuka file batas administrasi, silakan pilih menu File→Open, kemudian masukkan
batas administrasi yang Anda miliki.

Figure 2: overlay_admin

• Anda dapat membandingkan antara sebaran titik yang telah dikumpulkan dengan batas ad-
ministrasi. Jika menurut Anda titik-titik yang dikumpulkan masih belum memenuhi target
pemetaan yang diberikan atau masih ada objek-objek yang belum disurvei, Anda dapat mem-
inta Data Entry untuk melakukan survei ulang untuk memenuhi target yang diinginkan.

2. Memeriksa Hasil Survei Batas Administrasi

Data entry menggunakan peta survei untuk menggambarkan batas administrasi yang didapatkan
dari hasil diskusi dengan pihak kelurahan. Anda dapat melakukan pengecekan jumlah RW yang di-
hasilkan dalam kelurahan tersebut dan batas-batas di dalam peta apakah sudah jelas atau belum.

3. Menggabungkan hasil survei menjadi satu layer

Anda harus menggabungkan file hasil survei ODK Collect menjadi satu file yang sama. Untuk
menggabungkannya, langkah-langkah yang harus Anda lakukan adalah:

• Silakan Anda cari file ODK Collect yang telah Anda pindahkan dari smartphone ke lap-
top/komputer Anda dengan menggunakan Windows Explorer. Jika Anda lupa bagaimana
cara memindahkan data ODK Collect dari smartphone ke laptop/komputer Anda, silakan
baca kembali modul Menggunakan Aplikasi ODK Collect. Sebagai contoh, dalam modul
kali ini akan digunakan data hasil survei yang dilakukan di daerah Yogyakarta.

![data_odk_collect](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0203_Data_ODK_Collect_yang_sudah_dipindahkan_ke_laptop.png)
<p align="center"><i>Data ODK Collect yang sudah dipindahkan ke laptop/komputer</i></p>

• Setelah itu, pada kolom pencarian di sebelah kanan atas, silakan Anda ketik ‘.osm’. Hal ini
bertujuan untuk mencari seluruh data hasil survei dengan format .osm.

![pencarian_data](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0204_Pencarian_data_dengan_format_osm.png)
<p align="center"><i>Pencarian data dengan format .osm</i></p>

• Jika sudah, silakan Anda pilih semua data tersebut dengan cara klik pada salah satu file dan
tekan tombol Ctrl+A untuk memilih seluruh file tersebut.
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![seluruh_file](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0205_Seluruh_file_sudah_terpilih.png)
<p align="center"><i>Seluruh file sudah terpilih</i></p>

• Selanjutnya, silakan Anda klik dan tahan pada salah satu file, kemudian Anda geser seluruh
file tersebut dan masukkan ke dalam JOSM. Pastikan Anda sudah membuka software JOSM
terlebih dahulu.

![membuka_file_osm](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0206_Geser_dan_buka_file_osm.png)
<p align="center"><i>Geser dan buka file .osm ke dalam JOSM</i></p>

• Jika sudah berhasil terbuka akan muncul tampilan seperti berikut

![seluruh_file_osm](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0207_Seluruh_file_osm_berhasil_dibuka_dalam_JOSM.png)
<p align="center"><i>Seluruh file .osm yang berhasil dibuka dalam JOSM</i></p>

• Jika Anda lihat pada data yang telah dimasukkan, masing-masing titik hasil survei masih
berada dalam satu layer yang berbeda. Untuk itu Anda perlu menggabungkan seluruh data
tersebut menjadi satu layer baru. Untuk menggabungkannya, silakan Anda klik salah satu
layer data pada layer window kemudian tekan tombol Ctrl + A untuk memilih seluruh titik,
kemudian klik kanan dan pilih Merge.

![menggabungkan_layer](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0208_Menggabungkan_seluruh_layer.png)
<p align="center"><i>Menggabungkan seluruh layer</i></p>

• Anda akan diminta untuk memilih layer tujuan atau target layer. Anda tidak perlu mengubah
target layer ini dan langsung pilih Merge.

![merge_seluruh_data](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0209_Pilih_merge_untuk_menggabungkan_seluruh_data.png)
<p align="center"><i>Pilih merge untuk menggabungkan seluruh data</i></p>

• Data yang sudah berhasil digabungkan akan menjadi hanya satu layer.

![seluruh_data_digabungkan](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0210_Seluruh_data_yang_sudah_digabungkan.png)
<p align="center"><i>Seluruh data yang sudah digabungkan</i></p>

• Silakan Anda simpan layer yang telah disatukan dengan cara klik kanan pada layer tersebut,
kemudian pilih Save as. Simpan layer ini sesuai dengan nama yang Anda inginkan.

![save_as_png](id/images/04-Data-Validation-and-Quality-Assurance/02-Penggunaan-JOSM-untuk-Validasi-Data-Survei/0211_Save_as.png)

4. Upload Hasil Data Survei ke Google Drive

Setelah Anda gabungkan seluruh titik yang telah dikumpulkan, Anda perlu meng-upload data terse-
but ke dalam media penyimpanan yang dapat diakses secara bersama-sama, baik Data Entry
maupun Quality Assurance secara online. Anda dapat menggunakan media penyimpanan online
gratis seperti Google Drive. Silakan Anda upload sesuai dengan folder yang telah ditentukan.

Figure 3: google_drive
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II. Mengecek Hasil Input Data Survei

Setelah Anda melakukan pengecekan data mentah atau raw data yang telah dikumpulkan, Anda perlu
melakukan pengecekan terhadap data yang telah berhasil di-upload ke dalam server OpenStreetMap.
Pengecekan ini dilakukan dengan menggunakan bantuan plugin to do list dan alat validasi (validation
tool) yang telah tersedia di software JOSM.

1. Menggunakan Plugin To do list

Anda dapat menggunakan plugin pada JOSM yang bernama To do list untuk melakukan penge-
cekan data hasil survei. To do list memungkinkan Anda untuk membuat daftar objek-objek apa
saja yang telah dikumpulkan. Dengan adanya daftar ini akan memudahkan Anda untuk melakukan
pengecekan data sehingga tidak akan ada data yang terlewat. Anda dapat melihat kembali materi
Menggunakan to-do list di JOSM untuk memahami lebih lanjut.

Sebagai contoh, Anda mempunyai data hasil survei sebagai berikut:

Figure 4: contoh_hasiL_survey

Contoh data hasil survei

Data tersebut dikumpulkan menggunakan ODK Collect dan Open Map Kit (OMK). Data ini harus
dilakukan pengecekan apakah data tersebut telah dikumpulkan dengan benar. Terlebih dahulu
Anda harus men-download data OSM yang sudah ada untuk mengecek apakah objek yang dis-
urvei sudah dipetakan atau belum. Setelah itu, Anda dapat mengecek data yang telah disurvei,
Beberapa pengecekan yang dapat dilakukan antara lain memeriksa adanya kesalahan pengetikan
dan peletakan titik. Mengingat banyaknya data yang harus dicek, akan lebih mudah jika Anda
menggunakan to do list.

Sebagai contoh, Anda mempunyai data titik survei yaitu kantor kesehatan pelabuhan di daerah
Jakarta Utara. Untuk itu, Anda perlu men-download data OSM untuk memeriksa apakah ada
kesalahan dalam melakukan input data. Anda dapat melakukan perbandingan mengenai informasi
atau atribut yang telah ditambahkan, apakah masih terdapat kesalahan pengetikan atau informasi
yang tidak sesuai. Pada contoh, dapat terlihat bahwa pada atribut data mentah atau raw data
memiliki penulisan nama objek dengan huruf kecil, namun jika dibandingkan dengan data hasil
input, nama yang diketik sudah menggunakan huruf kapital pada awal kata. Hal ini menandakan
bahwa data entry sudah memasukan data dengan benar.

Perbandingan antara hasil input dan hasil data mentah
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Figure 5: perbandingan_data

Selain itu, Anda juga dapat memeriksa apakah titik objek tersebut telah diletakkan sesuai dengan
titik yang sebenarnya. Pada gambar terlihat bahwa data mentah (titik survei berwarna abu-abu)
belum terletak sesuai dengan lokasi sebenarnya, sedangkan pada data yang sudah dipetakan
titiknya telah sesuai dengan lokasi sebenarnya (titik survei berwarna). Anda dapat menggunakan
bantuan citra satelit sebagai acuan untuk melihat posisi titik tersebut apakah sudah sesuai dengan
objek bangunan yang ada di citra atau belum.

Perbedaan posisi titik data hasil input dan data mentah

2. Menggunakan Alat Validasi

Untuk melakukan pengecekan hasil input data survei, langkah-langkah yang harus dilakukan
adalah:

• Download data OpenStreetMap pada lokasi survei yang ingin Anda cek datanya.

Contoh data OpenStreetMap yang telah di-download

• Lakukan validasi dengan menggunakan validation tools atau alat validasi yang ada di JOSM. Untuk
mengaktifkan jendela validasi atau validation result silakan Anda pilih menu Window lalu pilih
Validation Result. Jendela validasi akan muncul di sebelah kanan bawah JOSM Anda.

Mengaktifkan jendela validasi pada JOSM

• Untuk melakukan validasi Anda dapat menggunakan tombol Validation yang ada pada jendela val-
idation result. Satu hal yang perlu Anda perhatikan pada saat melakukan validasi adalah pastikan
tidak ada objek yang sedang Anda pilih karena jika Anda sedang memilih salah satu objek, JOSM
hanya akan melakukan validasi terhadap objek yang sedang Anda pilih.

Hasil validasi menggunakan JOSM

• Perbaiki jika ada kesalahan (error) dan peringatan (warning) yang muncul pada data Anda hingga
selesai. Setelah itu jangan lupa untuk mengunggah kembali data yang sudah Anda perbaiki ke
dalam server OpenStreetMap.

125



Figure 6: perbedaan_posisi_titik

Figure 7: contoh_data
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Figure 8: mengaktifkan_jendela_validasi
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Figure 9: hasil_validasi

III. Pengertian Kesalahan (Error) dan Peringatan (Warning) di JOSM

Seperti telah dijelaskan sebelumnya, ketika melakukan validasi menggunakan JOSM, Anda akan men-
emukan dua jenis hasil validasi:

1. Kesalahan (Error)

Kesalahan atau Error merupakan jenis peringatan yang bersifat wajib untuk diperbaiki. Kesalahan
atauError berguna untuk memberitahukan adanya objek yang tidak dipetakan sesuai kaidahOpen-
StreetMap. Anda tidak dapat melakukan upload data jika Anda belum menyelesaikan kesalahan
atau error pada changeset Anda.

2. Peringatan (Warning)

Berbeda dengan kesalahan atau error, peringatan atau warning tidak bersifat wajib untuk diper-
baiki. Sesuai dengan namanya, peringatan atau warning diberikan untuk memberikan informasi
bahwa terdapat ketidaksesuaian dalam pemetaan Anda. Peringatan ini dapat Anda abaikan dan
Anda tetap dapat melakukan upload data ke dalam server OpenStreetMap. Meskipun demikian,
ada juga beberapa jenis warning yang sebaiknya diperbaiki seperti crossing building, building
inside building, crossing ways, dan sebagainya. Anda akan mempelajari lebih lanjut mengenai
jenis-jenis warning yang harus diperbaiki pada bagian selanjutnya.

Figure 10: contoh_kesalahan_warning

Contoh kesalahan (errors) dan peringatan (warnings) yang muncul pada saat validasi

Untuk kesalahan atau Error, Anda dapat langsung memperbaikinya secara otomatis dengan
menekan pada bagian Error, kemudian tekan tombol Fix. Namun, untuk peringatan atau warning,
Anda harus menyelesaikannya satu per satu.

Kesalahan atau Errors dapat diselesaikan secara otomatis dengan menggunakan tombol Fix
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Figure 11: memperbaiki_error

IV. Jenis-jenis Kesalahan (Error) dan Peringatan (Warning) yang Harus Diperbaiki

Terdapat banyak sekali kesalahan dan peringatan yang muncul ketika Anda melakukan validasi data
OpenStreetMap. Anda dapat menggunakan tools yang terdapat di JOSM (modulMenggunakan JOSM)
untuk memperbaiki kesalahan dan peringatan yang muncul pada alat validasi. Anda tidak perlu mengin-
gat setiap jenis kesalahan dan peringatan yang muncul, namun Anda perlu mengetahui jenis-jenis ke-
salahan dan peringatan apa yang seringkali muncul serta mana yang harus Anda perbaiki, seperti:

1. Kesalahan (Error)

• Duplicated Node (Titik Terduplikasi)

Kesalahan ini biasanya muncul ketika sebuah objek secara tidak sengaja diunggah sebanyak
2 kali atau lebih sehingga menyebabkan adanya objek yang tumpang tindih pada posisi yang
sama. Kesalahan ini biasanya terjadi ketika pengguna mengunggah data dengan menggu-
nakan koneksi internet yang kurang stabil, sehingga menyebabkan adanya gangguan pada
saat meng-upload data.

Error: Duplicated Node

• Duplicated Ways (Garis Terduplikasi)

Kesalahan ini sama seperti kesalahan duplicated node, dimana terdapat dua atau lebih garis yang
berada pada posisi yang sama. Kesalahan ini biasa terjadi pada objek jalan, namun seringkali juga
terjadi pada objek bangunan yang bertumpuk pada satu tempat yang sama. Kesalahan ini juga
disebabkan karena adanya objek yang terunggah sebanyak 2 kali dan disebabkan karena koneksi
internet yang kurang stabil.

Error: Duplicated ways

2. Peringatan (Warning)

• Crossing Building (Bangunan Bersinggungan)

Peringatan ini merupakan peringatan yang cukup sering muncul ketika melakukan validasi. Ser-
ingkali pengguna memetakan dua bangunan yang berbeda tetapi diletakkan secara bertumpuk.
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Figure 12: duplicated_node

Figure 13: duplicated_ways
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Untuk mengatasi warning ini, Anda cukup memindahkan atau menghapus salah satu bangunan
yang bertumpukan.

Figure 14: crossing_building

Warning: Crossing building

• Crossing Ways (Garis Bersinggungan)

Warning_ ini muncul ketika terdapat dua buah objek garis atau jalan yang digambar tanpa adanya
titik perpotongan antar jalan. Untuk mengatasi warning ini, Anda cukup menambahkan titik perpo-
tongan yang terletak pada percabangan kedua jalan tersebut.

Warning: Crossing ways

• Overlapping Highways (Jalan saling bertumpang tindih)

Warning ini muncul ketika terdapat bagian jalan yang bertumpukkan dengan bagian jalan lain. Un-
tuk menyelesaikannya, Anda dapat menggeser atau menghapus bagian jalan yang bertumpukkan.

Warning: Overlapping highways

• Node connect highways and building (Titik bangunan dan jalan saling terhubung)

Warning ini muncul ketika titik objek bangunan dan titik objek jalan secara tidak sengaja saling
terhubung satu sama lain. Untuk menyelesaikannya, silakan Anda pisahkan titik tersebut
dengan menggunakan tools unglue node.

Warning: Node connect highways and building

• Untagged ways (Objek belum diberi tag)
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Figure 15: crossing_ways
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Figure 16: overlapping_highways

Figure 17: node_connect_highways
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Untagged ways_ merupakan peringatan atauwarning yang muncul disebabkan adanya objek
yang belum diberi identitas atau tag. JOSM akan menandai objek tersebut sebagai objek
tanpa identitas, mengingat pentingnya pemberian identitas atau atribut pada setiap objek
yang dipetakan. Apabila Anda tetap mengabaikan peringatan ini, objek tersebut tetap dapat
Anda upload tetapi objek tersebut tidak akan muncul pada situs OpenStreetMap. Silakan
Anda berikan presets yang sesuai untuk objek yang belum diberikan informasi objek.

Figure 18: unttaged_ways

Warning:Untagged ways

• Way end node near other highways (titik tidak terhubung dengan garis terdekat)

Warning ini muncul ketika ada titik dari objek jalan yang berdekatan dengan jalan lainnya namun
tidak terhubung satu sama lain. Jika memang jalan tersebut merupakan jalan yang tidak dapat
dilalui (jalan buntu) silakan gunakan tag highway=block. Namun jika ternyata jalan tersebut saling
berhubungan, silakan Anda gabungkan jalan tersebut dengan menggunakan fungsi Merge.

Warning: Way end node near other highways

• Building inside building (bangunan di dalam bangunan)

Peringatan atau warning ini juga salah satu jenis warning yang sering muncul ketika melakukan
validasi. Warning ini terjadi ketika ada poligon bangunan yang digambar di dalam poligon ban-
gunan lain. Untuk menyelesaikannya, silakan Anda geser atau hapus salah satu bangunan yang
ada di dalam poligon bangunan lain.

Warning: Building inside building

• Unnamed ways (Jalan belum diberi nama)

Unnamed ways menandakan adanya jalan yang belum diberi nama. Jenis warning ini dapat dia-
baikan, karena bisa saja ketika Anda melakukan pemetaan jarak jauh, Anda hanya memetakan
objek jalannya saja tanpa mengetahui nama jalan tersebut.
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Figure 19: node_end_near_highway

Warning: Unnamed ways

• Similarly named ways (Jalan memiliki nama yang sama)

Warning ini muncul ketika ada beberapa jalan yang memiliki nama jalan yang hampir mirip. Seba-
gai contoh, ada jalan dengan nama Jalan Tebet Timur I, Jalan Tebet Timur IA, Jalan Tebet Timur
IAA, dan sebagainya. Jenis warning ini dapat Anda abaikan jika memang pada kenyataannya
jalan tersebut memiliki nama jalan yang hampir serupa.

Warning: Similarly named ways

RINGKASAN

Data OpenStreetMap yang memiliki sifat data terbuka menyebabkan data OpenStreetMap rawan
mengalami kerusakan oleh orang yang kurang bertanggung jawab. Oleh karena itu, setiap relawan
pemetaan yang memasukkan data OSM sangat penting untuk menjaga kualitas data OSM yaitu
dengan melakukan validasi data. Dengan mempelajari bagian ini, Anda telah dapat melakukan
pengecekan kualitas data baik data hasil survei maupun data yang telah dimasukkan ke dalam server
OpenStreetMap menggunakan alat validasi yang ada di dalam JOSM. Anda juga telah mengetahui
jenis-jenis kesalahan (error) dan peringatan (warning) yang sering muncul ketika melakukan validasi.
Setelah mempelajari modul ini, Anda diharapkan dapat memahami pentingnya menjaga kualitas data
yang ada di OpenStreetMap.
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Figure 20: building_inside_building
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Figure 21: unnamed_ways

Figure 22: similarly_named
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Penggunaan Tasking Manager

Tujuan Pembelajaran:

• Menjalankan fungsi dari tasking manager dalam konteks pemetaan partisipatif
• Mengoperasikan cara menggunakan tasking manager untuk kegiatan pemetaan

OpenStreetMap sebagai sebuah alternatif untuk melakukan pemetaan secara bebas dan terbuka memu-
ngkinkan semua orang tanpa terkecuali untuk dapat melakukan pemetaan dimanapun dan kapanpun.
Namun, bagaimana jika Anda ingin melakukan pemetaan secara serentak yang dilakukan oleh banyak
orang? Tentunya Anda membutuhkan sebuah alat untuk dapat membagi pekerjaan pemetaan tersebut
supaya bisa dikerjakan oleh banyak orang. Tasking manager memungkinkan Anda untuk melakukan hal
itu. Dalam modul ini, Anda akan mempelajari lebih lanjut mengenai Tasking Manager dan bagaimana
cara memetakan data OSM melalui Tasking Manager.

I. Apa itu Tasking Manager?

1. Definisi Tasking Manager

Tasking manager merupakan sebuah alat yang dibuat secara khusus untuk melakukan pemetaan
secara kolaboratif dan partisipatif. Tasking manager memungkinkan Anda untuk melakukan
pemetaan di suatu wilayah secara bersama-sama dengan pembagian wilayah yang berbeda.
Fungsi Tasking manager adalah untuk membagi pekerjaan pemetaan ke dalam beberapa
grid/kotak yang berbeda sehingga setiap orang dapat memilih grid/kotak untuk dikerjakan.
Selain itu, Tasking manager juga dapat memudahkan Anda dalam memantau proses pengerjaan
pemetaan. Anda dapat mengetahui wilayah mana yang masih butuh dipetakan, sedang dipetakan,
dan wilayah mana yang sudah selesai dipetakan.

Bayangkan Anda ingin melakukan pemetaan pada suatu wilayah tertentu dimana Anda harus
memetakan secara bersama-sama dengan 20 orang lainnya. Jika tidak ada pembagian tugas
dan wilayah, maka akan ada kemungkinan beberapa orang memetakan di wilayah yang sama.
Dengan adanya Tasking manager, hal seperti ini dapat dihindari dan pekerjaan pemetaan akan
dapat diselesaikan secara lebih cepat dan efisien.

2. Contoh Penggunaan Tasking Manager

Tasking manager pernah digunakan sebagai bentuk respon ketika bencana Topan Haiyan ter-
jadi di Filipina pada 8 November 2013. Pemetaan menggunakan tasking manager dilakukan di
Kota Tacloban, salah satu kota yang terdampak sangat parah ketika bencana terjadi. Dalam ku-
run waktu 24 jam setelah dibuatnya proyek tasking manager, sebanyak 10.000 bangunan telah
terpetakan atau sekitar 25% dari total jumlah bangunan yang ada di Kota Tacloban. Seluruh
pemetaan ini dilakukan oleh 33 orang relawan.

Figure 23: kondisi_bangunan

Kondisi bangunan sebelum dan setelah dipetakan menggunakan Tasking Manager

Tasking manager juga digunakan di Indonesia untuk respon ketika bencana terjadi. Salah satu
contohnya adalah ketika bencana gempa dan tsunami terjadi di Selat Sunda pada Desember 2018.
Dalam kurun waktu 1 bulan, seluruh daerah terdampak sudah selesai dipetakan oleh sekitar 60
orang relawan.
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Figure 24: tasking_manager_tsunami_selat_sunda

Tasking Manager yang dibuat sebagai respon bencana gempa dan tsunami di Selat Sunda

II. Memulai Tasking Manager

Anda dapat mengakses halaman tasking manager di alamat https://tasks.hotosm.org/. Ketika Anda
membuka halaman tersebut, akan muncul tampilan seperti berikut:

Halaman utama Tasking Manager

Pada halaman utama, Anda dapat melihat beberapa menu yang bisa Anda pilih. Untuk mengganti
bahasa yang ingin ditampilkan Anda dapat memilih tombol tanda panah di sebelah kiri tombol Login
pada kanan atas layar. Anda juga bisa mempelajari lebih lanjut mengenai tutorial penggunaan tasking
manager pada menu Learn di bagian atas layar.
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Tombol untuk mengganti bahasa di sebelah kanan dan tombol Learn di sebelah kiri

Sebelum dapat memetakan menggunakan Tasking Manager, ada beberapa hal yang perlu Anda per-
hatikan, seperti:

1. Login/Masuk ke dalam Tasking Manager

Sebelum Anda dapat melakukan memetakan, Anda harus melakukan login atau masuk dengan
menggunakan akun OpenStreetMap yang Anda miliki. Silakan Anda pilih menu Login yang be-
rada di sebelah kanan atas layar kemudian masukkan akun OpenStreetMap yang telah Anda
miliki. Pada pilihan Authorize access to your account silakan Anda centang pilihan read your
user preferences kemudian pilih Grant Access. Untuk lebih jelasnya, silakan Anda lihat gambar
berikut:

Figure 25: pilihan_untuk_otorisasi_akun

Pilihan untuk mengizinkan otorisasi pada akun Anda

Setelah Anda loginmaka Anda akan diarahkan kembali pada halaman Tasking Manager. Anda da-
pat melihat nama akun OpenStreetMap di bagian kanan atas halaman yang menandakan bahwa
Anda telah berhasil melakukan login. Untuk memulai memetakan, silakan pilih tombol Start Map-
ping atau tombol Contribute yang terletak di sebelah kiri atas layar.

Tombol Contribute dan Start Mapping pada halaman Tasking Manager

2. Mencari Proyek Tasking Manager di Kolom Pencarian

Setelah Anda menekan tombol Start Mapping atau Contribute akan muncul halaman Contribute.
Di halaman ini Anda dapat memilih tampilan Grid View dan Map View. Di dalam tampilan Grid
View ada beberapa hal yang perlu Anda perhatikan, seperti:

Beberapa pengaturan yang dapat dilakukan pada tampilan Grid View

1. Search (Kotak Pencarian)

Pada bagian ini, Anda dapat melakukan pencarian proyek tasking manager. Silakan Anda
ketik kata kunci yang diinginkan seperti nama kecamatan, kabupaten, provinsi, atau nama
kegiatan yang menjadi judul proyek yang telah dibuat.

2. Proyek Tasking

Di bagian ini, Anda dapat melihat berbagai proyek tasking manager yang telah dibuat se-
belumnya oleh para kontributor.

3. Mapping Difficulty
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Figure 26: tombol_contribute_dan_start_mapping

Figure 27: pengaturan_pada_tampilan_grid_view

141



Pada bagian ini, Anda dapat memilih tingkat kesulitan dari proyek tasking manager yang
ingin Anda cari. Tingkat kesulitan yang dapat dipilih dibagi menjadi 3 kategori, beginner,
intermediate, dan advance. Jika Anda masih pemula silakan Anda pilih beginner, jika Anda
sudah mahir memetakan silakan Anda pilih Intermediate, dan jika Anda sudah ahli dalam
memetakan maka Anda dapat memilih Advance. Jika Anda ingin melihat seluruh tasking
pilih All

4. Organization

Anda dapat memilih proyek tasking manager berdasarkan organisasi pembuat proyek terse-
but seperti American Red Cross, Missing Maps, HOTOSM, dan HOT Indonesia.

5. Campaign Anda juga dapat memilih proyek tasking manager berdasarkan kegiatan tertentu.
Sebagai contoh, Anda dapat memilih proyek tasking manager untuk kegiatan Malaria Elimi-
nation.

Anda dapat mengubah tampilan dariGrid View menjadiMap View. Pada tampilanGrid View, Anda
akan melihat daftar proyek tasking manager dalam bentuk grid atau kotak. Jika Anda memilih
tampilan Map View, tampilan utama yang akan Anda lihat adalah tampilan peta dunia dengan
banyak bulatan kecil berwarna biru di atasnya.

Figure 28: tombol_untuk_mengubah_tampilan_view

Tombol untuk mengubah tampilan Grid View atau Map View

Jika Anda telah mengubah tampilan Anda menjadi Map View, akan muncul halaman seperti
berikut:
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Tampilan Map View pada Tasking Manager

Berbeda dengan tampilan Grid View, tampilan Map View akan memperlihatkan tampilan peta
dunia dengan banyak bulatan biru. Anda dapat menggunakan tombol dengan tanda plus dan
minus yang ada di sebelah kiri atas bidang peta untuk memperbesar dan memperkecil tampilan
peta. Ketika tampilan peta diperbesar, maka akan muncul berbagai proyek tasking manager yang
ada di berbagai tempat ditandai dengan adanya titik-titik berwarna. Masing-masing warna tersebut
mewakili tingkat prioritas proyek tasking mulai dari urgent hingga low.

Figure 29: prioritas_tasking_manager

Jika Anda ingin mulai melakukan pencarian, maka Anda dapat mengubah tampilan menjadi Grid
View. Ubah kembali tampilan Tasking Manager Anda menjadi tampilan Grid View. Untuk dapat
mencari proyek tasking, silakan Anda arahkan kursor Anda pada kotak pencarian. Pada contoh
kali ini kita akan mencari proyek tasking manager dengan kata kunci ‘Penjaringan’ kemudian tekan
Enter. Untuk parameter lain seperti mapping difficulty, organization, dan campaign tidak perlu
diubah.

Hasil pencarian proyek tasking manager dengan kata pencarian ‘penjaringan’

Tasking Manager akan menampilkan proyek dengan kata kunci ‘Penjaringan’. Silakan Anda pilih
proyek tasking yang ada di sebelah kanan dengan judul ‘#781 - INSIST II (Integrated Services for
Infrastructure and Sanitation Technology) II - Kelurahan Penjaringan’.

3. Mengenal Tampilan Tasking Manager
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Figure 30: hasil_pencarian_proyek_tasking

Ketika Anda telah memilih satu proyek tasking, maka akan muncul tampilan sebagai berikut:

Tasking manager #781 INSIST - Kelurahan Penjaringan

Tampilan ini menunjukkan deskripsi proyek tasking manager yang sedang kita buka. Pada bagian
deskripsi, Anda dapat membaca latar belakang proyek pemetaan infrastruktur dan sanitasi di Pen-
jaringan. Di bagian bawah kita dapat melihat informasi lebih detail mengenai proyek ini, mulai
dari tingkat prioritas, organisasi pembuat, nama pembuat proyek, tingkat kesulitan, hingga objek
apa yang harus dipetakan. Jika Anda ingin membuat proyek tasking manager Anda sendiri, Anda
dapat membacanya di modul Membuat dan Mengelola Tasking Manager.

Tampilan proyek tasking manager

Di bagian bawah deskripsi Anda dapat melihat tampilan peta di sebelah kanan dan beberapa
informasi yang dapat Anda lihat di sebelah kiri. Jika Anda perhatikan pada bidang peta, terdapat
beberapa kotak dengan warna yang berbeda. Warna tersebut mewakili informasi:

• Ready (Siap) Menunjukkan kotak tersebut dapat Anda kerjakan

• Mapped (Dipetakan) Kotak berwarna kuning menunjukkan bahwa kotak tersebut telah selesai
dipetakan

• Bad Imagery (Citra Satelit Buruk) Kotak berwarna abu-abu kehitaman ditandai sebagai daerah
dengan citra satelit yang buruk

• Validated (Tervalidasi) Kotak berwarna hijau menunjukkan bahwa kotak tersebut telah tervalidasi

• Invalidated (Tidak Tervalidasi) Kotak berwarna merah menunjukkan bahwa kotak tersebut masih
perlu diperiksa ulang sebelum dilakukan validasi kembali

• Locked (Terkunci) Kotak berwarna abu-abu menunjukkan bahwa kotak tersebut telah dipilih oleh
pengguna lain

• Locked by you (Dikunci oleh Anda)Kotak berwarna dengan garis berwarna biru tua menunjukkan
kotak yang sedang Anda pilih dan kerjakan

1. Memulai Berkontribusi di Proyek Tasking Manager Anda dapat melakukan dua jenis kontribusi
pada proyek taskingmanager, yaitu melakukan digitasi objek dan melakukan validasi data yang su-
dah dipetakan. Untuk mulai berkontribusi dan melakukan pemetaan silakan ikuti langkah-langkah

144



Figure 31: tasking_kel_penjaringan

Figure 32: tampilan_proyek_tasking
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Figure 33: legenda_tasking_manager

berikut:

• Pilih tombolMap.

• Selanjutnya, tugas Anda adalah memilih grid/kotak proyek tasking manager mana yang akan
Anda kerjakan dengan cara memilih langsung grid/kotak pada proyek tasking manager atau
Anda juga dapat memilih kotak secara acak dengan menekan tombol Select a Random Task.

Anda juga dapat mengganti basemap atau peta dasar agar area pemetaan di citra satelit yang terkena
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awan atau hutan dapat terlihat, sehingga tidak perlu dipilih.

Jika Anda menemukan grid/kotak yang tertutup awan, silakan Anda pilih tombol Mark as Bad Imagery.
Jika Anda melihat bahwa area pemetaan tersebut hanya terdapat hutan, silakan Anda pilih Mark as
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CompletelyMapped.
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• Jika sudah terpilih kotak yang diinginkan, silakan pilih tombolStart Mapping.

• Silakan Anda pilih JOSM sebagai editor yang akan digunakan untuk memetakan, kemudian
pilih tombol Start Editor. Pastikan bahwa software JOSM Anda telah dibuka sebelumnya.

• Secara otomatis tasking manager akan mengunduh data ke dalam JOSM. Anda dapat langsung
memetakan menggunakan JOSM dan citra satelit yang telah disesuaikan dengan petunjuk yang
ada di halaman proyek tasking. Jika Anda ingin mengetahui bagaimana cara memetakan dengan
menggunakan JOSM, silakan Anda buka kembali modul Menggunakan JOSM. Petakan seluruh
objek yang ada di grid/kotak tersebut.

Figure 34: data_osm_berhasil_di_download

Data OSM yang telah berhasil di-download melalui tasking manager

• Setelah selesai, jangan lupa untuk meng-upload hasil pemetaan Anda secara berkala. Hal ini
bertujuan untuk mencegah terlalu banyaknya beban data yang akan di-upload. Ketika Anda in-
gin meng-upload, jangan lupa untuk menambahkan komentar. Jika Anda perhatikan pada kolom
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komentar, Anda akan melihat komentar bawaan yang sama dengan penomeran proyek tasking
manager tersebut. Silakan Anda tambahkan komentar Anda di belakang komentar tasking man-
ager tersebut.

Figure 35: kolom_komentar

Kolom komentar pada saat upload data dari JOSM

• Setelah Anda selesai melakukan pemetaan dan telah mengunggah data ke dalam server Open-
StreetMap, silakan Anda kembali pada halaman tasking manager. Anda dapat memberikan ko-
mentar mengenai perubahan yang telah dikerjakan. Jika telah selesai memetakan seluruh objek
di dalam proyek tasking manager, pilih tombol Mark as Completely Mapped. Namun, jika masih
ada beberapa objek yang belum terpetakan, Anda dapat memilih tombol Stop Mapping untuk
berhenti melakukan pemetaan dan dapat melanjutkan pemetaan nanti atau membiarkan kontribu-
tor lain untuk melengkapi dan memetakan objek tersebut.

Menambahkan komentar pada grid/kotak tasking manager yang telah dipetakan

1. Hal-hal yang Harus Diperhatikan saat Sudah Memilih Area di Proyek Tasking

Ada beberapa hal yang harus Anda perhatikan jika Anda telah memilih proyek dalam Tasking
Manager.
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Figure 36: menambahkan_komentar_pada_kotak
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• Batas waktu pengerjaan maksimal 120 menit

Ketika Anda telah memilih satu kotak untuk dikerjakan, kotak tersebut akan menjadi milik Anda
dalam jangka waktu 120 menit atau 2 jam. Pastikan Anda tidak terlalu lama mengerjakan dan
segera lakukan upload data secara berkala.

Figure 37: pemberitahuan_batas_waktu_pengerjaan

Pemberitahuan batas waktu pengerjaan tasking manager

• Jangan lupa untuk membuka kembali kotak yang telah Anda pilih

Jika Anda telah selesai memetakan, jangan lupa gunakan tombol Stop Mapping jika kotak belum
selesai dipetakan. Tombol Mark as Completely Mapped digunakan jika kotak yang Anda pilih
telah betul-betul selesai Anda petakan dan sudah tidak ada objek apapun yang dapat Anda
petakan.

Tombol Stop Mapping digunakan jika grid/kotak Anda belum selesai dipetakan

• Jangan memetakan objek di luar area tasking terpilh

Area yang terarsir tidak boleh Anda petakan

Ketika grid/kotak tasking manager yang Anda pilih telah terbuka di dalam JOSM, terdapat area
yang terarsir dan area tidak terarsir. Maksud dari area tidak terarsir menandakan bahwa area
tersebut merupakan area pemetaan Anda, sementara area yang terarsir merupakan area yang
tidak boleh Anda petakan. Hal ini dimaksudkan supaya tidak terjadi konflik antara pengguna task-
ing manager.

• Perlakuan khusus untuk objek yang berada di perbatasan antar kotak

Seringkali ketika memetakan menggunakan taskingmanager, Anda menemukan objek-objek yang
terletak di perbatasan antar dua grid/kotak tasking manager yang berbeda seperti contoh berikut:

Objek yang terletak di perbatasan grid/kotak tasking manager

Jika menemukan contoh objek seperti gambar di atas, silakan Anda petakan objek tersebut sedikit
melewati batas grid/kotak tasking manager yang Anda pilih. Hal ini dilakukan terutama pada objek
jalan untuk memberi panduan bagi kontributor lain yang memetakan di proyek tasking manager
berbeda dan bersebelahan dengan area Anda.

RINGKASAN Saat ini Anda telah berhasil mempelajari definisi serta fungsi dari tasking manager. Task-
ing manager merupakan sebuah alat yang sangat berguna untuk melakukan pemetaan secara kolab-
oratif dan partisipatif. Ketika suatu wilayah perlu untuk dipetakan secara masif dan perlu dilakukan
secara cepat, Tasking manager menjadi alat yang sangat berguna untuk digunakan. Anda juga telah
mempelajari bagaimana cara menggunakan Tasking Manager untuk kegiatan pemetaan. Diharapkan
dengan menggunakan Tasking Manager pekerjaan pemetaan yang Anda lakukan dapat diselesaikan
dengan lebih cepat dan dapat diorganisir dengan baik.
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Figure 38: tombol_stop_mapping
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Figure 39: area_yg_tidak_boleh_dipetakan

Figure 40: objek_yg_terletak_diperbatasan

 — title: Membuat Presets weight: 3 —

Tujuan Pembelajaran:

• Memahami pengertian dan konsep Presets di OpenStreetMap
• Mengerti dan memahami Bahasa XML di Presets OpenStreetMap
• Mengerti Membuat Presets Khusus di OpenStreetMap
• Memahami dan mengerti elemen-elemen penyusun presets

Seperti yang telah dipahami bahwa OpenStreetMap merupakan peta partisipatif yang bersifat terbuka
untuk seluruh dunia. Hal ini menjelaskan bahwa pemanfaatan OpenStreetMap untuk pemetaan akan
beragam pula. Semakin banyak pemetaan dengan tujuan yang berbeda-beda maka akan menimbulkan
banyaknya variasi informasi yang dihasilkan. Kebutuhan akan informasi yang berbeda-beda inilah yang
membuat pengguna OpenStreetMap membuat kesepakatan akan standar informasi yang ada di Open-
StreetMap yang disebut dengan Tag. Untuk penjelasan lebih lanjut soal Tag silakan dilihat pada Modul
Model Data OpenStreetMap.

Berangkat dari kebutuhan informasi dan disepakatinya standar internasional oleh para pengguna Open-
StreetMap dibuatlah beberapa platform yang membantu pengguna untuk menemukan informasi yang
mereka cari seperti halaman wiki Map Features, Referensi Objek OSM Indonesia, dan Tag Info. Un-
tuk memudahkan dalam memasukkan informasi-informasi objek yang ingin dipetakan ke dalam Open-
StreetMap maka komunitas OpenStreetMap membuat sebuah isian informasi umum yang disebut den-
gan presets di dalam perangkat lunak editor Java OpenStreetMap (JOSM) untuk memudahkan peng-
guna OpenStreetMap mengisi informasi yang mereka inginkan.

I. Konsep Presets di OpenStreetMap

a. Pengertian Umum Presets

Presets merupakan sebuah informasi yang diwakilkan oleh sebuah Tag, kombinasi antara key dan
value tertentu, dimana memudahkan para pengguna untuk melakukan edit atau memetakan di Open-
StreetMap menggunakan JOSM maupun iD Editor.
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“Tampilan presets di JOSM”

Tampilan presets di JOSM

Gambar di atas adalah contoh pemberian presets untuk objek sekolah. Jika kemudian Anda ingin
mengisi informasi-informasi terkait sekolah tersebut, maka tampilan di JOSM akan berganti seperti
berikut:

“Pengisian presets di JOSM”

Pengisian presets di JOSM

b. Presets Khusus di JOSM

Seperti yang sudah dijelaskan di sub-bab sebelumnya, komunitas OpenStreetMap telah membuat pre-
sets umum yang otomatis ada ketika Anda menggunakan JOSM. Akan tetapi, presets yang disediakan di
JOSM memiliki beberapa kekurangan khususnya untuk pengguna OpenStreetMap di Indonesia, antara
lain:

• Kolom Informasi untuk suatu objek tidak lengkap dan tidak sesuai kebutuhan pemetaan
• Kolom Informasi yang disediakan seringkali tidak dibutuhkan di Indonesia
• Pilihan jawaban dari masing-masing informasi seringkali tidak tepat sesuai dengan kebutuhan

pemetaan di Indonesia
• Tampilan isian informasi dalam Bahasa Inggris sehingga menyulitkan pengisian informasi
• Daftar objek-objek yang disediakan seringkali tidak tersedia atau tidak terdapat di Indonesia

Oleh karena itu solusi untuk mengatasi masalah-masalah tersebut adalah dengan membuat Presets
Khusus sesuai dengan kebutuhan pemetaan Anda sendiri. Dengan membuat presets sendiri Anda
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juga dapat menyesuaikan informasi-informasi apa saja yang ingin Anda kumpulkan dalam kegiatan
pemetaan Anda dan juga label serta bahasa apa yang ingin Anda tampilkan untuk presets Anda di
JOSM.

Tampilan presets bawaan JOSM (kiri) dan tampilan presets buatan / khusus (kanan)

II. Penggunaan Bahasa XML untuk Presets di OpenStreetMap

Sebelum memulai membuat presets ada baiknya Anda memahami terlebih dahulu bahasa yang digu-
nakan untuk membuat presets itu sendiri. Presets yang dimasukkan ke dalam JOSM menggunakan
bahasa yang disebut Extensible Markup Language atau disingkat XML. Bahasa XML merupakan ba-
hasa yang berfungsi untuk membawa data-data yang nantinya dapat ditampilkan di JOSM dan Open-
StreetMap. Bahasa XML menggunakan elemen-elemen penyusun yang memiliki hierarki dimana ele-
men tersebut akan mempunyai sub-elemen dan sub-elemen akan memiliki sub-sub-elemen.
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Contoh tampilan XML di Notepad ++

Berikut adalah hierarki dan terminologi dalam bahasa XML yang digunakan untuk membuat _presets
_di OpenStreetMap:

XML: Root Element –> Element dan Sub-Element –> Tag –> Attribute

• Root element: elemen terluar dari suatu file XML; root element mendeskripsikan informasi apa
saja yang termuat di dalam file XML. Root element ini ditulis seperti berikut …element..

• Element: satu daftar objek dalam XML, objek ini nanti akan memiliki beberapa informasi (tag)
yang berada diantara tag pembuka & penutup, contoh ..tag ..,..tag..

• Tag: suatu informasi yang termuat di dalam elemen dan sub-elemen. Informasi tersebut diisi oleh
attribute. Tag ditandai oleh tanda kurung <> dan diakhiri oleh </>, contoh < item >..attribute

• Attribute: Merupakan informasi spesifik yang termuat di dalam sebuah tag, contohnya lan-
duse=“orchard”

Berikut contoh hierarki tentang terminologi XML untuk preset OpenStreetMap

Hierarki file XML pada sebuah presets di OpenStreetMap
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III. Membuat Presets Khusus

Untuk bisa membuat presets Anda sendiri, ada beberapa hal yang perlu Anda persiapkan dan ketahui
terlebih dahulu. Untuk bisa membuat presets Anda perlu menginstal perangkat lunak tambahan untuk
membuat presets yaituNotepad ++ yang bisa Anda unduh di https://notepad-plus-plus.org/download/v7.
6.3.html kemudian instal di laptop/komputer Anda. Terdapat beberapa aturan yang perlu Anda ketahui
ketika ingin membuat presets sehingga nantinya presets Anda sesuai dengan ketentuan dari Open-
StreetMap seperti:

• Ketahui bentuk data dari objek yang ingin Anda petakan. Seperti yang telah dijelaskan pada Modul
Model DataOpenStreetMap bahwa ada 3 bentuk data diOpenStreetMap yaitu titik (nodes), garis
(ways), dan** area (closedway)**. Sebagai contoh, jika objek tersebut merupakan jalan maka
bentuk data yang akan Anda tuliskan di presets Anda adalah ways bukan yang lain.

• Anda harus menggunakan key dan value sesuai dengan ketentuan OpenStreetMap. Untuk meli-
hatnya Anda dapat merujuk di Halaman Wikipedia Map Features dan Referensi Objek OSM In-
donesia dan Tag Info. Untuk lebih jelasnya silahkan lihat di Modul Model Data OpenStreetMap.

• Penulisan key dan value harus menggunakan Bahasa Inggris, untuk penulisan label Indonesia
nanti dapat diatur dalam presets itu sendiri.

a. Elemen-Elemen di Presets

Jika sudah mengetahui dan memahami aturan dalam pembuatan_ presets_ maka Anda juga perlu un-
tuk mengetahui tentang elemen-elemen penyusun yang dapat menampilkan informasi di presets Anda
dengan bentuk yang beragam. Beberapa elemen-elemen _presets _tersebut adalah:

• Elemen key key

Struktur dasar : <key key="......" value="......" />

Ini merupakan key wajib yang mendefinisikan informasi utama dari suatu objek walaupun informasi yang
lain dikosongkan. Sebagai contoh jika dalam presets Anda ingin menekankan bahwa itu informasi tag
ini adalah sekolah maka Anda dapat menuliskannya seperti:

• Elemen text key

Struktur dasar : <text key="......" text="......" />

Ini merupakan elemen yang mendefinisikan informasi objek dalam bentuk isian. Elemen ini biasanya di-
gunakan untuk informasi nama dan alamat objek. Sebagai contoh jika Anda ingin memberikan informasi
nama objek maka Anda dapat menuliskannya seperti:

Penambahan kata “text” pada contoh di atas adalah sebagai label informasi yang akan tampil di JOSM.
Pada bagian “text” ini Anda dapat mengisinya dengan Bahasa Indonesia ataupun bahasa lain yang
Anda inginkan. Contoh tampilan dari elemen ini di JOSM seperti berikut:

“Tampilan elemen text key di JOSM”

Tampilan elemen text key di JOSM

• Elemen combo key

Struktur dasar : <combo key="......" text="......" values="...,...,..." display_values="...,...,..."/>

Ini merupakan elemen yang menampilkan informasi dalam bentuk pilihan. Elemen ini biasanya digu-
nakan untuk informasi seperti tipe atap ataupun jenis dinding. Jika ingin mengumpulkan seperti itu
Anda dapat menuliskannya di presets seperti berikut:
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Elemen yang terlihat pada contoh di atas tersebut berfungsi untuk menentukan informasi jenis dinding
sehingga key yang digunakan adalah “building:walls” dan kata “text” untuk menampilkan label key dalam
Bahasa Indonesia.

Anda juga dapat melihat value yang ada ditambahkan (s) dibelakangnya karena pilihan informasi yang
disediakan lebih dari 1 dan kata “display_values” adalah label value yang bisa dituliskan dalam Bahasa
Indonesia. Berikut adalah contoh tampilan di JOSM dari elemen di atas:

Tampilan elemen combo key di JOSM

• Elemen multiselect key

Struktur dasar : <multiselect key="......" text="......" values="...;...;...;..." display_valuest="..;..;..;.." />

Elemen ini dapat menampilkan informasi dalam bentuk pilihan. Elemen ini mirip dengan combo key
dimana Anda dapat memasukkan pilihan informasi yang akan dipilih, akan tetapi perbedaannya adalah
dengan elemen ini Anda dapat memilih lebih dari satu pilihan. Elemen ini biasanya digunakan untuk
informasi seperti sumber air di suatu bangunan dimana kadang bisa memiliki lebih dari 1 sumber air.
Berikut penulisan elemen ini dalam presets:

Penulisan elemen ini mirip dengan combo key dimana perbedaannya adalah kata multiselect menggan-
tikan kata combo dan pemisah antara value menggunakan titik koma (;) sedangkan label key dan value
yang dapat ditulis dalam Bahasa Indonesia sama-sama menggunakan kata text dan display_values. Ini
merupakan contoh tampilan elemen multiselect key di JOSM:

Tampilan elemen multiselect key di JOSM

• Elemen check key

truktur Dasar : <check key="......" text="......" value_on="yes" value_off="no" default="......" />

Elemen ini biasanya digunakan untuk menampilkan isian informasi yang berupa tanda centang. Bi-
asanya elemen ini digunakan untuk pertanyaan yang jawabannya iya atau tidak seperti akses ke atap
dan jalan satu arah. Anda dapat menuliskan elemen ini di preset seperti berikut:

Penulisan elemen menggunakan value_on dan value_off dimana masing-masing dapat sesuai dengan
nilai dimana value_on artinya jika informasi itu dicentang dan value_off jika tidak dicentang. Adapun
default atau pengaturan awal dari elemen ini adalah perintah bahwa jika tidak dicentang maka informasi
ini akan tetap muncul di jendela membership di JOSM. Berikut adalah contoh tampilan elemen ini di
JOSM:
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Tampilan elemen check key di JOSM

b. Memasukkan Ikon di Presets

Hal lain yang dapat Anda lakukan dalam membuat presets adalah memasukkan ikon di presets Anda.
Ikon berfungsi sebagai gambar yang mewakili objek yang akan diisi informasinya dan selain itu akan
memperindah tampilan dari presets Anda. Untuk memasukkan ikon di presetsmaka Anda harus mema-
sukkan keterangan ikon dan tipe data di elemen pada presets seperti contoh di bawah ini:

“susunan presets”

susunan elemen presets

Jika Anda ingin menggunakan ikon yang sudah ada di JOSM maka Anda dapat melihatnya di https:
//josm.openstreetmap.de/browser/josm/trunk/presets. Akan tetapi, jika Anda ingin menggunakan
ikon yang berbeda Anda dapat membuat ikon tersebut ataupun mengambilnya dari tempat lain dan
menempatkannya secara offline di laptop/komputer Anda. Akan tetapi jika Anda membagikan presets
Anda ke teman Anda maka ikon tersebut tidak akan muncul di JOSM yang ada di laptop/komputer
mereka. Berikut adalah contoh sumber untuk menaruh ikon secara offline di laptop/komputer Anda.

C:\Users\(nama komputer/laptop Anda)\Desktop\icon presets\building.png

Silahkan download contoh presets HOT-PDC InAWARE sebagai acuan Anda dalam mempelajari materi
presets di https://bit.ly/presetshotpdcid

Contoh tampilan ikon di Presets JOSM

RINGKASAN

Anda sudah mempelajari tentang cara pembuatan presets di OpenStreetMap. Materi ini dapat mem-
bantu Anda dalam mengumpulkan informasi khusus yang Anda butuhkan saat melakukan pengumpulan
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data di lapangan. Pemanfaatan presets akan sangat bermanfaat jika Anda mengetahui pembuatan pre-
sets untuk pemetaan spesifik dengan menggunakan OpenStreetMap. Selain itu Anda dapat membantu
pengguna OpenStreetMap yang lain dengan menambahkan informasi yang lebih banyak dan tersedia
di JOSM.
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 — title: Menggunakan Aplikasi OpenMapKit weight: 3 —

Tujuan Pembelajaran:

• Mampu menjelaskan OpenMapkit sebagai salah satu alat mengambil data infrastruktur
• Mampu mengoperasikan cara pengaturan awal untuk aplikasi OpenMapKit
• Mampu mengoperasikan cara memasukkan offline basemap untuk OpenMapKit
• Mampu menerapkan cara penggunaan OpenMapKit

Sebelumnya Anda sudah mempelajari aplikasiODK (OpenDataKit) Collect, sebuah aplikasi berbasis an-
droid pengganti formulir kertas untuk survei. ODK Collect memiliki ekstensi tambahan yang dinamakan
OpenMapKit (OMK). Ekstensi tambahan ini digunakan untuk menambahkan informasi posisi atau letak
objek yang disurvei.

I. Apa itu OpenMapKit

OpenMapKit (OMK) adalah sebuah aplikasi tambahan yang digunakan untuk melengkapi aplikasi ODK
Collect dalam menentukan posisi objek yang ditemukan saat survei lapangan secara tepat dan presisi.
OpenMapKit dapat dijalankan melalui aplikasi ODK Collect, setelah Anda membuka dan memilih salah
satu formulir yang tersedia. Dalam menentukan lokasi objek, aplikasi OpenMapKit membutuhkan latar
belakang peta berupa citra satelit atau peta OSM. Jika Anda menggunakan peta OSM, maka hal yang
harus diperhatikan adalah data tersebut harus tersedia di dalam server OSM. Saat ini OpenMapKit
hanya tersedia di smartphone android. Anda dapat men-download OpenMapKit secara gratis melalui
Play Store.

“Aplikasi OpenMapKit di Play Store”

Aplikasi OpenMapKit di Play Store

Catatan : Untuk dapat menggunakan OpenMapKit Anda harus menginstal juga ODK (Open-
DataKit) Collect versi terbaru, karena formulir yang diisi di dalam OpenMapKit bersumber
dari ODK Collect.

II. Pengaturan awal OpenMapKit

Sebelum OpenMapKit digunakan, pertama-tama Anda harus melakukan pengaturan awal terlebih
dahulu. Berikut ini adalah langkah-langkah pengaturan awal OpenMapKit:

• Pada halaman awal OpenMapKit, tekan tombol pengaturan yang terletak di pojok kanan atas.
• Pilih OSM User Name lalu masukkan OSM User Name Anda

“Tampilan menu pengaturan OpenMapKit”

Tampilan menu pengaturan OpenMapKit

• Untuk basemap atau peta dasar yang menjadi latar belakang, OpenMapKit secara default akan
menampilkan Online Humanitarian OpenStreetMap.
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III. Memasukkan offline basemap untuk OpenMapKit

OpenMapKit menyediakan peta OSM sebagai basemap yang harus diakses menggunakan koneksi in-
ternet. Namun jangan khawatir, Anda juga dapat memasukkan offline basemap ke dalam OpenMapKit
yang merupakan peta dasar yang dapat dibuka tanpa koneksi internet. Offline basemap dapat memu-
dahkan Anda dalam menambahkan informasi tepat di lokasi yang Anda survei. Berikut ini adalah cara
menambahkan offline basemap:

• Format data yang digunakan sebagai offline basemap dalam aplikasiOpenMapKit harus berformat
.mbtiles. Cara pembuatan .mbtiles dapat dilihat pada modulMembuat Mbtiles untuk OMK (Open-
MapKit). Setelah Anda memiliki file .mbtiles, sambungkan smartphone Anda ke komputer/laptop.
Buka folder yang berisi file .mbtiles yang akan dimasukkan. Pilih file .mbtiles nya kemudian salin
ke folder openmapkit → mbtiles yang ada di internal storage smartphone Anda.

“Proses menambahkan file mbtiles ke dalam OpenMapKit”

Proses menambahkan file .mbtiles ke dalam OpenMapKit

• Jika sudah berhasil memasukkan .mbtiles, Anda dapat mengubah basemap OpenMapKit dengan
cara tekan tombol pengaturan yang terletak di pojok kanan atas dan tekan Basemap kemudian
pilih .mbtiles yang baru saja Anda masukkan. Lalu tekan OK.

“Tampilan pengaturan basemap di OpenMapKit”

Tampilan pengaturan basemap di OpenMapKit

IV. Pengoperasian Dasar OpenMapKit

a. Men-download Data OSM di OpenMapKit

Data OSM yang sudah ada dapat memudahkan Anda untuk menambahkan informasi bangunan karena
Anda dapat memilih langsung bangunan yang akan Anda tambahkan informasinya. Oleh karena itu,
sebaiknya Anda men-download data OSM terlebih dahulu sebelum menambahkan informasi. Langkah-
langkah untuk men-download data OSM di dalam aplikasi OpenMapKit, yaitu:

• Arahkan peta ke lokasi Anda berada saat ini (misalnya Anda sudah berada di lokasi survei) dengan
cara tekan tombol bulat yang ada di pojok kanan bawah layar hingga tombol bulat berwarna biru.
Sebuah titik hitam akan muncul di lokasi Anda berada saat ini.
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“Mengarahkan ke lokasi saat ini pada OpenMapKit”

Mengarahkan ke lokasi saat ini pada OpenMapKit

• Tekan tombol pengaturan yang ada di pojok kanan atas
• Pilih OSM XML Downloader untuk men-download data OSM sesuai dengan tampilan di layar
smartphoneAnda (lama tidaknya waktu download bergantung pada besar kecilnya area). Pastikan
Anda tersambung dengan koneksi internet saat men-download data OSM. Perhatikan warna ban-
gunan, bangunan pada basemap OSM berwarna cokelat dan bangunan hasil download berwarna
ungu.

“Warna bangunan pada basemap OSM kiri dan Warna bangunan hasil download kanan”

Warna bangunan pada basemap OSM (kiri) dan Warna bangunan hasil download (kanan)

• Data OSM yang baru saja di-download akan tersimpan dalam format .osm yang dapat diaktifkan
atau dinonaktifkan melalui tombol pengaturan → OSM XML Layer.

“Pengaturan OSM XML Downloader dan OSM XML Layers”

Pengaturan OSM XML Downloader dan OSM XML Layers

b. Menambahkan informasi bangunan di OpenMapKit

Jika sudah berhasil men-download data bangunan dari OSM, Anda dapat menambahkan informasi ban-
gunan tersebut dengan cara:

• Pilih pada bangunan yang akan ditambahkan informasinya. Pastikan bangunannya berwarna
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ungu yang menandakan bangunan tersebut sudah di-download dari OSM. Jika bangunan terpilih,
warnanya akan berubah menjadi oranye.

• Anda dapat mengisi informasi bangunan tersebut sesuai dengan formulir yang sudah Anda pilih
sebelumnya di aplikasi ODK Collect, dengan cara tekan pada informasi tag pada baris pertama
yang terletak di bawah.

“Mengisi informasi bangunan menggunakan formulir dari ODK Col-
lect”

Mengisi informasi bangunan menggunakan formulir dari ODK Collect

• Setelah selesai, di akhir halaman pilih Save untuk menyimpan isian formulir ke dalamODK Collect.
Jika sudah selesai mengisikan formulir, bangunan yang Anda isikan informasinya akan terlihat
seperti ini:

“Tampilan bangunan yang sudah diisikan informasinya”

Tampilan bangunan yang sudah diisikan informasinya

Jika lokasi survei Anda masih belum tersedia data bangunannya di dalam OSM, Anda dapat memetakan
bangunan terlebih dahulu sebelum melakukan survei. Jika tidak ada waktu untuk melakukan pemetaan
bangunan, Anda dapat menggunakan titik untuk menandakan objek di aplikasi OpenMapKit dengan
cara:

• Gunakan .mbtiles yang sudah Anda masukkan sebelumnya untuk membantu menandai objek se-
cara akurat dengan cara tekan tombol pengaturan → Basemap

• Tekan ikon plus (+) yang ada di pojok kanan bawah layar Anda hingga berubah warna menjadi
hijau. Akan munculmarker atau penanda warna hijau dengan tulisan Add Node di atasnya. Geser
peta hingga lokasi penanda akurat dengan objek yang disurvei.

“Menambahkan penanda menggunakan ikon plus”

Menambahkan penanda menggunakan ikon plus (+)
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• Tekan Add Node jika titik sudah akurat

“Tombol add node saat menambahkan titik”

Tombol add node saat menambahkan titik

• Jika titik yang Anda tambahkan ternyata posisinya kurang sesuai dengan objek yang ada di lapan-
gan, Anda dapat menggeser titik yang sudah tambahkan dengan cara klik titik yang akan digeser
kemudian tekan ikon dua panah di pojok kanan atas. Warna titik akan berubah menjadi oranye
dan di atasnya terdapat tulisan Place Node.

“Menggeser titik yang sudah ditambahkan”

Menggeser titik yang sudah ditambahkan

• Geser peta hingga posisi titik akurat, kemudian tekan Place Node.

“Tombol place node saat menggeser titik”

Tombol place node saat menggeser titik

• Setelah posisi titik sudah akurat dan sama dengan objek yang ada di lapangan, Anda dapat
melakukan pengisian formulir sama seperti langkah sebelumnya.

• Masukkan informasi yang sesuai dengan kondisi di lapangan. Geser layar ke kanan atau ke kiri
untuk mengganti halaman pertanyaan pada formulir.

• Di akhir halaman, pilih Save untuk menyimpan isian formulir ke dalam ODK Collect. Jika sudah
selesai mengisikan formulir, titik objek yang Anda isikan informasinya akan terlihat seperti ini:

“Tampilan titik objek yang sudah diisikan informasinya”

Tampilan titik objek yang sudah diisikan informasinya

• Anda dapat melihat formulir yang sudah berhasil disimpan pada ODK Collect, yang dapat Anda
pelajari di modul Menggunakan Aplikasi ODK Collect.
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RINGKASAN

Jika Anda dapat mengikuti dan memperhatikan seluruh tahapan dalam bab ini, maka Anda telah berhasil
memahami OpenMapKit sebagai salah satu alat survei lapang untuk mengambil data infrastruktur. Se-
lain itu, Anda juga telah berhasil menerapkan pengoperasian cara pengaturan awal OpenMapKit, cara
memasukkan offline basemap untuk OpenMapKit dan cara penggunaan OpenMapKit untuk mengambil
data infrastruktur. Formulir yang sudah Anda tambahkan di dalam aplikasi OpenMapKit dapat dilihat
dan dikirimkan ke server melalui aplikasi ODK Collect.
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Pengenalan Java OpenStreetMap (JOSM)

Tujuan Pembelajaran:

• Mengerti cara download file instalasi JOSM
• Mampu melakukan instalasi JOSM
• Mampu mengubah pengaturan JOSM
• Memahami tampilan antarmuka JOSM

JOSM adalah singkatan dari Java OpenStreetMap yang merupakan perangkat editor OpenStreetMap
berbasis desktop. JOSM memungkinkan Anda melakukan proses edit data pemetaan secara offline
untuk sementara waktu atau tidak harus selalu terkoneksi dengan internet. Hal ini tentunya akan memu-
dahkan Anda yang bekerja dalam keterbatasan koneksi internet. Anda hanya membutuhkan koneksi
internet ketika akan men-download data dariOpenStreetMap dan ketika akan men-upload data ke server
OpenStreetMap. Selain itu pada modul ini juga akan mempelajari cara untuk mengubah beberapa pen-
gaturan pada JOSM agar nantinya memudahkan Anda dalam menggunakannya. Anda juga akan mem-
pelajari dan memahami apa saja bagian-bagian yang ada pada tampilan antarmuka di JOSM. Dengan
memahami setiap bagian dari JOSM, di akhir modul ini Anda akan mendapatkan pemahaman secara
menyeluruh mengenai perangkat JOSM beserta beberapa pengaturan dasar di dalamnya.

I. Download JOSM

Jika Anda memiliki salinan file instalasi JOSM pada sebuah CD atau flashdisk, Anda dapat langsung
melanjutkan ke sub-bab selanjutnya yaitu Menginstal JOSM. Tetapi jika Anda tidak memiliki JOSM,
atau ingin memiliki JOSM versi terbaru, silakan buka web browser Anda (dapat menggunakan Fire-
fox, Chrome, Opera, atau Internet Explorer). Pada kolom alamat di bagian atas jendela, kemudian
ketik josm.openstreetmap.de kemudian tekan enter. Anda juga dapat menemukan situs JOSM den-
gan mengetik kata pencarian “JOSM” pada mesin pencarian google. Situs JOSM akan tampak seperti
di bawah ini.

Tampilan situs JOSM

Silakan pilih file instalasi sesuai dengan sistem operasi komputer Anda. Jika Anda menggunakan kom-
puter dengan sistem operasi Windows, klik Windows JOSM Installer untuk men-download JOSM. Jika
Anda memiliki sistem operasi lainnya, klik pada link yang sesuai dengan sistem operasi komputer Anda.
Kemudian Anda dapat men-download-nya. Pada modul ini kami akan mengasumsikan Anda menggu-
nakan Windows, tetapi petunjuknya hampir sama dengan sistem operasi lainnya.
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II. Menginstal JOSM

Setelah Anda berhasil men-download JOSM, sekarang Anda akan menginstal JOSM ke komputer atau
laptop Anda. Berikut ini adalah cara-cara untuk melakukan instalasi JOSM: * Temukan file instalasi
JOSM di dalam komputer Anda. Klik dua kali pada file tersebut untuk memulai instalasi. Kemudian
akan muncul jendela “Do you want to allow this app from an unknown publisher to make changes to
your device?”, lalu klik Yes. * Selanjutnya akan muncul jendela untuk memilih bahasa. Di modul ini
hanya akan membahas JOSM yang berbahasa Inggris. Jika bahasa sudah dipilih, silakan klik OK.

Tampilan jendela installer language

• Kemudian akan muncul jendela selanjutnya mengenai JOSM Setup Wizard. Klik Next.

Tampilan JOSM Setup Wizard

• Selanjutnya akan muncul jendela License Agreement. Klik I Agree.
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Tampilan jendela License Agreement

• Berikutnya akan muncul jendela Choose Components. Disini Anda dapat memilih apa saja dari
bagian JOSM yang ingin Anda install. Kemudian klik Next.

Tampilan jendela choose components

• Selanjutnya akan muncul jendela Choose Install Location. Disini Anda dapat memilih folder di-
mana Anda ingin menginstal JOSM. Kemudian klik Install.
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Tampilan jendela choose install location

• Ketika instalasi selesai, klik Finish untuk membuka JOSM pertama kalinya. Kemudian, ketika
ingin memulai JOSM, Anda dapat melakukannya dengan mengklik pada Start Menu di pojok kiri
bawah pada komputer Anda, dan klik program JOSM.

• Ketika JOSM terbuka, maka akan terlihat tampilan seperti di bawah ini:

Tampilan awal JOSM

Catatan: Anda mungkin memiliki masalah ketika melakukan instalasi JOSM apabila Java
belum terinstal di komputer Anda. Jika Anda memiliki masalah ketika melakukan instalasi
pada bagian ini, cobalah mendownload dan menginstal Java. Anda dapat mendownload-
nya disini: http://www.java.com/en/download/ Anda mungkin akan melihat sebuah jendela
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muncul saat pertama kali membuka JOSM yang menanyakan untuk memperbarui perangkat
lunak tersebut. Anda tidak perlu memperbaharuinya karena yang baru saja Anda download
perangkat lunak baru. Tekan tombol “Cancel”. Jika Anda tidak ingin melihat pesan ini lagi,
centang kotak di bawah sebelum menekan “Cancel”. JOSM yang digunakan dalam modul
ini versi 14760. Tampilan mungkin berbeda jika Anda menggunakan JOSM versi yang lain.

III. Mengubah Pengaturan Pada JOSM

a. Mengubah Bahasa

Banyak pengaturan yang dapat Anda sesuaikan di JOSM. Salah satu pengaturan yang Anda mungkin
ingin sesuaikan adalah bahasa. JOSM telah diterjemahkan ke dalam berbagai macam bahasa, dan
Anda dapat memilih bahasa yang Anda inginkan. Berikut ini adalah langkah-langkah untuk mengubah
bahasa di JOSM:

• Akses jendela Preferences, klik Edit → Preferences.

Menu preferences di JOSM

• Pada sisi sebelah kiri, klik ikon Display Setting yang terlihat seperti kaleng dan kuas cat.

Ikon display setting

• Di atas jendela, klik tab yang bertuliskan Look and Feel.
• Pilihlah bahasa yang Anda inginkan pada kotak daftar pilihan yang bertuliskan Language. KlikOK

dan kemudian restart untuk mengganti bahasa JOSM anda ke dalam bahasa yang Anda inginkan.
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Tampilan display setting untuk mengganti bahasa

b. Mengatur Akun

Setelah mengubah bahasa yang diinginkan untuk digunakan di JOSM, Anda juga harus memasukkan
nama akun OSM Anda serta kata sandinya di dalam JOSM. Tujuannya adalah agar ketika Anda
melakukan edit atau menambahkan data di peta OSM, server akan mengenali bahwa hasil edit tersebut
dibuat oleh Anda. Jika Anda tidak memasukkan nama akun, maka Anda tidak dapat memasukkan data
yang sudah Anda edit atau tambahkan ke dalam peta OSM. Berikut ini adalah langkah-langkah untuk
memasukkan akun OSM Anda di JOSM:

• Akses jendela Preferences, klik Edit → Preferences.

Ikon preferences di JOSM

• Pada sisi sebelah kiri, klik ikon Connection Setting yang terlihat seperti gambar globe atau bola
dunia.
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Ikon connection setting

• Pilih Authentication → Use Basic Autentication.
• Masukkan nama akun dan kata sandi Anda.

Tampilan connection setting untuk memasukkan nama akun dan kata sandi

• Klik OK dan kemudian restart JOSM Anda.

c. Menambahkan Preset

Sekarang Anda telah memasukkan nama akun Anda. Selanjutnya adalah pengaturan untuk mema-
sukkan presets di JOSM. Presets adalah sebuah file yang dapat memberikan informasi terkait objek-
objek yang Anda petakan di OpenStreetMap. Untuk penjelasan lebih detail tentang presets dan pem-
buatan presets, Anda dapat melihatnya di Panduan Pembuatan Presets di modul Membuat Preset.
Berikut ini adalah langkah-langkah untuk menambahkan presets di JOSM:

• Akses jendela Preferences, klik Edit → Preferences.
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Menu preferences di JOSM

• Pada sisi sebelah kiri, klik ikon Map Setting yang terlihat seperti grid atau kotak-kotak.

Ikon Map Setting

• Dibawah kotak Available Preset cari dan pilih preset yang bernama HOT PDC InAWARE Indone-
sian Project. Lalu klik tanda panah biru yang berada di sebelah kanan kotak.

Menambahkan preset di JOSM

Jika Anda sudah memiliki file presets Anda sendiri di komputer Anda, Anda juga dapat langsung mema-
sukkannya dengan cara:

• Silahkan klik tanda + di samping kotak active presets.
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Tanda + untuk menambahkan preset dari komputer

• Kemudian ikon Open a File untuk mencari file presets Anda.

Ikon Open a File

• Jika sudah ditemukan klik Open kemudian OK.

d. Memasukkan Citra Satelit

Anda akan menggunakan citra satelit pada saat mengedit peta OSM. Jika koneksi internet Anda stabil
pada saat membuka pengaturan JOSM, maka di bagian Edit→ Preferences→ Imagery Preferences,
akan otomatis terpilih citra-citra satelit yang sering digunakan. Jika koneksi internet bermasalah dan
saat dilihat bagian Imagery Preferences tidak ada citra satelit yang terpilih, coba restart JOSM dan lihat
kembali di bagian Imagery Preferences apakah citra satelitnya sudah terpilih atau belum. Jika masih
belum terpilih juga, maka berikut ini adalah langkah-langkah untuk menambahkan presets di JOSM:

• Akses jendela Preferences, klik Edit→ Preferences.

Ikon preferences di JOSM

• Pada sisi sebelah kiri, klik ikon Imagery Preferences atau yang bertuliskan WMS TMS.

Ikon imagery preferences
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• Kemudian klik citra satelit yang ingin Anda pilih (misalnya Bing, Digital Globe, Mapbox, dan Esri)
pada kotak Available default entries.

• Selanjutnya klik tombol Activate di bawah kotak Available default entries.

Tombol Activate

• Kemudian Anda akan melihat citra satelit yang sebelumnya Anda pilih sudah masuk ke dalam
kotak Selected Entries seperti gambar di bawah ini. Kemudian klik OK dan JOSM akan meminta
untuk restart.

Tampilan citra yang sudah dipilih

e. Mengatur Tampilan Gambar Objek

Pada pengaturan awal di JOSM, setiap objek OpenStreetMap yang ada di JOSM tidak memperlihatkan
titik, label, dan ikon dari setiap objek OpenStreetMap.
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Contoh tampilan awal JOSM yang pengaturannya belum diubah

Untuk memunculkannya Anda harus mengubah tampilan style peta pada JOSM Anda. Berikut ini adalah
langkah-langkah untuk mengubahnya:

• Klik pada menu File → New Layer untuk memunculkan panel pada JOSM.
• Pada bagian kanan di panel JOSM, lihat pada bagian Map Paint Styles.
• Jika pada panel JOSM Anda belum ada jendela Map Paint Styles, silahkan Anda klik menu Win-
dows pada sisi atas JOSM Anda, kemudian klikMap Paint Styles untuk mengaktifkan jendelaMap
Paint Styles di sisi kanan JOSM Anda.
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Tampilan untuk mengaktifkan Map Paint Styles

• Setelah Anda klik, akan muncul jendela Map Paint Styles di sebelah kanan bawah JOSM Anda.
• Klik kanan pada JOSM default (Map CSS) dan pilih Style Settings.

• Samakan dengan tampilan di bawah ini.

Pengaturan Map Paint Styles di JOSM

Apabila semua pengaturan sudah disamakan dengan apa yang terlihat seperti di atas, tampilan gambar
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JOSM Anda nantinya akan memunculkan titik, label, dan ikon untuk setiap objek di OpenStreetMap
seperti contoh di bawah ini:

Contoh tampilan awal JOSM yang pengaturannya sudah diubah

IV. Tampilan Antarmuka JOSM

Sekarang Anda sudah melakukan beberapa pengaturan di JOSM. Agar lebih memudahkan Anda untuk
melakukan editing, Anda perlu untuk melihat beberapa bagian penting di JOSM. Untuk melihat tampilan
antarmuka JOSM, klik pada menu File → New Layer. Berikut adalah beberapa bagian di antar muka
di JOSM.

Bagian-bagian pada tampilan JOSM

Pada JOSM terdapat bidang peta, toolbar, dan panel. Bidang peta adalah bidang untuk melihat,
mengedit, dan menambahkan data OpenStreetMap. Pada bagian kanan JOSM terdapat serangkaian
panel yang memiliki fungsi tertentu. Biasanya ketika Anda pertama kali menginstal JOSM, beberapa
panel yang akan ditampilkan dengan pengaturan standar, seperti Layer, Selections, Tags/Memberships,
dan Author.
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• Panel layers akan menampilkan layer apa saja yang ditambahkan ke dalam JOSM, seperti citra
satelit, hasil download data OSM, dan sebagainya.

• Ketika Anda memilih sebuah objek, baik berupa titik, garis, atau poligon di dalam bidang peta,
akan ditampilkan di panel selections.

• Informasi mengenai objek yang akan ditampilkan pada panel Tags/Memberships.
• Nama pembuat objek akan ditampilkan di panel author.

Jika ingin menghilangkan panel-panel tertentu, Anda dapat mengklik tanda x pada pojok kanan panel
yang ingin hilangkan. Jika ingin menambahkan panel lainnya, Anda dapat mengaktifkannya di menu
Windows dan setelah diaktifkan akan muncul pada panel di sebelah kanan JOSM.

Toolbar samping kiri pada JOSM adalah jendela alat yang berisi beberapa tombol untuk editing seperti
tombol Select object dan Draw nodes. Di bawahnya adalah alat-alat yang untuk zoom andmove map,
delete nodes or way, dan create areas. Untuk pilihan toolbar lainnya, Anda dapat mengklik tombol dua
panah ke kanan warna hitam. Kemudian klik toolbar yang Anda inginkan dan akan muncul di toolbar.

Tombol untuk mengatur toolbar pada JOSM

RINGKASAN

Jika Anda dapat mengikuti dan mempraktikkan seluruh tahapan dalam modul ini, maka Anda telah
berhasil menginstal JOSM di dalam laptop atau komputer Anda. Selain itu, Anda juga telah berhasil
mempelajari dan mempraktekkan bagaimana cara melakukan pengaturan standar di JOSM untuk
memudahkan pekerjaan Anda. Pada modul selanjutnya Anda akan mempelajari bagaimana cara
menambahkan data di JOSM mulai dari tingkat dasar hingga tingkat lanjut.
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Penjaminan Kualitas Data dengan Tasking Manager

Tujuan Pembelajaran:

• Memahami penjaminan kualitas data dengan menggunakan Tasking Manager

Sebelumnya Anda pasti sudah pernah editing data OpenStreetMap menggunakan tasking manager.
Tasking manager memudahkan Anda untuk mengedit data OpenStreetMap secara bersama-sama
tanpa harus khawatir akan terjadi konflik dengan orang lain karena mengerjakan area yang sama.
Selain untuk mengedit data OpenStreetMap, Anda juga dapat melakukan validasi menggunakan
tasking manager sehingga Anda dapat melakukan validasi secara bersama-sama.

I. Penjaminan Kualitas Data dengan Tasking Manager

a. Validasi Area Proyek Tasking

Cara untuk melakukan validasi dengan menggunakan tasking manager tidak jauh berbeda dengan cara
mengedit di tasking manager. Berikut ini adalah langkah-langkah untuk melakukan validasi menggu-
nakan tasking manager.

• Buka web browser Anda dan silakan mengakses ke https://tasks.hotosm.org/.
• Anda akan melihat tampilan browser Anda seperti gambar di bawah ini.

Tampilan awal tasking manager

• Silakan Anda login atau masuk terlebih dahulu menggunakan akun OpenStreetMap Anda dengan
cara mengklik pada tombol Login di sebelah pojok kanan atas.
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Tombol login pada tasking manager

• Anda akan langsung diarahkan ke situsOpenStreetMap dan silakan Anda klikGrant Access untuk
mengizinkan akun Anda diakses oleh tasking manager.

Tampilan untuk Grant Access akun OSM Anda

• Selanjutnya Anda sudah berhasil login di tasking manager. Anda dapat memulai validasi dengan
cara klik tombol Contribute atau klik Start Mapping.

Tombol Contribute dan Start Mapping untuk memulai validasi

• Kemudian tampilan Anda akan seperti gambar di bawah ini.
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Tampilan Contribute

• Anda dapat memilih salah satu dari banyak tasking yang ada untuk Anda validasi. Atau Anda juga
dapat mencari tasking yang ingin Anda validasi dengan cara mengetik kata kunci di kolom Search
pada sisi sebelah kiri tampilan tasking manager Anda, kemudian tekan Enter. Anda akan melihat
daftar tasking yang berkaitan dengan kata kunci yang sebelumnya Anda cari. Silakan cari dan
pilih tasking yang ingin Anda validasi.

Contoh hasil pencarian menggunakan kata kunci yang telah dimasukkan

• Setelah Anda pilih tasking yang ingin Anda validasi, Anda akan melihat penjelasan umum menge-
nai tasking tersebut.
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Penjelasan umum mengenai tasking

• Jika Anda scroll ke bawah, Anda akan melihat Instructions tasking tersebut. Di atas instructions
terdapat 4 tab, salah satunya adalah validate. Anda dapat memulai validasi dengan cara klik tab
Validate. Selain dengan cara klik tab validate, di bagian paling bawah terdapat kotak pertanyaan
“Ready to get started?” dengan pilihan Map dan Validate, silakan Anda pilih Validate.
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Pilihan untuk memulai validasi

• Sebagai informasi, kotak atau grid yang akan Anda validasi adalah kotak yang sudah dipetakan
yaitu kotak yang berwarna oranye. Ketika Anda sudah selesai melakukan validasi, kotak yang
Anda kerjakan akan berubah menjadi warna hijau.

• Setelah Anda klik validate, terdapat beberapa pilihan untuk memilih kotak mana yang mau Anda
pilih. Untuk yang perannya sebagaimapper atau validator, pilihannya hanya ada dua pilihan, yaitu
pilihan pertama dan pilihan kedua, sedangkankan untuk kelima pilihan ini hanya dapat dilakukan
oleh yang perannya project manager. Berikut ini adalah pilihan-pilihannya:

1. Pilihan yang pertama adalah memilih sendiri kotak warna oranye yang mana yang ingin Anda
kerjakan.

2. Pilihan yang kedua adalah membiarkan tasking memilihkan kotak untuk divalidasi secara
acak.

3. Pilihan yang ketiga adalah memilih area yang akan divalidasi dengan cara menggambar
poligon sesuai dengan keinginan Anda, dan kemudian tasking akan otomatis terpilih beber-
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apa kotak tasking sesuai dengan area poligon yang Anda buat, kemudian klik start validating
yang berada di pilihan ketiga.

4. Pilihan keempat dapat dipilih ketika Anda sudah lock salah satu kotak tasking, tetapi Anda
lupa kotak yang mana yang sudah Anda pilih. Setelah Anda klik pilihan nomor empat, maka
tasking akan otomatis menunjukkan kotak yang sudah Anda pilih.

5. Pilihan kelima adalah memilih kotak tasking berdasarkan nama kontributor di bawah pilihan
kelima.

Pilihan untuk memilih kotak validasi

• Ketika Anda sudah memilih kotak mana yang ingin Anda kerjakan, sekeliling kotak Anda akan
berubah warna menjadi warna kuning. Anda dapat memulai validasi dengan memilih kotak Start
Validating. Jika Anda ingin mengganti kotaknya, Anda dapat memilih kotak Select Another Task.

Tampilan untuk memulai validasi

• Jika Anda sudah klik Start Validating, warna kotak yang Anda pilih akan berubah menjadi warna
biru dengan warna kuning di sekeliling kotak. Hal ini menandakan Anda telah mengaktifkan
kotak untuk divalidasi. Anda akan dapat memilih tools apa yang ingin Anda gunakan untuk
melakukan validasi. Anda dapat menggunakan iD Editor, JOSM, Potlatch 2, dan Field Papers.
Anda disarankan untuk menggunakan JOSM dalam melakukan validasi karena JOSM memiliki
lebih banyak fitur untuk mengedit.
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Pilihan tools untuk melakukan validasi

• Setelah Anda pilih JOSM sebagai alat untuk validasi, Anda dapat langsung klik Start Editor.

Tombol start editor untuk memulai validasi

• Setelah Anda klik Start Editor, JOSM akan secara otomatis men-download data OpenStreetMap
sesuai dengan grid/kotak yang telah Anda pilih. Untuk menggunakan JOSM sebagai alat validasi,
Anda dapat mempelajari lewat modul JOSM Untuk Perhitungan Kualitas Data.

• Setelah Anda selesai melakukan validasi di JOSM dan semua objek sudah terpetakan, silakan
Anda kembali ke web browser tasking manager Anda dan klikMark as Valid. Jika grid/kotak yang
Anda pilih belum terpetakan secara keseluruhan atau masih banyak objek yang belum sesuai
dipetakan, Anda dapat klik Mark as Invalid. Anda juga dapat menambahkan komentar alasan
kotak tersebut di Mark as Invalid, misalnya banyak objek yang belum terpetakan, agar kontributor
berikutnya yang memilih kotak tersebut mengetahui kesalahannya. Setelah Anda klik Mark as In-
valid, kontributor lain dapat mengerjakan ulang atau menambahkan data pada kotak tasking yang
sudah Anda Mark as Invalid tersebut. Jika Anda ingin mengganti kotak tasking untuk divalidasi,
Anda dapat klik Stop Validating, sehingga orang lain dapat melanjutkan validasi di kotak tersebut.
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Tombol-tombol untuk memilih setelah validasi

• Jika Anda klik Mark as Valid, maka kotak tasking yang sebelumnya Anda pilih berubah warna
menjadi hijau. Jika Anda klik Mark as Invalid, maka kotak tasking yang sebelumnya Anda pilih
berubah warna menjadi merah muda. Jika Anda klik Stop Validating, maka kotak tasking yang
sebelumnya Anda pilih berubah kembali menjadi berwarna oranye.

• Jika sudah selesai melakukan validasi dalam satu kotak tasking, Anda dapat melakukan validasi di
kotak lain yang berwarna oranye. Silakan Anda lakukan validasi sesuai dengan langkah-langkah
sebelumnya

b. Hal-hal yang Harus Diperhatikan Saat Melakukan Validasi di Proyek Tasking

Saat Anda melakukan validasi menggunakan tasking manager terdapat hal yang harus diperhatikan,
yaitu batas waktu untuk mengerjakan kotak yang sudah Anda pilih. Jika Anda sudah memulai validasi,
terdapat batasan waktu untuk mengerjakan tasking yang Anda pilih di bagian atas seperti di bawah ini:
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Contoh batas waktu untuk validasi

Batas waktu untuk mengerjakan validasi menggunakan tasking manager ini adalah dua jam. Setelah
melewati dua jam (120 menit), tasking akan otomatis terbuka kembali atau unlock kotak tasking yang
Anda pilih. Jika Anda sedang melakukan validasi dan membutuhkan waktu lebih dari dua jam, sebaiknya
Anda klik Stop Validating terlebih dahulu sebelum durasi dua jam tersebut habis, kemudian pilih Start
Editor kembali. Kemudian Anda dapat melanjutkan validasi kembali.

RINGKASAN

Anda telah mempelajari dan mempraktikkan bagaimana cara untuk melakukan validasi menggunakan
tasking manager. Validasi menggunakan tasking manager ini memudahkan Anda untuk melakukan val-
idasi secara bersama-sama dengan orang lain sehingga proses validasi dapat lebih cepat diselesaikan.
Selanjutnya Anda akan mempelajari cara penggunaan JOSM untuk menghitung kualitas data di OSM.
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 — title: JOSM untuk Perhitungan Kualitas Data weight: 4 —

Tujuan Pembelajaran:

• Memahami cara memilih dan menghitung jumlah objek dalam suatu batas administrasi
• Mengetahui cara menghitung jumlah error dan warning dalam suatu batas administrasi
• Mengetahui cara melakukan validasi batas-batas administrasi

Dalam melakukan kegiatan pemetaan salah satu targetnya adalah menghasilkan peta yang berkual-
itas. Salah satu kualitas yang dimaksud berupa kelengkapan jumlah data dan informasi yang diper-
oleh dalam kegiatan pengumpulan data di lapangan. Pemanfaatan OpenStreetMap sebagai peta dasar
yang digunakan untuk menampilkan hasil pengumpulan data di lapangan dapat membantu Anda dalam
melakukan perhitungan baik dari banyaknya data objek yang ada kumpulkan dan juga informasi yang
terdapat di dalamnya. Pada modul ini Anda akan mempelajari menghitung jumlah data infrastruktur dan
batas-batas administrasi hasil pengumpulan di lapangan dengan menggunakan perangkat lunak Java
OpenStreetMap (JOSM)

I. Menghitung Objek Dalam Batas Administrasi

Salah satu kegiatan pada tahap memantau kualitas data adalah dengan menghitung jumlah objek yang
berada di wilayah pemetaan. Tujuannya adalah untuk mengetahui pertambahan data yang ada di
wilayah pemetaan sebelum dan sesudah kegiatan pemetaan dilaksanakan. Selain itu, kegiatan ini
bertujuan untuk memantau kelengkapan atribut dan bentuk masing-masing objek yang menjadi prior-
itas di wilayah tersebut. Anda dapat menggunakan JOSM dalam melakukan perhitungan objek dalam
area pemetaan. Terdapat beberapa langkah untuk menghitung objek dalam suatu wilayah administrasi
misalnya pada tingkat kelurahan.

a. Download Data OpenStreetMap di Wilayah Pemetaan

Sebelum Anda memulai menghitung jumlah objek, tentu saja Anda harus men-download data Open-
StreetMap di area pemetaan. Dalam melakukan perhitungan objek, Anda dapat menggunakan batas
administrasi kelurahan yang terdapat di dalam wilayah kecamatan . Sebagai contoh, Anda akan menghi-
tung jumlah objek di Kelurahan Pleburan, Kecamatan Semarang Selatan. Berikut adalah langkah-
langkah yang dilakukan saat men-download data OpenStreetMap:

• Buka JOSM di laptop/komputer Anda.
• Kemudian pilih menu File → Download Data ,nda akan melihat kotak area yang dapat Anda
download di OpenStreetMap.

• Pilih menu Areas around Places kemudian masukkan nama kecamatan “Pleburan” di kotak pen-
carian dan pastikan Anda telah mencentang tipe dataOpenStreetMap Data dan pilihanDownload
as New Layer.

• Setelah berhasil, pilih hasil pencarian yang paling sesuai dengan kecamatan yang ingin Anda
download. Pilihlah yang berada di Semarang dan memiliki tipe boundary=administrative. Hasil
pencarian yang anda pilih akan berwarna biru.
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“Kotak pencarian area download di JOSM”

Kotak pencarian area download di JOSM

• Setelah semua selesai diatur, kemudian klik Download.

“Hasil download data di JOSM”

Hasil download data di JOSM

Catatan : Jika wilayah kecamatan Anda terlalu besar, silakan download secara bertahap
sampai semua area berhasil di-download ke dalam JOSM

b. Menghitung Jumlah Objek di Suatu Wilayah Administrasi

Jika Anda telah berhasil mendownload data di area pemetaan , maka langkah berikutnya adalah
melakukan perhitungan jumlah objek di kelurahan yang telah ditentukan. Berikut adalah langkah-
langkah dalam melakukan perhitungan jumlah objek:

• Pilih Edit → Search untuk memilih batas area administrasi Kelurahan Pleburan.
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“Menu pencarian data di JOSM”

Menu pencarian data di JOSM

• Kemudian di kotak pencarian silahkan ketik “admin_level=7” kemudian klik Start Search

“Jendela pencarian untuk memilih kelurahan di JOSM”

Jendela pencarian untuk memilih kelurahan di JOSM

• Anda akan melihat semua obyek OSM yang memiliki _tag “admin_level=7_” akan terpilih di jen-
dela selection. Setelah itu silakan pilih Kelurahan Pleburan yang akan Anda hitung objek yang
ada di dalam wilayah tersebut dan klik 2 kali. Anda akan melihat garis batas administrasi Kelura-
han Pleburan akan berubah menjadi warna ungu di dalam layer data JOSM, hal ini menandakan
kelurahan tersebut sudah terpilih.
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“Hasil pencarian kelurahan di JOSM”

Hasil pencarian kelurahan di JOSM

• Jika di JOSM Anda belum terdapat menu Selectionmaka Anda harus menginstal plugin utilsplugin
di JOSM. Penjelasan tentang cara menginstal plugin ini dapat Anda lihat di Modul Menambahkan
Data OSM menggunakan JOSM. Setelah itu pilih menu Selection → All inside [testing]. Anda
akan melihat seluruh data yang berada di Kelurahan Pleburan akan terpilih dan berwarna merah.

“Hasil seleksi data di JOSM”

Hasil seleksi data di JOSM

• Kemudian pilih kembali menu Selection → Intersecting Ways untuk memilih kembali semua data
yang di dalam maupun yang bersinggungan dengan Kelurahan Pleburan, seperti jaringan jalan
dan sungai. Durasi dari proses ini berlangsung tergantung dari luas wilayah dan banyaknya data
yang ada di dalamnya.
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“Seleksi keseluruhan data di area tertentu di JOSM”

Seleksi keseluruhan data di area tertentu di JOSM

• Setelah selesai Anda dapat melihat total jumlah objek di jendela properties/membership pada
JOSM Anda.

“Seleksi keseluruhan data di area tertentu di JOSM”

Seleksi keseluruhan data di area tertentu di JOSM

• Seperti yang terlihat di Kelurahan Pleburan, total data yang ada di wilayah tersebut sebesar 1995
objek. Namun perlu Anda ingat, ini hanyalah total data keseluruhan diOpenStreetMap yang men-
jadi rangkaian untuk menghitung kualitas data di JOSM, Anda tidak akan melakukan perhitungan

195



untuk masing-masing spesifik objek.

II. Menghitung Jumlah Error danWarning Dalam Batas Administrasi

Setelah berhasil menghitung total data dalam area pemetaan atau dalam contoh ini adalah Kelurahan
Pleburan, Anda akan melanjutkan langkah-langkah untuk menghitung jumlah Error dan Warning dalam
data yang telah Anda pilih di Kelurahan Pleburan. Berikut adalah langkah-langkah yang dapat dilakukan:

• Klik tombol Validation pada jendela validasi di JOSM. Kemudian tunggu hingga JOSM selesai
menghitung jumlah Error dan Warning yang ada di data Anda.

“Jendela validasi data di JOSM”

Jendela validasi data di JOSM

• Jika JOSM sudah selesai menghitung, maka akan muncul daftar error dan warning pada data
tersebut. Anda sebaiknya mencatat jumlah error dan warning yang terdapat pada jendela validasi
serta langsung memperbaiki dan menyelesaikan semua warning dan error. Untuk penjelasan lebih
lanjut tentang cara memperbaiki (validasi) data di JOSM serta daftar error danwarning yang sering
terjadi dapat anda lihat pada Modul Penggunaan JOSM untuk Validasi Data Survei.
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“Hasil validasi data di JOSM”

Hasil validasi data di JOSM

• Setelah memperbaiki error danwarning yang ada, Anda dapat melakukan rekapitulasi perhitungan
kualitas data diMicrosoft Excel atau Google Sheet. Hal ini bertujuan untuk melihat perbandingan
kualitas data yang ada di kelurahan pemetaan, sebelum dan sesudah kegiatan pengumpulan data
di lapangan, sehingga Anda dapat melihat progres dari kegiatan pemetaan tidak hanya dari sisi
kuantitas tapi juga dari kualitas data yang dihasilkan. Jenis error dan Warning yang dihasilkan
juga dimasukkan ke dalam tabel perhitungan.

Tabel Rekapitulasi Perhitungan Kualitas Data

“Tabel Rekapitulasi Perhitungan Data”

Seperti yang dapat Anda lihat pada tabel di atas, jumlah objek di Kelurahan Pleburan sebelum
pemetaan adalah 1.863 dimana terdapat 4 warning pada data yang ada. Kemudian setelah di-
lakukan kegiatan pengumpulan data di lapangan dan validasi data jumlah data yang ada di kelurahan
tersebut meningkat menjadi 1.963 dimana tidak terdapat error maupun warning sama sekali. Anda
dapat melihat contoh tabel hasil perhitungan kualitas data di Kota Semarang secara keseluruhan di
http://bit.ly/tabeldatasemarang

III. Melakukan Validasi Batas-Batas Administrasi

Setelah Anda melakukan rekapitulasi atau perhitungan jumlah objek dan kualitas data OSM di kelurahan
pemetaan, hal yang tidak kalah penting untuk dilakukan adalah melakukan perhitungan untuk kualitas
data terhadap batas-batas administrasi. Dalam perhitungan ini, Anda akan melakukan validasi terhadap
batas-batas kelurahan dan rukun warga (RW) yang terdapat di kelurahan tersebut. Adapun validasi
yang dilakukan adalah meliputi jumlah RW yang dipetakan, kelengkapan informasi (tag), relasi dari
batas kelurahan dan RW, dan melakukan backup batas administrasi dengan menyimpannya sebagai
file .osm yang baru. Kita kembali akan menggunakan Kelurahan Pleburan yang telah kita download
pada materi sebelumnya.

a. Menghitung Jumlah RW
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Berikut adalah langkah-langkah yang harus Anda lakukan dalam menghitung jumlah RW:

• Anda telah memiliki data OpenStreetMap Kelurahan Pleburan. Namun, data yang Anda miliki
adalah data keseluruhan dimana memiliki berbagai macam objek di dalamnya sehingga bisa
menyulitkan Anda untuk melihat batas-batas administrasi di wilayah tersebut. Untuk itu, Anda
dapat melakukan filter data di JOSM. Jika Anda belum mengetahui fungsi alat filter dan cara peng-
gunaanya dengan lebih lanjut silahkan melihat Modul Menggunakan Alat Filter di JOSM.

• Aktifkan alat filter di JOSM dengan cara klik menu Windows → Filter

“Langkah untuk melakukan filter data OpenStreetMap di JOSM”

Langkah untuk melakukan filter data OpenStreetMap di JOSM

• Jendela filter akan muncul di JOSM Anda. Kemudian silakan klik add dan masukkan query untuk
menyaring data sehingga yang akan ditampilkan di JOSM hanya batas-batas administrasi saja.
Query tersebut adalah “is_in:village”=”Pleburan”.

• Anda akan melihat tampilan data di JOSM anda akan berubah seperti berikut:
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“Tampilan hasil filter data untuk batas-batas administrasi di JOSM”

Tampilan hasil filter data untuk batas-batas administrasi di JOSM

• Kemudian pilih seluruh batas RW yang ada di Kelurahan Pleburan dengan cara menggunakan alat
search. Klik menu Edit → Search. Anda kemudian akan melihat jendela pencarian. Kemudian
masukkan query “admin_level=9” dan klik Start Search.

“Query untuk pencarian batas-batas RW di JOSM”

Query untuk pencarian batas-batas RW di JOSM

• Anda akan melihat batas RW di data yang terpilih. Hal ini ditunjukkan dengan garis-garis batas
administrasi menjadi warna ungu. Kemudian di bagian jendela selection Anda akan melihat daftar
RW yang ada di data Kelurahan Pleburan.
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“Hasil seleksi untuk batas-batas RW di Kelurahan Pleburan”

Hasil seleksi untuk batas-batas RW di Kelurahan Pleburan

• Anda dapat membandingkan jumlah RW yang ada di Kelurahan Pleburan yang merupakan hasil
selection di JOSM dengan tabel rekapitulasi hasil pengumpulan data di lapangan.

“Contoh tabel rekapitulasi jumlah RW di kelurahan
pemetaan”

Contoh tabel rekapitulasi jumlah RW di kelurahan pemetaan

Anda dapat melihat pada tabel di atas bahwa jumlah RW yang ada di Kelurahan Pleburan sebanyak 6
RW dan pada gambar hasil seleksi batas RW di JOSM juga terlihat terdapat 6 RW yang terpilih mulai
dari RW 01 hingga RW 06. Dengan begitu telah terdapat kesamaan data dan Anda dapat memvalidasi
jumlah RW di Kelurahan Pleburan yang ada di OpenStreetMap.

b. Menghitung Kelengkapan Tag dan Relasi Batas-Batas Administrasi

Setelah menghitung jumlah RW di Kelurahan Pleburan, sekarang Anda perlu untuk menghitung ke-
lengkapan informasi (tag) yang harus dimiliki oleh batas RW tersebut. Berikut adalah informasi (tag)
untuk batas-batas administrasi RW:

Tabel Tag Batas Administrasi Rukun Warga (RW)
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key possible values

type boundary
boundary administrative
name (nama RW)
admin_level 9
is_in:province (nama provinsi)
is_in:city (Kota) / is_in:town (Kabupaten) (nama kota/kabupaten)
is_in:municipality (nama kecamatan)
is_in:village (nama kelurahan)
is_in:RW (nama rw)
flood_prone *khusus untuk relasi RW yes (Iya), no (Tidak)
landslide_prone *khusus untuk relasi RW yes (Iya), no (Tidak)
source HOT_InAWARESurvey_2018 (Disesuaikan dengan kegiatan pemetaan)

Untuk melakukan validasi _tag _batas-batas RW, Anda dapat mengikuti langkah-langkah sebagai
berikut:

• Pilih semua daftar RW pada jendela selection hasil dari fitur search di JOSM.

“Memilih daftar RW yang ada di Kelurahan Pleburan”

Memilih daftar RW yang ada di Kelurahan Pleburan

• klik kanan pada daftar RW kemudian pilih Edit. Anda kemudian akan melihat kotak peringatan
bahwa Anda akan membuka seluruh informasi untuk masing-masing batas RW dimana untuk Kelu-
rahan Pleburan akan terbuka sebanyak 6 jendela informasi. Silahkan klik Ok.
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“Langkah melihat informasi batas batas RW”

Langkah melihat informasi batas-batas RW

• Setelah jendela terbuka silahkan Anda periksa kelengkapan informasi (tag) untukmasing-masing
batas RW. Selain itu, periksa hubungan relasi dengan antar batas-batas RW lain dengan melihat
alur relasi di bagian member. Relasi yang baik adalah jika hubungan antara member batas RW
saling terhubung dan membentuk loop atau lingkaran yang terhubung. Jika Anda ingin mengetahui
hubungan antar relasi dan cara melakukan input batas-batas administrasi di JOSM dengan lebih
lengkap, maka Anda dapat melihat Modul Membuat Batas Administrasi di JOSM.

Kotak relasi dan informasi batas administrasi di JOSM

Anda dapat menambahkan tag jika di RW tersebut belum sesuai dengan model data yang telah di-
tentukan dan memperbaiki bentuk relasi dengan mengatur urutan member dan rules masing-masing
member.

Catatan : Jika terdapat kekurangan atau kelebihan jumlah RW, maka Anda perlu
mendiskusikan masalah ini dengan Data Entry yang melakukan pengumpulan data
dan Quality Assurance yang melakukan input batas-batas administrasi ke dalam Open-
StreetMap. Lakukan langkah-langkah pengecekan yang sama terhadap relasi batas
administrasi kelurahan (“admin_level=7”) dan kecamatan (“admin_level=6”)

c. Melakukan Backup Batas Administrasi
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Setelah melakukan perhitungan dan validasi untuk batas-batas administrasi, Anda perlu untuk
melakukan backup batas administrasi. Hal ini dilakukan agar Anda dapat memiliki cadangan batas
administrasi wilayah pemetaan jika terjadi sesuatu yang tidak diinginkan seperti batas administrasi
tersebut hilang atau ada pengguna lain yang mengubahnya secara tidak tepat. Untuk melakukan hal
tersebut Anda dapat mengikuti langkah-langkah berikut ini:

• Silahkan klik menu Edit → Copy

“Menyalin data batas administrasi di JOSM”

Menyalin data batas administrasi di JOSM

• Kemudian pilih File → New Layer. Anda akan melihat layer baru pada JOSM.
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“Membuat layer baru
pada JOSM”

Membuat layer baru pada JOSM

• Kemudian klik Edit → Paste at source position
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“Menyalin batas administrasi pada Layer baru pada JOSM”

Menyalin batas administrasi pada Layer baru pada JOSM

• Anda akan memiliki layer baru yang hanya berupa data batas-batas administrasi saja. Kemudian
klik menu File → Save dan simpan data tersebut ke dalam format file .osm dan berikan nama
sesuai dengan kelurahan yang Anda petakan.
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“Menyimpan layer batas administrasi di JOSM”

Menyimpan layer batas administrasi di JOSM

RINGKASAN

Anda telah mempelajari cara untuk melakukan perhitungan kualitas data di JOSM. Materi ini merupakan
salah satu dari kegiatan rekapitulasi sekaligus validasi dari data yang telah dimasukkan ke dalam Open-
StreetMap setelah melakukan pengumpulan data di lapangan oleh Data Entry dan telah divalidasi oleh
Quality Assurance. Dengan melakukan perhitungan kualitas data yang telah divalidasi oleh Quality As-
surance, akan menghasilkan kualitas data yang semakin baik. Berikut adalah beberapa hal yang telah
Anda pelajari dalam modul ini:

• Menghitung jumlah objek dalam batas administrasi kelurahan tertentu
• Menghitung error dan warning dalam batas administrasi kelurahan tertentu
• Melakukan rekapitulasi perbandingan jumlah data dan jumlah error / warning
• Melakukan validasi batas administrasi meliputi menghitung jumlah RW, mengecek kelengkapan

informasi (tag) dan relasi antara batas-batas administrasi
• Melakukan backup data administrasi dalam file .osm
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Menggunakan Aplikasi OSMTracker

Tujuan Pembelajaran:

• Menjelaskan OSMTracker sebagai salah satu alat mengambil rute perjalanan dan pengambilan
gambar objek

• Mengoperasikan cara pengaturan awal untuk OSMTracker
• Menerapkan cara penggunaan OSMTracker

1. Apa itu OSMTracker?

OSMTracker adalah sebuah aplikasi android yang memungkinkan kita untuk mengambil data saat
melakukan saat survei lapangan. Sama seperti GPS, OSMTracker mampu untuk merekam waypoint
dan juga track survei. Jika Anda ingin mengetahui tentang penggunaan GPS untuk survei lapangan,
silakan Anda lihat Modul Penggunaan GPS. Salah satu keunggulan yang dimiliki oleh OSMTracker
adalah adanya fitur pengambilan foto objek pada saat melakukan survei. Foto ini akan mempermu-
dah Anda pada saat melakukan pemetaan sehingga Anda dapat melihat kembali objek apa yang telah
Anda survei. Hasil dari titik dan jalur survei yang telah diambil dapat diubah ke dalam bentuk file .gpx
sehingga Anda dapat dengan mudah membuka data hasil survei Anda menggunakan aplikasi JOSM
ataupun dapat langsung mengunggahnya ke dalam OpenStreetMap.

Untuk dapat menggunakan OSMTracker Anda harus melakukan instalasi terlebih dahulu melalui Play-
store. Anda dapat membuka aplikasi Google Playstore di perangkat smartphone Anda kemudian ketik
“OSMTracker” pada kolom pencarian.

“Aplikasi OSMTracker
dapat Anda download di Google Playstore”

Aplikasi OSMTracker dapat Anda download di Google Playstore

Jika sudah selesai terpasang, silakan Anda buka aplikasi OSMTracker pada smartphone Anda.
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“Tampilan awal aplikasi OSMTracker”

Tampilan awal aplikasi OSMTracker

2. Pengaturan Awal OSMTracker

Sebelum Anda dapat menggunakan OSMTracker, ada beberapa pengaturan dasar yang harus Anda
lakukan. Untuk dapat masuk ke dalam menu pengaturan silakan Anda pilih menu tombol

di sebelah kanan atas kemudian pilih Settings.
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“Memilih menu
Settings di aplikasi OSMTracker”
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Memilih menu Settings di aplikasi OSMTracker

Pada halaman settings ada beberapa pengaturan yang perlu diperhatikan, seperti:

“Beberapa pengaturan pada halaman Settings”

Beberapa pengaturan pada halaman Settings

1. GPS logging interval Pengaturan ini menentukan seberapa sering OSMTracker merekam track
Anda. Semakin kecil angkanya maka semakin sering OSMTracker akan melakukan perekaman.
Pengaturan awal adalah 0 detik, artinya setiap saat OSMTracker akan secara terus menerus
melakukan perekaman trek. Hal ini tentunya akan sangat menghabiskan baterai perangkat smart-
phone Anda. Ubahlah interval perekaman sesuai kebutuhan, misalnya menjadi 2 detik.

2. External storage (SD) directory Pengaturan ini dilakukan untuk menentukan dimana Anda akan
menyimpan seluruh hasil survei di dalam perangkat smartphone. OSMTracker secara otomatis
akan membuat folder baru bernama “osmtracker” di penyimpanan internal perangkat Anda. Anda
tidak perlu mengganti pengaturan ini apabila tidak perlu.

3. One directory per track Jika Anda mengaktifkan fitur ini, maka setiap track yang Anda simpan akan
membentuk sebuah folder baru di dalam folder OSMTracker.

4. Filename for named track Pengaturan ini menetapkan bagaimana pola nama file dari hasil survei
Anda. Pengaturan awal adalah nama track, tanggal dimulai, dan waktu pengambilan. Anda bisa
mengabaikan pengaturan ini jika Anda tidak ingin mengubah pola penamaan file Anda.

5. Screen always on Dengan mengaktifkan fitur ini, Anda akan membiarkan perangkat smartphone
Anda untuk terus menyala ketika Anda menggunakan OSMTracker. Namun perlu diingat bahwa
jika Anda mengaktifkan fitur ini maka baterai smartphone Anda juga akan semakin cepat habis.

6. Background map Pengaturan ini digunakan untuk menampilkan background peta pada tampilan
track Anda. Aktifkan pengaturan ini sehingga Anda dapat melihat hasil track Anda dengan tampi-
lan peta sebagai latar belakangnya.

7. Map tile provider Anda bisa mengubah tampilan latar belakang peta Anda melalui fitur ini.

Setelah semua pengaturan telah selesai dilakukan, Anda telah siap menggunakan OSMTracker. Jan-
gan lupa untuk mengaktifkan fitur Location atau GPS yang ada di smartphone Anda. Setelah itu, silakan
Anda kembali ke tampilan menu utama OSMTracker. Jika Anda baru pertama kali menggunakan OSM-
Tracker maka halaman utama Anda masih akan kosong. Seluruh hasil survei yang telah Anda lakukan
nantinya akan muncul di halaman utama.

3. Pengoperasian Dasar OSMTracker

1. Merekam Rute Perjalanan Untuk dapat mulai melakukan perekaman rute perjalanan atau pereka-
man jalur, silakan Anda pilih tombol bertanda + yang ada di sebelah kanan atas layar. Setelah itu
akan muncul tampilan Track Logger.
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“Tombol dengan icon yang digunakan untuk melakukan perekaman jalur atau merekam per-
jalanan Anda”

Tombol dengan icon + yang digunakan untuk melakukan perekaman jalur atau merekam per-
jalanan Anda

Satu hal penting yang perlu Anda perhatikan adalah tingkat keakurasian GPS. Seluruh fitur yang
ada di track logger tidak akan dapat Anda akses jika smartphone Anda belum mendapatkan sinyal
GPS dengan baik. Usahakan mendapatkan akurasi GPS semaksimal mungkin (accuracy di bawah
10 meter) untuk menghindari kesalahan perekaman posisi yang dilakukan pada saat survei. In-
dikator sinyal GPS dapat dilihat pada signal bar yang ada di sebelah kanan atas layarOSMTracker
Anda (lihat gambar). Sinyal akan semakin baik apabila indikator signal bar semakin penuh dan
berwarna hijau, sedangkan sinyal semakin buruk jika indikator ini masih belum terisi. Semakin
penuh indikator sinyal akan semakin baik penangkapan sinyal GPS Anda. Untuk mendapatkan
sinyal yang baik, posisikan diri Anda berada di luar ruangan dan tidak terhalang benda apapun
seperti atap bangunan atau pepohonan lebat.
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Figure 41: Fitur track logger belum bisa diakses karena smartphone belum menangkap GPS dengan
baik (Kiri); Fitur track logger dapat diakses setelah smartphone menangkap GPS (Kanan)

Fitur track logger belum bisa diakses karena smartphone belum menangkap GPS dengan baik
(Kiri); Fitur track logger dapat diakses setelah smartphone menangkap GPS (Kanan)

Ketika GPS sudah berhasil menangkap sinyal dengan baik, maka yang perlu Anda lakukan adalah
mulai berjalan sesuai dengan rute survei Anda. Setelah Anda menekan tombol + dan smartphone
Anda telah menangkap GPS dengan baik, makaOSMTracker secara otomatis telah merekam rute
perjalanan atau jalur perjalanan Anda.

2. Merekam Objek dengan Titik dan Gambar Ada beragam tombol yang terdapat di dalam track
logger, namun untuk mengambil titik survei atau waypoint, Anda cukup menggunakan 2 tombol
berikut:
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“Halaman Track Logger pada OSMTracker”

Halaman Track Logger pada OSMTracker

1. Text Note Text note digunakan untuk mengambil titik atau waypoint pada saat melakukan
survei. Jika Anda sudah berada di titik yang ingin Anda rekam, Anda cukup menekan tombol
ini kemudian isi dengan keterangan yang Anda inginkan. Sebagai contoh, Anda dapat meng-
gunakan penomoran diikuti dengan keterangan objeknya.
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“Contoh penggunaan Text Note untuk merekam titik survei”

Contoh penggunaan Text Note untuk merekam titik survei

2. Take Photo Take Photo digunakan untuk mengambil gambar objek yang Anda survei. Anda
dapat mengambil gambar secara langsung menggunakan kamera ataupun dapat mengam-
bilnya dari galeri foto Anda.

“Anda dapat memilih untuk mengambil foto langsung menggunakan kam-
era atau memilih foto dari galeri foto Anda”

Anda dapat memilih untuk mengambil foto langsung menggunakan kamera atau memilih foto
dari galeri foto Anda

3. Menghentikan Sementara dan Memulai Kembali Mode Rekam Rute Perjalanan

Untuk berhenti melakukan perekaman trek, Anda dapat mengikuti langkah-langkah berikut:

1. Pada halaman Track logger, silakan Anda kembali ke halaman utama, kemudian temukan
satu file track yang telah Anda kumpulkan. Pada file tersebut silakan Anda tekan dan tahan
beberapa saat hingga muncul menu tambahan.

Pilihan untuk menghentikan perekaman jalur (Stop tracking)

2. Pilih menu Stop tracking.

3. Anda juga dapat menggunakan tombol yang berada di sebelah kanan atas hala-
man Track logger Anda untuk berhenti melakukan perekaman dan menyimpan hasil pereka-
man Anda.

Jika Anda ingin melanjutkan kembali perekaman trek yang sudah Anda kumpulkan, langkah-
langkah yang perlu Anda lakukan adalah:

1. Pada file yang ingin Anda lanjutkan track-nya silakan Anda tekan dan tahan beberapa saat
hingga muncul menu tambahan

Pilihan untuk melanjutkan kembali perekaman jalur (Resume tracking)
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Figure 42: Pilihan untuk menghentikan perekaman jalur (Stop tracking)
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Figure 43: Pilihan untuk melanjutkan kembali perekaman jalur (Resume tracking)
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2. Kemudian pilih Resume Tracking

Catatan :

Figure 44: Ikon

Jika File Anda memiliki ikon atau tanda jam berwarna oranye di sebelah kanan nama file
menandakan bahwa file tersebut masih dalam mode perekaman jalur. Ikon ini akan hilang
jika Anda telah menghentikan mode perekaman jalur.

1. Melihat Daftar Objek yang Dikumpulkan

Anda dapat melihat objek-objek apa saja yang telah Anda kumpulkan pada saat survei. Pada

halaman Track logger pilih tombol yang berada di sebelah kanan atas, kemudian pilih
Waypoints.
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“Tombol untuk menampilkan daftar waypoints yang telah dikumpulkan”

Tombol untuk menampilkan daftar waypoints yang telah dikumpulkan

Anda akan melihat daftar titik serta foto yang telah berhasil Anda kumpulkan pada halaman Way-
point list.

“Halaman Waypoint list untuk melihat daftar objek yang telah dikumpulkan”

Halaman Waypoint list untuk melihat daftar objek yang telah dikumpulkan
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2. Melihat Rute Perjalanan dan Objek yang Dikumpulkan pada Peta

Anda juga dapat melihat sejauh apa rute perjalanan yang telah Anda lewati dan titik-titik objek

yang telah dikumpulkan. Pada halaman Track logger pilih menu di sebelah kanan atas,
kemudian pilih Display Track.

“Tombol untuk melihat rute perjalanan dan objek yang telah dikumpulkan”

Tombol untuk melihat rute perjalanan dan objek yang telah dikumpulkan

Pada saat menampilkan menu Display Track, OSMTracker akan bertanya apakah Anda men-
gizinkan akses untuk menampilkan peta. Pilih Display Background Map.
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“Pilihan untuk menampilkan latar belakang peta”

Pilihan untuk menampilkan latar belakang peta

Anda akan melihat tampilan halaman peta dengan simbol garis, bintang, dan orang di atasnya.
Simbol bintang ini menunjukkan titik-titik yang telah Anda survei, sedangkan simbol garis menun-
jukkan rute perjalanan yang telah Anda lewati. Simbol orang menunjukkan lokasi Anda saat ini.

“Contoh hasil rute perjalanan dan titik survei yang sudah diambil pada saat
survei”

Contoh hasil rute perjalanan dan titik survei yang sudah diambil pada saat survei

3. Menyimpan OSMTracker

Setelah Anda melakukan survei lapangan, Anda tentu ingin menyimpan data hasil survei Anda
untuk kemudian Anda gunakan sebagai acuan pada saat melakukan pemetaan. Untuk itu, data
hasil survei yang telah berhasil Anda kumpulkan dapat Anda simpan sebagai data .gpx, upload
ke dalam server OpenStreetMap, atau Anda pindahkan ke dalam laptop.

4. Menyimpan Rute Perjalanan dan Objek sebagai Data ._gpx_

Anda dapat menyimpan rute perjalanan dan objek yang telah Anda survei ke dalam format data
.gpx. Data .gpx dapat Anda pakai ketika Anda menggunakan aplikasi pemetaan seperti QGIS
maupun JOSM. Pada file survei Anda, silakan Anda tekan dan tahan kemudian pilih menu Export
asGPX. Jika file data survei telah berhasil disimpan dalam bentuk .gpx, maka akan muncul bulatan
warna hijau di sebelah kanan nama file.
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“Menu
untuk menyimpan data survei ke dalam file GPX”
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Menu untuk menyimpan data survei ke dalam file GPX

5. Mengunggah (Upload) Rute Perjalanan ke Server OpenStreetMap

Anda juga dapat meng-upload data hasil survei ke dalam server OpenStreetMap. Pada file hasil
survei Anda, ketuk dan tahan beberapa saat, kemudian pilih Upload to OpenStreetMap.
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“Menu
untuk mengunggah hasil survei ke dalam server OpenStreetMap”
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Menu untuk mengunggah hasil survei ke dalam server OpenStreetMap

Pada halaman OpenStreetMap Upload Anda akan diminta untuk mengisi beberapa isian seperti
nama dan deskripsi file. Pada isian Tags bisa Anda abaikan. Pada bagian paling bawah, Anda
dapat mengatur sifat dari trek yang akan Anda unggah sepeti private, public, trackable, dan iden-
tifiable.

1. Private

Track tidak akan terlihat pada daftar track publik. Trackpoints dapat diakses pada urutan
waktu melalui API GPS publik tanpa cap waktu.

2. Public

Track Anda akan terlihat untuk publik (umum) pada track GPS Anda dan pada daftar track
GPS publik. Pengguna lain masih dapat mengunduh track Anda dari daftar track publik serta
waktu pengambilan titik yang termuat di dalamnya. Namun, data yang tampil pada API tidak
mereferensikan pada halaman track Anda

3. Trackable

Track tidak akan terlihat pada daftar track publik, namun trackpoints akan tetap dapat diakses
melalui API GPS publik bseserta waktu pengambilan titiknya. Pengguna lain tetap dapat
mengunduh trackpoints tapi tidak akan direferensi/dikaitkan dengan Anda

4. Identifiable

Track Anda akan terlihat untuk publik (umum) pada track GPS Anda dan pada daftar track
GPS publik. Pengguna lain dapat mengunduh track Anda dan menghubungkannya dengan
username Anda. Waktu pengambilan titik-titik pada track juga dapat diakses melalui GPS
API publik.

Untuk pemilihan sifat track, Anda dapat memilih Trackable atau Public sehingga hasil upload Anda
dapat terlihat oleh pengguna lain.

“Contoh file hasil survei yang telah siap diunggah ke dalam server Open-
StreetMap”

Contoh file hasil survei yang telah siap diunggah ke dalam server OpenStreetMap

6. Mengambil Rute Perjalanan dan Titik ke Laptop/Komputer

Seluruh data yang sudah diekspor ke dalam data .gpx akan tersimpan ke dalam folder internal
smartphone Anda. Anda dapat mencari data tersebut dengan menggunakan aplikasi file manager
Anda. Untuk dapat memindahkan data tersebut silakan ikuti langkah-langkah berikut:

1. Hubungkan smartphone Anda ke laptop dengan menggunakan kabel data kemudian cari
folder bernama “osmtracker” di media penyimpanan smartphone Anda.

“Folder OSMTracker di media
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penyimpanan smartphone Anda”

Folder OSMTracker di media penyimpanan smartphone Anda

2. Dalam folderOSMTracker Anda akan menemukan satu folder yang berisi data dengan format
.gpx dan data foto. Silakan Anda kemudian pindahkan satu folder yang berisi data tersebut
ke dalam laptop Anda.

“Contoh data OSMTracker yang berisikan file data .gpx
dan foto-foto survei”

Contoh data OSMTracker yang berisikan file data .gpx dan foto-foto survei

3. Buka aplikasi JOSM Anda, kemudian masukkan file GPX tersebut ke dalam JOSM. Anda
dapat membukanya dengan cara File → Open, kemudian buka file dengan format .gpx.

“Silakan Anda buka file dengan format .GPX pada JOSM”

Silakan Anda buka file dengan format .GPX pada JOSM

4. Pada saat Anda membuka file .gpx tersebut maka secara otomatis JOSM akan menampilkan
rute perjalanan dan titik hasil survei lengkap dengan objek foto yang telah berhasil
dikumpulkan.

225



“Contoh hasil data survei pada saat dibuka menggunakan JOSM”

Contoh hasil data survei pada saat dibuka menggunakan JOSM

Hasil rute perjalanan dan juga titik objek yang telah Anda survei ini dapat Anda gunakan sebagai
acuan pada saat Anda memetakan menggunakan JOSM. Anda tidak perlu bingung lagi objek
apa yang sedang Anda petakan karena Anda telah melakukan survei lapangan dan melakukan
pengambilan foto objek yang Anda survei.

RINGKASAN Pada bab ini Anda telah mengetahui salah satu metode survei lapangan dengan menggu-
nakan OSMTracker, dimana OSMTracker dapat Anda gunakan untuk melakukan perekaman rute per-
jalanan, titik survei dan melakukan pengambilan foto objek. Anda juga telah mempelajari bagaimana
cara melakukan pengaturan awal dan cara menggunakan OSMTracker. Anda dapat menggunakan
OSMTracker sebagai alternatif alat survei jika Anda tidak memiliki GPS.
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Menggunakan Java OpenStreetMap (JOSM)

Tujuan Pembelajaran:

• Memahami cara menggunakan alat dasar di JOSM
• Mampu mengoperasikan penggambaran tingkat lanjut di JOSM
• Memahami tips editing di JOSM
• Memahami cara menggambar objek khusus seperti jembatan, kompleks sekolah, dan jaringan

jalan.

Java OpenStreetMap atau biasa yang disebut dengan JOSM adalah perangkat editor OpenStreetMap
berbasis desktop. JOSM memungkinkan Anda melakukan proses edit data pemetaan secara offline un-
tuk sementara waktu atau tidak harus selalu terkoneksi dengan internet. Jika pada modul sebelumnya
Anda mempelajari pengoperasian JOSM, maka pada modul ini Anda akan mempelajari cara menggu-
nakan JOSM.

I. Latihan Menggambar Dasar dengan JOSM

Silahkan Anda buka file contoh OSM yang akan digunakan untuk mempelajari cara dasar menggambar
peta dengan JOSM. Perhatikan bahwa data ini hanya sebuah contoh dengan tempat yang tidak nyata,
jadi Anda tidak akan menyimpan dan mengupload data tersebut ke dalam OpenStreetMap.

• Download file latihan tersebut disini: www.bit.ly/osmsampel
• Buka file contoh peta OSM di dalam JOSM. Klik tombol Open a File di bagian atas sebelah kiri.

Ikon Open a file

• Cari dan pilih file sample.osm di komputer Anda yang sebelumnya Anda download, kemudian klik
Open. Di komputer Anda akan muncul tampilan seperti berikut ini:

Tampilan file latihan di JOSM

a. Operasi Dasar

Untuk menggeser peta ke kanan atau ke kiri dan ke atas atau ke bawah, Anda dapat melakukannya
dengan cara klik kanan mouse Anda, kemudian tahan dan gerakkan mouse Anda sesuai dengan arah
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yang Anda inginkan. Terdapat dua cara untuk memperbesar dan memperkecil tampilan peta. Cara
yang pertama adalah menggunakan roda gulir atau scroll yang ada pada mouse Anda. Scroll ke depan
untuk memperbesar peta dan scroll ke belakang untuk memperkecil peta. Cara yang kedua adalah
menggunakan skala baris di sebelah kiri di jendela peta Anda. Klik dan tahan kemudian geser ke kanan
atau ke kiri dengan mouse Anda.

Skala baris di JOSM

b. Titik, Garis, dan Area

Pada OpenStreetMap terdapat tiga jenis objek yang digunakan. Ketiga jenis objek itu adalah titik, garis,
dan poligon.

• Titik adalah suatu lokasi yang digambarkan dengan simbol. Dalam data contoh ini terdapat dua
titik, yaitu toko sepatu dan supermarket. Toko sepatu digambarkan dengan simbol sepatu dan
supermarket digambarkan dengan simbol keranjang belanja. Jika Anda belum dapat melihatnya
dengan jelas, silahkan perbesar tampilan peta Anda.

• Terdapat beberapa garis yang terdapat dalam peta, objek yang digambarkan dalam bentuk garis
seperti jalan, sungai, dan tanggul sungai. Jika Anda melihat dengan lebih teliti, maka Anda akan
melihat di dalam garis akan terdapat titik-titik. Titik-titik tersebut tidak memiliki simbol atau informasi
apapun, tetapi titik-titik tersebut yang membentuk garis.

• Terakhir, ada beberapa poligon dalam peta contoh ini yang menunjukkan tempat-tempat yang
berbeda seperti hutan, sungai, dan bangunan. Suatu poligon secara umum mewakilkan suatu
area seperti lapangan ataupun bangunan. Poligon sama seperti garis, akan tetapi perbedaannya
adalah poligon terdiri atas beberapa garis yang membentuk dimana titik akhir bertemu dengan titik
awal garis tersebut.

c. Memilih Objek

Untuk mengedit suatu objek, Anda perlu untuk memilih objeknya terlebih dahulu. Berikut ini adalah cara
untuk memilih objek:

• Klik tool select, move, scale, and rotate object untuk memilih objek.

Ikon tool select, move, scale, and rotate object

• Kemudian klik pada objek yang ingin Anda pilih.

Ketika Anda memilih sebuah objek, objek tersebut akan berwarna merah dan muncul beberapa daftar
di panel Tags pada sebelah kanan layar JOSM Anda. Tags adalah bagian dari suatu titik, garis, atau
poligon yang memberitahukan informasi mengenai objek tersebut. Saat ini yang Anda butuhkan adalah
mengetahui informasi ini untuk menjelaskan apakah objek yang ada di peta itu hutan, sungai, bangunan,
atau bentuk lain.
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Informasi objek di panel Tags JOSM

d. Cara Mengubah Objek

Anda dapat mengubah objek yang sudah digambar di JOSM. Berikut ini adalah langkah-langkah untuk
mengubah objek:

• Pilih salah satu objek pada contoh, misalnya objek hutan. Pastikan Anda mengklik garis pada
hutan tersebut, bukan klik pada titiknya. Selanjutnya klik dan tahan objek tersebut kemudian geser.
Anda baru saja memindahkan hutan ke lokasi yang baru pada peta.

• Klik salah satu titik pada garis hutan. Klik dan tahan titik tersebut kemudian geser titiknya. Anda da-
pat menggerakan titik. Dengan menggerakkan titik ini Anda dapat mengubah bentuk dari sebuah
objek.

Contoh mengubah objek

e. Menggambar Objek

Di sebelah kiri pada layar JOSM terdapat banyak toolbar yang menyediakan lebih banyak informasi
mengenai peta. Tools ini dapat mengubah perintah apa yang Anda lakukan dengan mouse Anda, salah
satunya adalah untuk menggambar objek. Berikut ini adalah langkah-langkah untuk menggambar objek:
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• Sebelum menggambar objek, Anda perlu memastikan bahwa tidak ada objek yang terpilih. Klik
diluar objek peta dimana tidak terdapat objek, untuk memastikan tidak ada objek yang terpilih.

• Kemudian klik pada tombol Draw Tool untuk menggambar objek.

Ikon Draw Tool

• Temukan area kosong pada peta, dan klik dua kali denganmouse Anda kemudian akan tergambar
sebuah titik tunggal.

Contoh menggambar objek titik

• Untuk menggambar sebuah garis, klik sekali dengan mouse Anda. Gerakan mouse Anda dan klik
kembali. Lanjutkan hingga membentuk sebuah garis. Untuk mengakhiri garis, klik dua kali pada
mouse Anda.

Contoh menggambar objek garis

• Gambarlah sebuah poligon dengan cara yang sama seperti menggambar garis, tetapi untuk men-
gakhiri poligon dengan klik dua kali di atas titik yang pertama kali Anda buat.
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Figure 45: menggambar_garis

Contoh menggambar objek poligon

f. Cara Menambahkan Presets

Sekarang Anda telah memahami bagaimana cara untuk menggambar titik, garis, dan poligon. Akan
tetapi Anda masih belum memberikan informasi mengenai objek tersebut. Di OpenStreetMap mem-
berikan informasi mengenai objek yang Anda gambar adalah suatu kewajiban, apakah objek tersebut
adalah sekolah, rumah sakit, kantor pemerintahan dan apakah objek yang Anda buat itu bangunan atau
sesuatu yang lain. Hal ini diwajibkan agar orang lain dapat mengetahui informasi objek tersebut. Untuk
memberikan informasi terhadap objek yang Anda buat atau edit, Anda perlu memasukkan presets di
objek tersebut. Berikut ini adalah langkah-langkahnya:

• Klik tombol Select pada toolbar sebelah kiri di JOSM.
• Pilih objek yang ingin ditambahkan preset.
• Pilih menu Presets pada bagian atas JOSM. Gerakkan mouse Anda ke sub-menu jenis objek yang
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ingin Anda tentukan.

Memasukkan preset

• Jika Anda kesulitan mencari pada sub-menu, Anda dapat klik di bagianSearch preset atau dengan
menekan tombol F3 pada keyboard Anda.

• Kemudian akan muncul jendela search preset. Anda dapat langsung mengetik jenis objeknya,
misalnya dokter gigi. Kemudian klik Select.

Jendela search preset

• Selanjutnya akan muncul jendela mengenai informasi objek yang Anda petakan. Informasi ini
tidak wajib diisi semua, hanya yang Anda ketahui saja. Jika Anda mengetahui semua informasinya
silahkan diisi. Jika tidak tahu dilewatkan saja, kemudian klikApply Preset. Jika semuanya berjalan
dengan lancar, titik, garis, atau poligon yang Anda buat akan berubah warna atau memiliki suatu
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simbol. Perubahan ini tergantung dari informasi yang Anda masukkan ke dalam objek tersebut.

Jendela informasi objek

II. Latihan Menggambar Tingkat Lanjut dengan JOSM

Pada sesi sebelumnya Anda telah menginstal JOSM dan mempelajari bagaimana melakukan operasi
dasar di JOSM seperti menggambar titik, garis, dan poligon. Anda juga telah dapat menambahkan
preset ke objek yang Anda buat untuk melampirkan informasi mengenai objek tersebut. Pada akhirnya,
Anda dapat menggambar peta Anda sendiri di JOSM. Pada sesi ini Anda akan mempelajari bagaimana
tahapan-tahapan yang tepat dalam mengedit peta OpenStreetMap di JOSM dan juga bagaimana Anda
bisa memaksimalkan beberapa alat yang ada di JOSM untuk membantu Anda dalam melakukan editing.

a. Alat Menggambar Tingkat Lanjut di JOSM

Pada materi ini Anda akan mempelajari beberapa tools dasar dan teknik yang ada untuk menggam-
bar fitur peta di JOSM. Anda akan mempelajari lebih detail untuk tools menggambar lanjutan
yang akan membantu Anda dalam melakukan pemetaan di JOSM. Silakan Anda download di
[http://www.bit.ly/toolsbahasa] (http://www.bity.ly/toolsbahasa) kemudian buka JOSM dan file yang
telah di-download. Tampilan pada JOSM Anda akan seperti di bawah ini:
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Tampilan file latihan mengedit di JOSM

JOSM memiliki tools yang akan memudahkan Anda dalam mengedit baik garis atau poligon. Tools ini
dapat ditemukan di menu Tools di bagian atas JOSM. Jika Anda klik pada menu Tools di bagian atas
JOSM, Anda akan melihat bahwa terdapat banyak fungsi yang dapat membantu Anda dalam menggam-
bar garis dan poligon, dan juga mengedit objek pada peta.
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Pilihan yang ada di menu tools JOSM

Dalam mengaplikasikan fungsi dalam menu ini, Anda terlebih dahulu harus memilih sebuah titik, garis,
atau poligon pada bidang peta. File contoh yang telah Anda download berisi berbagai macam elemen
yang berlabelkan nama alat yang berbeda-beda di dalam menu. Anda dapat mencoba masing-masing
tools menggunakan file contoh. Penjelasan mengenai beberapa tools lainnya disediakan di bawah ini:

• Split Way (Memisahkan Segmen Garis/Way).

Split Way digunakan untuk membagi sebuah segmen garis menjadi dua segmen garis yang ter-
pisah. Ini berguna jika Anda ingin menambahkan atribut ke bagian jalan yang berbeda, seperti
jembatan atau jalan yang berbeda nama. Untuk menggunakan fungsi ini, pilih sebuah titik di ten-
gah segmen garis yang Anda ingin potong, kemudian klik Split Way dari menu Tools, dan garis
Anda akan terpotong menjadi dua. Tombol pintas untuk melakukan split way adalah tombol P
pada keyboard setelah anda memilih salah satu titik pada garis.
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Tampilan split way

Setelah Anda melakukan split way, Anda dapat menambahkan informasi mengenai masing-masing seg-
men jalan yang sudah dipisah, misalnya seperti memberikan nama jalan pada kedua jalan.

• Combine Way (menggabungkan segmen garis/way).

Combine way ini adalah kebalikan dari Split Way, digunakan untuk menggabungkan dua segmen
garis menjadi satu segmen garis. Kedua segmen garis ini harus saling terhubung dengan titik
yang sama. Untuk menggunakan fungsi ini, pilih kedua garis yang ingin Anda gabungkan. Anda
dapat memilih lebih dari satu objek dengan menahan tombol shift pada keyboard Anda dan klik
di kedua garisnya. Ketika Anda telah memilih kedua garis tersebut, klik Combine Way dari menu
Tools. Kedua segmen garis tersebut akan menyatu jadi satu segmen garis. Tombol pintas untuk
melakukan combine way adalah tombol C pada keyboard setelah anda mengklik kedua garis.

Tampilan combine way

236



Hasil menggabungkan Garis/Way JOSM

Jika Anda menggabungkan jalan yang memiliki arah yang berbeda, Anda akan mendapatkan peringatan
seperti di bawah ini. Peringatan tersebut berarti jika jalan yang terhubung dan memiliki arah yang sama.
Jika Anda yakin untuk menggabungkan kedua jalan tersebut, silakan Anda klik Reverse and Combine.

Peringatan change directions

• Reverse Way (membalikkan garis/way).

Reverse way digunakan untuk mengubah arah pada garis. Semua garis di dalam OSM memiliki
sebuah arah, yang ditunjukkan di dalam JOSM dengan panah pada garis. Pengaturan arah sangat
berguna untuk memetakan jalan yang memiliki satu arah dan aliran sungai (hulu ke hilir). Pada
kasus ini, Anda mungkin perlu membalikkan arah garis sehingga garis tersebut dalam arah yang
benar. Cara untuk menggunakan reverse way ini adalah klik pada garis yang ingin Anda ubah
arahnya, kemudian ke menu tools dan klikReverseWays. Tombol pintas untuk melakukan reverse
way adalah tombol R pada keyboard.

Tampilan reverse way

• Simplify Way (sederhanakan jalur)
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Jika garis Anda memiliki terlalu banyak titik di dalamnya dan Anda ingin membuatnya lebih seder-
hana, menu simplify way akan menghapus beberapa titik yang ada pada sebuah garis. Tool ini
juga digunakan untuk mempercepat saat upload data karena menghapus beberapa nodes/titik
yang berada di satu garis. Cara untuk menggunakan simplify way adalah klik pada garis yang
ingin Anda sederhanakan, kemudian ke menu tools dan klik Simplify Way. Tombol pintas untuk
melakukan simplify way adalah tombol Shift+Y pada keyboard.

Tampilan simplify way

• Align Nodes in Circle (Sejajarkan Node Membentuk Lingkaran).

Jika Anda mengalami kesulitan dalam menggambar bentuk lingkaran di dalam OSM, maka Anda
dapat menggunakan tools ini untuk membuat bentuk lingkaran secara sempurna. Cara untuk
menggunakan align nodes in circle ini adalah klik pada garis yang ingin Anda sederhanakan, ke-
mudian ke menu tools dan klik Align Nodes in Circle. Tombol pintas untuk melakukan align nodes
in circle adalah tombol O pada keyboard.

Tampilan Align Nodes in Circle
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• Create Circle (Buat Lingkaran)

Sebagai alternatif untuk membuat lingkaran, Anda dapat menggunakan tool create circle. Tool ini
akan membuat lingkaran dari diameter lingkaran (hanya memerlukan sebuah garis yang terdiri atas
dua titik). Cara untuk menggunakan create circle ini adalah gambar sebuah garis yang mewakili
diameter dari lingkaran yang Anda inginkan, dan kemudian ke menu tools dan klik Create Circle.
Tombol pintas untuk melakukan create circle adalah tombol Shift+O pada keyboard.

Tampilan create cirle

• Align Nodes in Line (Sejajarkan Node dalam Garis/Way)

Fungsi ini digunakan untuk mengubah garis yang tidak beraturan menjadi bentuk yang lurus. Hati-
hati karena hal ini memiliki kecenderungan untuk pergeseran garis walaupun sedikit. Perlu diingat,
fungsi ini akan meluruskan bentuk garis sesuai letak titik awal dan akhir garis tersebut. Cara untuk
menggunakan align nodes in line ini adalah klik garis yang ingin Anda sejajarkan, dan kemudian
ke menu tools dan klik Align Nodes in Line. Tombol pintas untuk melakukan align nodes in line
adalah tombol L pada keyboard.
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Tampilan align nodes in line

Contoh setelah menggunakan align nodes in line

• Orthogonalize Shape (Ortogonalisasi Bentuk)

Orthogonalize shape sangat berguna untuk membuat gambar poligon yang memiliki sudut-
sudut tidak teratur menjadi bentuk persegi, contohnya adalah bentuk bangunan. Setelah Anda
menggambar sebuah bangunan, fungsi ini akan membentuk menjadi bangunan yang memiliki
sudut persegi 90’. Cara untuk menggunakan orthogonalize shape ini adalah klik objek yang ingin
Anda ubah bentuknya, dan kemudian ke menu tools dan pilih Orthogonalize Shape. Tombol
pintas untuk melakukan orthogonalize shape adalah tombol Q pada keyboard.

Tampilan orthogonalize shape

Contoh setelah menggunakan orthogonalize shape

• Unglue Way (Memisahkan Titik/Garis)

Unglue way berfungsi untuk melepaskan titik-titik yang terhubung. Unglue way berguna ketika dua
objek berada di titik yang sama padahal seharusnya mereka tidak menempel. Sebagai contoh, ke-
salahan yang sering terjadi adalah sebuah jalan memiliki titik yang sama dengan sudut bangunan.
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Tentu saja di lapangan, jalan tidak mungkin bergabung dengan bangunan, sehingga ini adalah
suatu kesalahan. Untuk memperbaikinya Anda dapat melepaskan objek satu dengan yang lain.
Cara untuk menggunakan unglue way ini adalah klik titik yang saling menempel antara dua objek,
dan kemudian ke menu tools dan pilih Unglue Way. Tombol pintas untuk melakukan unglue way
adalah tombol G pada keyboard. Perlu Anda perhatikan ketika Anda sudah menggunakan tool ini,
antara kedua objek yang sebelumnya saling menempel, tidak langsung otomatis terpisah, tetapi
harus Anda menggeser salah satu objeknya.

Tampilan unglue way

Contoh setelah menggunakan unglue way

Sering kali terdapat pertanyaan bagaimana cara untuk memutar sebuah garis atau poligon setelah ob-
jek tersebut tergambar. Cara untuk memutar objek tersebut adalah sebagai berikut: * Untuk memutar
sebuah objek, pertama pilih objek yang ingin Anda putar. * Tahan SHIFT+CTRL pada keyboard Anda.
* Klik dan geser mouse untuk memutar.

Konsep memutar objek di JOSM

b. Tombol Pintas di Keyboard

Setelah melakukan editing di OpenStreetMap, Anda akan menyadari bahwa Anda kesulitan untuk men-
cari letak tools yang terdapat pada menu Tools. Untuk mengatasi hal ini, JOSM memiliki tombol pintas
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keyboard untuk segala hal. Hal ini bertujuan untuk mempermudah Anda tanpa harus mengklik sebuah
objek terlebih dahulu dan kemudian melalui proses menu dan sub-menu yang panjang. Anda dapat
memilih objek langsung dan menekan sebuah tombol pada keyboard Anda. Berikut ini adalah beber-
apa tombol pintas yang sering digunakan:

Tabel Beberapa Tombol Pintas di JOSM

No. Perintah Simbol

1 Aktifkan Select Tool

2 Aktifkan Draw Tool

3 Aktifkan Zoom Tool

4 Hapus objek yang terpilih

5 Zoom In

6 Zoom Out

III. Tips Editing

Ada beberapa kesalahan umum yang biasa dilakukan oleh pengguna ketika memulai menggunakan
OpenStreetMap. Berikut ini beberapa kesalahan yang sering dilakukan dan beberapa tips atau petunjuk
singkat untuk memetakan lebih baik.

1. Objek yang Sebaiknya Tidak Terhubung

Ketika Anda membuat poligon dan garis yang seharusnya tidak terhubung, pastikan bahwa mereka tidak
terhubung oleh satu titik. Contohnya titik jalan raya sebaiknya tidak menempel ke bangunan, walaupun
pada kenyataannya terdapat bangunan yang terletak di depan jalan, namun tetap ada sedikit ruang
yang memisahkan antara bangunan dan jalan tersebut. Jika Anda ingin memisahkan dua atau lebih
objek yang menempel di titik yang sama, pilih titik yang saling terhubung kemudian pilih menu Tools
→ UnGlue Ways atau tombol pintasnya adalah tekan G pada keyboard, kemudian geser salah satu
objeknya.
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(Kiri) Objek bangunan dan jalan yang tersambung dan (Kanan) objek bangunan dan jalan yang terpisah

2. Objek yang Harus Terhubung

Jika sebelumnya membahas mengenai objek yang tidak boleh terhubung, sekarang Anda akan mem-
pelajari objek apa saja yang harus terhubung, misalnya jalan yang bersinggungan atau persimpangan
seharusnya selalu terhubung pada titik. Jika mereka tidak terhubung pada satu titik, maka JOSM tidak
mengetahui bahwa jalan tersebut sebenarnya saling terhubung satu sama lain. Oleh karena itu, jika
terdapat jalan yang tidak saling terhubung satu sama lain, maka Anda dapat memperbaiki dengan pilih
node/titik dari jalan yang ingin dihubungkan, kemudian pilih menu Tools → Merge Nodes atau tekan M
pada keyboard.

Jalan harus terhubung satu sama lain

3. Objek yang Saling Overlap atau Tumpang Tindih

Salah satu kesalahan umum pada saat menggambar di JOSM adalah poligon saling overlap, padahal
seharusnya objek yang digambarkan tidak saling overlap. Sebuah bangunan tidak bisa overlap dengan
bangunan yang lain. Sebagai contoh, poligon penggunaan lahan permukiman tidak seharusnya overlap
atau tumpang tindih dengan poligon kebun.
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Contoh poligon yang saling overlap

Ada beberapa pengecualian pada aturan ini, contohnya seperti bangunan sekolah. Di dalam halaman
sekolah mungkin Anda ingin mengidentifikasi bangunan menggunakan poligon, tapi mungkin Anda juga
ingin membuat sebuah poligon yang meliputi seluruh halaman sekolah. Dalam kasus seperti ini, poligon
diperbolehkan untuk saling overlap, tetapi aturannya adalah pastikan bahwa bangunan-bangunan se-
cara menyeluruh berada dalam poligon penggunaan lahan.
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Contoh sekolah dengan poligon keseluruhan halaman sekolah dan bangunannya

4. Tips lain

Saat menggambar di JOSM, ada beberapa kesalahan-kesalahan lain yang sering terjadi. Berikut ini
adalah contoh-contoh kesalahan lainnya yang sering terjadi dan tips agar menghindari kesalahan terse-
but.

Tabel Kesalahan yang Sering Terjadi dan Tipsnya

Kesalahan Tips

Tag diberikan pada node, bukan pada objek
(misalnya: bangunan)

Satu masalah umum yang sering terjadi yaitu
menambahkan tag pada node atau titik yang
terdapat pada bagian dari sebuah garis atau
poligon. Ini sering terjadi ketika seseorang
menggambar sebuah objek, kemudian
melakukan select all) pada objek (memilih
semua titik/select node pada garis))

245



Kesalahan Tips

Persimpangan yang bertemu di sudut jalan atau
persimpangan jalan harus dipisah

Ketika jalan bersinggungan atau persimpangan
satu sama lain di sudut jalan, Anda tidak boleh
membuat garis melengkung di persimpangan.
Garis seharusnya berbentuk sudut 90° dan
terpisah menjadi dua segmen garis yang
berbeda, seperti di kondisi yang sebenarnya di
lapangan

Tidak ada tag pada node atau garis Untuk memperbaiki kesalahan ini, pilih objek
dan masukan presets sesuai dengan informasi
objek tersebut atau bisa dihapus bila objek itu
merupakan kesalahan. Hal ini dikarenakan,
server OSM tidak bisa membaca sebuah objek
yang tidak dilengkapi dengan presets (informasi
objek))

Garis berada dekat dengan garis lain tetapi
tidak terhubung

Untuk memperbaikinya, Anda dapat memilih
titik dari garis yang ingin dihubungkan dan
kemudian pilih tool Draw nodes untuk
menambahkan titik di garis yang mendatar/garis
yang berada di depannya. Alternatif lainnya,
Anda dapat menggunakan tool Merge Node
(jika di depan garis yang belum terhubung
tersebut merupakan sebuah titik))
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Kesalahan Tips

Garis tidak boleh melewati bangunan Untuk mengatasinya, Anda perlu melihat
menggunakan citra satelit objek mana yang
berada pada lokasi yang salah. Kemudian Anda
dapat menggeser objek tersebut ke tempat
yang sesuai. Contoh garis yang tidak boleh
melewati bangunan misalnya sungai.

IV. Menggambar Objek Khusus

Saat ini Anda telah mempelajari bagaimana cara menggambar sebuah objek di OSM dengan meng-
gunakan JOSM dan apa saja yang harus diperhatikan dalam menggambar sebuah objek di JOSM.
Ketika Anda mencoba menggambar sebuah objek menggunakan citra satelit, Anda mungkin akan mene-
mui beberapa objek membutuhkan teknik penggambaran khusus, seperti misalnya jembatan, kompleks
perkantoran, atau jalan besar yang mempunyai pembatas jalan.

1. Menggambar jembatan

Jembatan pada umumnya dapat dijumpai di atas suatu jaringan sungai. Namun, dalam penggambaran-
nya di OSM, Anda tidak bisa sekedar menggambarkan suatu garis/jalan di atas sungai. Apabila hal
tersebut Anda lakukan, secara teknis gambar Anda tetap dapat di-upload di OSM, namun akan diang-
gap sebagai suatu kesalahan oleh sistem. Lalu, bagaimana cara menggambar objek jembatan yang
benar? Berikut ini adalah contoh suatu area yang di dalamnya terdapat objek jembatan.

Contoh objek jembatan

Langkah digitasinya adalah sebagai berikut: * Gambar terlebih dahulu jaringan sungai.
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Contoh gambar jaringan sungai

• Gambar jaringan jalan yang melintasi (di atas) sungai tersebut.

Contoh gambar jaringan jalan di atas sungai

• Perbesar tampilan pada citra satelit, maka Anda akan melihat ujung kiri dan ujung kanan jembatan.
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Contoh gambar ujung jembatan

• Pada garis jaringan jalan, buatlah titik/node yang bertepatan dengan ujung kiri dan ujung kanan
jembatan.

Gambar titik di setiap ujung jembatan
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• Selanjutnya, Anda akan memisahkan garis yang merupakan jembatan dan garis yang hanya meru-
pakan jaringan jalan. Untuk melakukan pemisahan garis (split way), caranya adalah klik kedua
node yang baru saja Anda buat, yang merupakan ujung kiri dan kanan jembatan kemudian menuju
menu Tools → Split Way.

Contoh split way

• Maka, garis yang semula merupakan 1 segmen jaringan jalan saja, kini telah terbagi menjadi 3
segmen, yaitu (1) jaringan jalan di sebelah kiri jembatan, (2) jembatan, (3) jaringan jalan di sebelah
kanan jembatan.

Jalan sudah terbagi menjadi tiga segmen

• Setelah objek jembatan tergambarkan sebagai objek sendiri, langkah selanjutnya adalah memberi
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tag/keterangan bahwa objek tersebut adalah suatu jembatan. Sekarang, klik pada objek jembatan,
kemudian klik menu Preset → Man Made → Bridges → Bridge.

Cara menambahkan jembatan

• Akan terbuka kotak dialog preset jembatan (bridges). Cukup isikan keterangan Bridge=yes dan
Layer=1. Layer=1 ini berfungsi untuk menambahkan informasi bahwa jembatan tersebut berada
di satu tingkat lebih tinggi dibandingkan dengan dasarnya.
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Informasi yang harus diisi untuk jembatan

• Selesai.

Contoh gambar jembatan yang sudah berhasil dibuat

Contoh gambar jembatan dan informasinya di bagian panel tags

2. Menggambar Kompleks Sekolah, Perkantor, atau Gedung

Suatu sekolah, rumah sakit, atau perkantoran pada umumnya tidak berdiri sendiri, melainkan terdiri dari
beberapa bangunan di dalamnya. Dalam sub-bab ini, akan dibahas bagaimana menggambar sebuah
kompleks sekolah yang memiliki beberapa bangunan dan objek di dalamnya. Lihat contoh gambar di
bawah ini:
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Contoh beberapa bangunan sekolah

Beberapa orang menggambarkannya sebagai suatu kompleks bangunan yang sangat besar, yang di-
batasi oleh pagar yang mengitari (lihat gambar a). Sebagian yang lain menggambarkan setiap bangu-
nan di dalam kompleks tersebut secara terpisah, kemudian setiap bangunan diberi nama/keterangan
sesuai dengan nama/keterangan sekolah tersebut (gambar b). Dengan cara yang seperti itu, maka
akan terhitung bahwa pada lokasi tersebut terdapat lebih dari 1 sekolah. Hal tersebut bukanlah cara
penggambaran yang benar.

Gambar a dan gambar b

Lalu bagaimana cara penggambaran yang benar untuk suatu objek yang merupakan suatu kompleks,
yang terdiri atas bangunan-bangunan lain yang lebih kecil? Berikut ini adalah langkah-langkahnya: *
Pertama, gambarlah elemen-elemen/bagian-bagian dari sekolah tersebut yang berada di dalam area
pagar/batas terluar sekolah, misalnya gedung ruang kelas, gedung parkir, masjid, lapangan, dan taman.
Berikan tag sesuai jenis objek.
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Contoh gambar objek-objek yang terdapat di dalam sekolah

• Setelah semua elemen tergambar, gambarlah pagar/batas terluar dari sekolah tersebut, dengan
memberikan tag amenity=school.
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Gambar garis terluar dari sekolah

Jika sudah tergambar seperti gambar di atas, maka Anda sudah berhasil membuat gambar lingkungan
sekolah dengan benar.

3. Menggambar Jaringan Jalan Dengan Pembatas Jalan

Suatu jaringan jalan dapat dijumpai dalam wujud yang sederhana (lebar 1-3 meter dan tanpa pembatas)
(gambar a), namun dapat pula dijumpai dalam wujud yang kompleks, yang sangat lebar (mencapai 10-
20 meter) dan terdapat pembatas jalan (gambar b).
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Gambar a dan Gambar b

Untuk menggambar jaringan jalan yang sederhana, tentulah sangat mudah, yaitu cukup menggam-
barkannya dengan satu garis. Namun, untuk menggambar jaringan jalan yang terdapat pembatas di
tengah jaringan jalan tersebut, Anda harus menggambar ruas yang dipisahkan menjadi ruas jalan yang
berbeda. Di bawah ini adalah sebagian dari ruas jalan Thamrin, Jakarta Pusat. Jalan ini memiliki lebar
kurang lebih 40 meter, dan terdapat pembatas di tengah jalan, yang memisahkan arus kendaraan dari
arah utara dan kendaraan dari arah selatan.

Sebagian Jalan Thamrin

Untuk menggambarkan Jalan Thamrin tersebut, Anda harus menggambarkannya dengan dua garis,
yang nantinya akan menggambarkan ruas jalan yang dilewati oleh kendaraan dari arah utara dan
ruas jalan yang dilewati oleh kendaraan dari arah selatan. Berikut ini adalah langkah-langkah untuk
menggambar jalan seperti Jalan Thamrin.

• Pertama, gambarlah garis dari bawah ke atas (selatan ke utara), kemudian beri tag high-
way=primary, name=Jalan Thamrin, dan oneway=yes. Selanjutnya, gambarlah garis dari atas
ke bawah (utara ke selatan), kemudian beri tag highway=primary dan name=Jalan Thamrin
dan oneway=yes.
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Gambar jalan dari bawah ke atas (selatan ke utara)

Gambar jalan dari atas ke bawah (utara ke selatan)

Perhatikan arah panah pada kedua garis berbeda. Pada garis pertama, arah panah ke atas, artinya ruas
jalan tersebut adalah ruas jalan yang dilewati oleh kendaraan dari arah selatan ke arah utara. Pada garis
kedua arah panah ke bawah, artinya ruas jalan tersebut adalah ruas jalan yang dilewati oleh kendaraan
dari arah utara ke arah selatan.

Jika suatu jalan terdiri atas empat ruas yang berbeda (berarti terdapat 3 pembatas jalan), misalnya jalur
lambat arah ke utara, jalur cepat arah ke utara, jalur lambat arah ke selatan, dan jalur cepat arah ke
selatan; maka Anda harus menggambarkan jalan tersebut dengan 4 garis. Kondisi tersebut misalnya
dijumpai di Jalan Sudirman, Jakarta Pusat.
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Salah satu bagian Jalan Sudirman, Jakarta Pusat, yang terdiri dari empat ruas (tiga pembatas jalan)

Tampilan ruas jalan di atas, pada citra satelit
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Ruas jalan tersebut, meskipun merupakan satu jalan yang sama, yaitu Jalan Sudirman, namun terdiri
dari empat ruas; pada OSM, digambarkan dengan empat garis yang berbeda

RINGKASAN

Selamat! Jika semua berjalan dengan baik, Anda sudah mempelajari bagaimana menggunakan tools
atau alat-alat menggambar pada JOSM yang dapat membantu Anda dapat memetakan objek-objek di
OSM. Anda juga sudah mempelajari tips-tips editing yang akan berguna pada saat Anda editing meng-
gunakan JOSM. Pada bab selanjutnya, Anda akan melihat lebih dekat bagaimana proses mengedit peta
OSM di JOSM.
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 — title: Penggunaan YAML pada Export Tool weight: 4 —

Tujuan Pembelajaran:

• Mampu memahami konsep YAML
• Mampu membuat YAML untuk struktur data OSM
• Mampu mengoperasikan YAML untuk men-download data OSM pada Export Tool

Pada bab sebelumnya, Anda telah mempelajari bagaimana mengenal tag informasi objek di dalam
OpenStreetMap. Anda juga telah menentukan objek-objek yang akan dikumpulkan pada saat survei
lapang. Pada saat proses pengambilan data OSM yang telah di upload ke server menggunakan Export
Tool, Anda menemukan kendala karena beberapa data atribut yang berasal dari tag info tidak dapat di
download melalui tag yang disediakan Export Tool. Oleh karena itu, Anda dapat menggunakan YAML
untuk men-download data dengan atribut yang sama seperti atribut yang dimasukkan saat pemetaan.

I. Pengertian YAML

YAML (YAML Ain’t Markup Language) adalah sebuah struktur data sederhana yang dapat digunakan
pada semua bahasa pemrograman. YAML dapat digunakan untuk membuat struktur data yang dis-
esuaikan dengan tag (key dan value) data OSM, yang nantinya dapat berfungsi untuk menyaring data
OSM berdasarkan presets yang digunakan saat proses memasukkan data OSM.

II. Pembuatan YAML untuk Filter Data di Export Tool

a. Struktur Data YAML Cara membuat YAML untuk struktur data OSM dapat dibagi menjadi empat
bagian, yaitu :

• Judul file = menunjukkan nama file
• Types = menunjukkan tipe data pemetaan, terdiri dari points, lines, dan polygons
• Select = menunjukkan key yang berasal dari objek OSM
• Where = menunjukkan letak objek pada data OSM, terdiri dari key dan value dari objek tersebut
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Struktur format YAML untuk data OSM

b. Syarat Format Penulisan Struktur Data YAML

Ada beberapa syarat yang harus diperhatikan dalam pembuatan struktur data YAML, yaitu : * Penulisan
terdiri dari huruf kecil, tidak boleh kapital * Nama file/judul file diletakkan di awal dokumen dan tidak
boleh ada spasi pada format penulisan judul file. Jika judul lebih dari dua kata, gunakan tanda _ sebagai
pemisah kata * Antar elemen struktur data harus sejajar seperti pada contoh di atas.

c. Proses Pembuatan YAML

Anda dapat membuka modul Pembuatan Model Data OSM untuk melihat daftar model data objek OSM
yang akan dipetakan. Kemudian dari daftar tabel-tabel tersebut akan dibuat ke dalam struktur data
YAML. Langkah-langkah untuk membuat YAML, yaitu:

• Buat daftar objek yang dipetakan yang sudah dibuat sebelumnya pada model data OSM

Tabel Model Data OSM untuk Objek Bank

key possible values

amenity bank
building bank
amenity bank
name isian nama
addr:full isian alamat
capacity <50, 50-100, 100-250, 250-500, >500
building:levels isian dalam bentuk angka
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key possible values

building:structure confined_masonry (Rangka beton bertulang),
steel_frame (Rangka baja), wood_frame
(Rangka kayu), bamboo_frame (Rangka
bambu)

building:walls brick (Bata), concrete (Beton), wood (Papan
kayu), bamboo (Bambu), glass (Kaca)

building:floor ground (Tanah), wood (Papan kayu), cement
(Plester / Semen), tekhel (Tegel), ceramics
(Keramik)

building:roof tile (Genteng), tin (Seng), asbestos (Asbes),
concrete (Beton)

access:roof yes (Ada), no (Tidak ada)
building:condition poor (Buruk), good (Baik)
backup_generator yes (Ada), no (Tidak ada)

• Buka Notepad yang tersedia pada laptop/komputer Anda.

• Pada baris pertama ketikkan nama file yang akan dijadikan judul file, misalnya bank

bank:

• Pada baris kedua tekan enter + spasi empat kali dan ketikkan types:, kemudian tekan enter
+ spasi delapan kali + ketikkan - points/polygons/lines dan isi tipe data tersebut berdasarkan
model data OSM dengan mengetikkan ke bawah baris

types:
- points
- polygons

• Tekan enter dan sesuaikan dengan baris types:, kemudian ketikkan select: → tekan enter + spasi
delapan kali ketikkan daftar key yang terdapat pada objek “bank”.

select:
- amenity
- name
- addr:full
- addr:city
- capacity:persons
- building
- building:levels
- building:structure
- building:walls
- building:floor
- building:roof
- access:roof
- building:condition
- backup_generator
- source

• Tahap terakhir, tekan enter dan sesuaikan dengan posisi types dan select→ ketikkan where: key
dan value.

where: amenity='bank'

• Anda dapat meneruskan pembuatan YAML sampai seluruh objek pemetaan dimasukkan, yang
disamakan dengan format seperti sebelumnya.

• Simpan struktur YAML tersebut dalam format .txt di dalam direktori komputer/laptop Anda.

bank:
types:
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- points
- polygons

select:
- amenity
- name
- addr:full
- addr:city
- capacity:persons
- building
- building:levels
- building:structure
- building:walls
- building:floor
- building:roof
- access:roof
- building:condition
- backup_generator
- source

III. Penggunaan YAML pada Export Tool

• Buka halaman situs Anda, dan ketikkan link berikut ini https://export.hotosm.org

Halaman muka situs Export Tool

• Anda harus masuk menggunakan akun OSM dengan klik Login di sudut kanan atas. Apabila
muncul ‘Authorize access to your account’ klik Grant Access. Periksa alamat email Anda untuk
mengkonfirmasi pembuatan akun pada email yang masih aktif. Klik tautan pada email tersebut
untuk konfirmasi pembuatan akun.

Izin akses akun OSM

• Sekarang Anda sudah masuk dengan menggunakan akun OSM, kemudian klik Start Exporting
untuk memulai proses download data OSM
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• Pada Menu Describe akan muncul formulir isian dan gambar peta seperti gambar di bawah ini,
formulir isian yang wajib diisi dan Anda dapat memilih area yang diinginkan pada gambar peta di
sebelah kanan.

Lembar kerja Export Tool

• Ada beberapa cara untuk menggambarkan area yang akan dipilih :

Box = Menggambar area dengan menggunakan kotak. Jika Anda ingin mengulang untuk pembuatan
kotak klik tanda X pada kolom Box.
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Penentuan area dengan bentuk kotak

Draw = Menggambar area yang dipilih secara manual, Anda dapat klik pada area yang ingin digambar
dan diakhiri dengan klik dua kali.

Penentuan area dengan bentuk manual

Import = Menggunakan poligon dalam format .geojson untuk memilih area yang akan di download.
Syarat format data .geojson yang dapat ditambahkan ke dalam Export Tool adalah harus satu fitur (satu
baris) pada data atribut. Anda dapat membuka modulMenggunakan GeoJSON untuk mengetahui cara
mendapatkan data .geojson.
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Penentuan area dengan berdasarkan batas administrasi

• Jika sudah menyelesaikan formulir isian dan menentukan area yang akan di download, pilih menu
Format. Pilih data spasial yang Anda inginkan, misalnya .shapefile

Format data spasial

• Selanjutnya klik MenuData→YAML. Salin struktur data YAML yang telah dibuat, tempelkan/paste
ke kotak YAML
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Menu YAML

• Klik MenuSummary, Anda harus memilih apakah file ekspor ini akan dipublikasikan kepada umum
atau hanya ada pada akun Anda. Kemudian klikCreate Export untuk memulai proses ekspor data
OSM.

Menu summary

• Tunggu beberapa saat sampai proses selesai. Jika file export Anda sudah selesai, Export Tool
akan memberikan pemberitahuan melalui email, atau Anda dapat melihat hasilnya di Menu Ex-
port. Jika Anda ingin melihat hasil export yang dilakukan oleh pengguna lainnya, maka beri tanda
centang Show all Export.
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Menu Export

• Jika proses sudah selesai akan muncul kotak dialog seperti di bawah ini dengan status COM-
PLETED, klik tulisan berwarna biru seperti nama file.shp.zip untuk menyimpan hasil ekspor data
OSM.

Proses export tool telah selesai

Latihan!

Buatlah 2 (dua) proyek baru di Export Tool dan download data OSM dengan menggunakan tautan YAML
berikut https://tinyurl.com/group-stats. Data OSM tersebut akan digunakan pada bab selanjutnya men-
genai perhitungan jumlah objek menggunakan plugin Group Stats. Jika Anda telah berhasil, maka akan
ada 2 (dua) shapefile yaitu fasum dan jalan.

RINGKASAN

Anda telah menyelesaikan proses men-download data spasial dengan menggunakan Export Tool. Den-
gan menggunakan YAML, data yang dihasilkan akan sesuai dengan data yang dimasukkan pada proyek
pemetaan. Sehingga file tersebut sudah tertata rapi dan teratur, Anda dapat membuka file tersebut, un-
tuk melihat data-data yang sudah dihasilkan dari pemetaan. File yang sudah di-download dapat dibuka
di software pemetaan seperti QGIS.
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Membuat Formulir Survei untuk Aplikasi ODK Collect & OpenMapKit

Tujuan pembelajaran:

• Menjelaskan konsep XLSForm
• Mengoperasikan pembuatan XLSForm untuk ODK Collect
• Mengoperasikan pembuatan XLSForm untuk OpenMapKit

Dalam kegiatan survei lapangan terkadang Anda membutuhkan sebuah formulir survei. Bayangkan
apabila Anda membutuhkan formulir survei dengan puluhan pertanyaan untuk setiap responden, Anda
tentunya akan mengalami kesulitan pada saat pengisian data dan juga pada saat memasukkan data
ke dalam laptop. Pada materi ini Anda akan belajar bagaimana cara membuat sebuah formulir survei
dalam format digital yang nantinya akan dimasukkan ke dalam perangkat telepon genggam Anda.

I. Pengertian konsep XLSForm

XLSForm merupakan sebuah formulir standar yang dibuat untuk membantu mempercepat proses pem-
buatan formulir survei di Excel. Pembuatan formulir survei ini dilakukan dalam format yang mudah
dibaca dan menggunakan alat yang familiar - Excel/Google Spreadsheet. XLSForm menghasilkan
standar baku untuk berbagi dan bekerja sama dalam pembuatan formulir survei. XLSForm sangat mu-
dah untuk digunakan tetapi bisa juga menjadi sangat rumit apabila Anda sudah familiar dalam membu-
atnya.

Contoh format XLSForm

XLSForm ini kemudian akan diubah menjadi bentuk XForm, sebuah format standar yang bersifat ter-
buka, dimana format tersebut memungkinkan Anda untuk membuat sebuah formulir dengan fungsi yang
sangat kompleks, seperti pertanyaan bertingkat, ke dalam format yang sudah dikenali oleh perangkat
pengumpulan data baik itu dalam bentuk situs di internet, maupun dalam perangkat telepon genggam.
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Contoh format XForm

Syarat utama dalam membuat XLSForm adalah berkas akhir formulir survei Anda harus dalam jenis
Microsoft Excel (format .xls atau .xls). Apabila Anda membuat formulir survei menggunakan aplikasi
lain seperti Google Spreadsheet atau Libre Office, Anda harus memastikan bahwa hasil akhir berkas
tersebut disimpan dalam format .xls atau .xlsx.

II. Pembuatan XLSForm untuk aplikasi ODK Collect

Anda tentunya sudah memahami cara penggunaan aplikasi ODK Collect yang dijelaskan pada modul
Menggunakan aplikasi ODK Collect. Semua pertanyaan yang muncul pada aplikasi ODK Collect
dibuat dalam format XLSForm. Saat ini kita akan mempelajari bagaimana cara membuat formulir survei
sehingga bisa ditampilkan ke dalam aplikasi ODK Collect.

1. Format Standar

Dalam pembuatan formulir survei ada beberapa ketentuan yang harus Anda ikuti agar formulir survei
yang kita buat bisa diubah kedalam format XForm. Beberapa aturan yang harus diikuti untuk membuat
formulir survei yang sesuai adalah:

a. Tiga lembar kerja/sheet utama. Pada dokumen spreadsheet yang kita buat, harus terdiri dari 3
lembar kerja utama, yaitu lembar kerja yang bernama survey, choices, settings. Penamaan lembar
kerja ini harus sesuai dan tidak boleh salah karena nanti akan gagal pada saat meng-upload formulir
survei Anda.

Tiga Lembar Kerja Utama di setiap XLSForm
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Lembar kerja pertama yaitu survey. Pada lembar kerja ini semua pertanyaan yang akan kita buat harus
kita letakkan pada lembar kerja ini. Semua pertanyaan yang kita buat tidak perlu disertakan dengan
daftar jawaban. Semua daftar jawaban yang kita butuhkan akan mengacu ke lembar kerja berikutnya.

Lembar kerja kedua yaitu choices. Pada lembar kerja ini kita memasukkan semua daftar jawaban kita
dari setiap pertanyaan yang membutuhkan pilihan jawaban.

Lembar kerja ketiga yaitu settings. Pada lembar kerja ini kita hanya dapat memasukkan nama formulir
kita apabila nama formulir kita berbeda dengan nama berkas kita. Sebagai contoh, apabila nama berkas
kita adalah formulir_survei_air_bersih.xlsmaka pada lembar kerja ini kita bisa memberikan nama formulir
kita dengan nama yang kita inginkan, misalnya Formulir Kondisi Air Bersih.

b. Tiga nama kolom utama. Pada setiap lembar kerja harus terdapat dua-tiga nama kolom yang
berbeda di setiap lembar kerja. Nama kolom untuk masing-masing lembar kerja ini pun berbeda-beda.

b.1. Kolom pada Lembar Kerja survey Pada lembar kerja survey kita harus memasukkan tiga nama
kolom yaitu type, name, & label. Kolom dengan nama type menunjukkan jenis pertanyaan yang akan
muncul nantinya, apakah pertanyaan berbentuk pilihan, isian bebas ataupun mengambil lokasi.

Kolom dengan nama namemenunjukkan variabel unik untuk setiap daftar pertanyaan. Variabel ini tidak
boleh sama, tidak menggunakan spasi, dan hanya berupa angka, huruf atau garis bawah.

Kolom dengan nama label menunjukkan tulisan pertanyaan yang akan muncul pada perangkat ponsel
pengguna. Tidak ada format baku untuk kolom ini, Anda bebas menggunakan huruf, angka, dan karakter
spesial pada kolom ini.

Contoh kolom untuk lembar kerja survey

b.2. Kolom pada Lembar Kerja choices Pada lembar kerja choices kita harus memasukkan tiga
nama kolom yaitu list_name, name, & label. Pada kolom list_name ini anda membuat sebuah
grup yang berisikan sebuah set pilihan jawaban. Misalnya seperti sebuah set pilihan jawaban yang
akan muncul dibawah pertanyaan pilihan ganda. Untuk penamaan pada variabel list_name ini harus
mengikuti penamaan yang ada pada lembar kerja survey. Misalnya pada lembar kerja survey kita
memasukkan tipe pilihan ganda dengan nama select_one jns_bencana. Maka pada lembar kerja
choices kita harus mengisi list_name kita dengan nama jns_bencana. Ini akan dijelaskan lebih lanjut
pada pembahasan berikutnya.
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Kolom dengan nama name memiliki aturan yang sama dengan kolom name pada lembar kerja survey.
Semua harus dalam variabel unik yang tidak sama dengan yang lainnya baik pada lembar kerja survey
maupun lembar kerja choices; tidak menggunakan spasi melainkan diganti dengan menggunakan garis
bawah/underscore; dan tidak boleh menggunakan karakter spesial seperti tanda tanya, tanda seru, dsb.

Kolom dengan nama label memiliki aturan yang sama dengan kolom label pada lembar kerja survey.
Pada kolom ini berisikan teks jawaban yang akan muncul pada ponsel pengguna. Anda bisa bebas
menggunakan spasi, karakter khusus maupun huruf pada bagian kolom ini.

Contoh penamaan kolom pada lembar kerja choices

b.3. Kolom pada Lembar Kerja settings Lembar kerja settings digunakan apabila Anda ingin mem-
buat pengaturan tambahan seperti memberikan nama formulir survei Anda, memberikan id formulir se-
cara spesifik, dan versi formulir survei Anda. Agar dapat menggunakan fitur ini, Anda harus memberikan
tiga nama kolom ini: form_title, form_id, & version.

Pada kolom form_title, Anda bisa memberikan penamaan yang bebas untuk formulir Anda. Penamaan
ini yang nantinya akan muncul pada ponsel pengguna.

Sementara untuk kolom form_id, Anda bisa memberikan id formulir Anda. Syarat penamaan pada
kolom ini adalah Anda tidak boleh memiliki id yang sama seperti formulir lainnya, tidak menggunakan
spasi, dan tidak menggunakan karakter spesial.

Untuk kolom version, Anda bisa memberikan versi formulir Anda. Penambahan kolom version ini tidak
wajib. Apabila Anda sering menambah/mengubah formulir survei Anda, dengan memberikan kolom
version ini, akan memudahkan Anda dalam mengunggah formulirnya pada server.

Contoh penamaan kolom pada lembar kerja settings
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c. Semua isian harus dengan format standar dan dimulai dari kotak paling pertama. Salah satu
syarat yang paling utama adalah ketika kita membuat formulir survei, semua harus dimulai pada
field/kuadran A-1.

Posisi awal membuat formulir survei

Semua isian formulir harus dimulai pada kuadran/field tersebut karena nantinya sistem akan mengkon-
versi berkas spreadsheet ini menjadi dalam bentuk XForm, sehingga apabila Anda tidak memulai dari
posisi tersebut, akan terjadi error pada sistem.

Selain itu, syarat utama lainnya adalah tidak boleh menggunakan format tabel seperti contohnyamerge,
center, hide row/coloum, wrap text, dsb. Semuanya harus dalam keadaan format standar. Pengaturan
yang bisa kita gunakan adalah menambahkan huruf cetak tebal/bold, memberikan warna pada kolom
atau baris, dan mengubah bentuk dan ukuran huruf.

2. Tipe-tipe Pertanyaan Standar

Dalam formulir survei kertas, biasanya kita menemukan beberapa pertanyaan seperti jawaban singkat,
jawaban panjang, memasukkan tanggal lahir, dan pilihan berganda. Beberapa pertanyaan tersebut,
apabila kita buat dalam spreadsheet, memiliki tipe pertanyaan yang berbeda-beda, seperti:

a. Tipe pertanyaan text

Tipe pertanyaan jenis ini akan menghasilkan format pertanyaan dengan jawaban bebas. Pengguna
bisa dengan bebas memasukkan angka, huruf, dan karakter spesial apabila kita menggunakan tipe
pertanyaan ini.

Contoh tipe pertanyaan text

b. Tipe pertanyaan integer/decimal

Tipe pertanyaan jenis ini akan menghasilkan format pertanyaan dengan jawaban berupa angka bilangan
bulat (khusus untuk tipe integer) atau angka bilangan desimal (khusus untuk tipe decimal). Pengguna
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hanya bisa memasukkan angka saja dengan tipe pertanyaan ini, gabungan dari angka dan huruf tidak
akan bisa dimasukkan apabila kita menggunakan tipe pertanyaan ini.

Contoh tipe pertanyaan integer

c. Tipe pertanyaan select_one

Tipe pertanyaan jenis ini akan memberikan pengguna sebuah pilihan jawaban dimana pengguna hanya
boleh memilih satu jawaban saja. Dalam membuat tipe pertanyaan ini, Anda harus menggunakan format
seperti select_one [opsi]. Dimana [opsi] merupakan variabel grup yang akan dimasukkan ke dalam
lembar kerja choices di dalam kolom list_name.

Contoh tipe pertanyaan select_one [opsi]. Perhatikan bahwa pada list_name sesuai dengan apa yang
ada pada [opsi] di lembar kerja survey.

d. Tipe pertanyaan select_multiple

Tipe pertanyaan jenis ini sama seperti tipe pertanyaan sebelumnya. Jawaban yang disajikan ke peng-
guna merupakan beberapa pilihan dan pengguna boleh memilih lebih dari satu jawaban. Aturan dalam
pembuatan tipe pertanyaan ini juga sama seperti select_one. Anda harus menggunakan format seperti
select_multiple [opsi], dimana [opsi]merupakan variabel grup yang akan dimasukkan ke dalam lembar
kerja choices dalam kolom list_name.
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Contoh tipe pertanyaan select_multiple [opsi]. Opsi pada gambar diatas adalah floodcause yang juga
muncul didalam lembar kerja choices

e. Tipe pertanyaan geopoint

Tipe pertanyaan ini akan meminta pengguna untuk merekam koordinat posisi mereka dan akan meng-
hasilkan data berbentuk koordinat lintang dan bujur.

Contoh penggunaan tipe pertanyaan geopoint
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f. Tipe note

Tipe ini digunakan untuk menambahkan halaman catatan atau pemberitahuan. Pengguna akan dis-
ajikan satu halaman yang berisikan tampilan tulisan saja tanpa harus mengisi informasi apapun. Untuk
format penulisan masih mengikuti kaidah penulisan pada kolom label, dimana kita bebas memberikan
format tulisan apapun.

Contoh penggunaan tipe note

Tipe image, video atau audio

Tipe pertanyaan ini akan meminta pengguna untuk mengambil gambar, suara atau video.

Contoh penggunaan tipe image
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3. Format Tambahan

Anda bisa langsung menggunakan formulir survei Anda hanya dengan memasukan beberapa tipe per-
tanyaan standar yang sudah dijelaskan sebelumnya. Semakin Anda mahir membuat XLSForm, Anda
mungkin akan bertanya apakah ada tipe pertanyaan lain yang bisa membuat formulir survei Anda se-
makin mudah digunakan dan mengambil data sesuai kemauan Anda. Untuk melihat semua tipe per-
tanyaan yang bisa digunakan dalam membuat XLSForm, Anda bisa menuju situs http://xlsform.org.
Pada materi ini, kita hanya akan membahas beberapa tipe pertanyaan tambahan yang bisa Anda gu-
nakan apabila Anda ingin membuat formulir survei Anda menjadi lebih informatif dan mudah digunakan.

a. Hint

Hint merupakan salah satu fitur tambahan yang bisa kita tambahkan pada formulir survei digital kita. Den-
gan menggunakan fitur ini, kita bisa memberikan informasi tambahan atau petunjuk tentang bagaimana
cara mengisi sebuah pertanyaan yang kita buat. Untuk membuat fitur ini, kita harus menambahkan
kolom baru pada lembar kerja survey yang bernama hint. Dengan menambahkan kolom ini, setiap tipe
pertanyaan yang kita buat, bisa kita tambahkan dengan petunjuk informasi pengisian dengan mengisi
pada kolom hint ini.

Contoh penggunaan kolom hint

b. Required

Fitur ini dibutuhkan apabila pada formulir survei Anda, terdapat pertanyaan yang wajib untuk dijawab.
Dengan menggunakan fitur ini, pengguna tidak akan bisa mengisi pertanyaan selanjutnya apabila
mereka belum menjawab pertanyaan tersebut. Tipe pertanyaan yang menggunakan fitur ini juga akan
memiliki tanda bintang berwarna merah ( * ) apabila dilihat pada ponsel Anda. Untuk menggunakan
fitur ini, Anda cukup membuat sebuah kolom baru yang bernama required yang terletak pada lembar
kerja survey. Setiap tipe pertanyaan yang Anda akan atur menjadi wajib, harus anda tambahkan nilai
yes pada kolom required ini.
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Contoh penggunaan fitur required. Setiap pertanyaan yang mengaktifkan fitur ini tidak dapat dilewati
oleh pengguna apabila belum diisi

c. Field-list

Fungsi dari fitur ini adalah pengguna akan disajikan beberapa pertanyaan pada satu halaman saja pada
layar aplikasi. Secara pengaturan awal, setiap halaman hanya akan disajikan satu pertanyaan saja.
Apabila kita ingin agar semua pertanyaan muncul pada satu halaman, maka kita harus menggunakan
fitur ini.

Untuk mengaktifkan fitur ini, Anda harus melakukan beberapa pengaturan: 1. Anda harus menyelipkan
format begin_group pada bagian awal pertanyaan yang ingin Anda tampilkan ke dalam satu halaman
dan end_group pada bagian akhir pertanyaan yang ingin Anda tampilkan dalam satu halaman. Format
begin_group dan end_group ini harus berada di dalam kolom type. Dengan menyelipkan format ini,
sistem akan membaca bahwa semua pertanyaan yang berada setelah format begin_group dan sebelum
format end_group merupakan satu grup pertanyaan.

2. Setelah anda membuat grup pertanyaan tersebut, Anda harus menambahkan kolom appearance
dan disikan dengan format field-list. Dengan menambahkan kolom tersebut, Anda memberi-
tahukan kepada sistem bahwa semua grup pertanyaan yang telah Anda buat, akan dimasukkan
ke dalam daftar satu halaman saja.
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Contoh penggunaan fitur field-list pada beberapa kelompok pertanyaan

d. Relevant

Fitur ini memungkinkan kita untuk membuat daftar pertanyaan yang mengikuti jawaban dari pertanyaan
sebelumnya. Misalkan kita diberikan pertanyaan mengenai “Apa makanan yang kamu suka?” dengan
pilihan jawaban “A. Nasi Goreng B. Pizza C. Mi Goreng”. Apabila kita menjawab “B. Pizza”, maka
pertanyaan berikutnya hanya akan berkaitan dengan pizza, misalnya seperti “Topping pizza apa yang
kamu suka?” atau “Jenis pizza apa yang kamu suka?”. Pertanyaan tersebut tidak akan muncul apabila
kita menjawab dengan jawaban lain selain pizza. Cara memasukkan fitur relevant terdiri dari beberapa
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tahapan:

1. Membuat tipe pertanyaan awal Sebelum menggunakan fitur relevant, Anda terlebih dahulu harus
membuat pertanyaan Awal yang akan Anda masukkan kedalam format fitur relevant. Misalnya

dengan menggunakan tipe pertanyaan select_one:

Contoh pertanyaan pada lembar kerja survey

2. Membuat pilihan jawaban pada lembar kerja choices Setelah Anda membuat pertanyaan awal,
langkah selanjutnya adalah Anda harus membuat pilihan jawaban pada lembar kerja choices.

Contoh pilihan jawaban pada lembar kerja choices

3. Memasukkan fitur relevant pada pertanyaan selanjutnya Setelah Anda membuat pertanyaan awal
dan pilihan jawaban, langkah selanjutnya adalah Anda akan membuat pertanyaan yang akan
muncul sesuai dengan pilihan jawaban yang dipilih pada pertanyaan sebelumnya. Misalnya, pada
pertanyaan sebelumnya, Anda memilih prasasti untuk jenis objek yang dimaksud, maka pada per-
tanyaan berikutnya akan spesifik mengenai prasasti saja. Untuk mengaktifkan fitur ini, Anda harus
memasukkan kolom tambahan yang bernama relevant pada lembar kerja survey. Setelah mema-
sukkan kolom tambahan Anda bisa mengisi baris pertanyaan yang membutuhkan fungsi relevant
dengan format:

Format Deskripsi𝑓𝑖𝑒𝑙𝑑𝑛𝑎𝑚𝑒 =‘𝑐ℎ𝑜𝑖𝑐𝑒’|𝑈𝑛𝑡𝑢𝑘𝑡𝑖𝑝𝑒𝑠𝑒𝑙𝑒𝑐𝑡𝑜𝑛𝑒𝑠𝑎𝑗𝑎||𝑠𝑒𝑙𝑒𝑐𝑡𝑒𝑑({field_name},
‘choice’)

Untuk tipe select_multiple & select_one

Untuk field_name mengacu kepada variabel yang Anda tentukan sebelumnya di kolom name
pada lembar kerja survey. Sementara itu untuk choicemengacu kepada variabel pilihan jawaban
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yang tersedia pada lembar kerja choices.

Contoh pembuatan fitur relevant

III. Pembuatan form survey untuk aplikasi OpenMapKit

Selain menggunakan ODK Collect, untuk pengumpulan data di lapangan kita juga menggunakan Open-
MapKit. Anda tentunya sudah memahami cara penggunaan OpenMapKit untuk pengumpulan data di
lapangan. Jika Anda belum mengetahuinya, Anda bisa membaca modulMenggunakan Aplikasi Open-
MapKit. Sekarang kita akan belajar cara membuat formulir survei untuk digunakan di OpenMapKit.

Secara umum, pembuatan formulir survei untuk OpenMapKit mengikuti aturan seperti formulir survei
ODK Collect. Pembuatan formulir survei ini pun bisa dilakukan dalam berkas yang sama dalam pem-
buatan ODK Collect. Ada beberapa pengaturan standar yang harus kita ikuti agar formulir survei yang
kita buat bisa digunakan untuk OpenMapKit.

1. Empat lembar kerja/_sheet _utama

Secara umum, kebutuhan lembar kerja untuk membuat OpenMapKit tidak jauh berbeda dengan format
ODK Collect. Lembar kerja yang dibutuhkan oleh ODK Collect adalah survey, choices, & settings.
Namun untuk OpenMapKit, kita harus menambahkan lembar kerja baru bernama osm.

Lembar kerja utama untuk OpenMapKit

Lembar kerja osm berisikan tentang pertanyaan dan pilihan jawaban yang akan muncul pada Open-
MapKit. Pada lembar kerja inilah kita harus memasukkan semua daftar pertanyaan yang akan muncul
di OpenMapKit. Sementara itu, tiga lembar kerja lainnya mengikuti pengaturan dalam pembuatan ODK
Collect.

2. Tipe pertanyaan utama

Agar pertanyaan yang kita buat berhasil dimunculkan ke dalam OpenMapKit, kita harus memasukkan
tipe pertanyaan khusus, yaitu osm. Dengan memasukkan pertanyaan ini ke dalam lembar kerja survey,
sistem akan memunculkan semua pertanyaan di OpenMapKit yang telah kita buat pada lembar kerja
osm.

Tipe pertanyaan ini harus diikuti dengan variabel yang nantinya akan terhubung dengan variabel yang
ada pada kolom list name di lembar kerja osm.
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Tipe pertanyaan osm dengan variabel yang sama di lembar kerja osm

3. Tiga kolom utama

Pada lembar kerja osm, kita harus memasukkan tiga kolom utama, yaitu kolom list name, name,
dan label. Kolom list name berisi tentang pertanyaan dan pilihan jawaban. Kolom name berisi
tentang variabel unik yang mengikuti standar key dan value dari OpenStreetMap. Untuk daftar key
dan value, Anda bisa melihat pada modul Model Data OpenStreetMap atau bisa langsung menuju
situs https://wiki.openstreetmap.org/wiki/Map_Features dan https://wiki.openstreetmap.org/wiki/Id:
Indonesian_Tagging_Guidelines.
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Kolom name mengikuti aturan key dan value pada OSM

4. Pertanyaan dan pilihan jawaban didalam satu lembar kerja

Tidak seperti pembuatan formulir survei untuk ODK Collect yang setiap pertanyaan dan pilihan jawa-
ban terpisah pada lembar kerja berbeda, untuk pembuatan formulir survei OpenMapKit ini kita harus
memasukkan semua pertanyaan dan pilihan jawaban di dalam satu lembar kerja.

IV. Latihan Membuat Formulir Survei ODK Collect dan OpenMapKit

Sampai saat ini kita sudah memahami bagaimana cara membuat formulir survei untuk aplikasi ODK
Collect dan OpenMapKit. Sekarang kita akan mencoba membuat formulir survei yang bisa digunakan
untuk kedua aplikasi ini.

Bayangkan Anda saat ini ingin melakukan kegiatan pengumpulan data tempat ibadah dengan menggu-
nakan ODK Collect dan OpenMapKit. Beberapa data yang Anda ingin kumpulkan adalah:
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• Nama surveyor
• Berada di lokasi rawan bencana atau tidak
• Koordinat titik lokasi obyek survei
• Nama tempat ibadah
• Jenis agama untuk tempat ibadah

Dari data tersebut, Anda berhasil mengidentifikasi mana saja jenis pertanyaan yang masuk ke dalam
formulir survei ODK Collect dan mana saja jenis pertanyaan yang masuk ke dalam formulir surveiOpen-
MapKit. Pertanyaan yang masuk kedalam ODK Collect adalah nama surveyor, rawan bencana, &
koordinat titik lokasi obyek survey. Sementara itu pertanyaan yang masuk ke dalam OpenMapKit
adalah nama tempat ibadah & jenis agama untuk tempat ibadah.

Pertama-tama, kita harus membuat formulir survei untuk ODK Collect. Seperti syarat yang sudah Anda
pelajari sebelumnya, dalam berkas spreadsheet kita harus dibuat empat lembar kerja, yaitu survey,
choices, settings & osm.

Setelah itu, pada lembar kerja survey kita harus memberikan kolom utama kita, yaitu kolom type, name
& label. Jenis tipe pertanyaan yang harus kita buat untuk formulir survei ini adalah text, select_one &
geopoint.

Tipe pertanyaan untuk lembar kerja survey

Pada lembar kerja choices kita memasukkan pilihan jawaban untuk tipe pertanyaan select_one yang
sudah kita buat pada lembar kerja survey. Disini kita harus membuat tiga kolom utama yaitu list_name,
name, & label.

Pilihan jawaban yang dimasukkan pada lembar kerja choices_

Karena kita ingin menggunakanOpenMapKit untuk pengumpulan data lapangan kita, kita harus menam-
bahkan tipe pertanyaan yang nantinya akan mengarahkan kita ke aplikasiOpenMapKit, tipe pertanyaan
yang harus kita masukkan adalah osm. Pada lembar kerja osm kita memasukkan semua pertanyaan
yang berkaitan dengan OpenMapKit. Pada variabel name kita harus mengacu kepada key dan value
di wikipedia OpenStreetMap.
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Isi lembar kerja survey dan osm

Terakhir, pada lembar kerja settings kita memasukkan id formulir kita dan judul formulir kita. Pada
lembar kerja ini, hanya dibutuhkan dua kolom utama, yaitu form_id dan title.

Contoh pengaturan pada lembar kerja settings

RINGKASAN

Selamat! Saat ini Anda telah berhasil membuat formulir survei untuk aplikasi ODK Collect dan Open-
MapKit. Untuk lebih mengetahui jenis pertanyaan yang dapat dibuat pada ODK Collect, Anda bisa
langsung mengakses halaman http://xlsform.org. Pembuatan formulir yang tepat akan memudahkan
para surveyor dalam mengumpulkan data di lapangan.
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 — title: Menambahkan Data Hasil Survei ke OSM Menggunakan JOSM weight: 5 —

Tujuan Pembelajaran:

• Mampu menerapkan cara menginstal plugin Utilsplugin2
• Mampu menerapkan cara menggabungkan data hasil survei
• Mampu menerapkan cara menyimpan file di JOSM
• Mampu menerapkan cara men-download data OpenStreetMap
• Mampu menerapkan cara memunculkan citra satelit di JOSM
• Mampu menerapkan, menambahkan dan mengubah data OSM menggunakan JOSM
• Mampu menerapkan cara meng-upload perubahan ke OSM
• Mampu menerapkan cara melihat perubahan data OSM di situs OSM

Data OSM dapat diperkaya dengan cara menambahkan atau memetakan objek di OSM. Namun, jika
Anda menambahkan data OSM menggunakan citra satelit saja sebagai acuannya, maka informasi
objek yang Anda tambahkan tentu terbatas sekali. Survei lapangan dapat membantu Anda dalam
melengkapi informasi objek yang dipetakan. Anda dapat mempelajari alat pengumpulan data pada
modul Metodologi Pengumpulan Data. Untuk menambahkan data OSM, Anda memerlukan editor
data OSM. Banyak sekali editor data OSM yang tersedia, namun pada modul ini editor data OSM yang
digunakan adalah JOSM. JOSM menyediakan banyak alat serta plugin yang memudahkan pengguna
dalam menambahkan atau mengedit data OSM.

I. Menginstal plugin Utilsplugin2

Sebelum menambahkan atau mengedit data OSM menggunakan JOSM, instal plugin yang akan di-
gunakan terlebih dahulu. JOSM memiliki plugin yang salah satu fungsinya memudahkan Anda un-
tuk menyalin preset/tag yaitu plugin utilsplugin2. Anda harus menginstal plugin ini terlebih dahulu.
Langkah-langkah untuk menginstal plugin utilsplugin2 yaitu:

• Buka JOSM
• Klik menu Edit → Preferences
• Pilih menu Plugins (ikon steker) untuk menginstal plugin baru. Jika daftar plugins belum muncul,

Anda dapat mengklik Download List namun pastikan komputer/laptop Anda terkoneksi internet.
• Setelah men-download plugin, cari plugin utlisplugin2 dengan menuliskannya pada kolomSearch.

Setelah berhasil menemukan plugin utilsplugin2, silakan centang kotak plugin utilsplugin2 untuk
menginstal plugin tersebut.
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Melakukan instalasi plugin utilsplugin2

• Setelah itu klik OK dan tunggu hingga proses instalasi selesai. Jika sudah berhasil diinstal, akan
muncul menu More tools.

287



Tampilan menu More tools pada JOSM

Catatan : Terkadang JOSM meminta Anda untuk melakukan Restart setelah melakukan
instalasi plugin baru untuk mengaplikasikan plugin yang baru saja diinstal. Namun, tidak
semua plugin membutuhkan Restart untuk dapat digunakan setelah instalasi.

II. Menggabungkan Data Survei

Jika Anda sudah melakukan survei menggunakan alat pengumpulan data sepertiODKCollect danOpen-
MapKit, Anda dapat menggunakan data hasil survei tersebut sebagai acuan menambahkan informasi
objek di OSM. Data hasil survei yang didapatkan dari ODK Collect dan OpenMapKit formatnya adalah
.osm. Banyaknya file .osm hasil survei dari ODK Collect dan OpenMapKit sama dengan banyaknya ob-
jek yang disurvei karena informasi satu objek disimpan pada satu file .osm. Untuk memudahkan Anda
menggunakan data hasil survei untuk menambahkan informasi objek, gabungkan seluruh file .osm den-
gan cara:

• Arahkan File Explorer ke direktori tempat penyimpanan file hasil survei dari ODK Collect dan
OpenMapKit.
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Tampilan direktori penyimpanan file hasil survei menggunakan ODK Collect

• Cari semua file .osm dengan cara ketikkan osm pada kolom Search. Pilih semua file .osm dari
hasil pencarian.

Tampilan hasil pencarian pada direktori penyimpanan file hasil survei

• Tarik semua file .osm yang sudah dipilih ke JOSM.
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Tampilan layer setelah dimasukkan data hasil survei menggunakan ODK dan OMK

• Pilih semua layer file hasil survei dengan cara pilih layer hasil survei yang paling atas, tekan
Shift, pilih layer hasil survei yang paling bawah

• Klik kanan pada layer hasil survei, lalu klik Merge. Setelah itu muncul jendela Select target
layer, Anda tidak perlu mengubah target layer nya lalu klik Merge.

Menggabungkan layer hasil survei

• Simpan dan ubah nama layer hasil gabungan seluruh data survei dengan cara klik kanan pada
layer hasil gabungan, pilih Save As, ubah nama file nya dan kemudian klik Save.

Menyimpan layer hasil survei yang sudah digabungkan

• Untuk memudahkan Anda menandai objek-objek yang sudah dipetakan atau belum dari layer hasil
survei, JOSM menyediakan plugin to-do cara instalasi dan penggunaan secara detailnya dapat
dibaca pada modul Menggunakan to-do list di JOSM. Jika plugin to-do list sudah diinstal dan
kotak jendela Todo list sudah diaktifkan, pilih semua titik objek yang ada di layer hasil survei yang
sudah digabungkan menggunakan ikon Select object, kemudian pada kotak jendela Todo list klik
Add.
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Memasukkan objek hasil survei ke dalam Todo list

III. Men-download Data OSM

Setelah berhasil menggabungkan data hasil survei, Anda perlu men-download data OSM. Hal ini bertu-
juan agar dapat mengetahui data OSM yang sudah dipetakan oleh pengguna lainnya dan tersedia di
dalam server OSM. Untuk men-download data OSM caranya adalah:

• Klik menu File → Download Data
• Akan muncul jendela Download yang secara default menampilkan tab Slippy Map

Tampilan jendela Download Data OSM

• Jika peta belum menampilkan wilayah pemetaan Anda, geser peta dengan cara klik kanan tahan
mouse Anda dan geser/arahkan ke wilayah pemetaan Anda. Kemudian gambar kotak wilayah
pemetaan Anda dengan cara klik kiri tahan dan geserkan hingga membentuk kotak warnamerah
muda yang meliputi seluruh wilayah pemetaan Anda. Setelah itu klik Download.

• Jika wilayah pemetaan Anda cukup sulit mencarinya dengan cara menggeser peta, Anda dapat
memilih tab Areas around places dan ketik nama wilayah pemetaan Anda di kolom Enter a place
name to search for lalu klik Search. Setelah itu akan muncul nama wilayah yang Anda cari, klik
salah satu namanya lalu silakan kembali lagi ke tab Slippy Map. Peta di tab Slippy Map akan
menampilkan wilayah yang tadi sudah Anda pilih. Buatlah kotak yang meliputi seluruh wilayah
pemetaan Anda, lalu klik Download.

Catatan : Perhatikan banyaknya data OSM yang sudah ada di wilayah pemetaan Anda. Jika
sudah cukup banyak sebaiknya Anda tidak langsung men-download seluruh data OSM yang
ada di wilayah pemetaan Anda karena JOSM tidak dapat men-download data yang terlalu
besar sekaligus. Untuk mengatasinya, Anda dapat men-download data OSM di wilayah
pemetaan Anda per bagian.
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Tampilan tab “Areas around places” pada jendela Download

• Setelah berhasil men-download data OSM pada wilayah pemetaan Anda, akan muncul layer baru
yang juga akan menjadi layer area kerja Anda untuk menambahkan dan mengubah data OSM.
Pastikan Anda hanya menambahkan data pada kotak yang tidak diarsir karena kotak yang diarsir
sudah bukan wilayah yang Anda download. Pastikan seluruh area survei Anda data OSM nya
sudah di-download. Seperti ini tampilannya:

Tampilan JOSM ketika sudah berhasil men-download data OSM

• Jika sudah berhasil men-download data OSM di seluruh area survei Anda, gabungkan layer data
OSM hasil download dengan layer hasil survei yang sudah digabung pada subbab sebelumnya.
Caranya pilih kedua layer tersebut kemudian klik kanan, pilih Merge. Simpan pada layer hasil
survei yang sudah digabung. Kemudian klik Merge.
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Menggabungkan layer data OSM dengan data hasil survei

IV. Menambahkan Citra Satelit

• Setelah berhasil men-download data OSM, tambahkan citra satelit untuk acuan dalam memetakan
dengan cara mengklik Imagery→ pilih citra yang akan digunakan, misalnya DigitalGlobe Pre-
mium Imagery. Setelah berhasil menambahkan citra satelit berarti Anda sudah siap untuk menam-
bahkan data OSM. Tampilannya akan seperti ini:

Tampilan data OSM yang sudah ditambahkan citra satelit

• Anda juga dapat mengatur tampilan citra satelit yang Anda gunakan. Caranya, pilih layer citra
satelitnya kemudian klik pada ikon Change visibility of selected layer lalu ubah tampilannya
sesuai keinginan Anda.
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Mengubah tampilan citra satelit

• Terkadang citra satelit yang digunakan khususnyaDigitalGlobe Premium Imagerymemiliki perbe-
daan tampilan ketika di zoom in dan zoom out dan hanya salah satunya yang sesuai dengan data
OSM nya. Agar tampilan citranya tidak berubah-ubah ketika di zoom in atau zoom out, nonaktifkan
fitur Auto zoom dengan cara klik kanan pada citra di kanvas kerja → klik Auto zoom sehingga
tanda centang pada Auto zoom hilang.
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Menonaktifkan Auto zoom pada citra satelit

V. Mengedit dengan JOSM

Setelah menginstal plugin utilsplugin2, menggabungkan data hasil survei, men-download data OSM,
serta memasukkan citra satelit, sekarang Anda sudah siap menambahkan/mengubah data OSM meng-
gunakan JOSM. Anda dapat menggambar objek yang belum dipetakan atau mengubah objek yang
sudah dipetakan menggunakan alat-alat yang sudah Anda pelajari pada modul Menggunakan JOSM.
Berikut ini adalah cara mengedit data OSM menggunakan data hasil survei, data OSM dan citra satelit
yang sudah dibuka sebelumnya di JOSM:

• Setelah berhasil mengikuti langkah-langkah pada empat subbab sebelumnya, pada JOSM Anda
akan terdapat dua layer yang terbuka di JOSM yaitu layer citra satelit (pada gambar adalah layer
DigitalGlobe Premium Imagery) dan layer data hasil survei yang sudah digabungkan dengan
data OSM yang di-download (pada gambar adalah layer hasil_survey_jakut.osm). Tampilannya
akan seperti ini:

295



Tampilan JOSM setelah dimasukkan data hasil survei dan citra satelit

• Agar Anda tidak mengubah batas administrasi yang sudah dipetakan pada OSM, Anda dapat
menggunakan fitur Filter pada JOSM. Hal ini dikarenakan batas administrasi merupakan hal yang
bersifat khusus dan tidak terkait dengan objek lainnya di dalam OSM. Untuk menggunakan fitur
Filter, aktifkan kotak jendela Filter dengan cara klik menu Windows → Filter. Akan muncul kotak
jendela Filter di sebelah kanan kanvas kerja Anda. Klik Add pada kotak jendela Filter, tuliskan
boundary=administrative pada kolom Filter string dan kemudian klikSubmit Filter. Akan muncul
sebuah filter baru untuk batas administrasi, untuk menonaktifkan filter Anda dapat menghilangkan
tanda centang di sebelah filter. Untuk mengetahui lebih lanjut mengenai fitur Filter JOSM, Anda
dapat mempelajari modul Menggunakan Alat Filter di JOSM.

Tampilan kotak jendela Filter

Mengisi filter string pada jendela Filter
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Tampilan kotak jendela filter yang sudah ditambahkan sebuah filter

• Setelah itu, mulai lakukan pemetaan dengan perbesar ke sebuah objek langsung, pilih salah satu
objek yang ada di kotak jendela todo list kemudian klik Zoom. Setelah titik objek tersebut diperbe-
sar dan terpilih, Anda dapat menyalin tag yang ada di objek tersebut ke objek OSM ter-download.
Caranya pilih objek OSM ter-download yang bertampalan/berdekatan dengan titik objek hasil
survei yang sebelumnya dipilih, kemudian pilih menu More tools → Copy tags from previous
selection atau tekan Shift + R di keyboard. Pastikan objek yang Anda pilih sebelum menyalin
tag adalah objek hasil survei yang bertampalan/berdekatan dengan objek OSM ter-download.
Pastikan juga tag yang disalin sudah sesuai dengan aturan OSM serta sudah sesuai juga den-
gan objeknya. Seperti pada contoh objek klinik yang berada di ruko di bawah ini, objek titik hanya
berisi tag yang sesuai untuk objek titik, sedangan tag yang berisi informasi bangunan diberikan
ke objek bangunan dimana objek titik tersebut berada. Jika sudah selesai menyalin tag dari satu
objek, klik Mark untuk menandakan bahwa objek tersebut sudah dimasukkan ke OSM. Ulangi
langkah-langkah tersebut sampai semua objek selesai dimasukkan.
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Menggunakan fitur Zoom dan Mark pada Todo list

Menyesuaikan isi tag dengan objek titik

Menyalin tag mengenai bangunan menggunakan Shift + R

• Contoh objek yang dipetakan di atas digambarkan sebagai sebuah titik. Jika Anda menemukan
objek yang sebaiknya digambarkan sebagai poligon, seperti misalnya kompleks sekolah yang
memiliki lebih dari satu bangunan. Caranya hampir sama dengan memetakan objek titik pada
langkah sebelumnya. Pilih titik objek sekolah yang akan dipetakan pada jendela todo list kemu-
dian klik Zoom. Pilih titik objek sekolah lalu salin tag dari objek titik sekolah yang akan dipetakan
dengan memilih objek poligon bangunan yang bertampalan/berdekatan dengan titik objek seko-
lah tersebut kemudian klik menu More tools → Copy tags from previous selection atau tekan
Shift + R di keyboard. Setelah tag berhasil disalin, hapus tag yang tidak berhubungan dengan
bangunan dan sisakan tag yang berhubungan dengan bangunan. Gambar kawasan sekolah yang
meliputi seluruh bangunan menggunakanDrawnodes, lalu salin tag yang sesuai dengan informasi
kawasan sekolah (yang sebelumnya dihapus pada poligon bangunan) seperti amenity, name dan
addr. Setelah selesai memetakan kompleks sekolah, hapus objek titik hasil survei karena sudah
dipetakan sebagai poligon kawasan sekolah.
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Objek sekolah hasil survei

Menyesuaikan isi tag dengan bangunan sekolah
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Menyesuaikan isi tag dengan kawasan sekolah

VI. Menyimpan Perubahan

• Jika Anda sudah selesai menambahkan/mengubah objek menggunakan JOSM, simpan peruba-
han tersebut ke server OSM karena data yang Anda tambahkan/ubah hanya ada di komputer
Anda saja. Untuk menyimpan perubahan ke server OSM, caranya klik menu File → Upload Data.

• Apabila terdapat peringatan/kesalahan (warning/error) setelah Anda mengklik Upload Data,
sebaiknya peringatan/kesalahan tersebut diperbaiki terlebih dahulu. Untuk cara-cara memper-
baiki peringatan/kesalahan dan jenis-jenis peringatan/kesalahan yang sering ditemui, Anda
dapat mempelajari modul Penggunaan JOSM untuk Validasi Data Survei. Namun, jika Anda
belum memahami bagaimana cara untuk memperbaiki peringatan/kesalahan, maka Anda dapat
langsung mengklik Continue Upload dan akan muncul jendela Upload.

• Jika tidak ada peringatan/kesalahan (warning/error), akan langsung muncul jendela Upload.
Pada jendela Upload tersebut, pada kolom komentar isikan penambahan dan perubahan yang di-
lakukan dan pada kolom sumber tuliskan citra satelit yang digunakan untuk memetakan. Tuliskan
juga ‘survey’ pada kolom sumber apabila Anda melakukan survei. Jika Anda merasa pekerjaan
Anda perlu diperiksa oleh pengguna lain yang sudah mahir dalam memetakan menggunakan
OSM, silakan centang I would like someone to review my edits. Setelah itu klik Upload
Changes.
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Tampilan jendela Upload

Catatan: Ketika Anda memetakan suatu wilayah, sebaiknya Anda meng-upload-nya secara
berkala agar tidak terlalu banyak perubahan yang di-upload. Semakin banyak perubahan
yang di-upload akan semakin lama pula proses upload-nya selesai. Apabila hasil peker-
jaan Anda sudah terlanjur banyak jumlahnya, sebaiknya Anda meng-upload-nya per bagian.
Caranya, pada jendela Upload, pilih tab Advanced dan pilih Upload data in chunks of ob-
jects. Kemudian isi Chunk size nya dengan jumlah perubahan yang akan di-upload per
bagian, misalnya 500. Hal ini bertujuan agar upload tidak terputus di tengah jalan, terutama
apabila internet tidak stabil dan juga menghindari terjadinya kesalahan duplikasi objek.

VII. Menyimpan File .osm

• Anda juga dapat menyimpan layer hasil pekerjaan Anda dengan cara klik kanan di layer tempat
pekerjaan Anda dan pilih Save. Akan muncul jendela Save OSM file seperti di bawah ini. Tuliskan
nama file .osm nya sesuai yang Anda inginkan, kemudian klik Save. File hasil pekerjaan Anda
akan tersimpan dengan format .osm.
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Tampilan jendela Save OSM File

Catatan : Apabila Anda belum selesai memetakan wilayah pemetaan Anda dan ingin melan-
jutkan memetakan, Anda dapat menyimpan pekerjaan Anda terlebih dahulu dalam format
.osm dan melanjutkannya. Caranya, buka file .osm yang sudah disimpan dengan mengklik
menu File → Open kemudian pilih file yang akan dibuka dan klik Open. Setelah dibuka, per-
barui data OSM tersebut dengan mengklik menu File → Update Data dan setelah itu Anda
dapat melanjutkan pemetaan dan meng-upload-nya seperti langkah yang telah dibahas se-
belumnya.

VIII. Melihat Perubahan di Peta

• Anda dapat melihat perubahan di peta OSM dengan mengeceknya pada situs web OSM https:
//www.openstreetmap.org dan mengarahkan peta ke wilayah pemetaan yang sudah Anda tam-
bahkan datanya. Perlu diingat, perubahan baru dapat dilihat beberapa saat setelah Anda meng-
upload hasil pemetaan ke server OSM.

Tampilan perubahan sebelum (kiri) dan sesudah (kanan) proses pemetaan

RINGKASAN

Jika Anda dapat mengikuti dan memperhatikan seluruh tahapan dalam bab ini, maka Anda telah berhasil
menerapkan proses pemetaan OSM menggunakan JOSM. Anda sudah dapat menerapkan proses
menambahkan data hasil lapang ke dalam OpenStreetMap seperti men-download data OSM, menam-
bahkan citra satelit, mengedit dengan JOSM, meng-upload hasil pemetaan, menyimpan hasil pemetaan
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menjadi format .osm dan melihat perubahan hasil pemetaan. Anda dapat memasukkan hasil survei se-
cara berkala ke dalam OSM, misalnya hasil survei berdasarkan administrasi kelurahan. Jika Anda su-
dah melakukan survei di satu kelurahan, maka Anda dapat memasukkan data tersebut ke dalam OSM.
Hal ini dapat menghindari terjadinya penumpukan data survei dan Quality Assurance dapat melakukan
validasi data.
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Tujuan Pembelajaran:

• Mengetahui bagian-bagian yang ada di GPS
• Memahami cara menyalakan GPS
• Memahami cara menggunakan GPS
• Memahami definisi dari rute perjalanan dan titik objek pada GPS
• Memahami cara menyalakan perekaman rute perjalanan pada GPS
• Memahami cara menyimpan titik pada GPS
• Memahami cara menyalin rute perjalanan dan titik ke laptop

Dalam melakukan survei lapangan, dibutuhkan suatu alat navigasi yang memiliki fungsi sebagai
perekam jejak dan titik. Alat yang sering digunakan adalah Global Positioning System atau GPS.
Pada bab ini akan dibahas apa itu GPS, bagaimana cara menggunakan GPS, dan bagaimana hasil
survei dari GPS ini dapat digunakan untuk membuat peta. Pada modul ini akan dijelaskan bagaimana
mengoperasikan Garmin GPSmap 62s/64s, yaitu GPS yang sering digunakan untuk pemetaan. Banyak
model GPS lain yang dapat melakukan hal yang sama. Jika Anda menggunakan GPS dengan model
yang berbeda, Anda tidak perlu khawatir karena pada prinsipnya akan tetap sama. Jika Anda tidak
memiliki GPS, sebagai alternatif dapat menggunakan OSM Tracker yang dapat dipelajari pada modul
Menggunakan Aplikasi OSMTracker.

I. Pengertian dan Bagian-bagian GPS

Global Positioning System atau GPS adalah sebuah alat atau sistem berbasis satelit yang dapat digu-
nakan untuk memberikan informasi kepada penggunanya dimana pengguna berada (secara global) di
permukaan bumi. Pada dasarnya, cara kerja GPS sama seperti ponsel. Bedanya adalah ponsel mener-
ima sinyal radio dari menara telekomunikasi, sedangkan GPS menerima sinyal dari satelit yang berputar
mengelilingi bumi. Dengan menerima sinyal-sinyal dari satelit, sebuah GPS dapat memperhitungkan
letak atau lokasi pada permukaan bumi. GPS merekam lokasi ini dalam bentuk koordinat, dimana ter-
dapat dua deret nomor yang panjang. Deret nomor yang pertama menunjukkan posisi Anda dari Timur
atau Barat, atau biasa disebut sebagai posisi bujur. Deret nomor yang kedua menunjukkan posisi Anda
dari utara atau selatan, atau biasa disebut sebagai posisi lintang. Koordinat bujur dan lintang merupakan
koordinat geografis dan setiap tempat di bumi memiliki koordinat geografis yang berbeda-beda.

“Ilustrasi garis lintang dan garis bujur”

Ilustrasi garis lintang dan garis bujur

Berikut ini adalah bagian-bagian dari GPS Garmin 64s. Jika Anda menggunakan GPS tipe lain tidak
perlu khawatir, karena pada dasarnya semua GPS memiliki prinsip yang sama.
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“Bagian depan pada GPS”

Bagian depan pada GPS

“Bagian belakang pada GPS”

Bagian belakang pada GPS

Berikut ini fungsi dari tombol-tombol yang ada pada GPS:

• Tombol power terletak di sebelah kanan atas. Tekan tombol agak lama, kemudian GPS akan
otomatis nyala.

• Tombol (IN) berfungsi untuk memperbesar tampilan peta pada layar GPS.
• Tombol (OUT) berfungsi untuk memperkecil tampilan peta pada layar GPS.
• Tombol (FIND) berfungsi untuk membuka menu pencarian pada GPS.
• Tombol (PAGE) berfungsi untuk mengakses halaman utama dari GPS.
• Tombol (MARK) berfungsi untuk menyimpan titik lokasi pada saat survei menggunakan GPS.
• Tombol (MENU) berfungsi untuk membuka pilihan menu yang ada di GPS.
• Tombol (QUIT) berfungsi untuk membatalkan pilihan atau kembali ke menu sebelumnya.
• Tombol (ENTER) berfungsi untuk memilih atau ok pada suatu menu yang akan Anda pilih.
• Tombol berfungsi untuk menavigasi pada layar peta yang ditampilkan di GPS. Pada bagian be-

lakang GPS sisi atas, terdapat port USB yang berfungsi untuk menyambungkan ke laptop meng-
gunakan kabel USB. Di bagian bawahnya adalah untuk memasang baterai tipe AA.

II. Menyalakan GPS

Global Positioning System atau GPS adalah sebuah alat yang berbasis satelit sehingga untuk
menyalakan GPS, pastikan Anda berada di tempat yang terbuka dimana Anda dapat melihat langit
dengan jelas. GPS dapat menentukan lokasi Anda dengan cara menerima sinyal dari satelit se-
hingga jika Anda berada di dalam ruangan, maka GPS tidak akan dapat bekerja. Berikut ini adalah
langkah-langkah untuk menyalakan GPS:

• Pada bagian atas sisi kanan GPS Anda, tekan dan tahan tombol Power selama beberapa detik
hingga layar menyala dan memunculkan logo “Garmin”. Proses dengan logo Garmin ini memang
agak lama, tapi Anda tidak perlu khawatir karena GPS sedang memproses waypoints, tracks, dan
routes yang ada di dalam GPS Anda sehingga memerlukan waktu lebih lama.
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“GPS dalam keadaan baru nyala dengan logo Garmin”

GPS dalam keadaan baru nyala dengan logo Garmin

• Setelah GPS nyala, GPS akan otomatis menunjukkan lokasi dimana Anda berada, seperti gambar
di bawah ini.

“GPS menunjukkan lokasi dimana Anda berada”

GPS menunjukkan lokasi dimana Anda berada

III. Menggunakan GPS

GPS memiliki banyak fungsi yang bermanfaat bagi kehidupan sehari-hari, seperti untuk menentukan
arah perjalanan ataupun untuk mengukur jarak, membuat peta, dan dapat dijadikan sebagai referensi
pengukuran suatu wilayah. GPS juga memiliki beberapa pengaturan yang dapat disesuaikan dengan
keinginan, salah satunya adalah mengatur tingkat kecerahan dari layar GPS itu sendiri. Untuk mengatur
tingkat kecerahan, Anda dapat tekan sekali tombol power di sisi kanan atas GPS, kemudian pada layar
GPS akan muncul seperti gambar di bawah ini:
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“Tampilan layar GPS untuk pengaturan tingkat kecerahan layar”

Tampilan layar GPS untuk pengaturan tingkat kecerahan layar

Di layar GPS pada bagian atas dapat dilihat keterangan mengenai hari dan jam Anda menggunakan
GPS saat ini. Selanjutnya di bagian bawahnya terdapat pengaturan Backlight atau tingkat kecerahan
yang dapat anda atur dengan cara menekan tombol power sekali hingga menemukan tingkat kecera-
han yang sesuai dengan keinginan Anda, atau dengan menekan tombol navigasi. Di bagian bawah
Backlight, terdapat status baterai GPS Anda dan juga keterangan sinyal GPS Anda. Anda juga dapat
melihat berapa banyak satelit yang telah ditangkap oleh GPS Anda dengan cara tekan tombol Page →
Satellite. Kemudian layar GPS Anda akan seperti gambar di bawah ini:

“Tampilan layar GPS yang menunjukkan satelit yang sudah ditangkap”

Tampilan layar GPS yang menunjukkan satelit yang sudah ditangkap

Pada layar GPS dapat dilihat bagian Satellite, Anda dapat melihat koordinat dimana Anda berada,
akurasi dari GPS, titik ketinggian, jumlah satelit yang sudah ditangkap GPS, dan sinyal satelitnya. Gam-
bar diatas menunjukkan bahwa GPS Anda sedang mencari sinyal satelit. Ketika sudah terhubung den-
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gan tiga satelit atau lebih, GPS akan mendapatkan lokasi Anda.

Di GPS Anda juga dapat mengetahui arah mata angin dari titik lokasi Anda pada pilihan Compass.
Anda dapat mencobanya dengan cara menekan tombol Page→Compass. Kompas ini bertujuan untuk
menunjukkan arah mata angin pada saat survei.

“Kompas untuk membantu sebagai penunjuk arah pada saat survei”

Kompas untuk membantu sebagai penunjuk arah pada saat survei

Pada GPS Anda juga dapat mengetahui lokasi dimana Anda berada dan melihat tempat-tempat di seki-
tar lokasi Anda. Anda dapat mencobanya dengan cara menekan tombol Page → Map. Pada opsi map
ini, Anda juga dapat melihat track dan waypoint jika Anda sudah mulai merekam track dan waypoint.
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“Tampilan layar GPS pada pilihan menu
Map”

Tampilan layar GPS pada pilihan menu Map

Tampilan layar GPS Anda mungkin tidak akan seperti gambar di atas karena GPS akan menunjukkan
sesuai dengan lokasi Anda saat ini. Jika pada layar GPS Anda lokasinya terlalu besar, maka Anda dapat
memperkecil dengan menekan tombol OUT pada GPS beberapa kali hingga tampilan layarnya sesuai
dengan yang Anda inginkan. Sebaliknya, jika pada layar GPS Anda lokasinya terlalu kecil, maka anda
dapat memperbesarnya dengan menekan tombol IN pada GPS Anda hingga tampilan layarnya sesuai
dengan yang Anda inginkan.

Pada GPS Anda terdapat berbagai macam menu utama lainnya pada tombol MENU. Jika Anda
menekan tombol MENU, maka akan keluar tampilan pilihan menu seperti gambar di bawah ini.
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“Pilihan menu utama pada tombol MENU”

Pilihan menu utama pada tombol MENU

IV. Track danWaypoint

GPS Anda merekam dua jenis informasi yang berguna untuk membuat peta atau menyimpan koordinat
dari sebuah tempat. Pertama, GPS Anda dapat menyimpan jalur yang Anda lewati yang sering disebut
dengan track (trek). Kedua, GPS dapat menyimpan lokasi Anda pada memori GPS yang sering disebut
dengan titik objek (Waypoint).

a. Pengertian Track atau Rute Perjalanan

Track atau rute perjalanan adalah arah atau jalur perjalanan Anda saat mulai direkam dan akan disim-
pan berupa seri lokasi kemana pun Anda bergerak. Sebagai contoh, track akan merekam lokasi Anda
setiap satu detik, atau setiap satu meter, dan hasilnya akan berupa sebuah seri dari titik-titik yang me-
nunjukan jalur lokasi dimana Anda pernah berada. Track sangat berguna untuk memetakan objek yang
ditunjukkan oleh garis atau bentuk, seperti sebuah jalan, atau bentuk dari sebuah lapangan.

b. PengertianWaypoint atau Titik Objek

Waypoint atau titik objek adalah titik acuan atau kumpulan koordinat yang digunakan untuk keperluan
navigasi atau untuk mengidentifikasi sebuah titik di peta. GPS dapat menyimpan lokasi Anda pada
memori GPS. Ketika Anda menyimpan sebuah lokasi, koordinat akan disimpan dengan sebuah nama.
Sebagai contoh, titik pertama yang tersimpan oleh Anda akan diberi nama 001, kedua 002, dan seterus-
nya. Untuk lebih jelasnya, akan dibahas pada sub-bab VI. Menyimpan Titik.

V. Menyalakan Mode Perekaman Track atau Rute Perjalanan

Berikut ini adalah langkah-langkah dalam mengaktifkan perekaman track:

• Pergi ke Main Menu, pilih Setup.
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“Tampilan Main Menu Setup”

Tampilan Main Menu, Setup

• Pilih Tracks.

“Tampilan ikon Tracks”

Tampilan ikon Tracks

• Pada Track Log, ubah menjadi: Record, Show on Map.
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“Tampilan Track Log”

Tampilan Track Log

• Pastikan perekaman rute atau track pada GPS Anda dalam keadaan aktif sebelum Anda
melakukan survei.

• Jika sudah selesai survei dan inginmenonaktifkan perekam rute atau Track, lakukan cara seperti
tadi kemudian pilih Do Not Record.

Track disimpan setelah survei lapangan selesai dilakukan. Umumnya track disimpan perhari. Cara
untuk menyimpan Track yang sudah direkam adalah sebagai berikut:

• Pergi ke Main Menu, pilih Track Manager.

“Tampilan Main Menu Track Manager”

Tampilan Main Menu, Track Manager
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• Pilih Current Track, yaitu perekaman rute yang baru saja dilakukan.

“Tampilan Curent Track”

Tampilan Curent Track

• Pilih Save Track, untuk menyimpan rute perjalanan atau track.
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“Tampilan Save Track”

Tampilan Save Track

• Masukkan nama track, umumnya dalam bentuk Tanggal dan waktu survei kemudian pilih Done.
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“Tampilan Enter Name pada GPS”

Tampilan Enter Name pada GPS

• Bersihkan perekam track dari perekaman sebelumnya, pilih Yes.
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“Tampilan menghapus track sebelumnya”

Tampilan menghapus track sebelumnya

• Perhatikan akan muncul nama track yang Anda simpan. Ini membuktikan bahwa track survei Anda
sudah berhasil tersimpan.
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“Tampilan track yang telah berhasil
disimpan”

Tampilan track yang telah berhasil disimpan

VI. Menyimpan Titik

Langkah-langkah untuk menyimpan waypoint (titik lokasi) adalah sebagai berikut:
* Tekan tombol Mark pada GPS dan akan muncul tampilan sebagai berikut:
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“Menyimpan titik pada GPS”

Menyimpan titik pada GPS

• Pilih Done untuk menyimpan Waypoint.

Untuk melihat daftar waypoint yang sudah Anda simpan, silakan Anda pergi ke Main Menu dan pilih
Waypoint Manager. Kemudian akan muncul daftar waypoint yang sudah Anda simpan.

“Tampilan daftar waypoint yang tersimpan pada GPS”

Tampilan daftar waypoint yang tersimpan pada GPS

Untuk menghapus satu Waypoint yang sudah Anda simpan, tekan Enter pada salah satu titik Waypoint
yang akan dihapus, kemudian tekan tombol Menu dan pilih Delete.

VII. Menyalin Track danWaypoint ke Laptop

Selanjutnya data yang sudah dikumpulkan dengan GPS akan di-copy atau salin ke komputer untuk
digunakan sebagai acuan pemetaan. Langkah-langkahnya adalah sebagai berikut:

• Sambungkan GPS ke komputer dengan menggunakan kabel data.
• Pastikan GPS dalam keadaan menyala.

“Menyambungkan GPS dengan kabel ke Laptop”

Menyambungkan GPS dengan kabel ke Laptop

• Pergi ke direktori Garmin GPSMAP kemudian pilih folder Garmin → GPX
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“Tampilan pada komputer setelah disambungkan dengan GPS”

Tampilan pada komputer setelah disambungkan dengan GPS

• Pilih data dengan keterangan tanggal Anda survei (Track & Waypoint) dan salin data tersebut ke
komputer Anda.

“Tampilan setelah data di GPS dipin-
dahkan ke komputer”

Tampilan setelah data di GPS dipindahkan ke komputer

RINGKASAN

Selamat! Anda sekarang telah mendapatkan pemahaman bagaimana menggunakan GPS. Jika belum,
cobalah untuk melatih menyimpan titik dari beberapa lokasi yang menurut Anda penting. Pada modul
ini Anda telah mempelajari bagaimana mengumpulkan waypoint dan track dan membukanya di JOSM.
Nantinya, Anda akan menggunakan informasi ini untuk menambahkan objek baru ke OpenStreetMap.
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Meletakkan Formulir Survei ke Ona.io

Tujuan Pembelajaran:

• Mampu menjelaskan manfaat penggunaan Ona.io
• Menjelaskan cara mengunggah formulir survei ke server Ona.io

Setelah kita berhasil membuat formulir survei yang telah dipelajari pada modul Membuat Form Survey
untuk Aplikasi ODK Collect & OpenMapKit, Anda akan mempelajari platform yang digunakan untuk
mengunggah formulir survei ke salah satu platform. Platform yang digunakan pada materi ini adalah
Ona.io. Ona.io merupakan salah satu platform yang dapat digunakan untuk meletakkan formulir survei
yang akan digunakan untuk kegiatan survei lapangan menggunakan ODK Collect atau OpenMapKit.
Disini Anda akan mempelajari apa saja yang bisa dilakukan menggunakan Ona.io dan bagaimana cara
mengunggah formulir survei kedalam Ona.io.

I. Pengenalan Ona.io

a. Apa itu Ona.io

Ona.io adalah suatu perusahaan sosial yang membangun data infrastruktur untuk keperluan pengumpu-
lan data di lapangan. Mereka menyediakan beberapa platform yang dapat digunakan untuk membantu
pengumpulan data, salah satunya adalah platform penyimpanan data lapangan. Anda dapat mengung-
gah formulir survei Anda ke server yang disediakan oleh Ona.io dan kemudian Anda gunakan untuk
kegiatan lapangan Anda. Platform Ona.io menyediakan beberapa kemampuan yang akan membantu
kegiatan pengumpulan data. Salah satunya adalah:

• Statistik jumlah data yang masuk dalam bentuk grafik maupun tabel
• Peta lokasi sebaran data hasil pengumpulan di lapangan
• Tampilan foto yang berhasil dikumpulkan selama pengumpulan data
• Kemampuan mengunduh data dalam beberapa jenis file seperti csv, xls, kml, osm atau json

b. Batasan dalam Ona.io

Apabila Anda ingin menggunakan platform Ona.io Anda dapat membuat akun secara gratis dan ke-
mudian menggunakan platform tersebut untuk mengunggah formulir survei. Namun terdapat beberapa
batasan dalam menggunakan akun gratis diOna.io: * Hanya dapat membuat satu proyek pribadi * Untuk
proyek pribadi hanya dapat menampung 500 data masuk * Dalam satu proyek pribadi dapat menampung
sebanyak 10 jenis formulir survei

II. Manajemen Formulir Survei pada Ona.io

Setelah Anda mengetahui apa itu platform Ona.io dan batasannya, pada modul ini sekarang Anda akan
mencoba untuk memasukkan formulir survei yang sudah Anda buat sebelumnya pada modul Membuat
Formulir Survei untuk Aplikasi ODK Collect dan OpenMapKit. Apabila Anda belum membuat formulir
survei, Anda bisa mengunduh contoh formulir survey dengan mengakses link: http://bit.ly/sample_form_
survey.

a. Membuat akun di Ona.io

Sebelum Anda meng-upload formulir survei Anda, Anda harus memiliki akun di Ona.io terlebih dahulu.
Untuk membuat akun diOna.io klik pada tombolGet Free Account dan kemudian masukkan nama Anda
(huruf kecil) yang akan menjadi url tempat Anda menyimpan formulir dan nantinya akan digunakan di
dalam aplikasi ODK Collect.
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Tampilan membuat akun di Ona.io

b. Meng-upload Formulir Survei

Saat pertama kali Anda berhasil membuat akun pada Ona.io, Anda akan secara otomatis membuat
proyek pribadi dengan nama Anda sendiri.
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Proyek pribadi dengan nama akun Anda sendiri

Untuk meng-upload formulir Anda, klik pada nama proyek Anda sendiri. Setelah berhasil masuk ke
dalam proyek Anda. Klik pada bagian Add a form dan sebuah jendela baru akan muncul. Disini Anda
diminta untuk memasukkan file XLSForm. Pilih file formulir survei Anda. Setelah Anda berhasil memilih
file formulir survei Anda, klik pada bagianUpload Selected File. Sistem akan mengecek apakah formulir
Anda terdapat kesalahan dalam pembuatan ataupun tidak.

Tampilan jendela saat meng-upload formulir survei

Jika sudah berhasil mengunggah formulir survei, akan muncul keterangan Form Verified! Dan klik pada
tombol Save form untuk langsung menyimpan formulir surveinya.

Pilih Save Form untuk menyimpan formulir yang sudah terverifikasi
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c. Mengganti formulir survei

Apabila Anda melakukan perubahan di dalam formulir survei yang telah berhasil diunggah ke dalam
proyek Anda, Anda bisa memperbarui formulir survei tersebut. Namun yang perlu diingat adalah ketika
Anda memperbarui formulir survei Anda, apabila formulir tersebut sudah diisi oleh beberapa data,
maka ada potensi data yang sudah dimasukkan akan terhapus. Oleh karena itu, sebelum Anda
mengganti formulir survei, disarankan untuk mengunduh data Anda terlebih dahulu untuk berjaga-jaga
apabila terjadi kesalahan.

Untuk mengganti formulir survei Anda, klik pada tanda panah kebawah yang terletak di bagian paling
kanan dari formulir survei Anda. Kemudian pilih Replace Form.

Klik pada bagian kanan formulir survei Anda untuk memunculkan menu Replace Form

Apabila formulir survei Anda telah berisikan beberapa isian. Akan muncul peringatan dari Ona.io.
Peringatan tersebut muncul agar pengguna paham bahwa ketika mengganti formulir survei, terutama
mengganti variabel, Ona.io akan menggunakan variabel yang terdapat pada formulir survei yang baru.

Peringatan Ketika akan Mengganti Formulir Survei

Setelah Anda mengklik tombol I Understand, Anda akan diarahkan ke jendela untuk mengunggah for-
mulir survei. Pilih formulir survei baru Anda dan klik Upload Selected file. Setelah formulir berhasil
tervalidasi, klik pada bagian tombol Save form.
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d. Menghapus/Menonaktifkan Formulir Survei

Apabila Anda memiliki formulir survei yang ingin Anda hapus/dinon-aktifkan. Anda bisa melakukannya
dengan cara memilih tanda panah ↓ yang terletak pada bagian sebelah kanan formulir survei Anda dan
kemudian pilih Delete Form untuk menghapus atau Make inactive untuk menonaktifkan formulir Anda.

Tampilan untuk menghapus atau menonaktifkan formulir survei

Catatan: Apabila Anda memilih untuk Delete Form. Anda akan diminta untuk menulis ulang
kembali nama formulir survei Anda sebelum Anda bisa menghapus formulir survei Anda.
Dengan memilih Make inactive, maka formulir survei Anda tidak akan nampak pada aplikasi
ODK Collect pada saat tahapan mengambil formulir survei kosong.

e. Men-download XLSForm

Anda bisa men-download format XLSForm dari formulir survei yang telah Anda buat dengan mengklik
tanda panah ↓ pada bagian kanan dari formulir survei Anda dan kemudian pilih Download XLSForm.

f. Men-download Data Hasil Survei

Untuk men-download data hasil survei. Anda terlebih dahulu harus memilih formulir survei Anda. Sete-
lah Anda berhasil memilih formulir survei, Anda akan diarahkan pada halaman manajemen formulir
survei.
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Tampilan untuk mengunduh data hasil survei

Klik pada bagian tombol Prepare Data Export untuk memulai mengunduh data formulir survei Anda.
Setelah itu Anda akan diarahkan untuk memilih tipe file yang akan Anda unduh.

Pilihan jenis file yang dapat Anda unduh

Apabila formulir survei Anda tidak menggunakan foto, Anda bisa memilih langsung tipe file CSV. Namun
jika formulir survei Anda menggunakan foto, Anda bisa memilih Zip folder of media attachment. Lama
tidaknya proses download data survei tergantung dari berapa banyak data yang Anda hasilkan pada
kegiatan pengumpulan data.

Data hasil survei dari Ona.io ini nantinya dapat Anda gunakan untuk berbagai macam keperluan
pemetaan seperti misalnya data dengan format KML dapat Anda buka dengan aplikasi Google Earth,
data dengan format OSM dapat Anda buka dengan aplikasi JOSM, dan data dalam format CSV dapat
Anda buka dengan aplikasi Spreadsheet atau QGIS.

RINGKASAN

Selamat! Saat ini Anda telah memahami bagaimana mengunggah file formulir survei ke dalam salah
satu platform yang bisa digunakan untuk menyimpan formulir survei secara online. Ada beberapa pili-
han yang dapat Anda gunakan selain Ona.io untuk meng-upload formulir survei. Ona.io dapat menjadi
salah satu pilihan karena penggunaannya yang sangat mudah dan gratis berdasarkan syarat yang telah
dijelaskan sebelumnya.
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 — title: Menggunakan To-Do List di JOSM weight: 6 —

Tujuan Pembelajaran:

• Mampu melakukan instalasi alat tambahan untuk memasukkan data di JOSM
• Mampu mengoperasikan alat tambahan to-do list di JOSM untuk memasukkan data

Setelah melakukan kegiatan survei dengan menggunakan aplikasi OpenMapKit (OMK), langkah selan-
jutnya yang perlu Anda lakukan ialah memasukkan data survei berupa objek-objek titik lokasi tersebut
ke dalam OpenStreetMap dengan menggunakan JOSM. Untuk memudahkan Anda dalam melakukan
hal tersebut, Anda perlu menginstal perangkat tambahan pada JOSM yaitu plugin Todo list. Plugin Todo
list merupakan perangkat tambahan yang dapat membantu Anda untuk menemukan objek hasil survei
yang akan Anda upload pada peta OpenStreetMap (OSM).

I. Menginstal to-do list plugin di JOSM

Karena plugin Todo list merupakan perangkat tambahan pada JOSM, Anda perlu melakukan instalasi
plugin JOSM terlebih dahulu sebelum menggunakannya. Langkah-langkah untuk menginstal plugin
todo list di JOSM adalah sebagai berikut:

• Klik menu bar Edit → Preferences
• Akan muncul jendela Preferences dan pilih menu Plugins untuk menginstal plugins baru. Jika

daftar plugins belum muncul, Anda dapat mengklik Download list dan pastikan internet Anda
telah terkoneksi untuk men-download plugins.

Tampilan kotak jendela Preferences untuk menu pilihan Plugins

• Untuk mencari plugin todo list Anda dapat menggunakan kotak pencarian Search. Lalu ketikkan
todo pada kolom pencarian tersebut untuk menemukan plugin todo list. Setelah pencarian
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berhasil, Anda perlu mencentang kotak plugin todo untuk men-download plugin tersebut dan klik
OK lalu tunggu sampai proses men-download selesai.

Tampilan hasil pencarian plugin todo

• Kotak jendela plugin todo akan muncul di sebelah kanan kanvas peta dan apabila kotak todo
tersebut belum muncul, Anda dapat mengaktifkan panel plugin todo dengan cara klik pada bar
menu Windows, kemudian klik menu todo Anda akan melihat panel Todo list di sebelah kanan
JOSM Anda.
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Tampilan jendela plugin todo list yang telah terinstal

II. Menggunakan to-do list

Langkah-langkah penggunaan plugin to-do list adalah sebagai berikut:

• Anda perlu memasukkan terlebih dahulu semua file dengan format .osm yang akan dimasukkan
kedalamOpenStreetMap (OSM). File .osm ini berisi objek titik hasil survei yang telah diekspor dari
OpenMapKit (OMK) dengan cara klik File → Open pada menu bar.

• Dikarenakan satu file berisi satu titik objek, Anda perlu menggabungkan layer-layer tersebut hingga
menjadi satu layer. Cara menggabungkan ialah pada panel Layers pilih semua layer yang akan
digabungkan lalu klik kanan dan pilih Merge. Anda dapat memilih beberapa layer sekaligus den-
gan cara klik pada salah satu layer lalu tahan untuk untuk memilih semua layer pada panel atau
klik layer satu persatu dengan menekan tombol Ctrl pada keyboard Anda.

Menggabungkan beberapa layer yang berbeda menjadi satu layer

• Setelah semua objek titik telah tergabung menjadi satu layer, Anda perlu memilih salah satu objek
yang ingin Anda kerjakan. Setelah itu, Anda dapat memasukkan titik-titik objek tersebut ke dalam
daftar to-do list dengan cara klik Add pada panel Todo list.
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Memasukkan daftar objek ke dalam panel Todo list

• Untuk memperbesar tampilan ke salah satu objek yang ingin Anda kerjakan, Anda dapat menggu-
nakan pilihan Zoom pada panel Todo list atau klik dua kali pada objek di dalam daftar.

Memperbesar ke objek pada daftar Todo list

• Setelah Anda menemukan objek yang ingin dikerjakan dan telah melakukan perubahan yang diper-
lukan, Anda dapat menandai objek tersebut pada daftar todo untuk menghilangkan nama objek
dari daftar dengan cara mengklikMark pada panel Todo list. Anda juga menandai dengan memilih
objek langsung pada peta dengan cara pilih dan klik objek pada peta lalu klik Mark selected. Un-
tuk memahami langkah pada proses penambahan data OSM, Anda dapat mempelajari modul
Menambahkan Data OSM Menggunakan JOSM.
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Menandai objek dengan opsi Mark

• Apabila Anda ingin melewati satu objek tetapi masih ingin meninggalkan objek tersebut di dalam
daftar untuk dikerjakan kemudian, Anda dapat mengklik Pass.

Melewati objek dengan pilihan Pass

• Untuk menandai langsung semua objek di daftar Anda bisa menggunakan pilihanMark All dengan
cara klik kanan pada panel Todo list. Lalu apabila Anda ingin memunculkan kembali semua objek
yang telah ditandai seperti semula, Anda dapat menggunakan pilihan Unmark all. Anda juga
dapat menghapus seluruh daftar nama objek pada panel Todo list dengan cara klik kanan pada
panel dan klik Clear the todo list.
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Beberapa pilihan pada panel Todo list

RINGKASAN

Jika Anda dapat mengikuti dan memperhatikan seluruh tahapan dalam bab ini, maka Anda telah berhasil
memasang perangkat tambahan di JOSM. Selain itu, Anda juga telah berhasil mempelajari dan mem-
praktikkan bagaimana cara mengoperasikan plugin Todo list di JOSM untuk memudahkan pekerjaan
Anda nantinya.
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 — title: Pembuatan Peta Survei dengan Menggunakan QGIS weight: 7 —

Tujuan Pembelajaran:

• Memahami cara instalasi QGIS pada komputer/laptop
• Memahami cara mengoperasikan QGIS untuk memasang plugin
• Memahami cara mengoperasikan QGIS untuk membuat peta survei

Peta survei digunakan untuk memudahkan data entry dalam pengenalan dan identifikasi lokasi saat
survei lapangan. Jika Anda ingin melakukan pemetaan batas administrasi, peta survei ini dapat juga
digunakan untuk menggambarkan batas administrasi terbaru yang dihasilkan dari diskusi dengan pihak
kelurahan atau pemerintahan yang mengetahui batas wilayah tersebut. Pembuatan peta akan dilakukan
dengan menggunakan QGIS desktop versi 2.14.22. QGIS merupakan desktop yang gratis dan terbuka,
dimana semua orang dapat men-download secara gratis melalui situs https://qgis.org/.

I. Download dan Instal QGIS

• Jika Anda belum memiliki QGIS, maka Anda dapat men-download instalasi melalui web browser
seperti Firefox atau Chrome.

• Pada kolom halaman di atas jendela browser, masukan tautan berikut http://qgis.org/
• Tampilan utama QGIS akan tampak seperti gambar di bawah ini:

Tampilan Halaman Situs QGIS

• Klik Download Now → All Releases → klik here pada Older releases of QGIS are available
untuk mencari QGIS versi 2.14 atau Anda dapat klik tautan berikut : http://download.osgeo.org/
qgis/win64/QGIS-OSGeo4W-2.14.22-1-Setup-x86.exeuntuk Windows 32 bit dan http://download.
osgeo.org/qgis/win64/QGIS-OSGeo4W-2.14.22-1-Setup-x86_64.exe untuk Windows 64 bit.

Pencarian Versi QGIS
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• Jika Anda tidak menggunakan Windows, pilih sistem operasi yang Anda butuhkan pada indeks
QGIS.

Pemilihan sistem operasi laptop

• Ketika file instalasi telah selesai di download, jalankan dan ikuti instruksinya untuk menginstal
QGIS.

II. Instalasi Plugin QuickMapServices pada QGIS

Dalam pembuatan peta survei, Anda memerlukan plugin yang akan membantu dalam menampilkan
latar belakang peta untuk mengidentifikasi objek yang ada di lapangan. Plugin yang digunakan yaitu
QuickMapServices, Anda dapat men-download secara gratis melalui QGIS desktop dan memerlukan
jaringan internet untuk men-download. Langkah-langkah dalam menginstal plugin, yaitu:

• Buka QGIS dan pastikan laptop Anda sudah terhubung dengan koneksi internet. Klik Menu Plu-
gins → Manage and Install Plugins

Menu Plugin

• Pada kolom Search ketikkan QuickMapServices kemudian Install Plugin
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Proses Instalasi Plugin

• Jika proses instalasi plugin sudah selesai, mari lanjutkan dengan proses pembuatan peta cetak.

III. Persiapan Data

Dalam mempersiapkan data untuk pembuatan peta survei, data spasial yang diperlukan, yaitu batas
administrasi. Jika Anda memiliki peta jaringan jalan yang dilengkapi dengan nama jalan dapat juga
dipersiapkan dalam pembuatan peta untuk membantu dalam identifikasi lokasi di lapangan.

Langkah - langkah dalam mempersiapkan data, yaitu :

• Masukkan batas administrasi dalam ke dalam QGIS dengan klik Add Vector Layer

• Anda dapat melakukan simbologi dan labelling pada layer tersebut.
• Untuk melakukan simbologi, Anda dapat klik kanan pada layer batas administrasi → Proper-
ties → Style → Categorized. Arahkan kursor ke Column → pilih nama kolom yang berisi nama
kelurahan → Classify. Jika ingin mengubah simbologi, pilih Symbol → Change.
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Pengaturan simbologi

• Untuk pemberian label, klik kanan pada layer batas administrasi → Properties → Labels → Show
labels for this layer→ pada kolom label with pilih kolom yang berisi nama kelurahan. Anda dapat
mengatur format huruf di dalam menu Text, mengatur penegasan huruf di dalam menu Buffer,
mengatur penempatan huruf di dalam Menu Placement.
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Pemberian Label

• Jika sudah selesai, maka hasilnya seperti gambar di bawah ini

Hasil peta lengkap dengan label

• Untuk menampilkan latar belakang citra satelit secara online, klik Menu Web → QuickMapSer-
vices → Search QMS. Plugin akan tampil pada panel di sebelah kanan, Anda dapat mengetikkan
nama citra satelit yang tersedia, misalnya DigitalGlobe Imagery.
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Pemilihan citra satelit

• Pada kotak dialog akan tampak beberapa citra yang sesuai dengan nama tersebut, klik Digital-
Globe Premium Imagery. Tunggu beberapa saat sampai citra tersebut tampak padamap canvas
Anda.

Tampilan peta dengan citra satelit

• Simpan proyek peta Anda dengan klik Menu Project → Save → Beri nama proyek → Save.
Pemberian nama proyek QGIS, misalnya Peta Survei.
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Tampilan Menu Project

IV. Membuat Layout dengan Map Composer

• Untuk memulai pembuatan layout peta, pertama-tama buat composer baru di peta dengan klik
Menu Project → New Print Composer. Kemudian akan muncul jendela composer kosong.

Map Layout dengan Composer di QGIS

• Pada empty composer, pertama-tama lakukan pengaturan yang terkait dengan kertas yang akan
digunakan seperti ukuran kertas, orientasi, margin dan resolusi ekspor. Pengaturan dapat di-
lakukan di bagian Composition pada panel sebelah kanan dari composer.
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Menu composition

• Tambahkan garis tepi untuk layout berupa persegi dengan tools Add shape, lalu klik, tahan dan
geser untuk membuat bentuk persegi padamap layout. Anda bisa mengubah ketebalan dan warna
garis pada Item Properties → Style → Change.

339



Pengaturan simbologi pada garis batas persegi

• Tambahkan konten peta ke dalam composer melalui toolsAdd newmap, lalu klik, tahan dan geser
untuk menambahkan peta baru. Pengaturan terkait peta yang baru ditambahkan terletak pada
bagian Item Properties di sebelah kanan. Posisi dan skala konten peta dapat digeser dengan
Move Item Content. Pindahkan isi peta untuk mengatur posisi dan gunakan scroll untuk mengatur
skala. Skala juga dapat diubah melalui Item Properties.
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Pengaturan skala peta

• Tambahkan grid peta melalui Item Properties → Grids → klik tanda + → Draw Grid. Lakukan
pengaturan terhadap grid seperti tipe grid dan interval. Interval grid akan mengacu pada satuan
koordinat peta. Beri tanda centang pada Draw coordinate untuk menambahkan koordinat peta di
setiap garis grid.

Pengaturan grid dan koordinat peta

• Tambahkan judul peta dengan klik tools Add new label lalu klik mouse, tahan dan geser untuk
menambahkan label pada composer. Satu objek label hanya dapat menggunakan satu format
penulisan. Buat beberapa label jika menginginkan variasi format penulisan. Anda dapat klik Font
untuk mengubah format penulisan, klik Horizontal alignment → Center untuk membuat tulisan
berada di posisi tengah, dan klik Vertical alignment → Middle untuk membuat tulisan berada di
posisi tengah secara tegak lurus.
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Pengaturan font pada judul peta

• Tambahkan arah mata angin melalui tools Add Image → Item Properties → Search Directo-
ries. Kemudian buat kotak batasan yang menentukan lokasi dan ukuran gambar tersebut akan
ditampilkan pada peta, lalu pilih gambar arah mata angin yang ingin ditambahkan ke dalam peta.

Simbol arah mata angin

• Tambahkan skala peta melalui tools Add new scalebar. Untuk membuat skala angka, ubah Style
pada Main Properties menjadi numeric. Jika Anda ingin menambahkan lebih dari satu tampilan
skala, dapat ditambahkan kembali dengan klik tools yang sama. Anda dapat melakukan pengatu-
ran segments untuk mengatur jumlah baris pada skala baris.
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Pengaturan skala peta

• Tambahkan sumber data dengan tools Add new label Informasi sumber data dapat diisikan
dengan “DigitalGlobe Premium Imagery (www.digitalglobe.com) © Digital Globe” sebagai lisensi
karena sudah menggunakannya sebagai latar belakang peta.

Lisensi citra satelit Digital Globe

• Jika peta survei sudah selesai, maka Anda dapat mengekspor peta tersebut. Klik Export as Image
untuk mengekspor peta ke dalam format jpg, png, pdf, dan svg. Anda dapat memilih pengaturan
resolusi gambar dengan menambahkan angka pada Export resolutions agar hasil cetak semakin
bagus, pengaturan awal untuk resolusi gambar di QGIS yaitu 300 dpi. Hasil peta dengan resolusi
gambar 300 dpi sudah menghasilkan kualitas gambar/peta yang cukup bagus. Kemudian peta
diekspor dalam bentuk gambar untuk memudahkan dalam pencetakan.
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Pengaturan resolusi peta

• Setelah proses ekspor peta selesai, hasilnya akan menjadi seperti di bawah ini

Hasil peta survei

RINGKASAN

Jika Anda dapat mengikuti dan memperhatikan seluruh tahapan dalam bab ini, Anda sudah dapat mem-
buat peta survei sederhana yang dapat dicetak sesuai dengan ukuran kertas pada peta dengan menggu-
nakan QGIS. Kemudian peta tersebut dapat dibagikan dan dibawa oleh data entry/surveyor ke lapangan.
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Menggunakan Alat Filter di JOSM

Tujuan Pembelajaran:

• Melakukan aktivasi mode penyaring data di JOSM
• Mengoperasikan alat untuk menyaring data di JOSM

JOSM memiliki berbagai macam alat yang dapat memudahkan penggunanya untuk melakukan
pemetaan. Salah satu alat yang dapat digunakan adalah filter. Filter merupakan sebuah alat tambahan
untuk memilih salah satu objek berdasarkan informasi (tag) objek di OpenStreetMap (key dan value),
sehingga Anda dapat mengedit dan memeriksa data OSM berdasarkan informasi tertentu dari suatu
objek. Filter juga memudahkan Anda untuk menampilkan dan melihat data berdasarkan informasi
tertentu yang ingin Anda lihat. Hal ini sangat membantu ketika Anda ingin memeriksa data yang sangat
banyak dan kompleks.

I. Mengaktifkan Jendela Filter di JOSM

• Untuk dapat mengaktifkan jendela filter, silakan Anda pilih menu Window kemudian pilih Filter

Mengaktifkan jendela filter pada JOSM

• Jendela filter akan ditampilkan di sebelah kanan layar Anda.

Jendela filter pada JOSM

II. Menggunakan Alat Filter di JOSM

Contoh data OpenStreetMap di Daerah Cengklik

Bayangkan jika Anda mempunyai data seperti gambar di atas. Seringkali tampilan data seperti gambar
di atas tersebut terlihat membingungkan karena banyaknya data yang ditampilkan. Untuk itu Anda dapat
menggunakan filter untuk menyederhanakan tampilan data tersebut dengan menampilkan objek-objek
yang hanya ingin Anda lihat. Sebagai contoh, kita akan melakukan filter untuk objek jalan. Langkah-
langkah yang perlu Anda lakukan adalah sebagai berikut:

• Pada jendela filter, pilih menu Add.

Tombol Add di jendela filter
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Figure 46: jendela_filter
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Figure 47: jendela_filter_josm
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Figure 48: tombol_add

• Pada bagian Filter string, silakan Anda masukkan informasi key dan value yang ingin Anda fil-
ter. Pada kasus ini, silakan Anda tulis _highway=*_ (untuk memilih semua objek jalan yang ada).
Kemudian pilih Submit filter.

Figure 49: tampilan_filter

Tampilan filter

• Pada jendela filter Anda akan melihat tiga buah kotak yang dapat anda checklist.

Hasil filter

1. Jika Anda aktifkan kotak di angka 1, maka objek jalan akan disembunyikan namun terlihat pada
layer peta dengan warna hitam pekat

Hasil filter 1
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Figure 50: hasil_filter

Figure 51: hasil_filter_1
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2. Jika Anda aktifkan kotak di angka 1 dan 2, maka objek jalan akan disembunyikan sepenuhnya dan
tidak terlihat sama sekali di layer peta

Figure 52: hasil_filter_2

Hasil filter 2

3. Jika Anda aktifkan kotak di angka 1, 2 dan 3, maka layer peta hanya akan menampilkan objek
jalan di JOSM

Figure 53: hasil_filter_3

Hasil filter 3

Perlu diingat bahwa ketika Anda menggunakan fungsi filter pada JOSM, hasil filter tersebut akan secara
otomatis selalu muncul meskipun Anda sudah menutup software JOSM ataupun berpindah lokasi pada
saat melakukan pemetaan. Hal ini dapat menimbulkan masalah karena jika Anda memetakan daerah
lain dengan fungsi filter yang sama, objek jalan yang ada di daerah tersebut menjadi tidak terlihat dan
bisa saja Anda petakan lagi, padahal jalan tersebut sudah dipetakan sebelumnya. Oleh karena itu,
pastikan Anda menonaktifkan hasil filter terlebih dahulu setelah selesai menggunakan fungsi tersebut.
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Untuk melihat apakah fungsi filter masih aktif pada JOSM, Anda dapat melihat melihatnya pada bagian
kanan atas bidang peta di JOSM. Jika tulisan Filter active masih muncul maka hal itu menandakan
bahwa fungsi filter masih aktif.

Filter active yang menandakan fungsi filter masih aktif pada JOSM

Untuk menghapus filter yang masih aktif, silakan pilih hasil filter yang ingin Anda hapus di jendela filter,
setelah itu pilih tombol Delete.

Pilih tombol Delete untuk menghapus hasil filter

Setelah Anda berhasil menghapus hasil filter tersebut, maka tampilan data OpenStreetMap Anda akan
kembali seperti semula.

351



Tampilan Data OpenStreetMap setelah fungsi filter dihapus

Catatan : Saat Anda menggunakan fungsi filter pada JOSM, hasil filter tersebut akan se-
lalu muncul pada saat Anda membuka JOSM. Pastikan Anda selalu menghapus fungsi filter
setelah Anda menggunakannya!

RINGKASAN

Jika Anda telah berhasil mengikuti semua langkah-langkah yang ada, pada akhir modul ini Anda telah
berhasil mengetahui apa itu mode filter atau mode penyaringan data di JOSM. Anda juga telah mampu
mengoperasikan mode filter di JOSM untuk memilih data mana saja yang ingin Anda lihat. Silakan Anda
gunakan filter untuk membantu proses pemetaan Anda supaya menjadi lebih mudah.
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 — title: Pembuatan MBTiles untuk OpenMapKit (OMK) weight: 8 —

Tujuan Pembelajaran:

• Memahami konsep MBTiles
• Mengoperasikan cara membuat MBTiles dengan menggunakan Export Tool
• Mengoperasikan cara membuat MBTiles dengan menggunakan Plugin QTiles
• Memahami cara memindahkan file MBTiles ke dalam OMK pada smartphone

Pada saat Anda menggunakan aplikasi OpenMapKit (OMK) untuk melakukan survei lapangan,
terkadang Anda akan mengalami kesulitan dalam menentukan objek di aplikasi tersebut. Hal ini
dikarenakan, latar belakang peta yang digunakan belum dipetakan di dalam OpenStreetMap dan Anda
tidak memiliki waktu untuk mendigitasi objek di wilayah survei. Anda dapat menggunakan MBTiles
untuk latar belakang peta yang merupakan citra satelit, sehingga memudahkan Anda dalam melakukan
identifikasi objek di lapangan.

I. Pengertian MBTiles

MBTiles merupakan format data spasial untuk menyimpan beberapa tile peta yang digabung menjadi
satu file dalam bentuk raster, sehingga tampilannya seperti citra satelit. Salah satu penggunaan MBTiles
yaitu dapat digunakan sebagai basemap di dalam aplikasi OMK, yang memudahkan pengguna untuk
menandai sebuah objek di lapangan. Basemap merupakan sebuah peta dasar yang menjadi latar be-
lakang sebuah aplikasi, dapat berupa citra satelit dan peta OSM.

Tampilan MBTiles pada QGIS

II. Membuat MBTiles dengan Export Tool

Export Tool merupakan salah satu situs yang digunakan untuk men-download data OpenStreetMap
secara gratis berdasarkan fitur dan wilayah tertentu. Dimana format data spasial yang sering digunakan,
yaitu: Shapefile (.shp), GeoPackage (.gpkg), dan MBTiles (.mbtiles). Langkah-langkah untuk membuat
MBTiles dengan menggunakan export tools yaitu :

• Buka halaman situs Anda dan ketikkan https://export.hotosm.org/en/v3/, Anda harus login terlebih
dahulu dengan menggunakan akun OpenStreetMap. Jika belum memiliki akun, Anda dapat mem-
buatnya di situs https://www.openstreetmap.org pada modul Memulai Menggunakan OSM.

• Setelah Anda berhasil masuk, klik Start Exporting
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Tampilan Export Tool

• Lengkapi kotak dialog di sebelah kiri sebagai deskripsi proyek dan pilih wilayah yang Anda in-
ginkan. Pemilihan wilayah dapat dilakukan dengan beberapa pilihan dengan tools yang berada di
panel sebelah kanan. Anda tidak disarankan untuk memilih area yang terlalu besar pada penen-
tuan luasan wilayah pembuatan MBTiles, karena akan terjadi kegagalan saat proses berlangsung.
Jika Anda memiliki batas administrasi dalam format .geojson dapat menggunakan pilihan Import.
Hal yang perlu diperhatikan file .geojson harus terdiri dari satu jenis data atribut. Pada modul
ini, fitur yang akan digunakan adalah Import. Pilih Import dan masukkan file .geojson yang Anda
miliki. Jika Anda tidak memiliki file .geojson, maka Anda dapat membuka modul Menggunakan
GeoJSON.

Pengaturan Menu Describe

• Langkah selanjutnya, klik Menu Format → Beri tanda centang pada MBTiles
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Pemilihan format data spasial

• Selanjutnya klik pada bagian Menu Data, Anda harus menyalin alamat URL tilemap dari citra
satelit yang akan digunakan sebagai basemap. Anda mungkin hanya bisa melihat OpenStreetMap
sebagai salah satu opsi untuk membuat MBTiles. Secara pengaturan awal Export Tools hanya
menyediakan OpenStreetMap sebagai latar belakang MBTiles Anda. Namun, Anda bisa dengan
mudah menambahkan tautan citra satelit lain. Untuk menambahkan tautan di bawah, pilih salah
satu citra satelit yang tersedia, salin (copy) tautan di bawah dan letakkan (paste) pada kotak
MBTiles Source yang terdapat di dalam Menu Data.

Mapbox Satellite
http://a.tiles.mapbox.com/v4/openstreetmap.map-inh7ifmo/{z}/{x}/{y}.png?access_token=pk.eyJ1Ijoib3BlbnN0cmVldG1hcCIsImEiOiJncjlmd0t3In0.DmZsIeOW-3x-C5eX-wAqTw

Digital Globe
https://a.tiles.mapbox.com/v4/digitalglobe.316c9a2e/{z}/{x}/{y}.png?access_token=pk.eyJ1IjoiZGlnaXRhbGdsb2JlIiwiYSI6ImNqZGFrZ2c2dzFlMWgyd2x0ZHdmMDB6NzYifQ.9Pl3XOO82ArX94fHV289Pg

• Setelah Anda salin, Anda dapat menggeser ke kiri dan memilih tautan yang baru saja dimasukkan.
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Pengaturan Sumber Tautan Citra Satelit

• Lakukan pengaturan Zoom Range yang digunakan untuk memilih batas level untuk memperbesar
dan memperkecil tampilan MBTiles. Sebagai catatan, jika jarak antar zoom range semakin jauh
maka ukuran file akan semakin besar.

Pengaturan Zoom Level
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Kiri (zoom level 10) dan kanan (zoom level 18)

• Langkah terakhir pilih menu Summary, pada bagian ini akan ditampilkan ringkasan dari proyek
yang telah Anda lakukan. Jika proyek Anda ingin terlihat oleh pengguna lainnya dapat memilih
Publish this Export. Kemudian klik Create Export untuk memproses pembuatan MBTiles.

Menu summary

• Dalam proses pembuatan MBTiles dibutuhkan beberapa menit tergantung dengan jaringan inter-
net, luasan wilayah, dan zoom range yang telah diatur sebelumnya. Anda tidak perlu menunggu,
karena export tool akan memberikan pemberitahuan melalui email saat proses telah selesai. Anda
juga dapat melihat proyek lain yang telah dibuat pada Menu Exports.
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Tampilan Menu Exports

• Setelah proses selesai, status proyek Anda berubah menjadi COMPLETED. Klik nama file yang
ditandai dengan warna biru untuk men-download file mbtiles.

Download File MBTiles

• MBTiles dapat dibuka dengan menggunakan software pemetaan seperti QGIS, sehingga menjadi
tampilan citra satelit dalam bentuk offline. Hal ini dapat digunakan untuk memeriksa file mbtiles
sebelum dimasukkan ke dalam aplikasi OMK, caranya buka QGIS→ Add Raster Layer
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Tampilan MBTiles di dalam QGIS

III. Membuat MBTiles dengan menggunakan Plugin QTiles

PluginQTiles merupakan plugin yang dapat digunakan untuk menghasilkan tile raster dari proyek QGIS.
Plugin ini dapat menyimpan pengaturan perbesaran tampilan tile raster dari layanan tile seperti (Slippy
map, TMS). Anda dapat menggunakan plugin QuickMapServices pada modul sebelumnya Pembuatan
Peta Survei dengan QGIS, untuk menampilkan layanan tile raster. Kelebihan lainnya dengan meng-
gunakan plugin ini, Anda dapat menampilkan layer jalan dan batas administrasi pada proyek QGIS,
sehingga pada tampilan basemap OMK akan membantu data entry dalam pengenalan survei lapangan.
Langkah - langkah yang dilakukan untuk membuat mbtiles dengan plugin QTiles, sebagai berikut:

a. Instal Plugin QTiles

• Buka QGIS dan install plugin dengan klik Menu Plugin → Manage and Install Plugin.Tuliskan
pada kotak pencarian (Search) “qtiles” maka akan tampil di bawah ini, berikan tanda centang dan
klik Install Plugin. Jika download plugin tidak berhasil, maka Anda dapat memeriksa jaringan
internet.

Instal Plugin QTiles

• QTiles akan muncul pada Menu Plugin → QTiles → QTiles
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Plugin QTiles

b. Persiapan Data Layer

• Tambahkan data layer administrasi dan jaringan jalan yang dihasilkan dari pemetaan survei lapang.
KlikAdd Vector Layer→ arahkan ke direktori penyimpanan file→Open→Open. Data layer akan
tampil pada peta kanvas dan panel layer.

Menambahkan layer

• Lakukan simbologi dan pemberian label pada layer tersebut agar memudahkan data entry dalam
pengenalan survei lapangan.
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Simbologi dan pemberian label

• Sekarang Anda dapat menambahkan data layer yang berbentuk tilemap untuk menampilkan citra
satelit pada peta kanvas QGIS, dengan cara klik Menu Web → QuickMapServices → Search
QMS

Plugin QuickMapServices
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• Pada kotak pencarian Search QMS ketikkan DigitalGlobe Premium Imagery, kemudian klik Add

Pemilihan basemap

• Basemap citra satelit akan muncul pada daftar layer dan map canvas

Tampilan citra satelit DigitalGlobe Imagery

c. Penggunaan Plugin QTiles

• Anda dapat mengatur tampilan data layer, misalnya disesuaikan dengan tampilan batas adminis-
trasi, agar mempercepat proses pembuatan mbtiles
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Pengaturan Tampilan Batas Administrasi

• Untuk menampilkan plugin QTiles, klik Menu Plugin → QTiles → QTiles. Kemudian akan tampil
kotak dialog QTiles, klik Browse pada Directory dan buatlah folder baru dan nama file pada lap-
top/komputer Anda. Pada jenis file ganti dengan mbtiles dan simpan.

Pengaturan penyimpanan file pada QTiles

• Anda dapat mengatur perbesaran pada basemap digital globe dengan pengaturan yang terletak
di bawah kotak dialog QTiles. Lakukan pengaturan pada minimum zoom dan maximum zoom,
sebaiknya jarak antara keduanya tidak terlalu jauh, untuk mempercepat proses pembuatan mbtiles.
Klik Run untuk memulai proses pembuatan mbtiles, proses ini akan memerlukan jaringan internet.
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Pengaturan pada QTiles

• Jika proses sudah 100%, maka Anda dapat klik Close. Untuk memeriksa file mbtiles tersebut,
Anda dapat memasukkan file tersebut ke dalam QGIS dengan menggunakan Add Raster Layer
→ arahkan ke direktori penyimpanan → Open.
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Pencarian file mbtiles

• Tampilan mbtiles tersebut akan muncul pada peta kanvas QGIS, seperti gambar di bawah ini

Tampilan hasil mbtiles

IV. Memasukkan MBTiles ke dalam OMK

Pada proses ini, Anda telah memiliki file dalam bentuk format mbtiles yang akan dimasukkan ke dalam
aplikasi OMK pada smartphone android.

• Hubungkan perangkat smartphone dengan komputer untuk memindahkan kedua file tersebut ke
dalam aplikasi OMK dengan kabel data.

• Temukan aplikasi OMK di dalam direktori internal smartphone, arahkan ke dalam folder mbtiles.
Foldermbtiles digunakan untuk menyalin file basemap dalam format .mbtiles yang dihasilkan dari
export tool atau dari plugin QTiles yang terdapat di QGIS.

Direktori OpenMapKit (OMK)
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• Buka aplikasi OpenMapKit pada smartphone Anda, dan aktifkan file .mbtiles yang telah dipin-
dahkan dengan klik Menu Basemap pada aplikasi OpenMapKit. Anda dapat mempelajari modul
Menggunakan Aplikasi OpenMapKit untuk mengetahui bagaimana cara kerja aplikasi tersebut.

File .mbtiles saat di buka di OMK

RINGKASAN

Jika Anda telah menyelesaikan bab ini, Anda dapat membuat semua basemap berdasarkan wilayah
administrasi yang diperlukan untuk aplikasi OMK yang akan digunakan dalam survei lapangan. Harap
mengganti file .mbtiles per hari berdasarkan wilayah survei di dalam smartphone Anda agar tidak mem-
beratkan kinerja smartphone.
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 — title: Menggunakan buildings tools di JOSM weight: 8 —

Tujuan Pembelajaran:

• Mampu menerapkan cara melakukan instalasi alat tambahan untuk membuat objek bangunan
• Mampu menerapkan cara mengoperasikan alat tambahan di JOSM untuk membuat objek bangu-

nan

Jika Anda menambahkan data di JOSM tanpa melakukan survei lapangan, data yang ditambahkan
akan memiliki informasi yang terbatas karena hanya menggunakan citra satelit sebagai acuan pemetaan.
Salah satu objek yang dapat dipetakan menggunakan citra satelit adalah bangunan. Namun, Anda tidak
dapat mengetahui fungsi spesifik bangunan yang dipetakan menggunakan citra satelit kecuali bentuk
bangunannya cukup berbeda misalnya sekolah yang berbentuk seperti huruf L atau huruf U.

Bangunan sekolah berbentuk seperti huruf U

Dengan OSM, Anda dapat memetakan bangunan umum walaupun Anda tidak mengetahui fungsi spe-
sifiknya. Objek bangunan tersebut dapat diberikan preset/tag building=yes untuk menunjukkan bahwa
objek tersebut adalah bangunan. Tetapi jika Anda memetakan banyak bangunan, pasti cukup mere-
potkan juga jika Anda harus menambahkan preset/tag buidling=yes setiap kali Anda menggambarkan
satu bangunan. JOSM memiliki plugin (alat tambahan) yang dapat memudahkan Anda menggambar
objek bangunan. Alat ini memungkinkan bangunan yang Anda digitasi/gambar otomatis memiliki preset
building=yes dan memiliki bentuk bangunan yang relatif lebih rapi. Plugin ini bernama buildings tools.

I. Menginstal buildings tools di plugin JOSM

Untuk dapat menggunakan plugin buildings tools, Anda harus menginstalnya terlebih dahulu. Langkah-
langkah untuk menginstal plugin buildings tools adalah sebagai berikut:

• Buka JOSM Anda
• Klik menu Edit → Preferences
• Akan muncul jendela Preferences dan pilih menu Plugins (ikon steker) untuk menginstal plugin

baru. Jika daftar plugins belum muncul, Anda dapat mengklik Download List dan pastikan kom-
puter Anda terkoneksi dengan internet untuk dapat men-download plugins tersebut.
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Tampilan jendela Preferences untuk menu Plugins

• Pada kotak Search, tuliskan buildings_tools untuk mencari plugin buildings tools. Setelah
berhasil menemukan plugin buildings tools, silakan centang kotak kecil di samping plugin
buildings tools. Setelah itu klik OK dan tunggu hingga proses instalasi selesai.
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Tampilan hasil pencarian plugin buildings_tools

Catatan : Terkadang JOSM meminta Anda untuk melakukan Restart setelah melakukan
instalasi plugin baru untuk mengaplikasikan plugin yang baru saja diinstal. Namun, tidak
semua plugin membutuhkan Restart untuk dapat digunakan setelah instalasi.

• Jika plugin buildings_tools sudah berhasil diinstal, akan muncul tool Draw buildings di sebelah
kiri atas JOSM Anda. Anda dapat menggunakannya untuk menggambar bangunan.
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Ikon Draw buildings sudah muncul menandakan plugin buildings tools sudah berhasil terinstal

II. Menggunakan alat buildings tools

Langkah-langkah menggunakan plugin buildings tools adalah sebagai berikut:

• Seperti yang sudah dibahas pada modul Menambahkan Data OSM Menggunakan JOSM untuk
menambahkan data OSM menggunakan JOSM, Anda harus men-download data OSM yang sudah
ada terlebih dahulu di wilayah pemetaan Anda. Untuk men-download data OSM, klik menu File
→ Download Data.

• Gambar kotak pemetaan Anda dengan cara klik kiri tahan dan geser hingga membentuk kotak
warna merah muda yang meliputi seluruh wilayah pemetaan Anda. Setelah itu klik Download.

• Setelah berhasil men-download data OSM, akan muncul layer baru yang juga akan menjadi layer
dimana Anda dapat menambahkan data OSM. Pastikan Anda hanya menambahkan data pada
kotak yang tidak diarsir karena kotak yang diarsir sudah bukan wilayah yang Anda download.

• Tambahkan citra satelit sebagai acuan untuk memetakan dengan cara klik menu Imagery→ pilih
citra satelit yang akan digunakan, misalnya Digital Globe Premium Imagery.

• Sekarang Anda sudah siap untuk menambahkan data OSM. Untuk memetakan bangunan,
gunakan buildings tools untuk menggambarnya. Klik plugin buildings tools (ikon Draw build-
ings) yang terletak di sebelah kiri atas JOSM atau tekan B pada keyboard Anda. Jika kursor
mouse Anda sudah berubah menjadi tanda plus dengan ikon bangunan, berarti Anda sudah siap
menggambar bangunan menggunakan buildings tools.
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Tampilan kursor saat plugin buildings tools diaktifkan

• Setelah itu, gambar bangunannya sesuai dengan bentuk yang terlihat pada citra satelit. Klik kiri
satu kali pada salah satu titik pojok bangunan. Geser kursor ke titik pojok bangunan di sebelah
titik pojok bangunan yang pertama, kemudian klik kiri satu kali. Terakhir, geser kursor ke titik
pojok bangunan di sebelah titik pojok bangunan kedua lalu klik kiri satu kali pada titik tersebut.
Untuk lebih jelasnya, lihat gambar di bawah ini:

Proses menggambar bangunan menggunakan plugin buildings tools

• Jika daerah yang Anda petakan terdapat bangunan-bangunan yang ukurannya dan bentuknya
hampir sama seperti di kompleks perumahan, Anda dapat mengatur panjang dan lebar bangunan
yang digambar dengan cara klik menu Data → Set Building Size lalu isikan lebar bangunan di
kolom Buildings width/diameter dan isikan panjang bangunan di kolom Length step (masing-
masing dalam satuan meter). Pada jendela Set Building Size, Anda juga dapat mengatur bentuk
default bangunan yang digambar. Ada dua pilihan yaitu Rectangle (persegi empat) atau Circle
(lingkaran), tetapi karena pada umumnya bangunan berbentuk persegi empat pilih Rectangle.
Lalu klik OK.
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Tampilan jendela Set Building Size

• Jika ada bangunan berbentuk kompleks atau tidak kotak seperti huruf L atau huruf U, gambar dua
atau tiga bangunan tumpang tindih terlebih dahulu hingga membentuk L atau U. Pilih kedua atau
ketiga bangunan yang tumpang tindih tersebut, kemudian klik menu Tools → Join Overlapping
Areas atau tekan Shift + J pada keyboard untuk menggabungkan bagian yang tumpang tindih.
Setelah bangunan tergabung, rapikan bangunan dengan cara pilih bangunan tersebut lalu klik
menu Tools → Orthogonalize Shape atau tekan Q pada keyboard.

Proses menggambar bangunan yang berbentuk seperti huruf L

• Setelah objek-objek bangunan terpetakan, jangan lupa upload hasil pemetaan Anda dengan cara
klik menu File → Upload Data. Tuliskan hal yang Anda lakukan pada kolom komentar, misalnya
menambahkan bangunan serta tuliskan sumber pada kolom sumber misalnya nama citra yang
digunakan sebagai acuan dan kemudian klik Upload Changes.

Catatan : Pastikan tidak ada objek yang terpilih saat Anda menggunakan plugin build-
ings_tools agar kursor dapat digerakkan lebih leluasa saat menggambar bangunan
menggunakan plugin buildings_tools.
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RINGKASAN

Jika Anda dapat mengikuti dan memperhatikan seluruh tahapan dalam bab ini, maka Anda telah berhasil
menerapkan cara melakukan instalasi plugin buildings tools serta memetakan menggunakan plugin
buildings tools. Setelah ini, Anda akan mempelajari bagaimana membuat batas-batas administrasi
menggunakan JOSM.
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 — title: Pembuatan Batas Administrasi dengan JOSM weight: 9 —

Tujuan Pembelajaran:

• Mampu memahami pengertian dan contoh relasi data di OpenStreetMap
• Mampu memahami konsep batas administrasi di OpenStreetMap
• Mampu memahami syarat dan ketentuan membuat batas administrasi di OpenStreetMap
• Mampu membuat batas administrasi di OpenStreetMap

Pemetaan batas administrasi di dalamOpenStreetMapmerupakan hal yang rumit dan disarankan peng-
guna yang sudah mahir atau terbiasa menggunakan OSM yang melakukan digitasi dan meng-upload ke
dalam OSM. Sumber data yang digunakan dalam penarikan batas administrasi dan penentuan wilayah
administrasi harus melibatkan pihak pemerintah yang mengetahui batas tersebut.

Dalam proyek PDC InAWARE, penentuan batas administrasi melibatkan pihak kelurahan dan kepu-
tusan wilayah administrasi sepenuhnya berasal dari pihak kelurahan. Jika sumber data tidak jelas
dan tidak memiliki lisensi Open Data Commons Open Database License (ODbL), data tersebut tidak
diperkenankan untuk di-upload ke dalam OSM. Hal ini dapat menimbulkan permasalahan pada saat
pengguna lainnya men-download dan menggunakan data batas administrasi secara bebas untuk ke-
pentingan mereka.

I. Relasi Data di OSM

Relasi merupakan salah satu elemen utama dalam data OSM yang terdiri dari satu atau lebih tag dan
juga memuat daftar urutan objek yang tergabung dalam relasi sebagai anggota dari relasi tersebut.
Dalam membuat batas administrasi, kita harus menggunakan fitur relasi. Relasi digunakan untuk men-
gelompokkan batas administrasi dan memberikan tanda batas tersebut sebagai batas luar atau batas
dalam. Relasi dalam pembuatan batas administrasi terdiri dari dua jenis yaitu:

a. Relation Tags

Tabel Tags pada Relasi Batas Administrasi

Key Value Keterangan

admin_level (1-11) Disesuaikan dengan
level batas administrasi

Tag yang berguna untuk
mengidentifikasi tingkat batas
administrasi pada suatu
daerah, misalnya admin_level
= 4 di Indonesia merupakan
tingkat batas administrasi
untuk batas provinsi.

boundary administrative Tag ini merupakan tag batas
administrasi yang sebenarnya.

type boundary Tag ini adalah tag utama untuk
mengenali bahwa objek
tersebut termasuk ke dalam
batas administrasi.

name nama administrasi Tag yang mendeskripsikan
nama dari batas administrasi
tersebut, misalnya: Provinsi
Jawa Barat, Kota Depok,
Kecamatan Sawangan, RW
03 ataupun RW 05.
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Key Value Keterangan

place contoh: suburb,island Ini merupakan tag optional,
tidak wajib dipakai. Tag yang
berguna untuk
mendeskripsikan jenis area
yang ada di dalam batas
administrasi tersebut apakah
termasuk garis pantai dan
penggunaan lahan lainnya.
Info lengkap lihat di:
http://wiki.openstreetmap.org/
wiki/Key:place

land_area administrative Tag untuk menyatakan
sebagai sebuah batas wilayah
daratan

is_in:province nama provinsi Tag yang mendeskripsikan
nama Provinsi. Tag ini harus
dimasukkan pada batas
administrasi yang berada di
tingkat bawah dari Provinsi
(Kota/Kabupaten/Kotamadya,
Kecamatan, Kelurahan/Desa,
RW dan RT)

Kota = is_in:city
Kab/Kotamadya= is_in:town

nama kabupaten/kotamadya Tag yang mendeskripsikan
nama
Kota/Kabupaten/Kotamadya.

is_in:municipality nama kecamatan Tag yang mendeskripsikan
nama Kecamatan._Tag_ ini
harus dimasukkan pada batas
administrasi yang berada di
tingkat bawah dari Kecamatan
(Kelurahan/Desa, RW dan RT)

is_in:village nama kelurahan/desa Tag yang mendeskripsikan
nama Kelurahan/Desa._Tag_
ini harus dimasukkan pada
batas administrasi yang
berada di tingkat bawah dari
Kelurahan/Desa (RW dan RT)

is_in:RW nama RW Tag yang mendeskripsikan
nama RW. Tag ini harus
dimasukkan pada batas
administrasi yang berada di
tingkat bawah dari RW (RT)

b. Relation Members

• Admin_centre

Titik yang mewakili pusat administrasi pada suatu daerah biasanya berupa ibu kota provinsi, kelurahan,
dan sebagainya, tergantung dari tingkat batas administrasinya.

• Outer

Rangkaian dari garis-garis yang terhubung menjadi suatu batas tertutup seperti poligon / batas luar dari
suatu wilayah administrasi.

• Inner

Rangkaian dari garis-garis yang terhubung menjadi suatu batas tertutup seperti poligon dan objek terse-
but berada di dalam area yang termasuk inner/ batas dalam dari suatu wilayah administrasi.
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wilayah C berada di dalam wilayah A dan wilayah C diidentifikasi sebagai inner dari relation members
(https://wiki.openstreetmap.org/wiki/Main_Page)

II. Mengenal Batas Administrasi di OSM

a. Pengertian Batas Administrasi

Batas administrasi merupakan sebuah pembagian daerah / wilayah yang diakui oleh pemerintah atau
organisasi lain untuk keperluan administratif. Tingkat batas administrasi mulai dari yang tertinggi hingga
terendah di dalam OpenStreetMap ditandai dengan key=admin_level dan value= dari 1 - 11 (tertinggi
- terendah).
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Batas Rukun Tetangga (RT) dan Rukun Warga (RW) di Petamburan

b. Tingkat Batas Administrasi di Dunia

Tingkatan batas administrasi bisa jadi berbeda-beda antara negara yang satu dengan yang lainnya.
Sangat disarankan bila Anda hendak membuat atau mengedit batas administrasi negara tertentu, Anda
perlu mengetahui terlebih dahulu value dari key = admin_level yang digunakan. Daftar tingkat adminis-
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trasi berbagai negara dapat Anda lihat di halaman Wiki OpenStreetMap: http://wiki.openstreetmap.org/
wiki/Tag:boundary%3Dadministrative atau https://tinyurl.com/wiki-batasadm

c. Tingkat Batas Administrasi di Indonesia

Pembagian batas administrasi di Indonesia disesuaikan dengan pembagian wilayah daratan dan
perairan di Indonesia yang dikelola oleh pemerintah daerah menurut prinsip otonomi, dekonsentrasi,
desentralisasi dan tugas pembantuan. Jenis batas administrasi yang ada di Indonesia yaitu provinsi,
kota/kabupaten, kecamatan, dan kelurahan/desa.

Apabila jenis batas administrasi di Indonesia dilihat diOpenStreetMap, batas administrasi tersebut memi-
liki value yang berbeda-beda disesuaikan dengan tingkat administrasi. Berikut adalah tingkat adminis-
trasi yang digunakan di OpenStreetMap untuk wilayah Indonesia:

Tabel Tingkat Administrasi di Indonesia

value Tingkat Administrasi Tampilan di Mapnik Place

1 - - -

2 Batas Negara -
3 - - -

4 Batas Provinsi Province

5 Batas Kota /
Kotamadya /
Kabupaten (Daftar
Kota & Kab.
Indonesia)

Kota=City
Kab/Kotamadya=Town

6 Batas Kecamatan Municipality

7 Batas
Kelurahan/Desa

Village

8 Batas Dusun Hamlet

9 Batas Rukun Warga
(RW)

Community Group

10 Batas Rukun
Tetangga (RT)

Neighborhood Unit

III. Syarat dan Ketentuan Menggambar Batas Administrasi di OpenStreetMap

a. Syarat dan Ketentuan untuk Pengguna yang Ingin Menggambar

Batas administrasi merupakan hal yang sangat sensitif untuk dibuat atau diubah. Selain karena masalah
kebijakan, data batas administrasi secara topologi juga tersusun dari relasi yang kompleks. Jika salah
satu objek berubah, maka akan berdampak pada objek lainnya dalam satu relasi yang sama. Oleh
sebab itu, bagi pengguna OSM yang hendak mengubah data tersebut sangat diharapkan memiliki kom-
petensi sebagai berikut:

• Sudah memahami konsep relasi pada data OpenStreetMap terutama relasi untuk batas adminis-
trasi

• Mengetahui batas administrasi yang akan diedit dan sumber/referensi datanya
• Mengetahui tingkat batas administrasi di OpenStreetMap untuk wilayah Indonesia
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b. Syarat dan Ketentuan untuk Data yang Dimasukkan

Data yang dimaksud adalah data batas administrasi yang akan dimasukkan ke dalam OpenStreetMap.
Beberapa syarat dan ketentuan untuk data yang akan digunakan dan dimasukkan ke dalam Open-
StreetMap yaitu:

• Data harus memiliki sumber yang jelas dari mana asalnya misalnya data bersumber dari pemerin-
tah

• Data harus memiliki izin penggunaan (lisensi), apakah data tersebut boleh disebarluaskan ke pub-
lik atau tidak karena data ini nantinya akan dilihat dan digunakan oleh publik atau masyarakat
luas

• Data harus memiliki pembagian batas-batas administrasi yang jelas dan sesuai dengan yang su-
dah disahkan

IV. Langkah-Langkah Menggambar Batas Administrasi di OpenStreetMap

Dalam membuat batas administrasi sangat disarankan untuk menggunakan editor Java OpenStreetMap
(JOSM) karena alat yang disediakan lebih lengkap dan untuk melakukan editing dan modifikasi jauh lebih
mudah dibandingkan editor lainnya seperti iD Editor.

Catatan : Data yang dipakai pada tutorial ini hanyalah data contoh atau data fiktif untuk
mempermudah pemahaman kita dalam mempraktekan pembuatan batas administrasi.

Berikut langkah-langkah yang dilakukan untuk membuat batas administrasi di OpenStreetMap yaitu :

a. Menggambar Garis Batas Administrasi

• Hal pertama yang dilakukan adalah membuka editor JOSM di komputer Anda.
• Kemudian pilih wilayah yang akan dibuat batas administrasinya dengan men-download data OSM

di wilayah tersebut.
• Jika data OSM sudah lengkap seperti bangunan dan jalan, Anda dapat menggunakan fungsi fil-

ter pada JOSM yang terdapat pada modul Menggunakan alat Filter di JOSM untuk mengatur
tampilan bangunan dan jalan agar memudahkan dalam digitasi batas administrasi.

• Mulailah dengan mendigitasi batas administrasi yang sudah sesuai dengan syarat dan ketentuan
data yang akan dimasukkan pada penjelasan sebelumnya. Untuk mendigitasi gunakanlah tool
Draw Node.

• Gambar di bawah ini adalah salah satu contoh mendigitasi batas administrasi.
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Pembagian contoh wilayah

• Dalam menggambar batas administrasi, harap memperhatikan hal-hal berikut:
– Gambarlah sebagai garis yang saling tersambung satu sama lain antar batas administrasi
– Tidak ada garis batas administrasi yang saling bertampalan atau tergambar dua kali
– Pastikan setiap pertemuan garis merupakan garis yang terpisah (dalam artian berbeda seg-

men). Jika garis tersebut masih terlihat seperti pada gambar di bawah ini :

380



Kesalahan pada relasi batas admin

• Anda harus membagi garis tersebut menggunakan Tools→SplitWay atau menggunakan shortcut
tombol P pada keyboard Anda dengan cara memilih 2 (dua) node dari garis yang akan Anda bagi
hingga hasilnya menjadi seperti ini:
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Split way pada garis administrasi

b. Memberikan Tag pada Garis Batas Administrasi

• Langkah selanjutnya kita akan memberikan tag pada tiap garis batas yang kita buat. Pilih salah
satu segmen garis dari batas administrasi.
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Pemilihan garis pada batas administrasi

• Kemudian berikan tag pada garis yang terpilih tersebut dengan cara klik Menu Presets→ Batas
Administrasi → Garis Batas Administrasi. Jika presets ini tidak ada di daftar Anda, silahkan
buka modul Pengoperasian JOSM untuk menambahkan “PDC InAWARE Indonesia preset”.

Presets Batas Administrasi

• Akan muncul jendela yang dapat Anda isi sesuai dengan nama desa yang berbatasan, misalnya
Desa A / Desa B. Tag ini bertujuan untuk memberikan keterangan bahwa segmen garis terse-
but merupakan batas administrasi untuk Desa A dan Desa B. Kemudian klik Apply preset untuk
menyimpan hasil.
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Tag Batas Administrasi

• Anda dapat melihat tags pada garis tersebut, dengan memilih garis menggunakan select tool dan
arahkan pada panel Tags di sebelah kanan, akan terlihat seperti gambar di bawah ini:

Tags pada garis admin

• Mari kita lanjutkan memberi tag pada segmen-segmen garis pembentuk batas administrasi Desa
A. Sekarang pilih segmen garis batas antara Desa A dan Desa C. Berikan tag dengan langkah
yang sama seperti sebelumnya.
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Pemberian tag antar batas desa A dan C

• Tutorial kali ini akan memberikan contoh membuat batas administrasi desa dan kelurahan yang
mana kelurahan tersebut wilayahnya mencakup satu daratan/pulau. Pada gambar dibawah ini,
garis yang berwarna merah merupakan garis batas antara Desa A dengan wilayah laut.
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Batas administrasi yang berbatasan dengan laut

• Pada kasus ini, tag yang harus diberikan sedikit berbeda, yaitu harus ditambahkan key=natural
dan value=coastline, kemudian untuk key=note dapat dihilangkan. Untuk menambahkan tag
tersebut, klik Menu Presets→ Perairan → Natural→ Garis Pantai.
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Pemberian tag pada garis pantai

• Setelah segmen-segmen dari garis batas Desa A diberi tag, gambarlah sebuah titik sebagai titik
pusat dari Desa A.
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Digitasi titik sebagai nama desa

• Kemudian beri tag pada titik tersebut dengan pergi ke Presets → Batas Administrasi → Titik
Pusat Administrasi. Isi kolom Nama dengan nama desa dan pilih tingkat administrasi sesuai
dengan kategori batas administrasi.

Pemberian tag nama desa

• Setelah titik tersebut diberi tag maka hasilnya akan seperti ini:
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Hasil titik nama desa

c. Membuat Relasi Batas Administrasi (contoh: Desa)

• Langkah selanjutnya kita akan memulai membuat sebuah relasi untuk membuat batas administrasi
Desa A. Pilih semua segmen/garis batas administrasi dan titik nama desa dengan Select Tool.

Pilih semua garis dan titik nama desa

• Kemudian pilih Presets→ Batas Administrasi → Wilayah Administrasi.
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Presets untuk relasi wilayah administrasi

• Kemudian akan muncul jendela mengenai isian daftar wilayah administrasi. Isikan daftar tersebut
sesuai dengan wilayah administrasi yang Anda dapatkan dari instansi pemerintah. Jika Anda
menemukan tanda v pada baris isian, silahkan di klik dan dipilih yang sesuai. Klik New relation
untuk membuat relasi baru.
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Daftar isian wilayah administrasi

• Selanjutnya akan terbuka jendela relasi seperti dibawah ini:
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Jendela relasi wilayah administrasi

• Selanjutnya, perhatikan pada bagian Role. Setelah anggota relasi Desa A lengkap, saatnya kita
menentukan peran dari setiap anggota relasi. Segmen garis pembentuk batas Desa A kita beri
peran sebagai “outer” atau sebagai batas luar dari wilayah administrasi. Sedangkan Titik pusat
Desa A kita beri peran sebagai “admin_centre”.
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Peran di setiap wilayah administrasi

• Pastikan daftar segmen pembentuk batas administrasi sudah urut. Jika daftar segmen belum urut,
maka garis di sebelah kanan daftar tidak akan menutup seperti ini:

• Untuk membuat daftar segmen sesuai urutan, klik tombol Sortir Relasi Member (Sort the relation
members)

• Jika daftar segmen sudah urut, maka garis di sebelah kanan daftar akan menutup seperti ini:

• Setelah memberikan peran pada tiap anggota relasi dan memastikan daftar segmen pembentuk
batas administrasi sudah urut, klik tombol OK.

• Sekarang klik dua kali di dalam area administratif Desa A. Jika relasi sudah terbentuk, maka
wilayah Desa A akan berwarna ungu seperti ini:
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Wilayah desa A

• Selanjutnya, silahkan Anda lakukan hal yang sama seperti diatas untuk membuat batas adminis-
trasi Desa B. Jika sudah berhasil maka hasilnya akan seperti ini:

Wilayah desa B

• Sebelum kita lanjut untuk membuat batas Desa C, kita akan mencoba untuk mendigitasi batas
desa baru yang ada di dalam wilayah Desa C. Mari kita sebut desa baru ini sebagai Desa D.
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Tambahan admin baru yang berada di dalam Desa C

• Setelah anggota relasi Desa C lengkap, saatnya kita menentukan peran dari setiap anggota relasi.
• Segmen garis pembentuk batas luar Desa C (garis batas antara Desa C/A, garis batas antara

Desa C/B, dan garis batas antara Desa C/Laut) → berperan sebagai “outer” atau sebagai batas
luar dari wilayah administrasi seperti pada gambar di atas.

• Segmen garis batas dalam Desa C (garis batas antara Desa C/D) → berperan sebagai “inner”
atau sebagai batas dalam dari wilayah administrasi seperti pada gambar di atas.

• Titik pusat Desa C → berperan sebagai “admin_centre”

Pengaturan relasi Desa C

• Klik tombol Sortir Relasi Member (Sort the relation members) untuk memastikan daftar anggota
relasi sudah urut.

• Sekarang klik dua kali di dalam area administratif Desa C. Jika relasi sudah terbentuk, maka
wilayah Desa C akan berwarna ungu seperti ini:
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Hasil relasi Desa C

• Setelah membuat batas administrasi Desa C, mari kita lanjutkan untuk membuat batas Desa D.
Silahkan Anda lakukan hal yang sama untuk membuat wilayah administrasi Desa D. Jika sudah
berhasil maka hasilnya akan seperti ini:
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Hasil relasi Desa D

c. Membuat Relasi Batas Administrasi (contoh: Kecamatan)

• Pada langkah-langkah sebelumnya kita sudah membuat batas administrasi dalam tingkat desa,
sekarang kita akan membuat batas administrasi satu tingkat di atas desa, yaitu kecamatan.
Langkah yang akan kita lakukan kurang lebih sama dengan langkah-langkah sebelumnya.

• Mari kita buat titik pusat Kecamatan Kertamukti, kemudian berikan tag: KlikMenu Preset→Batas
Administrasi → Titik Batas Administrasi

Pemberian presets pada titik nama kecamatan

• Pilih semua segmen batas administrasi dan titik administrasi kecamatan untuk memulai membuat
relasi.
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Pilih semua batas terluar dan titik kecamatan

• kemudian pilih Menu Presets → Batas Administrasi → Wilayah Administrasi. Silahkan Anda
isi secara lengkap nama kecamatan, tingkat administrasi kecamatan, dan kosongkan isian Keca-
matan.
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Daftar isian presets wilayah admin kecamatan

• Setelah anggota relasi Kecamatan Kertamukti lengkap, saatnya kita menentukan peran dari se-
tiap anggota relasi. Segmen garis pembentuk batas Kecamatan Kertamukti kita beri peran seba-
gai “outer” atau sebagai batas luar dari wilayah administrasi, sedangkan Titik pusat Kecamatan
Kertamukti kita beri peran sebagai “admin_centre”

Pengaturan relasi kecamatan
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• Pastikan daftar segmen pembentuk batas administrasi sudah urut. Jika daftar segmen belum urut,
maka garis di sebelah kanan daftar tidak akan menutup seperti ini:

• Untuk membuat daftar segmen sesuai urutan, klik tombol Sortir Relasi Member (Sort the relation
members)

• Jika daftar segmen sudah urut, maka garis di sebelah kanan daftar akan menutup seperti ini:

• Setelah memberikan peran pada tiap anggota relasi dan memastikan daftar segmen pembentuk
batas administrasi sudah urut, klik tombol OK.

• Jika Anda ingin melanjutkan batas administrasi sampai tingkat ke level yang lebih tinggi, maka
langkah yang digunakan akan sama, yang membedakan pada saat memberikan tags wilayah
administrasi dan titik administrasi.

• Cek hasil batas administrasi yang sudah Anda buat di www.openstreetmap.org

400

http://www.openstreetmap.org


Contoh batas administrasi di dalam OSM

RINGKASAN

Anda telah mempelajari langkah-langkah dalam membuat batas administrasi dengan mendigitasi di
JOSM, dengan menggunakan relasi di dalam OSM. Sebuah relasi terbangun dari garis-garis yang dis-
atukan menjadi sebuah kesatuan membentuk poligon, sehingga data batas admin yang dihasilkan akan
membentuk sebuah poligon pada saat di-download menggunakan Export Tool.
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 — title: Perhitungan Kuantitas Data Menggunakan Plugin Group Stats weight: 9 —

Tujuan Pembelajaran:

• Memahami cara melakukan instalasi tambahan (plugin) untuk menghitung jumlah objek menggu-
nakan QGIS

• Memahami cara mengoperasikan group stats untuk menghitung jumlah objek di QGIS

Kuantitas adalah kualitas sesuatu hal yang terbentuk dari proses perhitungan dan pengukuran (Thomp-
son:1990). Perhitungan kuantitas data dapat menjadi indikator dalam pencapaian proyek pemetaan
yang dapat dituangkan ke dalam sebuah laporan pemetaan. Proses perhitungan kuantitas data OSM
dapat dilakukan dengan menginstal plugin group stats di QGIS secara gratis, plugin ini dapat digunakan
untuk menghitung jumlah objek berdasarkan kategori tertentu.

I. Instalasi Group Stats

• Jika Anda belum memiliki QGIS, Anda dapat download di situs tautan berikut : http://download.
osgeo.org/qgis/win64/QGIS-OSGeo4W-2.14.22-1-Setup-x86.exe untuk Windows 32 bit dan http:
//download.osgeo.org/qgis/win64/QGIS-OSGeo4W-2.14.22-1-Setup-x86_64.exe untuk Windows
64 bit.

• Setelah selesai di download, kemudian klik Instal dan Buka QGIS

• Klik menu Plugins → Manage and Install Plugins

Tampilan Menu Plugins

• Anda memerlukan koneksi internet untuk menginstal plugin, pada kotak Search ketikkan Group
Stats. Berikan tanda centang pada group stats → Install Plugin. Tunggu beberapa saat hingga
proses instalasi plugin selesai.
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Plugin Group Stats

• Jika sudah berhasil, plugin akan muncul pada Menu Vector → GroupStats

Tampilan Plugin GroupStats

II. Cara Menghitung Jumlah Objek dengan Plugin Group Stats

Kalkulasi kuantitas data dapat dihitung berdasarkan batas administrasi agar memudahkan dalam mem-
buat laporan bulanan dan memantau timeline pemetaan. Dalam perhitungan jumlah objek membu-
tuhkan dua jenis data yaitu: file .shapefile objek OSM dan file .shapefile batas administrasi. Sebelum
melakukan perhitungan, Anda harus mempunyai kedua file .shapefile tersebut.

Data batas administrasi yang akan digunakan pada bab ini dapat di download pada tautan
http://tinyurl.com/admin-smg dan data objek OSM dapat di download dengan menggunakan Ex-
port Tool yang terdapat pada modul Penggunaan YAML pada Export Tool. Anda dapat melakukan
perhitungan jumlah objek sebelum dan sesudah pemetaan, agar terlihat kalkulasi data yang dihasilkan
dari proyek pemetaan. Hasil download data OSM pada pada modul Penggunaan YAML pada
Export Tool akan digunakan untuk perhitungan jumlah objek. Ada 2 (dua) kategori ._shapefile_ yang
dihasilkan, yaitu:

• Fasum :

1. Semua objek yang masuk ke dalam amenity=*
2. Instalasi Kelistrikan (power=*)
3. Rekreasi dan RTH (leisure=*)
4. Kantor pemerintahan (office=*)
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5. Supermarket (shop=supermarket)

• Jalan : highway=*

Jika Anda telah memiliki data ._shapefile_ seperti di atas, maka dapat melanjutkan langkah di bawah ini
mengenai bagaimana menghitung kuantitas data OSM. Langkah - langkah dalam menghitung kuantitas
data OSM, yaitu:

a. Persiapan Data Layer

• Persiapkan data objek OSM hasil download dari Export Tool yang sudah dilakukan Extract. Ke-
mudian gunakan QGIS desktop untuk membuka data tersebut dengan klik Add Vector Layer →
Browse yang berada di sisi sebelah kiri QGIS atau klik Menu Layer → Add Layer → Add Vector
Layer → Browse.

Tampilan Add Vector Layer

• Arahkan ke direktori tempat penyimpanan file → Pilih semua → Open → Open

Daftar file .shp hasil download data OSM

• Layer-layer tersebut akan tampil pada map canvas (kanvas peta) dan daftar layer akan tampil
pada Layers Panel.
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Tampilan peta pada QGIS

• Tambahkan data vektor batas kelurahan ke QGIS dengan klik Add Vector Layer

Tampilan batas administrasi kelurahan

b. Penggabungan Layer Objek dan Batas Administrasi

• Gabungkan layer batas administrasi dengan layer objek OSM agar data objek memiliki atribut
nama kelurahan. Klik Menu Vector → Geoprocessing Tool → Intersect untuk memulai peng-
gabungan layer. Pada bagian input vector layer (layer objek OSM) pilih satu per satu objek untuk
digabungkan dengan Intersect layer (layer kelurahan). Pilih Browse untuk menentukan lokasi
penyimpanan output shapefile di direktori Anda, lalu klik OK.
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Intersect penggabungan layer

• Setelah berhasil akan ada layer baru sebagai hasil gabungan keduanya. Untuk melihat hasilnya,
Anda dapat membuka atribut tabel, dengan klik kanan pada layer fasum dan pilihOpen Attribute
Table. Pada tabel atribut akan terlihat nama kelurahan pada kolom name_2 di setiap objek OSM
pada layer “fasum_point_admin”.

Tabel atribut fasum point

• Lakukan kembali proses intersect kepada layer “jalan” dan layer “fasum polygon”, sehingga
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Anda memiliki 3 (tiga) layer baru dari hasil penggabungan batas administrasi dan objek.
• Buka atribut tabel di setiap layer dan periksa kolom yang dapat dijadikan acuan untuk perhitungan

data OSM. Apakah di dalam tabel atribut tersebut sudah ada nama kolom seperti di bawah ini:

1. Fasum point = amenity, power, office dan supermarket
2. Fasum polygon = amenity, power, office, supermarket, dan leisure
3. Jalan = highway

c. Perhitungan Data Objek OSM

Data OSM yang dihasilkan dari proyek pemetaan terdiri dari points, lines, dan polygons. Anda akan
melakukan perhitungan dengan dua formula yang berbeda pada saat menggunakan plugin Group Stats.
Data OSM dalam bentuk points dan polygons akan dihitung dengan menggunakan formula “count”,
formula tersebut akan menghitung atribut objek berdasarkan banyaknya atribut yang terdapat di kolom
atribut. Sedangkan data OSM dalam bentuk lines akan dihitung menggunakan formula “sum”, dimana
formula tersebut atribut akan menjumlahkan segmen panjang jalan.

1. Perhitungan Data OSM dalam bentuk Points dan Polygon

• Jika Anda melakukan pemetaan dalam ruang lingkup kota, maka akan lebih mudah melakukan
perhitungan kuantitas data per kecamatan. Lakukan filter pada layer “fasum_point_admin”,
agar data yang ditampilkan hanya untuk kecamatan tertentu, dengan klik kanan pada layer
fasum_point_admin → Filter. Kemudian, lakukan langkah seperti gambar di bawah ini.
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Langkah-langkah filter data

• Ketika Anda klik OK akan tampil objek OSM yang hanya ada di Kecamatan Candisari
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Tabel atribut hasil filter

• Sekarang Anda akan memulai proses perhitungan dengan pluginGroup Stats. BukaMenu Vector
→ Group Stats → GroupStats

Group Stats

• Lakukan seperti langkah di bawah ini:

• Layers= menunjukkan layer yang akan dihitung jumlah objeknya. Fields = secara otomatis me-
nunjukkan kolom yang ada pada tabel atribut layers yang dipilih

• Columns= akan menjadi kategori kolom pada saat proses perhitungan, isi dengan kolom yang
ada pada Fields, dengan cara pilih dan pindahkan ke kotak Columns.

• Rows= akan menjadi kategori baris pada saat proses perhitungan, isi dengan kolom yang akan
dijadikan baris, dengan cara pilih dan pindahkan ke kotak Rows.

• Value= sebagai acuan dasar perhitungan, pilih formula + kolom Layers

• Klik Calculate untuk memulai proses perhitungan
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Langkah-langkah Group Stats

• Tabel yang muncul pada Group Stats, akan di copy dan di paste ke tempat yang lebih mudah
untuk dimodifikasi misalnya menjadi bentuk grafik. Anda dapat memindahkan tabel tersebut ke
Excel atau Google Sheets.

Caranya : Klik Data → Copy all to clipboard.

Copy dan paste tabel atribut

• BukaMicrosoft Excel atauGoogle Sheet untuk memindahkan isi dari tabel hasil perhitunganGroup
Stats tersebut.

• Lakukan langkah yang sama untuk perhitungan objek-objek lainnya. Anda dapat melihat contoh
tabel hasil perhitungan objek di Kota Semarang pada http://tinyurl.com/kuantitas-data
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2. Perhitungan Objek Garis dengan Perhitungan Panjang Jalan

Perhitungan objek jalan berbeda dengan perhitungan objek dalam bentuk point dan polygon. Jika Anda
ingin menghitung panjang jalan, maka data shapefile jalan Anda harus diatur ataupun diubah ke dalam
koordinat UTM. Langkah-langkah untuk menghitung panjang jalan adalah sebagai berikut :

Mengubah Sistem Koordinat

• Klik kanan pada layer jalan → Save as → pilih Format ESRI Shapefile → Save as dalam di-
rektori → CRS pilih sistem koordinat UTM sesuai dengan wilayah Anda → OK.

Simpan file dengan CRS berbeda

• Jika Anda memberikan tanda centang pada Add saved file to map, maka layer jalan yang baru
akan langsung muncul di Layers Panel dan kanvas peta.

Membuat Kolom Baru untuk Perhitungan Panjang Jalan
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• Klik kanan pada Layers “Jalan_Admin_UTM” → Open Attribute Table. Aktifkan toolbar yang
terletak di atas dengan klik Toggle editing mode untuk mengaktifkan semua toolbar.

Toolbar Toggle editing mode

• Untuk menambahkan kolom baru, klik New Field yang terletak pada toolbar.

Toolbar New Field

• Tampilan kotak dialog Add field akan nampak seperti gambar di bawah ini, ada beberapa pengat-
uran isian, yaitu :

• Name = menampilkan judul kolom

• Type = menunjukkan tipe data yang dapat dipilih sesuai dengan jenis data isi kolom. Tipe decimal
number (real) akan menunjukkan bilangan desimal.

• Provider type double = Length menunjukkan jumlah angka di setiap baris dan precision menun-
jukkan jumlah desimal di belakang koma.

• Klik OK = untuk menyelesaikan pengaturan

Pengaturan Add field
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Perhitungan Panjang Jalan (meter) dengan Field Calculator

• Anda dapat memeriksa kolom yang sudah dibuat yang terletak di baris paling akhir pada tabel
atribut. Untuk melakukan pengisian kolom perhitungan panjang jalan, Anda dapat mengaktifkan
Open field calculator.

• Ada beberapa pengaturan untuk pengisian field calculator, yaitu :

• Berikan tanda centang pada bagian Update existing field untuk memperbarui isian kolom

• Pilih kolom yang akan diperbaharui datanya

• Anda dapat mengetikkan “length” untuk menghitung panjang jalan secara otomatis.

• Klik dua kali pada bagian Geometry → length sebagai formula untuk menghitung panjang jalan,
kata $length akan muncul pada kotak Expression.

• Klik OK untuk menyelesaikan pengaturan field calculator
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Pengaturan Field Calculator untuk panjang jalan

• Periksa kolom paling akhir di tabel atribut untuk mengetahui panjang jalan untuk setiap segmen
jalan.
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Panjang jalan untuk segmen jalan

• Simpan hasil perhitungan jalan tersebut dengan cara klik toolbar Save Edits. Untuk mengakhiri
mode pengeditan klik Toggle Editing.

Simpan perubahan

Menghitung Jumlah Panjang Jalan Berdasarkan Jenis Jalan dengan Group Stats

• Untuk memudahkan proses perhitungan kuantitas data untuk panjang jalan, Anda akan melakukan
filter perhitungan berdasarkan administrasi kecamatan, langkah yang diperlukan yaitu klik kanan
pada layer “jalan_admin_utm” → Filter → (ikuti langkah-langkah seperti gambar di bawah) →
OK.
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Filter berdasarkan Kecamatan

• Buka plugin Group Stats dengan klik Menu Vector → Group Stats → Group Stats.
• Pada bagian Value, Anda dapat menggunakan formula “sum” untuk menghitung panjang jalan

yang terdapat di kolom Panjang_Jl yang telah dihitung sebelumnya.
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Pengaturan Group Stats untuk panjang jalan

• Sama seperti sebelumnya, tabel yang muncul pada Group Stats akan disalin dan paste ke tempat
yang lebih mudah untuk dimodifikasi misalnya menjadi bentuk grafik. Anda dapat memindahkan
tabel tersebut ke Microsoft Excel atau Google Sheets.

Caranya : Klik Data → Copy all to clipboard.
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Copy dan paste tabel atribut

• Siapkan Microsoft Excel atau Google Sheet untuk memindahkan tabel tersebut

Tabel Data Statistik Jaringan Jalan (meter)

Katagori
Jalan Candi Jatingaleh Jomblang Kaliwiru

Karang
Gunung Tegalsari Wonotinggal

Motorway - 1313.88 163.85 - - - -
Trunk - 1571.20 - 1602.19 - - -
Primary - 1389.34 1264.54 - 206.96 - -
Secondary 1065.13 - 24.17 2353.86 - - -
Tertiary 271.49 3920.71 1612.78 - 836.18 - -
Service 500.24 2567.00 226.11 116.68 150.03 301.93 851.94
Residential 8486.45 14300.66 20972.41 5424.36 13322.03 15234.38 11635.03
Pedestrian - 1313.88 163.85 - - 141.93 344.38
Path - 14.68 - - - 601.85 26.40
Living
Street

5913.74 2841.22 6588.17 451.66 4401.59 3509.38 2576.71

• Lakukan langkah-langkah yang sama untuk melakukan perhitungan objek-objek lainnya. Contoh
tabel perhitungan objek OSM yang ada di Kota Semarang http://tinyurl.com/kuantitas-data

RINGKASAN

Anda telah menyelesaikan perhitungan data OSM dengan menggunakan plugin Group Stats pada QGIS
untuk mendapatkan kuantitas data objek yang dihasilkan dari proyek pemetaan. Data statistik tersebut
dapat dikembangkan dalam bentuk laporan untuk mengetahui progres dan memantau kinerja pemetaan
yang sedang Anda lakukan.
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 — title: Konversi Data Shapefile ke GeoJSON weight: 10 —

Tujuan Pembelajaran: * Memahami Pengertian Data GeoJSON * Mengetahui Melakukan Konversi
Shapefile ke GeoJSON dengan QGIS * Mengetahui Cara Mendapatkan GeoJSON dengan Overpass
Turbo * Mengetahui Melakukan Konversi Shapefile ke GeoJSON dengan GeoData Converter

Jika Anda tidak memiliki latar belakang pendidikan di bidang geografi ataupun tidak terlalu familier den-
gan Sistem Informasi Geografi (SIG) maka format GeoJSON ini mungkin terdengar asing bagi Anda.
Akan tetapi, Anda tidak perlu khawatir dengan hal tersebut karena mendapatkan data spasial den-
gan format GeoJSON tidak sesulit yang Anda kira. GeoJSON dapat diperoleh dengan mengubah
atau melakukan konversi dari data spasial yang sudah Anda miliki seperti shapefile, keyhole markup
language (.kml) maupun hasil GPS yaitu .gpx . Dalam modul ini Anda akan mempelajari pengertian
dari data GeoJSON hingga beberapa alat yang dapat membantu Anda untuk melakukan konversi data
spasial khususnya shapefile ke dalam format GeoJSON.

I. Pengertian Data GeoJSON

GeoJSON, yang merupakan modifikasi dari Java Script Object Notation (JSON), adalah sebuah format
data spasial yang sederhana. Berbeda dengan format spasial yang lain seperti shapefile, GeoJSON
menampilkan bentuk spasial dari suatu data dengan ukuran yang lebih ringan tetapi tetap membawa
informasi atribut dari data tersebut.

GeoJSON dapat berupa titik (point), garis (line), area (polygon) dimana dapat merepresentasikan dari
suatu objek yang ada di permukaan bumi. Karena sifatnya yang sederhana dan merupakan modifikasi
dari suatu bahasa program, GeoJSON lebih sering digunakan untuk pengolahan Sistem Informasi Ge-
ografi (SIG) bersifat web maupun situs-situs yang menggunakan SIG untuk melakukan visualisasi data
spasial seperti Mapbox, Leaflet, OpenLayer dan bahkan beberapa situs yang disediakan oleh Humani-
tarian OpenStreetMap Team (HOT) seperti HOT Export, Tasking Manager dan Map Campaigner.

II. Konversi Shapefile ke GeoJSON dengan QGIS

Dengan menggunakan QGIS, Anda dapat melakukan konversi data shapefile baik dari data Open-
StreetMap (OSM) maupun data spasial Anda sendiri yang telah Anda miliki sebelumnya. Akan tetapi
sebelum melakukan konversi data shapefile Anda perlu untuk mengunduh softwareQGIS di laptop atau
komputer Anda. Panduan untuk mengunduh QGIS dapat Anda lihat di Modul Pembuatan Peta Survei
dengan QGIS.

Jika sudah melakukan instalasi dan QGIS sudah terpasang di laptop/komputer Anda, maka silakan ikuti
langkah-langkah di bawah ini:

• Silakan buka QGIS Anda dan pilih Add Vector Layer untuk memasukkan data shapefile Anda ke
dalam QGIS.
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Menambahkan data shapefile ke dalam QGIS

• Kemudian cari dan masukan data shapefile yang ingin Anda konversi ke dalam bentuk GeoJSON
di QGIS dengan klik Browse dan klik Open

Tampilan data shapefile di QGIS

• Klik kanan pada _layer _data shapefile Anda kemudian pilih Save As…
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Pilihan untuk konversi data shapefile

• Anda akan melihat sebuah kotak dan aturlah seperti gambar di bawah ini:

[tampilan pengaturan konversi](id/images/06-OSM-Field-Survey-Manager-Guidelines/10-Konversi-
Data-Shapefile-ke-GeoJSON/1004_pengaturan_geojson_di_qgis.png()(

Tampilan pengaturan konversi shapefile ke GeoJSON

• Format : Pilihlah Format GeoJSON
• Save as : Tempat/Direktori Anda menyimpan data GeoJSON
• CRS : Referensi Koordinat untuk hasil data GeoJSON
• Add saved file to map : Memasukkan data GeoJSON ke dalam QGIS setelah proses konversi

selesai
• Jika sudah, maka klikOK dan Anda sudah berhasil melakukan konversi data GeoJSON yang akan

muncul di QGIS komputer/laptop Anda.
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Tampilan hasil konversi GeoJSON di QGIS

III. Mendapatkan Data GeoJSON dengan Overpass Turbo

Jika Anda tidak ingin atau tidak bisa menginstal QGIS di laptop/komputer Anda akan tetapi ingin
melakukan konversi format data ke GeoJSON dari data OpenStreetMap maka Overpass Turbo adalah
solusi untuk hal tersebut. Overpass Turbo adalah suatu situs yang diciptakan oleh kontributor Open-
StreetMap dimana dapat memudahkan para pengguna mendapatkan beberapa format data spasial
dari OpenStreetMap dan GeoJSON adalah salah satunya. Silakan ikuti langkah-langkah berikut untuk
mendapatkan GeoJSON dari situs Overpass Turbo :

• Silakan buka browser internet Anda kemudian buka situs https://overpass-turbo.eu/

422

https://overpass-turbo.eu/


Tampilan awal situs Overpass Turbo

• Setelah itu silakan cari area yang ingin Anda ambil datanya di _OpenStreetMap _dengan
mengetikan nama area di kotak pencarian atau bisa juga dengan mengatur tampilan peta dengan
memperbesar dan memperkecil peta dengan simbol ‘+’ dan ‘-’

Pencarian area di situs Overpass Turbo

• Setelah menemukan area di OpenStreetMap yang ingin Anda ambil datanya sebagai GeoJSON,
selanjutnya silakan pilih menu Wizard di sebelah atas dari situs Overpass Turbo.

Menu wizard di situs Overpass Turbo

• Setelah itu masukkan query terhadap data yang ingin Anda dapatkan. Query yang Anda ma-
sukkan merupakan tag yang memiliki key dan value berdasarkan standar OpenStreetMap. Jika
Anda belum mengetahui tentang tag serta key dan value maka Anda dapat melihat Modul Model
Data OpenStreetMap terlebih dahulu. Sebagai contoh query di modul ini, Anda ingin mengambil
batas administrasi Kota Semarang oleh karena itu Anda dapat menuliskan “admin_level=5 and
name=Semarang” di query wizard dan klik build and run query
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Tampilan query wizard di situs Overpass Turbo

• Setelah itu hasil query akan muncul di Overpass Turbo

Tampilan hasil query wizard batas Kota Semarang

• Setelah hasil query muncul silakan klik Export di menu Overpass Turbo kemudian pilih dan klik
pilihan download/copy as GeoJSON.
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Pilihan export format data GeoJSON di Overpass Turbo

IV. Konversi Shapefile ke GeoJSON dengan GeoData Converter

Jika Anda ingin mengubah data shapefile Anda sendiri bukan dari OpenStreetMap kemudian tidak ingin
atau tidak bisa menginstal QGIS di laptop/komputer, maka Anda dapat menggunakan salah satu situs
di internet yang menyediakan fungsi melakukan konversi data shapefile ke GeoJSON seperti GeoData
Converter. Untuk melakukan konversi di situs ini silakan ikuti langkah-langkah berikut:

• Silakan buka browser internet Anda kemudian buka situs https://mygeodata.cloud/converter/shp-
to-geojson

Tampilan situs MyGeoData Converter
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• Masukkan data shapefile Anda di kotak Upload dengan klik kalimat Or browse file to convert
kemudian pilih + Add Files..

Kotak untuk memasukkan Data Shapefile

• Perlu Anda ketahui saat mengunggah data shapefile jangan lupa ikut menyertakan file yang tera-
sosiasi dengan shapefile seperti .dbf dan .shx agar data shapefile Anda dapat dikonversi dengan
sempurna. Jadi, pastikan Anda sudah memilih semua file seperti contoh di bawah ini:

Hasil memasukkan data shapefile ke situs GeoData Converter

• Kemudian klik Continue dan Anda akan melihat kotak konfirmasi untuk data shapefile yang ingin
Anda konversi. Pastikan Output Format sudah GeoJSON kemudian klik Convert Now!
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Jendela ringkasan sebelum memulai konversi

• Jika sudah silakan klik Download pada jendela yang muncul. Data GeoJSON hasil konversi akan
otomatis diunduh ke dalam laptop/komputer Anda.

Jendela untuk mengunduh hasil konversi GeoJSON

RINGKASAN

Anda telah mempelajari tentang data spasial dengan format GeoJSON dan juga bagaimana melakukan
konversi data shapefile ke GeoJSON dengan menggunakan beberapa alat seperti QGIS, Overpass
Turbo, dan GeoData Converter. Seluruh alat bantu tersebut dapat Anda gunakan sesuai dengan ke-
butuhan dan ketersediaan data shapefile yang Anda miliki. Data GeoJSON yang Anda miliki dapat
digunakan sebagai tampilan di WebGIS atau situs-situs yang dapat menampilkan data spasial seperti
Mapbox, Leaflet, HOT Export dan Tasking Manager.
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 — title: Mengatasi Konflik pada Data OpenStreetMap (OSM) weight: 10 —

Tujuan Pembelajaran:

• Mampu menjelaskan pengertian konflik data OSM pada JOSM
• Mampu menjelaskan jenis-jenis konflik data di JOSM
• Mampu melakukan cara memperbaiki konflik data di JOSM
• Mampu memahami cara menghindari konflik data di JOSM

Saat Anda meng-upload objek dengan menggunakan JOSM, beberapa kontributor OSM mungkin saja
sedang mengedit wilayah yang sama dengan Anda. Hal ini dapat menimbulkan konflik pada saat Anda
meng-upload objek OSM. Untuk itu, pada modul ini Anda akan mempelajari apa itu konflik pada JOSM,
jenis konflik, dan cara menyelesaikan konflik pada JOSM.

I. Pengertian konflik data OSM pada JOSM

Ketika Anda sedang bekerja di JOSM dan ketika Anda meng-upload peta yang telah diedit (pelajari
selengkapnya pada modul Menggunakan JOSM), mungkin Anda pernah mendapatkan pesan seperti
ini:

Contoh jendela apabila konflik terdeteksi

Gambar diatas menunjukkan konflik yang terjadi pada data OSM. Mengapa konflik data pada OSM
dapat terjadi? Hal ini dikarenakan, pada saat Anda mengedit di JOSM, Anda mengedit data OSM yang
sama dengan pengguna lainnya pada waktu yang bersamaan. Kemudian pengguna lain lebih dahulu
meng-upload perubahan data ke server OSM, sehingga ketika Anda ingin meng-upload hasil kerja Anda,
server sudah memiliki versi yang baru.

Anda akan berhadapan dengan konflik ketika Anda melakukan perubahan data OSM dengan mengedit,
menambahkan, atau menghapus dari server utama, dimana data tersebut juga sedang diedit oleh orang
lain. Karena Anda hanya bekerja pada sebuah salinan di JOSM yang tersimpan pada komputer Anda,
pengguna lain masih dapat menerima, mengedit dan meng-upload objek-objek OSM di area yang sama
dan di waktu yang bersamaan dengan Anda. Kemudian, ketika objek tersebut telah Anda edit dan di-
upload pada saat yang bersamaan, server OSM tidak mengetahui versi mana yang benar dan hasil
perubahan mana yang akan disimpan. Jika terjadi hal demikian, maka konflik perlu diperbaiki dan dise-
lesaikan sebelum Anda meng-upload data ke server OSM.
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Contoh ilustrasi penyebab konflik

Gambar diatas merupakan contoh konflik yang mungkin terjadi diakibatkan oleh perbedaan antara lokasi
objek versi Anda (versi saya) dan versi yang ada di server OSM (versi mereka). Untuk menyelesaikan
konflik tersebut, Anda harus memilih salah satu versi diantara kedua versi tersebut (lihat III. Cara mem-
perbaiki konflik data di JOSM).

II. Jenis-jenis konflik data di JOSM

a. Konflik properti

Konflik properti merupakan konflik yang disebabkan perbedaan titik koordinat yang terjadi pada sebuah
objek yang telah dipindahkan atau dihapus posisinya pada dua versi yang berbeda. Hal ini dapat dise-
babkan objek tersebut telah diedit, dipindahkan posisinya atau dihapus oleh pengguna lain.
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Tampilan jendela konflik properti

Gambar diatas merupakan contoh jenis konflik yang disebabkan oleh perbedaan versi posisi salah satu
node/titik pada suatu objek. Untuk menyelesaikannya Anda perlu memilih versi posisi titik mana yang
ingin Anda gunakan.

b. Konflik tag

Konflik tag terjadi akibat adanya perbedaan tag atau informasi yang terjadi pada sebuah objek yang
telah diubah atau dihapus posisinya pada dua versi yang berbeda.

Tampilan jendela konflik tag

Gambar diatas menunjukkan perbedaan versi tag pada objek yang sama. My version menunjukkan
objek yang mempunyai tag Rumah Sakit (amenity = hospital) dengan nama Rumah Sakit Tebet Raya.
Sedangkan objek pada Their versionmenggunakan tag klinik (amenity = clinic) dengan nama RS Tebet
Timur. Untuk menyelesaikannya, Anda perlu memilih salah satu versi tag yang menurut Anda paling
benar.
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c. Konflik node/titik

Konflik pada titik/node terdapat perbedaan pada daftar titik/node yang terjadi pada sebuah objek yang
berbentuk garis, dimana titik pada garis tersebut telah dipindahkan atau dihapus posisinya pada dua
versi yang berbeda.

Tampilan jendela konflik node/titik

III. Cara memperbaiki konflik data di JOSM

Proses dalam menyelesaikan konflik cukup sederhana di dalam JOSM, walaupun sebagian besar peng-
guna OSM mengalami kebingungan untuk menyelesaikan permasalahan konflik pada data OSM. Pada
dasarnya, semua konflik yang terjadi JOSM akan menyediakan dua pilihan - objek versi Anda dan satu
lagi versi orang lain yang berada di server. Anda harus memilih apakah ingin tetap menggunakan versi
Anda atau versi server. Langkah untuk menyelesaikan konflik adalah sebagai berikut:

• Ketika jendela konflik muncul, Anda mungkin akan memilih tombol Synchronize node 5,960,126
only, tetapi pilihan ini hanya akan memperbaiki konflik yang terjadi pada satu node/titik tertentu.
Oleh karena itu, sebaiknya Anda memilih tombol Synchronize entire dataset agar anda dapat
menyelesaikan seluruh konflik sekaligus.
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Tampilan kotak dialog ketika konflik terdeteksi

• Setelah itu akan muncul jendela berisi jumlah konflik yang terdeteksi, klik OK.

Jumlah konflik yang terdeteksi

• Akan muncul daftar konflik pada panelConflict di sebelah kanan peta Anda. Untuk menyelesaikan
konflik yang muncul, Anda dapat memilih konflik pada panel tersebut dengan cara klik pada konflik
kemudian klik Resolve.

Panel Conflict untuk menyelesaikan konflik yang terdeteksi

• Ketika Anda klik tombol Resolve, akan muncul jendela baru yang yang berisikan detail konflik
Anda. Pesan konflik tersebut mungkin terlihat rumit, namun sebenarnya sederhana. Anda akan

mengetahui jenis konflik apa yang Anda dapatkan yang ditunjukkan oleh simbol . Konflik dalam
contoh ini terjadi karena perbedaan titik koordinat dan perubahan posisi objek. Anda dapat melihat
daftar koordinat yang mengalami perubahan pada contoh gambar di bawah. Konflik yang terjadi
merupakan konflik properti yang disebabkan oleh satu titik.
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Contoh tampilan jendela untuk menyelesaikan konflik

• Anda hanya dapat menyelesaikan dua konflik pada saat yang sama. Anda dapat memilih salah
satu antara versi Anda atau versi yang lain pada server. Jika Anda yakin bahwa hasil editing yang
Anda lakukan benar dan tepat (misalnya Anda sudah survei lapangan atau mengetahui wilayah
tersebut), maka Anda dapat memilih Versi Saya/My Version (local dataset). Namun, jika Anda
tidak mengetahui wilayah tersebut dan melihat pengguna tersebut lebih mahir maka Anda dapat
memilih Versi mereka/Their version (server dataset). Klik tanda panah biru pada kolom versi
yang telah Anda pilih. Konflik yang sudah berhasil diselesaikan akan berubah warna menjadi

hijau serta tanda centang hijau .

Tahap memilih salah satu versi yang benar untuk penyelesaian konflik

• Setelah Anda memilih versi mana yang menurut Anda paling benar, Anda harus memastikan warna
kolom sudah berubah dari warna merah muda menjadi warna hijau. Hal ini menandakan bahwa
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Anda telah berhasil memilih salah satu versi untuk menyelesaikan konflik.

Perbedaan warna antara konflik yang terjadi dan yang sudah diselesaikan

• Kemudian klik Apply Resolution seperti ditunjukkan gambar di bawah. Setelah Anda selesai
menyelesaikan semua konflik, Anda dapat memulai untuk upload hasil perubahan data OSM Anda.

Tampilan jendela konflik yang berhasil diselesaikan

• Pada jendela menu, Anda memiliki kotak jendelaConflicts . Jendela ini menampilkan jumlah
dari daftar konflik yang terjadi pada cara klik pada salah satu konflik lalu klik tombol Resolve.
Anda juga dapat menggunakan cara lain yaitu dengan klik kanan pada salah satu konflik, lalu pilih
Resolve to my versions atau Resolve to their versions. Untuk menemukan objek yang terkena
konflik, klik kanan lalu klik Zoom to Conflict. Ini sangat berguna apabila Anda berhadapan dengan
banyak konflik dan Anda perlu memeriksa dan menyelesaikannya satu per satu.
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Tampilan jendela dari daftar konflik pada JOSM

Catatan : Anda tidak dapat meng-upload perubahan sampai panel Conflicts kosong dan
semua konflik telah diselesaikan. Perlu diperhatikan bahwa Anda perlu berhati-hati dalam
menyelesaikan konflik yang terjadi dan sebaiknya konflik diperiksa dan diselesaikan satu
persatu agar hasilnya lebih maksimal.

IV. Cara menghindari konflik data di JOSM

Anda dapat melakukan beberapa hal, agar terhindar dari konflik saat meng-upload objek ke dalam server
OSM.

a. Meng-upload hasil perubahan secara berkala

• Untuk meminimalkan konflik yang dapat terjadi, Anda dapat mengupload secara berkala untuk
hasil pengeditan data OSM. Misalnya, jika Anda akan melakukan pemetaan 100 bangunan dan
koneksi internet Anda tidak bagus, maka Anda dapat mengupload secara berkala setiap Anda
mendijitasi 20 bangunan atau setiap 15 menit sekali. Kemungkinan konflik akan muncul lebih
banyak apabila Anda mengedit seluruh wilayah terlebih dahulu dan menunda untuk meng-upload
nya. Semakin lama selang waktu antara men-download data dengan meng-upload editan Anda,
maka semakin besar kemungkinan seseorang telah mengedit data tersebut pada saat itu.

• Jika Anda menyimpan data OSM dan ingin meng-upload di waktu yang tidak bersamaan, maka
Anda dapat membarui data OSM untuk mendapatkan data OSM terbaru yang ada di server OSM.
Sebelum meng-upload pekerjaan Anda ke OSM, klik pada menu File → Update data atau pilih
Update Modified lalu tunggu sampai proses pembaharuan data selesai. Setelah itu Anda dapat

meng-upload data dengan menggunakan opsi Upload data pada menu File atau klik ikon
pada bar menu.
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Pilihan update data pada menu File

b. Lakukan perubahan hanya di area yang di-download

Anda dapat melakukan pemetaan di wilayah yang spesifik untuk mengurangi risiko konflik dengan tidak
mengedit objek yang berada di area yang diarsir pada data layer JOSM. Langkah ini dapat menghindari
banyak pengguna mengedit di wilayah yang sama. Anda dapat dengan mudah melihat mana daerah
luar dari daerah yang Anda download di JOSM, karena latar belakang daerah luar tersebut terdapat
garis-garis diagonal (arsiran), bukan hanya warna hitam.
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Perbedaan area hasil download (hitam polos) dan area di luar hasil download (garis arsiran)

Setelah Anda melakukan download data, area untuk Anda melakukan perubahan ialah area kotak
yang tidak mempunyai garis arsiran. Area diluar kotak yang merupakan area arsiran adalah area yang
mungkin saja sedang dikerjakan oleh pengguna lain. Sebaiknya Anda menghindari area tersebut untuk
menghindari terjadinya konflik.

c. Menggunakan Tasking Manager

Jika Anda ingin memetakan wilayah yang sama secara kolaboratif, maka Anda dapat menggunakan
Tasking Manager. Dengan menggunakan Tasking Manager, Anda lebih mudah memilih wilayah yang
spesifik dan wilayah tersebut tidak bisa diambil oleh pengguna lainnya. Para relawan pemetaan di
area tersebut dapat memilih sebuah kotak yang ingin dipetakan, dan ketika mereka selesai melakukan
pemetaan, mereka dapat menandai kotak tersebut sebagai komplit atau sudah selesai dipetakan. Den-
gan cara ini, sebuah tim yang berisi banyak orang yang tersebar di berbagai daerah dapat berkoordinasi
bersama untuk menyelesaikan pemetaan pada grid tersebut. Penggunaan grid/kotak untuk membagi
area kerja masing-masing tiap pengguna dapat meminimalisasi terjadinya konflik di JOSM. Cara peng-
gunaan Tasking Manager selengkapnya dapat dilihat pada modul Penggunaan Tasking Manager.

Tampilan situs Tasking Manager (tasks.openstreetmap.id)

RINGKASAN

Jika Anda dapat mengikuti dan mempraktikkan seluruh tahapan dalam bab ini, maka Anda telah berhasil
mengetahui pengertian konflik dan menyelesaikan konflik pada data OSM dengan menggunakan JOSM.
Selain itu, Anda juga telah berhasil mempelajari jenis-jenis konflik yang dapat terjadi dan mengetahui
cara-cara untuk menghindari konflik pada JOSM.
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